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บทคัดย่อ 
 การวิจัยครั้งนี้มีวัตถุประสงค์เพื่อ 1) พัฒนา หาคุณภาพและประสิทธิภาพของบทเรียนอีเลิร์นนิง่     
เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
และ 2) เปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน ก่อนเรียนกับหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง  
เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 กลุ่มตัวอย่างที่ใช้ในการวิจัยนี้คือนักเรียนชั้นมัธยมศึกษาปีที่ 3
โรงเรียนโนนกุงวิทยาคม จังหวัดอุบลราชธานี ปีการศึกษา 2557 ได้มาจากการจับสลากนักเรียนมา 1 
ห้องเรียน มีจ านวนนักเรียน 30 คน เครื่องมือที่ใช้ในการวิจัยประกอบด้วย บทเรียนอีเลิร์นนิ่ง แบบ
ประเมินคุณภาพของบทเรียนอีเลิร์นนิ่ง และแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน มีค่าดัชนีความ
สอดคล้อง (IOC) ระหว่าง 0.67-1.00 ค่าความยากง่าย (p) ระหว่าง 0.27- 0.80 ค่าอ านาจจ าแนก (r)      
ระหว่าง 0.20-0.47 และมีค่าความเชื่อถือได้ (KR 20) เท่ากับ 0.81 วิเคราะห์ข้อมูลโดยใช้สถิติ ค่าเฉลี่ย
ส่วนเบี่ยงเบนมาตรฐาน และการทดสอบที (t-test) ชนิดสองกลุ่มไม่เป็นอิสระต่อกัน  
 ผลการวิจัยพบว่า 1) บทเรียนอีเลิร์นนิ่ง มีคุณภาพด้านเนื้อหาอยู่ในระดับดีมาก ( ̅=4.51) และ     
ด้านเทคนิคการผลิตสื่ออยู่ในระดับดีมาก ( ̅=4.63) และมีประสิทธิภาพ E1/E2 เท่ากับ 82.00/88.00 
และ 2) ผลสัมฤทธิ์ทางการเรียนของนักเรียนหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร ์CS5 ชั้นมัธยมศึกษาปีที่ 3 สูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
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ABSTRACT 
 The purpose of this study were to 1) to develop and evaluate the quality as         
well as the efficiency of e-learning on Adobe Dreamweaver CS5 for Mathayomsaksa3 
students at Nongkungwittayakom School, and 2) to compare pre-test and post-test    
learning achievement of the students after the experiment. The samples in this study 
which were divided into three groups, a group of three experts and 30 students who 
were studying in the academic year 2557 from one class of Mathayomsaksa 3     
students at Nongkungwittayakom School UbonRatchathani, were obtained by means 
of Purposive Sampling and Simple Random Sampling respectively. The research 
instruments were the e-Learning lessons on Adobe Dreamweaver CS5, the e-learning 
evaluative questionnaire, and the e-learning achievement test. The statistics used in 
the analysis were mean ( ̅), standard deviation (S), and t-test for Dependent Samples.           
 The consistency index (IOC) was reported between 0.67-1.00 while the level of   
difficulty (P) was between 0.27-0.80; the discrimination (R) was between 0.20-0.47    
while the reliability (KR 20) was at 0.81. The result showed that the quality of e-learning 
lessons was at an excellent level ( ̅=4.51). The technical and media production was 
at an excellent level ( ̅=4.63) and the efficiency of e-learning lessons (E1/E2) was 
82/88 respectively, which was based on the assumption that it should not be less 
than 80/80 and when comparing to the overall learning achievement of e-learning, it 
is revealed that post-test achievement is higher than that of pre-test at .05 significant 
level. 
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กิตติกรรมประกาศ 
 
 วิทยานิพนธ์ฉบับนี้สําเร็จลุล่วงได้ก็ด้วยความอนุเคราะห์จาก ผู้ช่วยศาสตราจารย์ ดร.ทนงศักด์ิ 
โสวจัสสตากุล อาจารย์ที่ปรึกษาวิทยานิพนธ์ และ รองศาสตราจารย์ ดร.พรรณี ลีกิจวัฒนะ อาจารย์ที่
ปรึกษาวิทยานิพนธ์ร่วม ที่ได้กรุณาให้คําแนะนํา ช่วยเหลือ และช่วยตรวจสอบแก้ไขข้อบกพร่องต่างๆ 
จนวิทยานิพนธ์ฉบับน้ีสําเร็จได้อย่างสมบูรณ์ ผู้วิจัยรู้สึกซาบซ้ึงในความกรุณา และขอขอบพระคุณเป็น
อย่างสูง  
 ขอขอบพระคุณคณะกรรมการสอบวิทยานิพนธ์ทุกท่านท่ีได้กรุณาให้คําแนะนํา ตรวจสอบ 
แก้ไขข้อบกพร่องต่างๆ ในขั้นตอนสุดท้ายจนทําให้วิทยานิพนธ์ฉบับน้ีมีความสมบูรณ์ และผู้วิจัย
ขอขอบพระคุณผู้ทรงคุณวุฒิ ดร.ทศพร แสงสว่าง อาจารย์ประจําสาขาเทคโนโลยีและส่ือสาร
การศึกษา ภาควิชาเทคโนโลยีและสื่อสารการศึกษา คณะครุศาสตร์อุตสาหกรรม มหาวิทยาลัย
เทคโนโลยีราชมงคลธัญบุรี ดร.สมเกียรติ ตันติวงศ์วาณิช อาจารย์ประจําสาขาวิชาครุศาสตร์
อุตสาหกรรม คณะครุศาสตร์อุตสาหกรรม สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง
ดร.เศรษฐชัย ชัยสนิท ผู้ช่วยคณบดีฝ่ายวิจัย คณะเทคโนโลยีสารสนเทศ มหาวิทยาลัยศรีปทุม ที่ได้
กรุณาช่วยเหลือให้คําแนะนําและตรวจสอบแก้ไขข้อบกพร่องต่างๆ ของเคร่ืองมือวิจัยในครั้งนี้ เพ่ือ
ปรับปรุงให้มีคุณภาพและมีความเหมาะสมต่อการวิจัย และขอขอบคุณนักเรียนช้ันมัธยมศึกษาปีที่ 3 
โรงเรียนโนนกุงวิทยาคม ที่ให้ความร่วมมือในการเป็นกลุ่มตัวอย่างให้ผู้วิจัยได้เก็บข้อมูลในการวิจัยน้ีได้
เป็นอย่างดี 
 ขอขอบพระคุณบิดา มารดา และเพ่ือนนักศึกษารวมท้ังบุคคลที่ผู้วิจัยไม่ได้กล่าวถึงไว้ในที่น้ี ที่
ช่วยเหลือให้คําแนะนําต่างๆ และเป็นกําลังใจให้แก่ผู้วิจัยมาโดยตลอด 
 คุณค่าและประโยชน์อันพึงมีจากวิทยานิพนธ์ฉบับน้ี ผู้วิจัยขอมอบแด่ผู้มีพระคุณทุกท่านด้วย
ความเคารพย่ิง หากมีข้อผิดพลาดประการใด ผู้วิจัยขออภัยมา ณ ที่นี้ด้วย 
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บทที่ 1 

บทนํา 
 

1.1 ความเป็นมาและความสําคัญของปัญหา 
 
 การนําเอาระบบคอมพิวเตอร์มาใช้มากขึ้นในกระบวนการเรียนการสอนอีกทั้งคอมพิวเตอร์
สามารถใช้เป็นเครื่องมือช่วยสอนและสามารถสื่อสารแบบสองทางได้อย่างมีประสิทธิภาพ เป็น       
นวัตกรรมและเทคโนโลยีทางการศึกษาท่ีมีรูปแบบการนําเสนอเน้ือหาได้หลากหลาย ตอบสนองต่อ
การเรียนการสอนที่เน้นนักเรียนทุกคนมีความสามารถเรียนรู้และพัฒนาตนเองได้และถือว่าผู้เรียนมี
ความสําคัญท่ีสุด กระบวนการจัดการศึกษาต้องส่งเสริมให้ผู้เรียนสามารถพัฒนาตามธรรมชาติและ
เต็มตามศักยภาพ จัดการเรียนรู้ให้เกิดข้ึนได้ทุกเวลาทุกสถานที่ (สํานักงานคณะกรรมการการศึกษา
แห่งชาติ. 2542 : 7) ซ่ึงสังคมเทคโนโลยีสารสนเทศได้มีวิวัฒนาการและการเปล่ียนแปลงแบบก้าว    
กระโดด มีวิถีของการพัฒนาการเปลี่ยนแปลงไปอย่างรวดเร็วและซับซ้อนมากข้ึน 
 ซ่ึงความจําเป็นในการปรับเปลี่ยนเน้นในการพัฒนาเยาวชนของชาติเข้าสู่โลกยุคศตวรรษท่ี 21 
โดยมุ่งส่งเสริมผู้เรียนมีคุณธรรม รักความเป็นไทย ให้มีทักษะ การคิดวิเคราะห์ สร้างสรรค์ มีทักษะ
ด้านเทคโนโลยี สามารถทํางานร่วมกับผู้อ่ืน และสามารถอยู่ร่วมกับผู้อ่ืนในสังคมโลกได้อย่างสันติอัน
จะส่งผลต่อการพัฒนาประเทศแบบย่ังยืน เยาวชนไทยเติบโตในสังคมโลกที่กําลังเปลี่ยนแปลงอย่าง
รวดเร็วด้วยเทคโนโลยีและสติปัญญาของมนุษย์ เม่ือคํานึงถึงอัตราการเปลี่ยนแปลงและองค์ความรู้
มหาศาลที่กําลังถูกสร้างขึ้น นักเรียนจําเป็นต้องมีทักษะท่ีจําเป็นเพ่ือเผชิญความเปลี่ยนแปลงและใช้
ชีวิตอย่างคุ้มค่า (สํานักบริหารงานการมัธยมศึกษาตอนปลายและสํานักงานคณะกรรมการการศึกษา
ขั้นพ้ืนฐาน. 2554 : 4) 
 เม่ือเข้าสู่ศตวรรษท่ี 21 มีการปรับเปลี่ยนเทคโนโลยีสารสนเทศเน้นการให้ความสะดวกในด้าน
การบริหารจัดการ และให้เกิดความคล่องตัวต่อการดําเนินงานไปในทิศทางที่สอดคล้องกัน เป็นการใช้
เทคโนโลยีคอมพิวเตอร์แบบที่เป็นเคร่ืองเดียว หรือการเรียกผ่านเครือข่ายเช่ือมโยงสู่อินเตอร์เน็ต เพ่ือ
การค้นคว้าหาข้อมูลแลกเปลี่ยนความรู้บนเครือข่าย ซ่ึงที่ผ่านมาเราใช้สื่อการเรียนการสอนในรูปแบบ
ของสื่อประสม (Multimedia) ใช้การนําเสนอลงบนแผ่นซีดี - รอมโดยใช้ Authoring Tool ทั้งภาพ    
และเสียงเพ่ือเกิดการปฏิสัมพันธ์ (Interactive) ให้กับนักเรียน แต่ด้วยปัจจุบันเทคโนโลยีสารสนเทศ
เข้ามามีบทบาทอย่างมากเราสามารถติดต่อกับคนท้ังโลก สามารถเข้าไปค้นหาข้อมูลได้เพียงปลายน้ิว
สัมผัสบนเครือข่ายอินเตอร์เน็ต เป็นเหมืองความรู้อันมหาศาลเพ่ือใช้ในการพัฒนาองค์ความรู้ ดังนั้น
การปรับรูปแบบการเรียนการสอนในรูปแบบอีเลิร์นน่ิงจึงเกิดขึ้น 
 การใช้สื่อที่นิยมกันมากนอกจากอีเลิร์นน่ิงแล้ว ยังมีการเรียนการสอนด้วยสื่ออิเล็กทรอนิกส์ 
(Web Base Learning) เป็นการเรียนแบบผู้เรียนสามารถเรียนท่ีไหนก็ได้ เวลาใดก็ได้ไม่มีข้อจํากัด
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รูปแบบการเรียนการสอนและการเรียนการสอนทางไกล (Distance Education) เป็นการเรียนการ
สอนท่ีประยุกต์เทคโนโลยีหลาย ๆ อย่าง เช่น ระบบเครือข่ายคอมพิวเตอร์ การประชุมทางไกลชนิด
ภาพและเสียง รวมถึงเอกสารต่าง ๆ เพ่ือเข้าถึงนักเรียนท่ีอยู่ห่างไกลและเราสามารถนําซอฟแวร์ที่
เกี่ยวข้องกับการเขียนเว็บเพจ ซ่ึงเป็นโปรแกรมทางด้าน Authoring Tool เช่น Macromedia      
Dreamweaver เป็นต้น ใช้ในการสร้างเว็บไซต์สําหรับแสดงข้อมูลหรือสร้างองค์ความรู้และส่ิงที่ควร
คํานึงถึงจากการเรียนการสอนแบบ e-Learning โดย Khan (1997: 7-8) ได้กล่าวไว้ว่า การออกแบบ
เว็บที่ดีจะต้องมีความสําคัญต่อการเรียนการสอนเป็นอย่างมาก ดังนั้นจึงควรทําความเข้าใจถึง      
คุณลักษณะ 2 ประการของโปรแกรมการเรียนการสอนผ่านเว็บ  
  จากความก้าวหน้าทางด้านเทคโนโลยีด้านต่างๆ ไม่ว่าจะเป็นเทคโนโลยีคอมพิวเตอร์หรือ
เทคโนโลยีอินเตอร์เน็ต ส่งผลต่อการดํารงชีวิตของมนุษย์อย่างมาก ดังนั้นในการจัดการเรียนการสอน
จึงจําเป็นที่ต้องบรรจุรายวิชาคอมพิวเตอร์เข้าไปเป็นส่วนหน่ึงของหลักสูตร เพ่ือท่ีจะให้นักเรียนได้
ศึกษาและสามารถนําความรู้ไปใช้ในชีวิตประจําวัน หรือเป็นพ้ืนฐานในการศึกษาในระดับที่สูงขึ้น 
ตลอดจนใช้ในการประกอบอาชีพ และโปรแกรม Adobe Dreamweaver CS5 เป็นโปรแกรม              
สําเร็จรูปที่นิยมใช้งานในด้านการทําเว็บไซต์ สามารถเพ่ิมข้อความ ตัวเลข รูปภาพ เช่ือมโยงลิงค์ข้อมูล
รวมทั้งสามารถจัดเก็บข้อมูลในรูปแบบฐานข้อมูลได้ และเพ่ือให้สอดคล้องกับมาตรฐาน ง 3.1 เข้าใจ 
เห็นคุณค่าและใช้กระบวนการเทคโนโลยีสารสนเทศในการสืบค้นข้อมูล การเรียนรู้ การส่ือสาร การ     
แก้ปัญหา การทํางาน และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล และมีคุณธรรม (กระทรวง      
ศึกษาธิการ. 2551 : 216) โรงเรียนโนนกุงวิทยาคม อําเภอตระการพืชผล จังหวัดอุบลราชธานี ได้
บรรจุหลักสูตรการเรียนการสอนรายวิชาการออกแบบและเขียนเว็บไซต์ ซ่ึงมีการใช้ อะโดบี ดรีมวีฟ
เวอร์ CS5 สําหรับออกแบบเว็บไซต์ แต่นักเรียนยังไม่มีความรู้ในการใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
และยังขาดสื่อการเรียนการสอนรวมทั้งผู้สอนเน้นการถ่ายทอดความรู้และเน้ือหาในห้องเรียนมีการใช้
หนังสือประกอบการสอนเป็นส่วนใหญ่ ทําให้สนองความต้องการของนักเรียนได้น้อยและนักเรียนยัง
ขาดช่องทางในการศึกษาเน้ือหาเพ่ิมเติมหรือการทบทวนความรู้ที่เรียนผ่านไปแล้ว ดังน้ัน การจัดการ
เรียนการสอนด้วยระบบอีเลิร์นน่ิง จึงเป็นกระบวนการและส่ือที่ตรงกับลักษณะความสนใจของ
นักเรียน และน่าจะเป็นทางเลือกหน่ึงที่ผู้สอนจําเป็นต้องเลือกใช้ให้เกิดรูปแบบการเรียนการสอนแบบ
ผสมผสาน อันจะช่วยเร้าความสนใจของนักเรียนให้สามารถเรียนรู้ได้อย่างต่อเน่ือง อีกท้ังยังเอ้ือ
ประโยชน์ต่อผู้สอนในการจัดเตรียมการสอนล่วงหน้าและสร้างปฏิสัมพันธ์กับนักเรียนให้มากข้ึน 
 ดังนั้น ผู้วิจัยจึงมีความสนใจที่จะพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์   
CS5 ช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม เพ่ือให้นักเรียนมีความรู้ความเข้าใจเก่ียวกับการใช้ 
การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 และเพ่ือให้นักเรียนได้เข้ามาศึกษาหาความรู้ และทบทวนบทเรียน
ด้วยตนเอง แล้วยังช่วยให้นักเรียนได้ใช้ความคิดริเริ่มสร้างสรรค์มากขึ้น รวมทั้งเป็นศูนย์กลางของ
กิจกรรมการเรียนรู้และสร้างปฏิสัมพันธ์ระหว่างครูกับนักเรียนได้เป็นอย่างดี 
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1.2 วัตถุประสงค์ของการวิจัย 
 
 1. เพ่ือพัฒนาบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ที่มีคุณภาพและ      
ประสิทธิภาพ สําหรับนักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
 2. เพ่ือเปรียบเทียบผลสัมฤทธ์ิทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ของ                 
นักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม กอ่นเรียนกับหลังเรียนด้วยบทเรียนอีเลิร์นน่ิง 
 

1.3 สมมติฐานการวิจัย 
 
 ผลสัมฤทธ์ิทางการเรียนของนักเรียนหลังเรียนด้วยบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีม   
วีฟเวอร์ CS5 ช้ันมัธยมศึกษาปีที่ 3 สูงกว่าก่อนเรียน 
 

1.4  กรอบแนวคิดที่ใช้ในการวิจัย 
 
 1.4.1 กรอบแนวคิดในการพัฒนาบทเรียนอีเลิร์นนิ่ง 
 การวิจัยครั้งนี้ผู้วิจัยได้นํากรอบแนวคิดในการพัฒนาบทเรียนอีเลิร์นน่ิง ตามหลักการออกแบบ
ของ ADDIE Model อ้างใน ฉัตรพงศ์ ชูแสงนิล (2555) [ออนไลน์] โดยผู้วิจัยได้นํามาใช้ในการพัฒนา
บทเรียนมี 5 ขั้นตอนดังน้ี 
 1.  ขั้นการวิเคราะห์ (Analysis) 
 2.  ขั้นการออกแบบ (Design) 
 3.  ขั้นการพัฒนา (Development) 
 4.  ขั้นการนําไปใช้ (Implementation) 
 5.  ขั้นการประเมินผล (Evaluation) 
 

 1.4.2 กรอบแนวคิดในการออกแบบบทเรียน 
 กรอบแนวคิดในการออกแบบบทเรียน ผู้วิจัยดัดแปลงขั้นตอนการออกแบบจากกระบวนการ   
สอนแบบอีเลิร์นน่ิงของ Ritchie & Hoffman (1998 : 135-138) ในการออกแบบบทเรียนอีเลิร์นนิ่ง  
เพ่ือให้เกิดการเรียนรู้ที่ดีที่สุด โดยอาศัยกระบวนการเรียนการสอน 7 ขั้นตอน ดังนี ้
 1. การสร้างแรงจูงใจให้กับผู้เรียน (Motivating the learner)  
 2. การระบุวัตถุประสงค์ของการเรียน (Identifying what is to be learned)  
 3. การทบทวนความรู้เดิม (Reminding learners of past knowledge)   
 4. การกระตุ้นการเรียนรู้ (Requiring active involvement)   
 5. การให้คําแนะนําและข้อมูลย้อนกลับ (Providing guidance and feedback)  
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 6. การทดสอบความรู้ (Testing)  
 7. การนําเสนอข้อมูลเพ่ิมเติมหรือการซ่อมเสริม (Providing enrichment and remediation) 
 

 1.4.3 กรอบแนวคิดในการประเมนิคุณภาพของบทเรียนอีเลิร์นนิ่ง 
 ผู้วิจัยศึกษาจากแนวคิดของ ไพโรจน์ ตีรณธนากุล และคณะ (2546 : 197-204) กล่าวว่า การ
ประเมินคุณภาพของบทเรียนสามารถประเมินใน 2 ด้าน ดังนี้ 
 1. คุณภาพด้านเน้ือหา  
 2. คุณภาพด้านเทคนิคผลิตสื่อ  
 

 1.4.4 กรอบแนวคิดในการหาประสิทธิภาพบทเรียน 
 ผู้วิจัยศึกษาจากกรอบแนวคิดของประสิทธิภาพของกระบวนการ/ประสิทธิภาพของผลลัพธ์      
(E1/E2) ของ ชัยยงค์ พรหมวงศ์ (2521 : 136) โดยที่ E1 และ E2 มีความหมายดังนี้ 
 E1 แทน คะแนนเฉลี่ยของนักเรียนท่ีตอบถูกจากการทําแบบทดสอบระหว่างเรียนคิดเป็นร้อย   
ละ (ประสิทธิภาพของกระบวนการ) 
 E2 แทน คะแนนเฉลี่ยของนักเรียนที่ตอบถูกจากการทําแบบทดสอบหลังเรียนคิดเป็นร้อยละ 
(ประสิทธิภาพของผลลัพธ์) 
 

 1.4.5 กรอบแนวคิดในการวัดผลสัมฤทธิ์ทางการเรียน 
 ผู้วิจัยได้นําแนวความคิดของภพ เลาหไพบูลย์ (2537 : 161-165) มาใช้เป็นกรอบแนวความคิด
ในการสร้างแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ของ
นักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม โดยวัดพฤติกรรมทางด้านพุทธิสัยในระดับ   
ความรู้ - ความจํา ความเข้าใจ และการนําไปใช้ 
 

1.5 ขอบเขตของการวิจัย 
 
 1.5.1 ประชากรและกลุ่มตัวอย่าง 
 ประชากรที่ใช้ในการศึกษาคือ นักเรียนโรงเรียนโนนกุงวิทยาคม อําเภอตระการพืชผล จังหวัด
อุบลราชธานี สังกัดสํานักงานเขตพ้ืนที่การศึกษามัธยมศึกษา เขต 29 ภาคเรียนที่ 2 ปีการศึกษา 
2557 จํานวน 3 ห้อง มีนักเรียนห้องละ 30 คน รวมทั้งหมด 90 คน 
 กลุ่มตัวอย่างที่ใช้ในการศึกษาคือ นักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม อําเภอ
ตระการพืชผล จังหวัดอุบลราชธานี สังกัดสํานักงานเขตพ้ืนท่ีการศึกษามัธยมศึกษา เขต 29 ภาคเรียน
ที่ 2 ปีการศึกษา 2557 จํานวนนักเรียน 90 คน ซ่ึงได้มาจากได้มาจากการจับสลากนักเรียนมา 1 ห้อง 
เรียน มีนักเรียนจํานวน 30 คน 
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 1.5.2 ขอบเขตด้านเนื้อหา 
 เนื้อหาวิชาที่ใช้ในการสร้างบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ช้ันมัธยม 
ศึกษาปีที่ 3 ของโรงเรียนโนนกุงวิทยาคม วิชานี้อยู่ในกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี
ตามหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 ประกอบด้วยเน้ือหา 7 หน่วยการ
เรียน ดังนี้  
 1. หลักการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver 
 2. ใส่และตกแต่งข้อความบนเว็บเพจ 
 3. ใส่ภาพประกอบเว็บเพจ 
 4. การสร้างไฮเปอร์ลิงค์ 
 5. จัดหน้าเว็บเพจด้วยตาราง 
 6. แบ่งหน้าเว็บเพจด้วยเฟรม 
 7. เล่นมัลติมีเดียบนเว็บเพจ 
 

 1.5.3 โครงสร้างของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ชั้นมัธยม 
ศึกษาปีที่ 3 ในการวิจัยคร้ังน้ีประกอบด้วยส่วนต่างๆดังต่อไปน้ี 
 1. การเข้าสู่ระบบ (Login / Logout) 
 2. ส่วนของบทเรียน (Information) 
 2.1 ส่วนของบทนํา (Introduction) 
 2.2 วัตถุประสงค์ (Objection) 
 2.3 แบบทดสอบก่อนเรียน (Pre-test) 
 2.4 เน้ือหาของบทเรียน (Content) 
 2.5 แบบทดสอบท้ายบทเรียน (Post-test) 
 2.6 การประเมินผล (Evaluation) 

 

 1.5.4 ตัวแปรที่ศึกษา 
 การวิจัยครั้งนี้มีตัวแปรท่ีศึกษา ดังน้ี 
 1. คุณภาพของบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 สําหรับนักเรียนช้ัน
มัธยมศึกษาปีที่ 3 
 2. ประสิทธิภาพของบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 สําหรับนักเรียน
ช้ันมัธยมศึกษาปีที่ 3  
 3. ตัวแปรท่ีใช้ในการเปรียบเทียบผลสัมฤทธ์ิทางการเรียน กําหนดตัวแปรดังน้ี 
 ตัวแปรต้น คือ การเรียนด้วยบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 แบ่ง
ออกเป็นก่อนเรียนกับหลังเรียน 
 ตัวแปรตาม คือ ผลสัมฤทธ์ิทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
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1.6 ข้อตกลงเบ้ืองต้น 
 
 1. การใช้บทเรียนอีเลิร์นน่ิง นักเรียนต้องอ่านวิธีการใช้งานก่อน 
 2. นักเรียนที่เข้าเรียนด้วยบทเรียนอีเลิร์นน่ิง เร่ือง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 จะต้องมี
พ้ืนฐานความรู้เกี่ยวกับการใช้คอมพิวเตอร์มาบ้าง  
 3. ซอฟแวร์ที่ใช้สร้างบทเรียนอีเลิร์นน่ิงเป็นโปรแกรมมูเดิล Moodle เวอรช่ัน 2.8 
 4. ระบบฮาร์ดแวร์ที่ใช้มีดังน้ี 
 4.1 ซีพียู Pentium 4 หรือสูงกว่า 
 4.2 ระบบปฏิบัติwindows XP หรือ windows 7 หรือสูงกว่า 
 4.3 หน่วยความจําอย่างตํ่า 128 MB 
 4.5 การ์ดแสดงผล640 x 480,256-Color display หรือสูงกว่า 
 4.6 พ้ืนที่ว่างบนฮาร์ดดิสก์ อย่างตํ่า 100 MB 
 4.7 ระบบเสียง (sound card) ควรเป็น Sound Blaster หรือเทียบเท่า 
 5. โปรแกรมเว็บเบราเซอร์ Internet Explorer Version 8 ขึ้นไป หรือ Google Chrome 
สําหรับเปิดใช้งานโปรแกรม 
 

1.7 นิยามศัพท์เฉพาะที่ใช้ในการวิจัย 
 
 1. บทเรียนอีเลิร์นน่ิง หมายถึง บทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5    
สําหรับนักเรียนช้ันมัธยมศึกษาปีที่ 3 ประกอบด้วยเนื้อเรื่อง หลักการสร้างเว็บไซต์ด้วยโปรแกรม    
Dreamweaver ใส่และตกแต่งข้อความบนเว็บเพจ ใส่ภาพประกอบเว็บเพจ การสร้างไฮเปอร์ลิงค์ 
(Hyperlink) จัดหน้าเว็บเพจด้วยตาราง (Table) แบ่งหน้าเว็บเพจด้วยเฟรม (Frame) เล่นมัลติมีเดีย
บนเว็บเพจ (Web Multimedia) มีคําถามเพ่ือทดสอบก่อนและหลังเรียนระหว่างเรียนจะมีแบบทดสอบ
หลังหน่วยการเรียนให้นักเรียนฝึกปฏิบัติ เพ่ือเสริมความเข้าใจในการเรียน นอกจากนี้นักเรียนสามารถ
ย้อนกลับไปศึกษาใหม่ได้ 
 2. นักเรียน หมายถึง นักเรียนระดับช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม อําเภอ
ตระการพืชผล จังหวัดอุบลราชธานี ภาคเรียนที่ 1 ปีการศึกษา 2557 
 3. คุณภาพของบทเรียน หมายถึง ผลการประเมินบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 โดยการประเมินผู้ทรงคุณวุฒิ ซ่ึงแบ่งออกเป็น 2 ด้าน คือ 
 คุณภาพด้านเน้ือหา หมายถึง ด้านการนําเสนอเน้ือหา ด้านความถูกต้องของเนื้อหา ด้านแบบ 
ทดสอบและผลย้อนกลับ 
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 คุณภาพด้านเทคนิคการผลิตสื่อ หมายถึง ด้านตัวอักษร ด้านภาพน่ิง ด้านภาพเคลื่อนไหว ด้าน
ปฏิสัมพันธ์ 
 4. ประสิทธิภาพของบทเรียนอีเลิร์นน่ิง หมายถึง คุณภาพของบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ 
อะโดบี ดรีมวีฟเวอร์ CS5 ซ่ึงวัดจากผลสัมฤทธ์ิทางการเรียนของนักเรียนที่เรียนจากบทเรียนอีเลิร์นนิ่ง
ตามสูตร E1/ E2 ดังน้ี 
 E1 หมายถึง ประสิทธิภาพของกระบวนการซ่ึงคิดจากคะแนนของนักเรียน เม่ือศึกษาจากบท 
เรียนดังกล่าวแล้ว ทําแบบทดสอบระหว่างเรียนได้คะแนนเฉลี่ยไม่น้อยกว่าร้อยละ 80  
 E2 หมายถึง ประสิทธิภาพของผลลัพธ์ ซ่ึงคิดจากคะแนนของนักเรียน เม่ือศึกษาจากบทเรียน
ดังกล่าวแล้ว ทําแบบทดสอบหลังเรียนได้คะแนนเฉลี่ยไม่น้อยกว่าร้อยละ 80 
 5. แบบทดสอบวัดผลสัมฤทธ์ิ หมายถึง เครื่องมือท่ีใช้วัดผลสัมฤทธ์ิทางการเรียนของนักเรียนท่ี
เรียนด้วยบทเรียนอีเลิร์นน่ิง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 โดยมุ่งประเมินผลทางความรู้ -
ความจํา ความเข้าใจ และการนําไปใช้ 
 6. ผลสัมฤทธ์ิทางการเรียน หมายถึง คะแนนท่ีได้จากการทําแบบทดสอบก่อน และหลังจาก
นักเรียนช้ันมัธยมศึกษาปีที่ 3 ได้เรียนผ่านบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
โดยใช้แบบทดสอบวัดผลสัมฤทธ์ิทางการเรียนที่ผู้วิจัยสร้างข้ึน 
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บทท่ี 2 

เอกสารและงานวิจยัที่เกี่ยวข้อง 
 
 ในการศึกษาเอกสารและงานวิจัยที่เกี่ยวข้องกับการสร้างบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร์ CS5 ชั้นมัธยมศึกษาปีที่ 3 ผู้วิจัยได้แบ่งออกเป็นหมวดหมู่ดังนี้ 
 2.1 ข้อมูลพ้ืนฐานเกี่ยวกับหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 สาระ
การงานอาชีพและเทคโนโลยี 
 2.2 ความแตกต่างระหว่าง CAI WBI และ E-learning 
 2.3 แนวคิดเก่ียวกับบทเรียนอีเลิร์นนิ่ง 
 2.4 การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต 
 2.5 โปรแกรมท่ีใช้ในการพัฒนาบทเรียนอีเลิร์นนิง 
 2.6 ประสิทธิภาพของสื่อการเรียนการสอน 
 2.7 การวัดผลสัมฤทธิ์ทางการเรียน 
 2.8 งานวิจัยที่เกี่ยวข้อง 
 

2.1 ข้อมูลพื้นฐานเกี่ยวกับหลักสูตรแกนกลางการศึกษาข้ันพื้นฐาน พุทธศักราช 2551 
สาระการงานอาชีพและเทคโนโลยี  

 
 หลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 มีสาระส าคัญโดยสังเขปดังนี้             
(กระทรวงศึกษาธิการ. 2551 : 8 - 219)  
 

 2.1.1 หลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พ.ศ. 2551 มาตรฐานการเรียนรู้ 
 การพัฒนาผู้เรียนให้เกิดความสมดุลต้องค านึงถึงหลักพัฒนาการทางสมองและพหุปัญญา                           
หลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน จึงก าหนดให้ผู้เรียนเรียนรู้ 8 กลุ่มสาระการเรียนรู้ ดังนี้ 
 1. ภาษาไทย 
 2. คณิตศาสตร์ 
 3. วิทยาศาสตร์ 
 4. สังคมศึกษา ศาสนา และวัฒนธรรม 
 5. สุขศึกษาและพลศึกษา 
 6. ศิลปะ 
 7. การงานอาชีพและเทคโนโลยี 
 8. ภาษาต่างประเทศ 
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 ในแต่ละกลุ่มสาระการเรียนรู้ได้ก าหนดมาตรฐานการเรียนรู้เป็นเป้าหมายส าคัญของการพัฒนา
คุณภาพผู้เรียน มาตรฐานการเรียนรู้ระบุสิ่งที่ผู้เรียนพึงรู้และปฏิบัติได้และมีคุณลักษณะอันพึงประสงค์
อย่างไร เมื่อจบการศึกษาขั้นพ้ืนฐานนอกจากนั้นมาตรฐานการเรียนรู้ยังเป็นกลไกส าคัญ ในการ
ขับเคลื่อนพัฒนาการศึกษาทั้งระบบเพราะมาตรฐานการเรียนรู้จะสะท้อนให้ทราบว่าต้องการอะไรจะ
สอนอย่างไรและประเมินอย่างไรรวมทั้งเป็นเครื่องมือในการตรวจสอบเพ่ือการประกันคุณภาพ
การศึกษาโดยใช้ระบบการประเมินคุณภาพภายในและการประเมินคุณภาพภายนอก ซึ่งรวมถึงการ
ทดสอบระดับเขตพ้ืนที่การศึกษาและการทดสอบระดับชาติ ระบบการตรวจสอบเพ่ือประกันคุณภาพ
ดังกล่าวเป็นสิ่งส าคัญที่ช่วยสะท้อนภาพการจัดการศึกษาว่าสามารถพัฒนาผู้เรียนให้มีคุณภาพตามที่
มาตรฐานการเรียนรู้ก าหนดเพียงใด 
 ตัวช้ีวัด 
 ตัวชี้วัดระบุสิ่งที่นักเรียนพึงรู้และปฏิบัติได้รวมทั้งคุณลักษณะของผู้เรียนในแต่ละระดับชั้น  ซึ่ง
สะท้อนถึงมาตรฐานการเรียนรู้ มีความเฉพาะเจาะจงและมีความเป็นรูปธรรม น าไปใช้ในการก าหนด
เนื้อหา จัดท าหน่วยการเรียนรู้ จัดการเรียนการสอนและเป็นเกณฑ์ส าคัญส าหรับการวัดประเมินผล
เพ่ือตรวจสอบคุณภาพผู้เรียน 
 1. ตัวชี้วัดชั้นปี เป็นเป้าหมายในการพัฒนาผู้เรียนแต่ละชั้นปีในระดับการศึกษาภาคบังคับ
(ประถมศึกษาปีที ่1- มัธยมศึกษาปีที ่3) 
 2. ตัวชี้วัดช่วงชั้น เป็นเป้าหมายในการพัฒนาผู้ เรียนในระดับมัธยมศึกษาตอนปลาย
(มัธยมศึกษาปีที ่4 - มัธยมศึกษาปีที ่6) 
 กิจกรรมพัฒนาผู้เรียน 
 กิจกรรมพัฒนาผู้เรียน มุ่งให้ผู้เรียนได้พัฒนาตนเองตามศักยภาพ พัฒนาอย่างรอบด้านเพ่ือ
ความเป็นมนุษย์ที่สมบูรณ์ ทั้งร่างกาย สติปัญญา อารมณ์ และสังคม เสริมสร้างให้เป็นผู้มีศีลธรรม 
จริยธรรม มีระเบียบวินัย ปลูกฝังและสร้างจิตส านึกของการท าประโยชน์เพ่ือสังคม สามารถจัดการ
ตนเองได ้และอยู่ร่วมกับผู้อ่ืนอย่างมีความสุขกิจกรรมพัฒนาผู้เรียน แบ่งเป็น 3 ลักษณะ ดังนี้ 
 1. กิจกรรมแนะแนว เป็นกิจกรรมที่ส่งเสริมและพัฒนาผู้เรียนให้รู้จักตนเอง รู้รักษ์สิ่งแวดล้อม 
สามารถคิดตัดสินใจ คิดแก้ปัญหา ก าหนดเป้าหมาย วางแผนชีวิตทั้งด้านการเรียน และอาชีพ 
สามารถปรับตนได้อย่างเหมาะสม นอกจากนี้ยังช่วยให้ครูรู้จักและเข้าใจนักเรียน ทั้งยังเป็นกิจกรรมที่
ช่วยเหลือและให้ค าปรึกษาแก่ผู้ปกครองในการมีส่วนร่วมพัฒนาผู้เรียน 
 2. กิจกรรมนักเรียน เป็นกิจกรรมที่มุ่งพัฒนาความมีระเบียบวินัยความเป็นผู้น าผู้ตามที่ดี 
ความรับผิดชอบการท างานร่วมกัน การรู้จักแก้ปัญหา การตัดสินใจที่เหมาะสม ความมีเหตุผล การ
ช่วยเหลือแบ่งปันกันเอ้ืออาทร และสมานฉันท์ โดยจัดให้สอดคล้องกับความสามารถ ความถนัด และ
ความสนใจของผู้เรียนให้ได้ปฏิบัติด้วยตนเองในทุกขั้นตอน ได้แก่ การศึกษาวิเคราะห์วางแผน ปฏิบัติ
ตามแผน ประเมินและปรับปรุงการท างาน เน้นการท างานร่วมกันเป็นกลุ่ม ตามความเหมาะสมและ
สอดคล้องกับวุฒิภาวะของผู้เรียน บริบทของสถานศึกษาและท้องถิ่น กิจกรรมนักเรียนประกอบด้วย 
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 2.1 กิจกรรมลูกเสือ เนตรนารี ยุวกาชาด ผู้บ าเพ็ญประโยชน์ และนักศึกษาวิชาทหาร 
 2.2 กิจกรรมชุมนุม ชมรม 
 3. กิจกรรมเพื่อสังคมและสาธารณประโยชน์ เป็นกิจกรรมที่ส่งเสริมให้ผู้เรียนบ าเพ็ญตนให้
เป็นประโยชน์ต่อสังคม ชุมชน และท้องถิ่นตามความสนใจในลักษณะอาสาสมัคร เพ่ือแสดงถึงความ
รับผิดชอบ ความดีงาม ความเสียสละต่อสังคมมีจิตสาธารณะ เช่น กิจกรรมอาสาพัฒนาต่างๆ 
กิจกรรมสร้างสรรค์สังคม 
 ระดับการศึกษา หลักสูตรแกนกลางการศึกษาข้ันพื้นฐาน จัดเป็น 3 ระดับ ดังนี้ 
 1. ระดับประถมศึกษา (ชั้นประถมศึกษาปีที่ 1 - 6) การศึกษาระดับนี้เป็นช่วงแรกของการศึกษา 
ภาคบังคับ มุ่งเน้นทักษะพ้ืนฐานด้านการอ่าน การเขียน การคิดค านวณ ทักษะการคิดพ้ืนฐานการ
ติดต่อสื่อสาร กระบวนการเรียนรู้ทางสังคม และพ้ืนฐานความเป็นมนุษย์ การพัฒนาคุณภาพชีวิตอย่าง
สมบูรณ์และสมดุลทั้งในด้านร่างกาย สติปัญญา อารมณ์ สังคม และวัฒนธรรม โดยเน้นจัดการเรียนรู้
แบบบูรณาการ 
 2. ระดับมัธยมศึกษาตอนต้น (ชั้นมัธยมศึกษาปีที่ 1 - 3) เป็นช่วงสุดท้ายของการศึกษาภาค      
บังคับมุ่งเน้นให้ผู้เรียนได้ส ารวจความถนัดและความสนใจของตนเอง ส่งเสริมการพัฒนาบุคลิกภาพ
ส่วนตน มีทักษะในการคิดวิจารณญาณ คิดสร้างสรรค์ และคิดแก้ปัญหา มีทักษะในการด าเนินชีวิต มี
ทักษะการใช้เทคโนโลยีเพ่ือเป็นเครื่องมือในการเรียนรู้  มีความรับผิดชอบต่อสังคม มีความสมดุลทั้ง
ด้านความรู้ความคิด ความดีงาม และมีความภูมิใจในความเป็นไทย ตลอดจนใช้เป็นพ้ืนฐานในการ
ประกอบอาชีพหรือการศึกษาต่อ 
 3. ระดับมัธยมศึกษาตอนปลาย (ชั้นมัธยมศึกษาปีที่ 4 - 6) การศึกษาระดับนี้เน้นการเพ่ิมพูน      
ความรู้และทักษะเฉพาะด้าน สนองตอบความสามารถ ความถนัด และความสนใจของผู้เรียนแต่ละคน
ทั้งด้านวิชาการและวิชาชีพ มีทักษะในการใช้วิทยาการและเทคโนโลยี ทักษะกระบวนการคิดขั้นสูง 
สามารถน าความรู้ไปประยุกต์ใช้ให้เกิดประโยชน์ในการศึกษาต่อและการประกอบอาชีพ มุ่งพัฒนาตน
และประเทศตามบทบาทของตน สามารถเป็นผู้น าและผู้ให้บริการชุมชนในด้านต่าง ๆ 
 การจัดเวลาเรียน 
 หลักสูตรแกนกลางการศึกษาข้ันพื้นฐาน ได้ก าหนดกรอบโครงสร้างเวลาเรียนขั้นต่ าส าหรับกลุ่ม
สาระการเรียนรู้ 8 กลุ่มและกิจกรรมพัฒนาผู้เรียน ซึ่งสถานศึกษาสามารถเพ่ิมเติมได้ตามความพร้อม
และจุดเน้นเน้น โดยสามารถปรับให้เหมาะสมตามบริบทของสถานศึกษาและสภาพของผู้เรียน ดังนี้ 
 1. ระดับชั้นประถมศึกษา (ชั้นประถมศึกษาปีที่ 1 - 6) ให้จัดเวลาเรียนเป็นรายปี โดยมีเวลา
เรียนวันละ ไม่เกิน 5 ชั่วโมง 
 2. ระดับชั้นมัธยมศึกษาตอนต้น (ชั้นมัธยมศึกษาปีที่ 1 - 3) ให้จัดเวลาเรียนเป็นรายภาคมีเวลา 
เรียนวันละไม่เกิน 6 ชั่วโมง คิดน้ าหนักของรายวิชาที่เรียนเป็นหน่วยกิต ใช้เกณฑ์ 40 ชั่วโมงต่อภาค
เรียนมีค่าน้ าหนักวิชา เท่ากับ 1 หน่วยกิต (นก.) 
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 3. ระดับมัธยมศึกษาตอนปลาย (ชั้นมัธยมศึกษาปีที่ 4 - 6) ให้จัดเวลาเรียนเป็นรายภาค มี    
เวลาเรียน วันละไม่น้อยกว่า 6 ชั่วโมง คิดน้ าหนักของรายวิชาที่เรียนเป็นหน่วยกิต ใช้เกณฑ์ 40 
ชั่วโมงต่อภาคเรียน มีค่าน้ าหนักวิชาเท่ากับ 1 หน่วยกิต (นก.) 
 2.1.2 ความส าคัญของกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี 
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีเป็นกลุ่มสาระที่ช่วยพัฒนาให้ผู้เรียนมีความรู้
ความเข้าใจมีทักษะพ้ืนฐานที่จ าเป็นต่อการด ารงชีวิตและรู้เท่าทันการเปลี่ยนแปลงสามารถน าความรู้
เกี่ยวกับการด ารงชีวิต การอาชีพและเทคโนโลยีมาใช้ประโยชน์ในการท างานอย่างมีความคิด
สร้างสรรค์และแข่งขันในสังคมไทยและสากล เห็นแนวทางในการประกอบอาชีพรักการท างานและมี
เจตคติที่ดีต่อการท างานสามารถด ารงชีวิตอยู่ในสังคมได้อย่างพอเพียงและมีความสุข   
 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี มุ่งพัฒนาผู้เรียนแบบองค์รวม เพ่ือให้มี
ความรู้ความสามารถ มีทักษะในการท างาน เห็นแนวทางในการประกอบอาชีพและการศึกษาต่อได้
อย่างมีประสิทธิภาพโดยมีสาระส าคัญ ดังนี้   
 การด ารงชีวิตและครอบครัว เป็นสาระเกี่ยวกับการท างานในชีวิตประจ าวัน  การช่วยเหลือ
ตนเอง ครอบครัวและสังคมได้ในสภาพเศรษฐกิจที่พอเพียงไม่ท าลายสิ่งแวดล้อม เน้นการปฏิบัติจริง
จนเกิดความมั่นใจและภูมิใจในผลส าเร็จของงาน เพ่ือให้ค้นพบความสามารถความถนัดและความ
สนใจของตนเอง 
 การออกแบบและเทคโนโลยี เป็นสาระเกี่ยวกับการพัฒนาความสามารถของมนุษย์อย่าง
สร้างสรรค์ โดยน าความรู้มาใช้กับกระบวนการเทคโนโลยี สร้างสิ่งของเครื่องใช้วิธีการหรือเพ่ิม
ประสิทธิภาพในการด ารงชีวิต 
 เทคโนโลยีสารสนเทศและการสื่อสาร เป็นสาระเก่ียวกับกระบวนการเทคโนโลยีสารสนเทศ การ
ติดต่อสื่อสาร การค้นหาข้อมูล การใช้ข้อมูลและสารสนเทศ การแก้ปัญหาหรือการสร้ างงาน คุณค่า
และผลกระทบของเทคโนโลยีสารสนเทศและการสื่อสาร 
 การอาชีพ เป็นสาระเกี่ยวกับทักษะที่จ าเป็นต่ออาชีพ เห็นความส าคัญของคุณธรรม จริยธรรม
และเจตคติที่ดีต่ออาชีพ ใช้เทคโนโลยีได้เหมาะสมเห็นคุณค่าของอาชีพสุจริตและเห็นแนวทางในการ
ประกอบอาชีพ 
 สาระการเรียนรู้การงานอาชีพและเทคโนโลยี  
 สาระที่เป็นองค์ความรู้ของกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ประกอบด้วย  
 สาระที่ 1 การด ารงชีวิตและครอบครัว 
 สาระที่ 2 การออกแบบและเทคโนโลยี 
 สาระที่ 3 เทคโนโลยีสารสนเทศและการสื่อสาร 
 สาระที่ 4 การอาชีพ 
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 สาระและมาตรฐานการเรียนรู้ 
 มาตรฐาน ง 1.1 เข้าใจการท างาน มีความคิดสร้างสรรค์ มีทักษะกระบวนการท างาน ทักษะ
การจัดการ ทักษะกระบวนการแก้ปัญหา ทักษะการท างานร่วมกัน และทักษะการแสวงหาความรู้ มี
คุณธรรมและลักษะนิสัยในการท างาน มีจิตส านึกในการใช้พลังงาน ทรัพยากรและสิ่งแวดล้อม เพ่ือ
การด ารงชีวิตและครอบครัว 
 มาตรฐาน ง 2.1 เข้าใจเทคโนโลยีและกระบวนการเทคโนโลยี ออกแบบและสร้ างสิ่งของ
เครื่องใช้หรือวิธีการ ตามกระบวนการเทคโนโลยีอย่างมีความคิดสร้างสรรค์ เลือกใช้เทคโนโลยีในทาง
สร้างสรรค์ต่อชีวิต สังคม สิ่งแวดล้อม และมีส่วนร่วมในการจัดเทคโนโลยีที่ยั่งยืน 
 มาตรฐาน ง 3.1 เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการสือบค้น
ข้อมูลการเรียนรู้ การสื่อสาร การแก้ปัญหาการท างาน และอาชีพอย่างมีประสิทธิภาพ ประสิทธิผล 
และมีคุณธรรม 
 มาตรฐาน ง 4.1 เข้าใจ มีทักษะที่จ าเป็น มีประสบการณ์ เห็นแนวทางในงานอาชีพใช้เทคโนโลยี 
เพ่ือพัฒนาอาชีพ มีคุณธรรม และมีเจตคติที่ดีต่ออาชีพ 
 

 2.1.3 ข้อมูลเกี่ยวกับรายวิชาการงานอาชีพและเทคโนโลยี 
 หลักสูตรวิชาการงานอาชีพและเทคโนโลยีนี้เป็นหลักสูตรของสถานศึกษา กลุ่มสาระการงาน
อาชีพและเทคโนโลยีรหัสวิชา ง 23101 รายวิชาการงานอาชีพและเทคโนโลยี ชั้นมัธยมศึกษาปีที่ 3 
จ านวน 1 หน่วยกิต ต่อภาคเรียน เวลา 40 ชั่วโมง ซึ่งเรื่องการสร้างเว็บไซต์นี้ได้ถูกบรรจุไว้ใน 
ภาคเรียนที่ 1 จ านวนเวลาเรียน 10 ชั่วโมง มีรายละเอียดวิชาดังนี้ 
 1. ค าอธิบายรายวิชา 
 ศึกษาค้นคว้า ความรู้ทั่วไปเกี่ยวกับการท าโฮมเพจ เวิรด ไวด์ เว็บ เว็บเบราเซอร์ โฮมเพจ เว็บ
เพจ เว็บไซต์ ขั้นตอนวิธีการสร้างโฮมเพจ โดยใช้โปรแกรม Adobe Dreamweaver CS5   
 การจัดการเว็บเพจ ปรับแต่งและการออกแบบเว็บเพจ การเพ่ิมลูกเล่นต่างๆส าหรับหน้า
โฮมเพจ เชื่อมโยงเว็บไซต์ของตนเองและผู้อ่ืน   
 นักเรียนมีคุณธรรม จริยธรรมในการจัดท าเว็บไซต์และการใช้อินเตอร์เน็ตในทางที่เป็นประโยชน์ 
 2. จุดประสงค์รายวิชา 
 2.1 มีความรู้พ้ืนฐานเกี่ยวกับ Dreamweaver และการท างานเบื้องต้นของเว็บไซต์ 
 2.2 บอกความหมายของโฮมเพจ เว็บเพจและเว็บไซต์ได้ 
 2.3 สามารถสร้างเว็บเพจออกมาเป็นชิ้นงานได้ 
 3. โครงสร้างกลุ่มสาระการงานอาชีพและเทคโนโลยี ระดับชั้นมัธยมศึกษาปีท่ี 3 รหัสวิชา  
ง. 23101 
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ตารางท่ี 2.1  โครงสร้างกลุ่มสาระการงานอาชีพและเทคโนโลยี ระดับชั้นมัธยมศึกษาปีที่ 3 

หน่วยที่ ชื่อหน่วยการเรียนรู้ / หน่วยย่อยการเรียนรู้ จ านวนชั่วโมง 

ภาคเรียนที่  2 

1 หลักการท าโครงงาน 5 

2 โปรแกรมภาษาขั้นพ้ืนฐาน  10 

3 น าเสนองานด้วยเทคโนโลยีสารสนเทศ 10 

4 คอมพิวเตอร์ช่วยสร้างผลงาน 10 

5 ทางเลือกประกอบอาชีพ 5 

 
2.2 ความแตกต่างระหว่าง CAI WBI และ E-learning 
 
 การเรียนการสอนแบบ e-learning มีความแตกต่างกัน ผู้สอนควรเลือกใช้เครื่องมือที่เหมาะสม
กับบทเรียน ดังนั้นผู้วิจัยจึงขอสรุปความแตกต่างของแต่ละชนิดดังนี้ 
 

 2.2.1 การเรียนการสอนปกติในชั้นเรียน 
 1. ผู้เรียนถูกจ ากัดด้วยเวลาเรียน ชั้นเรียน และท่ีตั้งของสถานศึกษา 
 2. ผู้เรียนกับผู้สอนมีการเผชิญหน้ากันโดยตรง การสื่อสารใช้ค าพูดเป็นหลัก 
 3. บทเรียนมีการควบคุมเวลาโดยผู้สอนและหลักสูตร 
 4. สื่อการเรียนการสอนที่ใช้เป็นหลัก ได้แก่ เอกสารสิ่งพิมพ์ และการบรรยาย 
 5. การจัดกลุ่มกิจกรรมการเรียนการสอนท าได้ค่อนข้างจ ากัด เนื่องจากปัญหาทางด้านจ านวน
ผู้เรียน เวลาเรียนและสถานที่ 
 

 2.2.2 การเรียนการสอนด้วยบทเรียนบนเว็บ 
 1. ผู้เรียนเลือกเวลาศึกษาบทเรียนได้ตามความสะดวก 
 2. ผู้เรียนกับผู้สอนติดต่อสื่อสารซึ่งกันและกันผ่านเครือข่ายอินเทอร์เน็ต 
 3. บทเรียนไม่มีการควบคุมเวลา ผู้เรียนสามารถศึกษาได้ตามความสามารถของตนเอง 
 4. สื่อการเรียนการสอนที่ใช้มีหลากหลาย ทั้งบทเรียนบนเว็บหรือข้อมูลอ่ืน ๆ จากแหล่งข้อมูล
บนเครือข่ายใยแมงมุม 
 5. การจัดกลุ่มกิจกรรมการเรียนการสอนท าได้หลากหลายรูปแบบ เนื่องจากผู้เรียนไม่จ าเป็น 
ต้องเดินทางไปร่วมกลุ่ม 
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 2.2.3 บทเรียน CAI/CBT 
 1. เป็นการใช้งานในลักษณะโดยล าพัง 
 2. สนับสนุนการเรียนการสอนแบบ Asynchronous เพียงอย่างเดียว 
 3. ไม่สามารถจัดการเรียนการสอนแบบร่วมมือได้ (Collaborative Learning) 
 4. จัดให้มีระบบพ่ีเลี้ยง (Mentoring) ในการเรียนการสอนได้ยาก 
 5. สามารถเข้าถึงบทเรียนได้เป็นบางส่วนเท่านั้น 
 6. ไม่สนับสนุนให้เกิดเครือข่ายหรือสังคมแห่งการเรียนรู้ 
 

 2.2.4 บทเรียน WBI/WBT 
 1. เป็นการใช้งานในลักษณะเครือข่าย 
 2. สนับสนุนการเรียนการสอนทั้งแบบ Synchronous และ Asynchronous 
 3. สนับสนุนการเรียนการสอนแบบร่วมมืออย่างสมบูรณ์ 
 4. สามรถจัดให้มีระบบพ่ีเลี้ยง เพ่ือช่วยเหลือผู้เรียนเกี่ยวกับการเรียนการสอน 
 5. สามารถเข้าถึงบทเรียนได้ทุกๆ ส่วน 
 6. เปิดโอกาสให้เกิดเครือข่ายหรือสังคมแห่งการเรียนรู้ได้ง่ายและกว้างไกลกว่า 

 

 2.2.5 บทเรียน e-learning 
 1. ความยืดหยุ่นและความสะดวก ความสะดวกสบายและการเข้าถึงข้อมูล ผู้เรียนสามารถเข้า 
ถึงเนื้อหาตามความต้องการได้อย่างสะดวก รวดเร็ว ผ่านอินเทอร์เน็ตโดยไม่จ ากัดสถานที่และเวลา 
ผู้เรียนสามารถเชื่อมโยงการเข้าถึงข้อมูลที่หลากหลายทางอินเทอร์เน็ต 
 2. ผู้เรียนสามารถควบคุมการเรียนด้วยตนเอง ดังนั้นวิธีเรียนด้วยอีเลิร์นนิ่งจึงช่วยเพ่ิมความพึง
พอใจและลดความเครียดของผู้เรียนได้ทางหนึ่ง 
 3. ผู้สอนสามารถเสนอเนื้อหา ปรับปรุง เปลี่ยนแปลงแก้ไขเนื้อหา และสื่อการสอนได้ง่ายและ
สะดวกผ่านอีเลิร์นนิ่ง ท าให้น าเสนอข้อมูลที่ทันสมัยอยู่เสมอ 
 4. เป็นการสื่อสารแบบสองทิศทาง เป็นการสื่อสารและปฏิสัมพันธ์ทางการเรียนระหว่างผู้สอน
และผู้เรียนจะดีกว่าการเรียนในห้องบรรยายใหญ่ ซึ่งปฏิสัมพันธ์ในกานเรียนอีเลิร์นนิ่งช่วยให้ผู้สอน
และผู้เรียนใกล้ชิดกันผ่านเทคโนโลยี โดยปัจจัยนั้นมีความส าคัญต่อการสร้างความส าเร็จในการเรยน
ของผู้เรียนด้วย 
 5. รูปแบบมัลติมีเดีย สามารถน าเสนอเนื้อหาที่มีรูปแบบหลากหลายมากขึ้น เช่น ตัวอักษร 
เสียง วีดีทัศน์ และการติดต่อสื่อสาร ณ เวลาจริง 
 6. ระยะเวลา ช่วยลดเวลาในการเดินทางของผู้เรียน โดยไม่ต้องเดินทางมาสถานศึกษาและ
ห้องเรียนนอกจจากนี้ยังสามารถก าหนดเวลาการเรียนและกิจกรรมการเรียนรู้ได้ 
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2.3 แนวคิดเกี่ยวกับบทเรียนอีเลิร์นนิ่ง 
 
 2.3.1 ความหมายของบทเรียนอีเลิร์นนิ่ง 
 อีเลิร์นนิ่ง เป็นการใช้เทคโนโลยีคอมพิวเตอร์ เทคโนโลยีเครือข่าย และเทคโนโลยีการสื่อสาร 
เป็นเครื่องมือในการสร้างสรรค์ และส่งผ่านองค์ความรู้ในรูปแบบต่างๆ ไปยังผู้เรียนในสถานที่แตก 
ต่างกัน ให้ได้รับความรู้ ทักษะ และประสบการณ์ร่วมกัน อย่างมีชีวิตชีวา กระบวนการเรียนรู้จะถูก
สร้างสรรค์ขึ้นมาอย่างเหมาะสม และน าไปใช้กับผู้เรียนในลักษณะของการศึกษาทางไกลและการ
ฝึกอบรม โดยที่ผู้เรียนสามารถเรียนรู้ได้ตามความถนัดและความสามารถของตนเอง ระบบอีเลิร์นนิ่ง
ผ่านเครือข่ายคอมพิวเตอร์ จะด าเนินการจัดการต่างๆ เกี่ยวกับกระบวนการเรียนการสอนให้เป็นไป
อย่างอัตโนมัติ เสมือนกับการเรียนการสอนในสถานศึกษาปกติ (มนต์ชัย เทียนทอง. 2545 : 265) 
 อีเลิร์นนิ่ง หมายถึง การเรียนเนื้อหาหรือสารสนเทศส าหรับการเรียนการสอนหรือการอบรม ซึ่ง
การน าเสนอด้วยอักษร ภาพนิ่ง ผสมผสานกับการใช้ภาพเคลื่อนไหว วีดีทัศน์ และเสียง โดยอาศัย
เทคโนโลยีของเว็บ (Web Technology) ในการถ่ายทอดเนื้อหา รวมทั้งการใช้เทคโนโลยีระบบจัดการ
คอร์ส ในการบริหารการจัดการงานสอนต่างๆ เช่นการจัดให้มีเครื่องมือการสื่อสารต่างๆ เช่น E-mail 
WebBoard ส าหรับตั้งค าถาม หรือแลกเปลี่ยนความคิดเห็นระหว่างผู้เรียนด้วยกัน หรือกับวิทยากร 
การจัดให้มีแบบทดสอบหลังจากเรียนจบเพ่ือวัดผลการเรียนรวมทั้งจัดให้มีระบบบันทึก การติดตาม
ตรวจสอบและประเมินผลการเรียน โดยผู้เรียนที่เรียนจากอีเลิร์นนิ่งนี้ ส่วนใหญ่แล้วจะศึกษาเนื้อหาใน
ลักษณะออนไลน์ ซึ่งหมายถึงเครื่องมือที่มีการเชื่อมต่อกับระบบเครือข่าย (ถนอมพร เลาหจรัสแสง . 
2545 : 5) 
 ไพโรจน์ ตีรณธนากุล (2546 : 11) ได้กล่าวถึงความหมายของบทเรียนอีเลิร์นนิ่งไว้ว่า                                                                                                                               
Electronic - Learning เป็นการด าเนินการศึกษาหรือการเรียนรู้ด้วยเทคโนโลยีอิเล็กทรอนิกส์หรือ
ดิจิตอล ทั้งทางด้านการเรียนการสอน การบริการทางการศึกษาและการบริหารการจัดการศึกษา เพ่ือ
สนองความต้องการการศึกษาที่ไร้พรมแดน ไร้เงื่อนไขของเวลา และสถานที่เป็นการจัดให้การศึกษา
สนองตอบต่อความต้องการของเอกัตบุคคล รวมทั้งการศึกษา โดยผู้เรียนเป็นส าคัญจะเป็นการศึกษา
ในสถานที่ ในห้องเรียน ที่บ้าน หรือท่ีไหนก็ได้ โดยใช้คอมพิวเตอร์แบบ Stand Alone หรือ Network 
Intranet หรือ Internet ตามความจ าเป็นและเหมาะสม 
 ศุภชัย สุขนินทร์ (2545 : 15) ได้กล่าวว่า บทเรียนอีเลิร์นนิ่ง มาจากค าว่า Electronic 
Learningหรือเป็นการเรียนรู้ทางอิเล็กทรอนิกส์ ซึ่งก็คือการเรียนรู้ทางคอมพิวเตอร์หรือเป็นการ
เรียนรู้ทางใหม่โดยใช้คอมพิวเตอร์ ซึ่งอาจจะเป็นการเรียนในรูปแบบของการใช้คอมพิวเตอร์ วีดีโอ 
ซีดีรอม สัญญาณดาวเทียม แลน อินเทอร์เน็ต 
 ใจทิพย์ ณ สงขลา (2547 : 17) กล่าวว่า บทเรียนอีเลิร์นนิ่ง หรือบทเรียนอิเล็กทรอนิกส์ 
หมายถึง หลักสูตรการเรียนการสอนที่ใช้สื่อใดๆ ที่แปลงรูปให้เป็นอิเล็กทรอนิกส์ ที่มีความหมาย
เหมาะสมในการส่งผ่านเครือข่ายคอมพิวเตอร์ที่มีเครือข่ายกว้างขวางที่สุด ซึ่งหมายถึงเครือข่าย
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อินเทอร์เน็ต รวมทั้งการใช้เครื่องมือสื่อสารบนอินเทอร์เน็ตเพ่ือจัดกิจกรรมการเรียนการสอน
โดยเฉพาะอย่างยิ่งต้องมีระบบบริหารเนื้อหา สาระการจัดการเรียน 
 

 2.3.2 ลักษณะของบทเรียนอีเลิร์นนิ่ง 
 บทเรียนอีเลิร์นนิ่ง เป็นรูปแบบการเรียนที่เกิดขึ้นเพ่ือตอบสนองการเรียนทางไกลที่เรียกว่า
Distance Learning โดยผู้เรียนจะต้องศึกษาเนื้อหาจากสื่อการสอนทางคอมพิวเตอร์ที่ได้รับการออก 
แบบและพัฒนาอย่างมีประสิทธิภาพ เพ่ือใช้ในการน าเสนอเนื้อหาความรู้ในลักษณะของสื่อประสม 
(Multimedia) ที่แบ่งบทเรียนออกเป็นหน่วยย่อย (Module) โดยในแต่ละหน่วยมีการออกแบบ
กิจกรรมให้ผู้เรียนได้ศึกษาเนื้อหาในบทเรียน มีแบบฝึกหัดให้ผู้เรียนตรวจสอบความเข้าใจมีแบบ 
ทดสอบให้ตรวจสอบความสามารถของตนเองส าหรับการเรียนในหน่วยอ่ืนที่สูงขึ้นหรือแม้แต่ระหว่าง
ผู้เรียนกับผู้สอน ซึ่งกระบวนการดังกล่าวจะต้องอาศัยคุณลักษณะของทรัพยากรอินเทอร์เน็ตและ
ระบบเครือข่าย (World Wide Web) 3 ประการ (ณัฏฐ์สิตา ศิริรัตน์. 2548 : 3) ได้แก่ 
 1. การน าเสนอ (Presentation) ในลักษณะของเว็บที่ประกอบด้วยข้อความ กราฟิกและมัลติ 
มีเดียอ่ืน ๆ ที่สามารถน าเสนอได้อย่างเหมาะสมตามลักษณะของสื่อ 
 2. การสื่อสาร (Communication) ในลักษณะของการส่งอีเมล์โต้ตอบกัน การสนทนาผ่าน
อินเทอร์เน็ต การอภิปราย การประชุมทางไกล เป็นต้น 
 3. การปฏิสัมพันธ์ (Dynamic Interactive) ในลักษณะของการสืบค้น การเข้าสู่เว็บไซต์และ
การบริหารจัดการเว็บไซต์การเรียนการสอน 
 

 2.3.3 องค์ประกอบของอีเลิร์นนิง  
 อีเลิร์นนิง ประกอบไปด้วย ส่วนส าคัญท่ีท าหน้าที่ในการบริหารและจัดการบทเรียน จัดการด้าน
เนื้อหา จัดการด้านการน าส่งบทเรียนไปยังผู้เรียน และจัดการด้านการทดสอบ ซึ่งส่วนประกอบทั้ง 4 
ได้แก่ (มนต์ชัย เทียนทอง. 2545 : 273-275) 
 1. Learning Management System (LMS) 
 Learning Management System (LMS) หมายถึง ระบบการจัดการด้านการเรียนรู้ ซึ่งเป็น
ส่วนส าคัญของ อีเลิร์นนิง จะต้องน าพา (Tracking) ผู้เรียนไปยังเป้าหมายที่ต้องการนับตั้งแต่การลง 
ทะเบียนเรียนจนถึงการประเมินผล 
 2. Content Management System (CMS) 
 Content Management System (CMS) หมายถึง ระบบการจัดการด้านเนื้อหา ซึ่งเป็นส่วน
บริการส าหรับผู้ออกแบบหรือผู้พัฒนาบทเรียน ในการสร้างสรรค์และน าเสนอเนื้อหาบทเรียนเริ่ม
ตั้งแต่เนื้อหาส่วนของการลงทะเบียน การรบรวม การจัดการเนื้อหา และการน าส่งเนื้อหา (Delivery) 
ไปยังเว็บไซต์ของอีเลิร์นนิงหรือการพิมพ์เป็นเอกสารหรือการบันทึกลงซีดดีรอมเนื้อหาบทเรียนซึ่งเป็น
องค์ความรู้ส าหรับผู้เรียนเหล่านี้ จะถูกจัดการน าเสนอโดยระบบ CMS โดยสามารถปรับปรุงแก้ไข 
เพ่ือน ากลับมาใช้ใหม่ก็ได้ในกรณีที่เห็นว่ามีข้อผิดพลาดเกิดขึ้น 
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 3. Delivery Management System (DMS)  
 Delivery Management System (DMS) หมายถึง ระบบการจัดการด้านการน าส่ง ซึ่งเป็น
การน าส่งบทเรียนไปยังผู้เรียนได้ศึกษาตามวัตถุประสงค์ การน าส่งบทเรียนจึงรวมถึงการจัดการ
บทเรียนบนเครือข่ายคอมพิวเตอร์ ทั้งเครือข่ายอินเทอร์เน็ต อินทราเน็ต หรือเอ็กซ์ทราเน็ต การพิมพ์
เป็นเอกสารส าหรับผู้เรียน การบันทึกลงสื่ออิเล็กทรอนิกส์ และการน าส่งบทเรียน ในรูปแบบอ่ืนๆ ไป
ยังผู้เรียนให้ศึกษาบทเรียนตามวัตถุประสงค์ที่ต้องการ เช่น ส่งผ่านโทรทัศน์ตามสาย เป็นต้น 
 ดรุณรัตน์ พ่ึงตน (2545 : 41-43) กล่าว่า ในการออกแบบพัฒนาอีเลิร์นนิง ประกอบด้วย 4 
องค์ประกอบหลักได้แก่ 
 1. เนื้อหาบทเรี่ยน ไม่ว่าจะเป็นการศึกษาในลักษณะใด เนื้อหาก็จะต้องถือว่าส าคัญที่สุด ดังนั้น
แม้ว่าจะพัฒนาบทเรียนอีเลิร์นนิง ก็จะต้องให้ความส าคัญกับเนื้อหาเป็นอันดับแรก 
 2. ระบบบริหารการเรียน หรือ LMS ซึ่งย่อมาจาก Learning Management System ท า
หน้าที่เป็นศูนย์กลางในการติดต่อสื่อสารและการก าหนดล าดับเนื้อหาในบทเรียน แล้วส่งผ่านเครือข่าย
คอมพิวเตอร์ไปยังผู้เรียน ซึ่งรวมไปถึงขั้นตอนการประเมินผลในแต่ละบทเรียนควบคุมและสนับสนุน
การให้บริการแก่ผู้เรียน 
 3. การติดต่อสื่อสาร ความโดดเด่นและความแตกต่างของ อีเลิร์นนิง กับการเรียนทั่ว ๆ ไป คือ 
การน ารูปแบบการติดต่อสื่อสารแบบ 2 ทาง (Two – way communication) มาใช้ประกอบในการ
เรียนเพ่ือสร้างความสนใจและความตื่นตัวของผู้เรียนให้มากยิ่งขึ้น เช่น ในระหว่างบทเรียนก็อาจจะมี
แบบฝึกหัดเป็นค าถามเพ่ือเป็นการทดสอบในบทเรียนที่ผ่านมา และผู้เรียนก็จะต้องเลือกค าตอบและ
ส่งค าตอบกลับมายังระบบทันที ลักษณะแบบนี้จะท าให้การเรียนในระบบน่าสนใจ และรักษาเวลาใน
การเรียนได้ตามที่ก าหนดไว้อย่างเหมาะสม นอกจากนี้วัตถุประสงค์ส าคัญอีกประการติดต่อแบบ 2 
ทาง คือ ใช้เป็นเครื่องมือที่จะช่วยให้ผู้เรียนได้ติดต่อสอบถาม ปรึกษาหารือ และแลกเปลี่ยนความ
คิดเห็นระหว่างตัวผู้เรียนกับผู้สอน ระหว่างผู้เรียนกับเพ่ือนร่วมชั้นเรียนอื่น ๆ  
 4. การสอน/การวัดผลการเรียน เป็นส่วนประกอบที่ส าคัญที่จะท าให้อีเลิร์นนิง เป็นการเรียนที่
สมบูรณ์ โดยทั่วไปแล้วการเรียนไม่ว่าจะเป็นระดับใดหรือวิธีใด ก็ย่อมต้องมีการสอน/การวัดผลการ
เรียนเป็นส่วนหนึ่งอยู่เสมอ แต่รูปแบบก็อาจจะแตกต่างกันออกไป กล่าวคือ ในบางวิชาต้องมีการวัด
ระดับความรู้ (Pretest) ก่อนสมัครเข้าเรียน เพ่ือให้ผู้เรียนเลือกเรียนในบทเรียน/หลักสูตรที่เหมาะสม
มากที่สุด ซึ่งจะท าให้การเรียนที่จะเกิดข้ึนเป็นการเรียนที่มีประสิทธิภาพสูงสุด เมื่อเข่าสู่บทเรียนในแต่
ละหลักสูตรแล้ว ก็ควรจะมีการสอบย่อยท้ายบทและการสอบใหญ่ ก่อนที่จะจบหลักสูตร เพ่ือเป็นการ
วัดประสิทธิภาพในการเรียนอีเลิร์นนิง ประกอบด้วย 4 องค์ประกอบ ได้แก่ 
 4.1 เนื้อหา (Content) เนื้อหาเป็นองค์ประกอบส าคัญที่สุดส าหรับ อีเลิร์นนิง คุณภาพการ
เรียนการสอนของอีเลิร์นนิง และการที่ผู้เรียนจะบรรลุวัตถุประสงค์การเรียนในลักษณะนี้หรือไม่
อย่างไร สิ่งส าคัญที่สุดคือเนื้อหาการเรียนซึ่งผู้สอนได้จัดหาให้แก่ผู้เรียน ซึ่งผู้เรียนมีหน้าที่ในการใช้
เวลาส่วนใหญ่ศึกษาเนื้อหาด้วยตนเอง เพ่ือท าการปรับเปลี่ยน (Convent) เนื้อหาสารสนเทศที่ผู้สอน
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เตรียมไว้ให้เกิดความรู้ โดยผ่านการคิดค้นวิเคราะห์อย่างมีหลักการและเหตุผลด้วยตัวของผู้เรียนเอง 
ค าว่าเนื้อหาในองคป์ระกอบของอีเลิร์นนิงนี้ไม่จ ากัดเฉพาะบทเรียนคอมพิวเตอร์หรือคอร์สแวร์เท่านั้น 
ยังหมายถึง ส่วนประกอบส าคัญอ่ืนๆ ที่อีเลิร์นนิงจ าเป็นต้องมีเพ่ือให้เนื้อหามีความสมบูรณ์องค ์
ประกอบของเนื้อหาที่ส าคัญ 
 4.2 ระบบบริหารจัดาการรายวิชา (Learning Management System)  
 องค์ประกอบส าคัญมากเช่นกันส าหรับอีเลิร์นนิง ได้แก่ระบบบริหารจัดากรเรียนวิชา ซึ่งเป็น
เสมือนระบบที่รวบรวมเครื่องมือซึ่งออกแบบไว้เพ่ือความสะดวกแก่ผู้ใช้ในการจัดการเรียนการสอน
ออนไลน์ ซึ่งผู้ใช้นี้อาจแบ่งเป็น 3 กลุ่ม ได้แก่ ผู้สอน (Instructor) ผู้เรียน (Student) และผู้บริหาร
ระบบเครือข่าย (Network Administrator) ซึ่งมีเครื่องมือและระดับสิทธิในการใช้ที่จัดหาไว้ให้ ก็จะมี
ความแตกต่างกันไปตามแต่ละการใช้งานของแต่ละกลุ่ม ตามปกติแล้วเครื่องมือที่ระบบบริหารจัดการ
รายวิชาต้องจัดการหาไว้ให้กับผุ้ใช้ ได้แก่ พ้ืนที่และเครื่องมือส าหรับการช่วยผู้เรียนในการเตรียม
เนื้อหาบทเรียน พ้ืนที่และเครื่องมือส าหรับการท าแบบทดสอบ แบบสอบถาม การจัดฟ้ามข้อมูลต่าง ๆ 
นอกจานี้ระบบบริหารจัดการรายวิชาที่สมบูรณ์จะจัดหาเครื่องมือในการติดต่อสื่อสารไว้ส าหรับผู้ใช้
ระบบ ไม่ว่าจะเป็นในลักษณะของไปรษณีย์อิเล็กทรอนิกส์  (E-mail) หรือเว็บบอร์ด (Web-Board) 
หรือแชท (Chat) บางระบบ ก็ยังจัดหาองค์ประกอบพิเศษอ่ืนๆ เพ่ืออ านวยความสะดวกให้กับผู้ใช้อีก
มากมาย เช่น การจัดให้ผู้ใช้สามารถเข้าดูคะแนนการสอน ดูสถิติเข้าใช้งานในระบบ การอนุญาตให้ผู้  
ใช้สร้างตารางเรียนปฏิทินการเรียน เป็นต้น 
 4.3 รูปแบบการติดต่อสื่อสาร (Modes of Communication)  
 องค์ประกอบส าคัญของอีเลิร์นนิงที่ขาดไม่ได้อีกประการหนึ่งคือการจัดให้ผู้เรียนสามารถติดต่อ
กับผู้สอน วิทยากร ผู้เชี่ยวชาญอ่ืนๆ รวมทั้งผู้เรียนด้วยกัน ในลักษณะที่หลากหลายและสะดวกต่อผู้ใช้ 
กล่าวคือมีเครื่องมือที่จัดหาไว้ให้แก่ผู้เรียนได้มากกว่า 1 รูปแบบ รวมทั้งเครื่องมือนั้นจะต้องมีความ
สะดวกใช้ ซึ่งเครื่องมือที่อีเลิร์นนิงควรจัดให้ผู้เรียนได้แก่ การประชุมทางคอมพิวเตอร์ หมายถึงการ
ประชุมทางคอมพิวเตอร์ในลักษณะการติดต่อสื่อสารแบบต่างเวลาที่รู้จักกันในเว็บบอร์ด หรือการ
ติดต่อสื่อสารแบบเดียวกัน เช่น การสนทนาออนไลน์ เป็นต้น 
 4.4 แบบฝึกหัด / แบบทดสอบ 
 องค์ประกอบสุดท้ายของอีเลิร์นนิง แต่ไม่ได้มีความส าคัญน้อยที่สุดแต่อย่างใด ได้แก่ การจัดให้
ผู้เรียนได้มีโอกาสในการตอบโต้ตอบเนื้อหาในรูปแบบของการท าแบบฝึกหัดและแบบทดสอบความรู้ 
ซึ่งมีรายละเอียดดังนี้ 
 1. การจัดให้มีแบบฝึกหัดส าหรับผู้เรียน เพื่อตรวจสอบความเข้าใจไว้ด้วยเสมอเพราะอีเลิร์นนิง
เป็นระบบการเรียนการสอนซึ่งเน้นการเรียนรู้ด้วยตนเองของผู้เรียนเป็นส าคัญ ดังนั้นผู้เรียนจึงจ าเป็น
อย่างยิ่งที่จะต้องมีแบบฝึกหัดเพ่ือตรวจสอบว่าตเองเข้าใจและรอบรู้ในเรื่องที่ศึกษาด้วยตนเองมาแล้ว
อย่างดีหรือไม ่อย่างไร 
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 2. การจัดให้มีแบบทดสอบผู้เรียน สามารถอยู่ในรูปแบบทดสอบก่อนเรียนระหว่างเรียน หรือ
หลังเรียนก็ได้ ส าหรับอีเลิร์นนิง แล้วระบบบริหารจัดากรรายวิชาท าให้ผู้สอนมีความสะดวกในการจัด 
การสอบได้อย่างง่ายดาย 
 

 2.3.4 ลักษณะส าคัญของอีเลิร์นนิ่ง (e-Learning)  
 ถนอมพร เลาหจรัสแสง (2545 : 21-22) ได้กล่าวถึงลักษณะส าคัญของอีเลิร์นนิ่งไว้ดังนี้ 
 1. Anywhere, Anytime หมายถึง อีเลิร์นนิ่ง (e-Learning) ควรต้องช่วยขยายโอกาสในการ
เข้าถึงเนื้อหาการเรียนรู้ของผู้เรียนได้จริง ในที่นี้หมายรวมถึงการที่ผู้เรียนสามารถเรียกดูเนื้อหาตาม
ความสะดวกของผู้เรียน  
 2. มัลติมีเดีย (Multimedia) หมายถึง อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการน าเสนอเนื้อหา
โดยใช้ประโยชน์จากสื่อประสมเพื่อช่วยในการประมวลผลสารสนเทศของผู้เรียนเพื่อให้เกิดความคงทน
ในการเรียนรู้ได้ดีข้ึน 
 3. Non-linear หมายถึง อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการน าเสนอเนื้อหาในลักษณะที่
ไม่เป็นเชิงเส้นตรง กล่าวคือ ผู้เรียนสามารถเข้าถึงเนื้อหาตามความต้องการ โดยอเีลิร์นนิ่งจะต้องจัดหา
การเชื่อมโยงที่ยืดหยุ่นแก่ผู้เรียน 
 4. การโต้ตอบ (Interaction) หมายถึง อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการเปิดโอกาสให้
ผู้เรียนโต้ตอบ (มีปฏิสัมพันธ์) กับเนื้อหาหรือกับผู้อ่ืนได้ กล่าวคือ 
 4.1 อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการออกแบบกิจกรรม ซึ่งผู้เรียนสามารถโต้ตอบกับ
เนื้อหารวมทั้งมีการจัดเตรียมแบบฝึกหัดและแบบทดสอบให้ผู้เรียนสามารถตรวจสอบความเข้าใจด้วย
ตนเองได ้
 4.2 อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการจัดหาเครื่องมือในการให้ช่องทางแก่ผู้เรียน ในการ
ติดต่อสื่อสารเพื่อการปรึกษา อภิปราย ซักถาม แสดงความคิดเห็นกับผู้สอน วิทยากร ผู้เชี่ยวชาญหรือ
เพ่ือนๆ 
 5. Immediate Response หมายถึง อีเลิร์นนิ่ง (e-Learning) ควรต้องมีการออกแบบให้มี
การทดสอบ การวัดผล และการประเมินผล ซึ่งให้ผลป้อนกลับในทันทีแก่ผู้เรียน ไม่ว่าจะอยู่ในลักษณะ
ของแบบทดสอบก่อนเรียน (Pretest) หรือแบบทดสอบหลังเรียน (Posttest) 
 

 2.3.5 วัตถุประสงค์ของการเรียนการสอนแบบอีเลิร์นนิ่ง 
 ถนอมพร เลาหจรัสแสง (2545 : 16-17) ได้กล่าวถึงวัตถุประสงค์ของอีเลิร์นนิ่งไว้ดังนี้ 
 1. สื่อเสริม (Supplementary) หมายถึงการน า อีเลิร์นนิง ไปใช้ในลักษณะสื่อเสริมกล่าวคือ 
นอกจากเนื้อหาที่ปรากฏในลักษณะอีเลิร์นนิง แล้วผู้เรียนยังสามารถศึกษาเนื้อหาเดียวกันนี้ในลักษณะ
อ่ืน ๆ เช่น เอกสารประกอบการสอน จากวีดิทัศน์ การใช้อีเลิร์นนิง ในลักษณะนี้เท่ากับว่า ผู้สอนเพียง
ต้องการจัดหาทางเลือกใหม่อีกทางหนึ่งส าหรับผู้เรียนในการเข้าถึงเนื้อหาเพ่ือให้ประสบการณ์พิเศษ
เพ่ิมเติมกับผู้เรียน 
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 2. สื่อเติม (Complementary) หมายถึง การน าอีเลิร์นนิง ไปใช้ในลักษณะเพ่ิมเติมจาก
วิธีการสอนในลักษณะอ่ืน ๆ เช่น นอกจากค าบรรยายในห้องเรียนแล้ว ผู้สอนยังออกแบบเนื้อหาให้ผู้ 
เรียนเข้าไปศึกษาเนื้อหาเพิ่มเติมจากอีเลิร์นนิง 
 3. สื่อหลัก (Comprehensive Replacement) หมายถึง การน าอีเลิร์นนิงไปใช้ในลักษณะ
แทนที่การบรรยายในห้องเรียน ผู้เรียนจะต้องศึกษาเนื้อหาทั้งหมดออนไลน์ ในปัจจุบันอีเลิร์นนิงส่วน
ใหญ่ในต่างประเทศจะได้รับการพัฒนาขึ้น เพ่ือวัตถุประสงค์ในการใช้เป็นสื่อหลักส าหรับแทนครูใน
การสอนทางไกล ด้วยแนวคิดท่ีว่ามัลติมีเดียที่น าเสนอทาง อีเลิร์นนิง สามารถช่วยในการถ่ายทอดเนื้อ 
หาได้ไกล้เคียงกับการสอนจริงของครูผู้สอน โดยสมบูรณ์ได้ 
 กระทรวงศึกษาธิการ (2548 : 9-10) ได้กล่าวถีงวัตถุประสงค์ของอีเลิร์นนิง ไว้ดังนี้ 
 1. เป็นส่วนเสริม (Supplementary) ระดับนี้ข้อมูลข่าวสารต่าง ๆ ที่ถูกน าเสนอออนไลน์
สามารถถูกค้นพบได้ในรูปแบบอ่ืน ๆ หน้าที่ของสิ่งต่าง ๆ ที่อยู่ออไนลน์คือเป็นทางเลือกทางการศึกษา
แก่ผู้เรียนอีกทางหนึ่ง หรือเป็นการขยายโอกาสให้ผู้เรียนได้มีประสบการณ์เพ่ิมเติม 
 2. เป็นองค์ประกอบ (Complementary) ระดับนี้เป็นการเพ่ิมสื่อออนไลน์เข้าไปกับวิธีน า 
เสนออ่ืน ๆ เช่น ในชั้นเรียนปกติ สื่อที่เป็นออนไลน์จัดว่าเป็นองค์ประกอบส่วนหนึ่งที่ผู้เรียนจะต้องเข้า
ไปเรียนรู้ หน้าที่ของสื่อชนิดนี้คือการให้ประสบการณ์การเรียนแก่ผู้เรียนซึ่งประสิทธิภาพขึ้นอยู่กับ
ประเภทของสื่อท่ีใช้ 
 3. เป็นการทดแทนสมบูรณ์แบบ (Comprehensive Replacement) ระดับนี้การน าเสนอ
แบบออนไลน์จัดว่าเป็นรูปแบบหลักของการน าเสนอรูปแบบอ่ืนที่ไม่ใช่คอมพิวเตอร์เข้ามาเกี่ยวข้อง
ร่วมด้วยได้ เช่น สื่อสิ่งพิมพ์หรือสื่อปฏิบัติการ เป็นต้น หน้าที่ของสิ่งต่างๆ ทีอยู่ออนไลน์คือเป็นการให้
สิ่งแวดล้อมการเรียนอย่างสมบูรณ์ของเนื้อหากระบวนวิชา 
 

 2.3.6 ทฤษฎีการเรียนรู้ของมนุษย์ ที่เกี่ยวข้องกับการออกแบบบทเรียนอีเลิร์นนิ่ง 
 การออกแบบโครงสร้างหรือล าดับของการน าเสนอเนื้อหาบทเรียนอีเลิร์นนิ่งบทหนึ่ง ๆ นั้น
จ าเป็นอย่างยิ่งที่ผู้สร้างจะต้องพิจารณาถึงหลักเกณฑ์ในการออกแบบ ซึ่งเป็นไปตามทฤษฏีการเรียนรู้
ของมนุษย์ที่เกี่ยวข้องกับการออกแบบบทเรียนอีเลิร์นนิ่ง (ถนอมพร เลาหจรัสแสง.2542 : 51-56) 
ได้แก่  
 1. ทฤษฏีพฤติกรรมนิยม (Behaviorism) 
 ทฤษฎีพฤติกรรมนิยม (Behaviorism) เป็นทฤษฏีซึ่งเชื่อว่า จิตวิทยาเป็นเสมือนการศึกษาทาง
วิทยาศาสตร์ของพฤติกรรมมนุษย์ (Scientific Study of Human Behavior) และการเรียนรู้ของ
มนุษย์เป็นสิ่งที่สามารถสังเกตได้จากพฤติกรรมภายนอก นอกจากนี้ยังมีแนวคิดเกี่ยวกับความสัมพันธ์
ระหว่างสิ่งเร้ากับการตอบสนอง (Stimuli and Response) ซึ่งเชื่อว่าการตอบสนองกับสิ่งเร้าของ
มนุษย์เป็นพฤติกรรมแบบแสดงอาการการกระท า (Operant Conditioning) ซึ่งมีการเสริมแรง 
(Reinforcement) เป็นตัวการโดยทฤษฏีพฤติกรรมนิยมนี้ จะไม่พูดถึงความนึกคิดภายในของมนุษย์ 
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ความทรงจ า ภาพ ความรู้สึก โดยถือว่าค าเหล่านี้เป็นค าต้องห้าม (Taboo) ในลักษณะที่การเรียนเป็น
ชุดของพฤติกรรม ซึ่งจะต้องเกิดขึ้นตามล าดับที่แน่ชัด การที่ผู้เรียนจะบรรลุวัตถุประสงค์ได้นั้น จะต้อง
มีการเรียนตามขั้นตอน เป็นวัตถุประสงค์ไป ผลที่ได้จากการเรียนขั้นแรกนี้จะเป็นพ้ืนฐานของการเรียน
ในขั้นตอ่ ๆ ไปในท่ีสุด 
 บทเรียนอีเลิร์นนิ่ง ที่ออกแบบตามแนวความคิดของทฤษฏีพฤติกรรมนิยมนี้ จะมีโครงสร้างของ
บทเรียนในลักษณะเชิงเส้นตรง (Linear) โดยผู้เรียนทุกคนจะได้รับการเสนอเนื้อหาในล าดับที่เหมือน 
กันและตายตัว ซึ่งเป็นล าดับที่ผู้สอนได้พิจารณาแล้วว่าเป็นล าดับการสอนที่ดีและผู้เรียนจะสามารถ
เรียนรู้ได้อย่างมีประสิทธิภาพมากที่สุด นอกนั้นจะมีการตั้งค าถาม ถามผู้เรียนอย่างสม่ าเสมอ โดยหาก
ผู้เรียนตอบถูกก็จะได้รับการตอบสนองในรูปผลป้อนกลับทางบวกหรือรางวัล (Reward) ในทางตรง 
กันข้ามหากผู้เรียนตอบผิดก็จะได้รับการตอบสนองในรูปของผลป้อนกลับในทางลบและค าอธิบายหรือ
การลงโทษ (Punishment) ซึ่งผลป้อนกลับนี้ถือเป็นการเสริมแรงเพ่ือให้เกิดพฤติกรรมที่ต้องการ 
บทเรียนอิเล็กทรอนิกส์ ที่ออกแบบตามแนวคิดของทฤษฎีพฤติกรรมนิยม จะบังคับให้ผู้เรียนผ่านการ
ประเมินตามเกณฑ์ที่ได้ก าหนดไว้ตามวัตถุประสงค์เสียก่อน จึงสามารถผ่านไปศึกษาต่อยังเนื้อหาของ
วัตถุประสงค์ต่อไปได้ หากไม่ผ่านตามเกณฑ์ที่ได้ก าหนดไว้ ผู้เรียนจะต้องกลับไปศึกษาในเนื้อหาเดิม
อีกครั้งจนกว่าจะผ่านการประเมิน 
 2. ทฤษฎีปัญญานิยม 
 ทฤษฎีปัญญานิยม (Cognitivism) เกิดขึ้นจากแนวคิดของชอมสกี้ (Chomsky) ทีไม่เห็นด้วย
กับสกินเนอร์ (Skinner) บิดาของทฤษฏีพฤติกรรมนิยม ในการมองพฤติกรรมมนุษย์ไว้ว่า เสมือนเป็น
การทดลองทางวิทยาศาสตร์ ชอมสกี้เชื่อว่า พฤติกรรมมนุษย์นั้นเป็นเรื่องของภายในจิตใจมนุษย์ไม่ใช่
ผ้าขาวที่เมื่อใส่สีอะไรลงไปก็จะกลายเป็นสีนั้น มนุษย์มีความนึกคิดมีอารมณ์ จิตใจและความรู้สึก
ภายในที่แตกต่างกันออกไป ดังนั้นการออกแบบการเรียนการสอนก็ควรค านึงถึงความแตกต่างภายใน
ของมนุษย์ด้วย 
 ทฤษฏีปัญญานิยมนี้ส่งผลต่อการเรียนการสอนที่ส าคัญในยุคนั้น กล่าวคือ ทฤษฏีปัญญานิยมท า
ให้เกิดแนวความคิดเกี่ยวกับการออกแบบให้ลักษณะสาขา (Branching) ของคราวเดอร์ (Crowder) 
ซึ่งการออกแบบบทเรียนในลักษณะสาขา หากเมื่อเปรียบเทียบที่ออกแบบตามแนวความคิดของ
พฤติกรรมนิยมแล้ว จะท าให้ผู้เรียนมีอิสระมากขึ้นในการควบคุมการเรียนของตนเองโดยเฉพาะอย่าง
ยิ่งการมีอิสระมากขึ้นในการเลือกล าดับของการน าเสนอเนื้อหาบทเรียนที่เหมาะสมกับตน บทเรียน
อิเล็กทรอนิกส์ ที่ออกแบบตามแนวความคิดของทฤษฏีปัญญานิยมนี้ก็จะมีโครงสร้างของบทเรียนใน
ลักษณะสาขาเช่นกัน โดยผู้เรียนทุกคนจะได้รับการเสนอเนื้อหาในล าดับที่ไม่เหมือนกัน โดยเนื้อหาที่
จะได้รับการน าเสนอต่อไปนั้นจะขึ้นอยู่กับความสามารถ ความถนัดและความสนใจของผู้เรียนเป็น
ส าคัญ 

 ความแตกต่างระหว่างทฤษฎีพฤติกรรมนิยมและทฤษฎีปัญญานิยม  
 เวสท์และคณะ อ้างใน ณัฐกร สงคราม (2553 : 51 -52)  ได้เปรียบเทียบความแตกต่างไว้ดังนี้ 
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 1. ทฤษฎีพฤติกรรมนิยมมุ่งเน้นในเรื่องของพฤติกรรมหรือการกระท าภายนอก ซึ่งสามารถ
สังเกตได้ ในขณะที่ทฤษฎีปัญญานิยมมุ่งเน้นถึงสิ่งที่อยู่ภายในจิตใจมนุษย์ 
 2. ทฤษฎีพฤติกรรมนิยมมุ่งชี้ความส าคัญขององค์ประกอบย่อยๆ แต่ละส่วนจากส่วนหนึ่งไปยัง
อีกส่วนหนึ่งและจากส่วนประกอบต่างๆ ไปสู่ภาพรวมหรือวัตถุประสงค์รวมในที่สุดในทางกลับกันนั้น 
ทฤษฏีปัญญานิยมพยายามชี้ในภาพรวมเป็นหลัก จากภาพรวมหรือวัตถุประสงค์รวมไปสู่ส่วนประกอบ
และตามด้วยการมองจากส่วนประกอบต่างๆ ไปสู่ภาพรวมหรือวัตถุประสงค์รวมอีกครั้งหนึ่ง 
 3. ทฤษฎีพฤติกรรมนิยมมุ่งเน้นสิ่งที่เป็นรูปธรรม ซึ่งสามารถจับต้องได้ในขณะที่ทฤษฎีปัญญา
นิยมมุ่งเน้นในสิ่งที่เป็นนามธรรมซึ่งไม่สามารถจับต้องได้ 
 4. ทฤษฎีพฤติกรรมนิยมมีความเชื่อเก่ียวกับเรื่องของความรู้ของมนุษย์ในลักษณะของสิ่งที่มีอยู่
แล้วและรอให้มนุษย์ค้นพบและเรียกกลับมาใช้ใหม่ ในขณะที่ทฤษฎีปัญญานิยมมีความเชื่อเกี่ยวกับ
เรื่องของความรู้ในลักณะของสิ่งที่มนุษย์จ าเป็นต้องสร้างให้เกิดขึ้นหากต้องน าความรู้กลับมาใช้อีกก็
จ าเป็นจะต้องการสร้างขึ้นมาใหม่ 
 5. ทฤษฎีพฤติกรรมนิยมเปรียบเทียบจิตใจมนุษย์เป็นเสมือนโรงงานประกอบชิ้นส่วนต่างๆ ซึ่ง
หมายถึงความเชื่อที่ว่า สิ่งที่อยู่ภายในจิตใจมนุษย์นั้นเกิดจากการประกอบขึ้นของมนุษย์นั่นเองไม่มี
ความสลับซับซ้อน ชิ้นส่วนในการประกอบเป็นอย่างไรผลผลิตที่ได้ก็จะเป็นเช่นนั้น ในขณะที่ทฤษฎี
ปัญญานิยมเปรียบเทียบจิตใจเป็นเสมือนคอมพิวเตอร์ซึ่งหมายถึงความเชื่อที่ว่าสิ่งที่อยู่ภายในจิตใจ
มนุษย์นั้นเกิดจากการประมวลผลภายใน ซึ่งมีการท างานที่สลับซับซ้อนและยากแก่การท าความเข้าใจ 
 6. ทฤษฎีพฤติกรรมนิยมมุ่งเน้นในผลลัพธ์ ในขณะที่ทฤษฎีปัญญานิยมมุ่งเน้นในกระบวนการ 

 3. ทฤษฏีโครงสร้างความรู้ (Schema Theory) 
 ทฤษฎีโครงสร้างความรู้ (Schema Theory) เป็นแนวคิดท่ีเชื่อว่าโครงสร้างภายในของความรู้ที่
มนุษย์มีอยู่นั้นจะมีลักษณะเป็นโหมดหรือกลุ่มที่มีการเชื่อมโยงกันอยู่ ในการที่มนุษย์เรียนรู้อะไรใหม่ๆ 
นั้น มนุษย์จะน าความรู้ใหม่ๆ ที่เพ่ิงได้รับนั้นไปเชื่อมโยงกับกลุ่มความรู้ที่มีอยู่เดิม (Pre-Existing 
knowledge) รูเมลฮาร์ทและออโทนี่ (Rumelhart and Orto) ได้ให้นิยามความของค า โครงสร้าง
ความรู้ ไว้ว่าเป็นโครงสร้างข้อมูล (Perception) การรับรู้ข้อมูลนั้นจะไม่สามารถเกิดขึ้นได้หากขาด
โครงสร้างความรู้ (Schema) ทั้งนี้ก็เพราะการรับรู้ข้อมูลนั้นเป็นการสร้างความหมายโยงการถ่ายโอน
ความรู้ใหม่เข้ากับความรู้เดิมภายในกรอบความรู้เดิมที่มีอยู่และจากการกระตุ้นโดยเหตุการณ์หนึ่งๆ ที่
ช่วยให้เกิดการเชื่อมโยงความรู้นั้น ๆ เข้าด้วยกัน การรับรู้เป็นสิ่งส าคัญที่ท าให้เกิดการเรียนรู้เนื่องจาก
ไม่มีการเรียนรู้ใดเกิดขึ้นได้โดยปราศจากการรับรู้ นอกจากโครงสร้างความรู้จะช่วยในการรับรู้และการ
เรียนรู้แล้วนั้น โครงสร้างความรู้ยังช่วยในการระลึก (Recall) ถึงสิ่งต่าง ๆ ที่เราเคยเรียนรู้มา 
 4. ทฤษฎีความยืดหยุ่นทางปัญญา (Cognitive Flexibility Theory) 
 ทฤษฎีความยืดหยุ่นทางปัญญา (Cognitive Flexibility Theory) เป็นแนวคิดที่เชื่อว่าความรู้
แต่ละองค์ความรู้นั้นมีโครงสร้างที่แน่ชัดและสลับซับซ้อนมากน้อยแตกต่างกันไป โดยองค์ความรู้บาง
ประเภทสาขาวิชา เช่น คณิตศษสตร์หรือวิทยาศาสตร์กายภาพนั้น ถือว่าเป็นองค์ความรู้ ประเภทที่มี
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โครงสร้างตายตัว ไม่สลับซับซ้อน (Well-Structured Knowledge Domains) เพราะตรรกะและ
ความเป็นเหตุเป็นผลที่แน่นอนของธรรมชาติขององค์ความรู้ ในขณะเดียวกันองค์ความรู้บางประเภท
สาขาวิชา เช่น จิตวิทยาถือว่าเป็นองค์ความรู้ประเภทที่ไม่มีโครงสร้างตายตัวและสลับซับซ้อน เพราะ
ความไม่เป็นเหตุเป็นผลของธรรมชาติขององค์ความรู้ อย่างไรก็ตาม การแบ่งลักษณะโครงสร้างของ
องค์ความรู้ตามประเภทสาขาวิชาไม่สามารถหมายรวมไปทั้งองค์ความรู้ในวิชาหนึ่ง  ๆ ได้ทั้งหมด 
บางส่วนขององค์ความรู้บางประเภทสามขาวิชาที่มีโครงสร้างตายตัวก็สามารถที่จะเป็นองค์ความรู้
ประเภทที่ไม่มีโครงสร้างตายตัวได้เช่นกัน แนวคิดในเรื่องความยืดหยุ่นทางปัญญานี้ส่งผลให้เกิด
ความคิดในการออกแบบบทเรียนคอมพิวเตอรช่วยสอนเพ่ือตอบสนองต่อโครงสร้าขององค์ความรู้ที่
แตกต่างกันซึ่งได้แก่ แนวคิดในเรื่องการออกแบบบทเรียนแบบสื่อหลายมิติ (Hypermedia) 
 แม้ว่าทฤษฎีโครงสร้างความรู้และความยืดหยุ่นทางปัญญาที่กล่าวถึงนี้จะมีความแตกต่างกัน
ทางแนวคิดอยู่มาก แต่ทฤษฎีทั้งสองต่างก็ส่งผลต่อการออกแบบบทเรียนอิเล็กทรอนิกส์ ในปัจจุบันใน
ลักษณะที่ใกล้เคียงกัน กล่าวคือ ทฤษฎีทั้งสองต่างสนับสนุนแนวคิดเกี่ยวกับการจัดระเบียบโครงสร้าง
การน าเสนอเนื้อหาบทเรียนอิเล็กทรอนิกส์ ในลักษณะสื่อหลายมิติเพราะมีงานวิจัยหลายชิ้นที่
สนับสนุนว่า การจัดระเบียบโครงสร้างการน าเสนอเนื้อหาบทเรียนในลักษณะสื่อหลายมิติจะ
ตอบสนองต่อวิธีการเรียนรู้ของมนุษย์ ในความพยายามที่จะเชื่อมโยงความรู้ใหม่กับความรู้ที่มีอยู่เดิม
ได้เป็นอย่างดี ซึ่งตรงกับแนวคิดของทฤษฎีโครงสร้างความรู้ นอกจากนี้น าเสนอเนื้อหาบทเรียนใน
ลักษณะสื่อหลายมิติยังสามารถท่ีจะตอบสนองความแตกต่างของโครงสร้างขององค์ความรู้ที่ ไม่ชัดเจน
หรือมีความสลับซับซ้อนซึ่งเป็นแนวคิดของทฤษฎีความยืดหยุ่นทางปัญญาได้อีกด้วยโดยการจัด
ระเบียบโครงสร้างการน าเสนอเนื้อหาบทเรียนในลักษณะสื่อหลายมิติจะอนุญาตให้ผู้เรียนทุกคน
สามารถที่จะมีอิสระในการควบคุมการเรียนของตน (Learner Control) ตามความสามารถ ความสนใจ 
ความถนัด และพ้ืนฐษนความรู้ของตนได้อย่างเต็มที่ บทเรียนอิเล็กทรอนิกส์ที่ออกแบบตามแนวคิด
ของทฤษฎีทั้งสองนี้ก็จะมีโครงสร้างของบทเรียนแบบสื่อหลายมิติ ในลักษณะโยงใย(เหมือนใยแมงมุม) 
โดยผู้เรียนทุกคนจะได้รับการเสนอเนื้อหาในล าดับที่ไม่เหมือนกันและไม่ตายตัวโดยเนื้ อหาที่จะได้รับ
การน าเสนอจะขึ้นอยู่กับความสามารถ ความถนัด และความสนใจของผู้เรียนเป็นส าคัญ ความ
แตกต่างที่ส าคัญระหว่างการออกแบบตามแนวคิดของทฤษฎีทั้งสองนี้กับการออกแบบตามแนวคิดของ
ทฤษฎีนิยมคือ บทเรียนอิเล็กทรอนิกส์ ที่ออกแบบตามแนวคิดของทฤษฎีทั้งสองนี้จะให้อิสระผู้เรียนใน
การควบคุมการเรียนของตนมากกว่า เนื่องจากการออกแบบที่สนับสนุนโครงสร้างความสัมพันธ์ของ
เนื้อหาที่ลึกซ้ึงและสลับซับซ้อน (Criss - Crossing Relationship) มากกว่า 
 

 2.3.7 กระบวนการและข้ันตอนการออกแบบและพัฒนาบทเรียนอิเล็กทรอนิกส์ 
 เป็นกระบวนการผลิตบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ที่ได้ตามมาตรฐานการ
ออกแบบการเรียนการสอน (Instructional Design) โดยมีกระบวนการและขั้นตอนในการพัฒนา
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บทเรียนอิเล็กทรอนิกส์ (e-Courseware) ตามหลักการพัฒนาบทเรียนอิเล็กทรอนิกส์ของ ADDIE 
Model อ้างใน ฉัตรพงศ์ ชูแสงนิล (2555) [ออนไลน์] ดังต่อไปนี้ 
 1. การวิเคราะห์ (Analysis) ขั้นตอนการวิเคราะห์บทเรียนอิเล็กทรอนิกส์ (e-Courseware) 
เป็นขั้นตอนแรกของการออกแบบการเรียนการสอน ( Instructional Design) โดยขั้นตอนนี้เป็น
ขั้นตอนของการวิเคราะห์ (Analysis) องค์ประกอบทั้งหมดที่เกี่ยวกับการเรียนการสอนแบบอีเลิร์นนิ่ง 
(e-Learning) ไม่ว่าจะเป็นเนื้อหาบทเรียนออนไลน์อีเลิร์นนิง (e-Learning) ผู้เรียน วัตถุประสงค์ของ
การเรียนการสอน รวมทั้งอุปกรณ์ เครื่องมือ และเทคโนโลยีที่ใช้ในการเรียนการสอน  ขั้นตอนการ
วิเคราะห์บทเรียนอิเล็กทรอนิกส์ (e-Courseware) แบ่งออกได้ดังนี้ 
 1.1 การวิเคราะห์หลักสูตร 
 1.2 การวิเคราะห์เนื้อหา 
 1.3 การวิเคราะห์ผู้เรียน 
 โดยขั้นตอนการวิเคราะห์เป็นส่วนส าคัญในการพัฒนาชุดวิชาต่าง ๆ โดยผู้ออกแบบบทเรียน
อิเล็กทรอนิกส์ (e-Courseware) จะต้องค านึงถึงหลักสูตรการเรียนการสอนออนไลน์ ลักษณะเนื้อหา 
วิชา วัตถุประสงค์ของการเรียนการสอน กลุ่มเป้าหมาย การเลือกสื่อที่น ามาใช้ในการน าเสนอ ความ
เหมาะสมของบทเรียนกับผู้เรียน รวมถึงบทเรียนต้องใช้งานง่าย 
 2. การออกแบบ (Design) ขั้นตอนการออกแบบบทเรียนอิเล็กทรอนิกส์ (e-Courseware) 
ขั้นตอนนี้เป็นผลมาจากการวิเคราะห์โดยออกมาในลักษณะของแบบร่างการเรียนการสอนทางไกล 
(Distance Learning) แบบร่างนี้เป็นเอกสารการออกแบบที่ครอบคลุมถึงวัตถุประสงค์การเรียนการ
สอน กลยุทธ์ในการเรียนการสอน เนื้อหาบทเรียน โดยใช้เอกสารนี้ในการสื่อสารกับทีมงานในการ
ท างานร่วมกันให้ประสบผลส าเร็จ 
 2.1 การออกแบบเนื้อหาบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ในส่วนของการออกแบบ
เนื้อหา บทเรียนอิเล็กทรอนิกส์ (e-Courseware) นั้น มีลักษณะเป็น Learning Object โดยบทเรียน
อิเล็กทรอนิกส์ (e-Courseware) ต้องได้รับการจ าแนกเป็นหน่วย ๆ เพ่ือใช้ง่ายต่อการเรียนรู้และมี
วัตถุประสงค์การเรียนรู้ในหน่วยการเรียนนั้นๆ รวมถึงเนื้อหาต้องมีความถูกต้อง ชัดเจน ครอบคลุม
วัตถุประสงค์ 
 2.2 การออกแบบโครงสร้างและลักษณะของบทเรียนอิเล็กทรอนิกส์ (e-Courseware) การ
ออกแบบโครงสร้างบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ต้องค านึงถึงลักษณะการใช้งานและ
ความสามารถทางการเรียนของผู้เรียนที่แตกต่างกัน การออกแบบหน้าจอบทเรียน ควรมีการออกแบบ
ที่ค านึงถึงหลักของความสวยงามประกอบกับหลักการเรียนรู้ของผู้เรียนเป็นส าคัญ รวมทั้งควรมีการ
เลือกสี รูปภาพ ตัวอักษรที่เหมาะสมกับเนื้อหาบทเรียนอิเล็กทรอนิกส์ (e-Courseware) และผู้เรียน 
การน าเสนอบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ต้องมีความทันสมัย และทันต่อเหตุการณ์ 
 2.3 การออกแบบบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ให้มีปฏิสัมพันธ์และการเชื่อมโยง 
การปฏิสัมพันธ์กับบทเรียนอิเล็กทรอนิกส์ (e-Courseware) เป็นสิ่งส าคัญจะส่งให้ผู้เรียนเกิดความ
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กระตือรือร้น ความสนใจที่จะเรียนอีเลิร์นนิง (e-Learning) การโต้ตอบกับบทเรียนอิเล็กทรอนิกส์  
(e-Courseware) และการเชื่อมโยงเนื้อหาที่ดีนั้น จะส่งให้ผู้เรียนเกิดการเรียนรู้ที่ดียิ่งขึ้น 
 2.4 การออกแบบรูปแบบการน าเสนอบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ให้มีความ
น่าสนใจ การออกแบบรูปแบบน าเสนอบทเรียนอิเล็กทรอนิกส์ (e-Courseware) เป็นส่วนที่จะกระตุ้น
ผู้เรียนให้เกิดความอยากรู้อยากเรียนอีเลิร์นนิง (e-Learning) ลดความน่าเบื่อของการเรียนจากการ
เรียนที่มีความยาวนาน การน าเสนอที่น่าสนใจ ตื่นตาตื่นใจ เหมาะสมกับเนื้อหาบทเรียน
อิเล็กทรอนิกส์ (e-Courseware) จะช่วยให้ เกิดความคงทนของการจ าเหตุการณ์หรือเนื้อหาได้ 
 3. การพัฒนา (Development) ขั้นการพัฒนาบทเรียนอิเล็กทรอนิกส์ (e-Courseware) 
เป็นขั้นตอนของการผลิตตามเอกสารการออกแบบเป็นการพัฒนาสื่อการเรียนการสอนอีเลิร์นนิง  
(e-Learning) โดยเริ่มจากเขียน Storyboard ตามเอกสารการออกแบบที่ได้รับการตรวจสอบเนื้อหา
ที่ถูกต้องแล้ว การเขียน Storyboard เป็นการอธิบายหน้าจอของการเรียนการสอนในแต่ละหน้าว่า
ผู้เรียนจะเห็น ได้ยินหรือว่ามีปฎิสัมพันธ์อะไรกับบทเรียนออนไลน์อีเลิร์นนิง (Online e-Learning) 
สตอรี่บอร์ด Storyboard จะเป็นเครื่องมือในการท างานของกราฟิก ทีมตัดต่อเสียง / ภาพ และ
โปรแกรมเมอร์ในการผลิตบทเรียนอิเล็กทรอนิกส์ (e-Courseware) และบทเรียนออนไลน์อีเลิร์นนิง 
(Online e-Learning) ที่เสร็จสมบูรณ์ต้องได้รับการตรวจสอบความถูกต้องและรูปแบบที่ต้องการสื่อ
ความหมายจากผู้ที่มีความเชี่ยวชาญด้านเนื้อหาก่อนน าไปใช้ 
 4. การน าไปใช้ (Implementation) ขั้นการน าบทเรียนอิเล็กทรอนิกส์ (e-Courseware) ไป
ใช้ในการเรียนการสอน โดยน าบทเรียนอีเลิร์นนิง (e-Learning) ลงระบบ ท าการตรวจสอบการใช้งาน
ของบทเรียนอิเล็กทรอนิกส์ (e-Courseware) และระบบพร้อมกับมีฝ่ายเทคนิคให้การช่วยเหลือผู้ 
เรียนในการใช้งานบทเรียนออนไลน์อีเลิร์นนิง (Online e-Learning) ไม่ว่าจะเป็นด้านโปรแกรมหรือ
ว่าเครื่องมือการใช้งานบทเรียนอีเลิร์นนิง (e-Learning) 
 5. การประเมินผล (Evaluation) ขั้นการประเมินผลบทเรียนอิเล็กทรอนิกส์ (e-Courseware) 
เป็นขั้นตอนสุดท้าย คือประสิทธิภาพของบทเรียนออนไลน์อีเลิร์นนิง (Online e-Learning) ที่ผลิต
ขึ้นมา โดยอาจารย์ผู้สอนและคณะกรรมการเป็นผู้ตรวจสอบความถูกต้องของบทเรียนอิเล็กทรอนิกส์  
 

 2.3.8 ข้อได้เปรียบของ e-Learning (ถนอนพร เลาหจรัสแสง. 2545 : 18-19) 
 1. อีเลิร์นนิ่ง (e-Learning) ช่วยให้การจัดการเรียนการสอนมีประสิทฺธิภาพมากยิ่งขึ้น เพราะ
การถ่ายทอดเนื้อหาผ่านทางมัลติมีเดีย สามารถท าให้ผู้เรียนเกิดการเรียนรู้ได้ดีกว่าการเรียนจากสื่อ
ข้อความเพียงอย่างเดียว หรือจากการสอนภายในห้องเรียนของผู้สอนซึ่นเน้นการบรรยายในลักษณะ 
Chalk and Talk โดยเมื่อเปรียบเทียบกับอีเลิร์นนิ่ง (e-Learning) ที่ได้รับการออกแบบและผลิตมา
อย่างมีระบบ จะช่วยท าให้ผู้เรียนเกิดการเรียนรู้ได้อย่างมีประสิทธิภาพมากกว่าในเวลาที่เร็วกว่า 
 2. อีเลิร์นนิ่ง (e-Learning) ช่วยท าให้ผู้สอนสามารถตรวจสอบความก้าวหน้าพฤติกรรมการเรียน
ของผู้เรียนได้อย่างละเอียดและตลอดเวลา เนื่องจากอีเลิร์นนิ่ง (e-Learning) มีการจัดหาเครื่องมือ 
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(Courseware Management tools) ที่สามารถท าให้ผู้สอนติดตามการเรียนนของผู้เรียนได้ 
 3. อีเลิร์นนิ่ง (e-Learning) ช่วยท าให้ผู้เรียนสามารถควบคุมการเรียนของตนเองได้ เนื่องจาก
การน าเอาเทคโนโลยี Hypermedia มาประยุกต์ใช้ ซึ่งมีลักษณะการเชื่อมโยงข้อมูลไม่ว่าจะเป็นในรูป
ของข้อความ ภาพนิ่ง เสียง กราฟฟิก วีดิทัศน์ ภาพเคลื่อนไหว ที่เกี่ยวเนื่องกันเข้าไว้ด้วยกัน ใน
ลักษณะที่ไม่เป็นเชิงเส้น (Non-Linear) ท าให้ Hypermedia สามารถน าเสนอเนื้อหาในรูปแบบใย
แมงมุมได้ ดังนั้น ผู้เรียนจึงสามารถถึงข้อมูลใดก่อนหรือหลังก็ได้ โดยไม่ต้องเรียงตามล าดับและเกิด
ความสะดวกในการเข้าถึงของผู้เรียนอีกด้วย 
 4. อีเลิร์นนิ่ง (e-Learning) ช่วยท าให้ผู้เรียนสามารถเรียนรู้ได้ตามจังหวะของตน (Self-Paced 
Learning) เนื่องจากการน าเสนอเนื้อหาในรูปแบบของ Hypermedia เปิดโอกาสให้ผู้เรียนสามารถ
ควบคุมการเรียนรู้ของตนในด้านของล าดับการเรียนได้ (Sequence) ตามพ้ืนฐานความรู้ ความถนัด 
และความสนใจของตน นอกจากนี้ผู้เรียนยังสามารถเลือกเรียนเนื้อหาเฉพาะบางส่วนที่ต้องการ
ทบทวนได้ โดยไม่ต้องเรียนในส่วนเข้าใจแล้ว ซึ่งถือว่าผู้ เรียนได้รับอิสระในการควบคุมการเรียนของ
ตนเอง จึงท าให้ผู้เรียนได้เรียนรู้ตามจังหวะของตนเอง 
 5. อีเลิร์นนิ่ง (e-Learning) ท าให้เกิดปฏิสัมพันธ์ระหว่างผู้เรียนกับครูผู้สอน และกับเพ่ือน ๆ 
ได้ เนื่องจากอีเลิร์นนิ่ง (e-Learning) มีเครื่องมือต่างๆ มากมายเช่น ห้องสนทนา (Chat Room), เว็บ
บอร์ด (Web Board), อีเมล (E-mail) เป็นต้น ที่เอ้ือต่อการโต้ตอบ (Interaction) ที่หลากหลาย 
นอกจากนั้นอีเลิร์นนิ่ง (e-Learning) ที่ออกแบบมาเป็นอย่างดีจะเอ้ือให้เกิดปฏิสัมพันธ์ระหว่างผู้เรียน
กับเนื้อหาได้อย่างมีประสิทธิภาพ เช่น การออกแบบเนื้อหาในลักษณะเกมส์ หรือการจ าลอง เป็นต้น 
 6. อีเลิร์นนิ่ง (e-Learning) ช่วยส่งเสริมให้เกิดการเรียนรู้ทักษะใหม่ๆ รวมทั้งเนื้อหาที่มีความ
ทันสมัยและตอบสนองต่อเรื่องราวต่าง ๆ ในปัจจุบันได้อย่างทันที เพราะการที่เนื้อหาการเรียนรู้อยู่ใน
รูปของข้อความอิเล็กทรอนิกส์ (E-text) ซึ่งได้แก่ ข้อความ ที่ได้รับการจัดเก็บประมวลผล น าเสนอ 
และเผยแพร่ทางคอมพิวเตอร์ ท าให้มีข้อได้เปรียบสื่ออ่ืน ๆ หลายประการ โดยเฉพาะอย่างยิ่งในด้าน
ของความสามารถในการปรับปรุงเนื้อหาสารสนเทศให้ทันสมัยได้ตลอดเวลา การเข้าถึงข้อมูลที่
ต้องการด้วยความสะดวกรวดเร็วและความคงทันของข้อมูล 
 7. อีเลิร์นนิ่ง (e-Learning) ท าให้เกิดรูปแบบการเรียนที่สามารถจัดการเรียนการสอนให้แก่
ผู้เรียนในวงกว้างข้ึน เพราะผู้เรียนใช้การเรียนลักษณะอีเลิร์นนิ่ง (e-Learning) จะไม่มีข้อจ ากัดในด้าน
การเดินทางมาศึกษาในเวลาใดเวลาหนึ่งและสถานที่ใดสถานที่หนึ่ง ดังนั้นอีเลิร์นนิ่ง (e-Learning) จึง
สามารถน าไปใช้เพ่ือสนับสนุนการเรียนรู้ตลอดชีวิต (Life Long Learning) ได้ และยิ่งกว่านั้นยัง
สามารถน าอีเลิร์นนิ่ง (e-Learning) ไปใช้เพ่ือเปิดโอกาสให้ผู้เรียนที่ขาดโอกาสทางการศึกษาใน
ระดับอุดมศึกษาได้เป็นอย่างดี 
 8. อีเลิร์นนิ่ง (e-Learning) ท าให้สามารถลดต้นทุนในการจัดการศึกษานั้น ๆ ได้ในกรณีที่มี
การจัดการเรียนการสอนส าหรับผู้เรียนที่มีจ านวนมาก และเปิดกว้างในสถานบันอ่ืน ๆ หรือบุคคล
ทั่วไปเข้ามาใช้อีเลิร์นนิ่ง (e-Learning) ได้ ซึ่งจะพบว่าเมื่อต้นทุนการผลิตอีเลิร์นนิ่ง (e-Learning) เท่า
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เดิม แต่ปริมาณผู้เรียนมีปริมาณเพ่ิมมากขึ้น หรือขยายกว้างการใช้ออกไป ก็เท่ากับเป็นการลดต้นทุน
ทางการศึกษานั่นเอง 
 

 2.3.9 ประโยชน์ของบทเรียนอีเลิร์นนิ่ง 
 มนต์ชัย เทียนทอง (2545 : 266-267) ได้กล่าวถึงประโยชน์ของบทเรียนอีเลิร์นนิ่ง ไว้ดังนี้ 
 1. ความสะดวกสบาย (Convenient) ระบบการเรียนการสอนของบทเรียนอีเลิร์นนิ่งสามารถ
จัดการศึกษาให้กับผู้เรียนได้ตามความต้องการ โดยไม่ต้องอาศัยชั้นเรียนผู้เรียนที่อาศัยอยู่ในชุมชน
ห่างไกล หรือมีภารกิจหน้าที่การงานประจ าอยู่ที่สามารถลงทะเบียนเพ่ือศึกษาบทเรียนผ่านอีเลิร์นนิ่ง
ได้ ทั้งที่อยู่ที่บ้านพักอาศัย หรือสถานที่ท างาน เพียงแต่ต่อเชื่อมคอมพิวเตอร์ส่วนตัวเข้ากับเครื่อง
เซิร์ฟเวอร์ของอีเลิร์นนิ่ง ผ่านเครือข่ายอินเทอร์เน็ตเท่านั้นก็ศึกษาบทเรียนได้ เนื่องจากการเชื่อมต่อ
เข้าระบบต้องการเพียงชื่อผู้ใช้และรหัสผ่านเท่านั้น ซึ่งง่ายต่อการจดจ าและสะดวกสบายกว่าการน า
เอกสารหรือหนังสือติดตัวไปศึกษานอกสถานที่ 
 2. ความสัมพันธ์กับปัจจุบัน (Relevant) เนื้อหาสาระและข้อมูลต่าง ๆ ที่ปรากฏอยู่ในระบบ
การเรียนการสอนของอีเลิร์นนิ่ง สามารถปรับเปลี่ยนตามสถานการณ์ปัจจุบันได้ง่าย ซึ่งมีความทันสมัย
และสัมพันธ์กับปัจจุบัน มากว่าเนื้อหาสาระและข้อมูลในการเรียนการสอนแบบปกติ ซึ่งเป็นการ
ด าเนินการตามหลักสูตรที่ก าหนดไว้ล่วงหน้าหลายปีโดยเฉพาะอย่างยิ่ง การฝึกอบรม ในสถาน
ประกอบการณ์ที่ต้องการองค์ความรู้ใหม่ๆ ในการพัฒนาศักยภาพของบุคลากรให้มีความพร้อมที่จะ
สามารถแข่งขันได้ในตลาดโลก ระบบอีเลิร์นนิ่ง ซึ่งเนื้อหาสาระได้ถูกเก็บไว้ในเซิร์ฟเวอร์ส่วนกลาง 
สามารถด าเนินการเปลี่ยนแปลงข้อมูลเหล่านั้นให้ทันสมัยและสัมพันธ์กับสถานการณ์ปัจจุบันได้ง่าย
และเร็วกว่า 
 3. ความเร็วแบบทันทีทันใด (Immediate) ผู้เรียนในระบบอีเลิร์นนิ่ง เพียงแต่คลิกเมาส์เพ่ือ
ปฏิสัมพันธ์ กับบทเรียนที่ปรากฏอยู่ก็สามารถศึกษาบทเรียนได้ทันทีโดยไม่มีเงื่อนไขใดๆ ทั้งการศึกษา
และการฝึกอบรมเพ่ือประกอบอาชีพ เมื่อประสบกับปัญหาใดๆ ก็สามารถต่อเชื่อเข้ากับระบบและ
ศึกษาข้อมูลที่ปรากฏอยู่ใน อีเลิร์นนิง ได้ทันที 
 4. ความเป็นเลิศของระบบ (Excellent) อีเลิร์นนิ่ง ไม่เพียงแต่การสร้างสรรค์องค์ความรู้ที่
เหมาะสมและมีประสิทธิภาพเท่านั้น แต่อีเลิร์นนิ่ง ยังสามารถน าเสนอเนื้อหาสาระและระบบการ
จัดการที่มีความเป็นเลิศ ทันสมัย และน่าสนใจ ท าให้การเรียนการสอนผ่านอีเลิร์นนิ่งเป็นสื่อ
อิเล็กทรอนิกส์ที่ชวนติดตามมากกว่าระบบการเรียนการสอนแบบปกติสามารถจัดการบทเรียนได้
ตั้งแต่เริ่มบทเรียนจนถึงรายงานผลการเรียนได้ครบสมบูรณ์ โดยไม่ต้องเดินทางไปสถานศึกษาแต่อย่าง
ใด 
 5. การมีปฏิสัมพันธ์ (Interactive) นอกจากการปฏิสัมพันธ์กับบทเรียนโดยตรง ซึ่งถือว่าเป็น
รูปแบบปกติของการปฏิสัมพันธ์แล้ว ระบบอีเลิร์นนิ่งยังสามารถสร้างสรรค์ปฏิสัมพันธ์กับผู้เรียนที่อยู่
ต่างชุมชน ด้วยความสะดวกและมีประสิทธิภาพ เพ่ือร่วมกันสร้างสรรค์องค์ความรู้ ในลักษณะของ
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ระบบการเรียนรู้แบบร่วมมือ (Collaborative Learning System) ท าให้การเรียนการสอนผ่าน
เครือข่ายอินเทอร์เน็ตมีลักษณะคล้ายกับการศึกษาในห้องเรียนปกติมากขึ้น กล่าวได้ว่า เป็นประโยชน์
ที่ส าคัญอีกประการหนึ่งที่ชดเชยการเรียนการสอนนด้วยตนเอง ซึ่งเคยได้รับการมองในแง่ลบว่าเป็น
การเรียนรู้รายบุคคลที่ผู้เรียนไม่มีปฏิสัมพันธ์กับเพ่ือนร่วมชั้นเรียน โดยการจัดการเรียนการสอนให้มี
สภาพแวดล้อมในลักษณะของระบบการเรียนรู้ร่วมกันหรือการจัดการเรียนการสอนตามแนวความคิด
ของกลุ่มที่เรียกว่า Constructivism System ท าให้เกิดการปฏิสัมพันธ์ระหว่างกลุ่มผู้เรียนด้วยกัน
มากขึ้น 
 6. ความเป็นสหวิชาการ (Interdisciplinary) การเรียนรู้ในระบบอีเลิร์นนิ่ง จะเป็นการ
เรียนรู้ที่เกี่ยวข้องกันหลายวิชา หรือท่ีเรียกว่า สหวิชาการ ซึ่งมีความหลากหลายมากกว่าการเรียนการ
สอนในระบบปกติ ซึ่งเป็นการจัดการตามหลักสูตรรายวิชาใดวิชาหนึ่งเท่านั้น เนื่องจากไม่มีข้อจ ากัด
ทางด้านเวลาการสอนเหมือนชั้นเรียนปกติ 
 

2.4 การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต 
 
 การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตหรือการเรียนการสอนผ่านเว็บ  เป็นรูปแบบการ
เรียนการสอนอย่างหนึ่งที่การเรียนจะกระท าผ่านสื่อบนเครือข่ายอินเทอร์เน็ต  โดยผู้สอนจะน าเสนอ
ข้อมูลความรู้ให้ผู้เรียนได้ท าการศึกษาผ่านเว็บหรือเวิลด์ไวด์เว็บ (World Wide Web : WWW) เป็น
บริการส าหรับให้ข่าวสารแก่ผู้ใช้ในระบบอินเทอร์เน็ต เวิลด์ไวด์เว็บเป็นระบบที่พัฒนาขึ้นบนเครือข่าย
อินเทอร์เน็ต เพ่ือช่วยให้ผู้ใช้คอมพิวเตอร์รับส่งข้อมูลระหว่างเครื่องแม่ข่ายและเครื่องผู้ใช้ง่ายขึ้นและ
ช่วยให้การแสดงผลบนเครื่องคอมพิวเตอร์ของผู้ใช้เป็นแบบมัลติมีเดีย (พรพิไล เลิศวิชา. 2544 : 31) 
เว็บ (Web) จะบรรจุสารสนเทศหรือข้อมูลต่างๆที่จะสืบค้น ซึ่งประกอบด้วยเว็บไซต์ 
 ปรัชญนันท์ นิลสุข (2547 : 11) ได้ให้ความหมายไว้ดังนี้คือ เว็บไซต์ (Web site) หมายถึงเว็บที่
ประกอบด้วยเว็บเพจหลายๆเว็บเพจมารวมกัน อยู่ภายในพ้ืนที่เดียวกันและเชื่อมโยงระหว่างกัน
ภายใต้โดเมนเนมเดียวกัน โดยมีโฮมเพจเป็นหน้าแรกของเว็บไซต์ท าหน้าที่เชื่อมโยงไปยังเว็บเพจต่าง ๆ
โฮมเพจ (Home page) หมายถึง เว็บเพจที่เป็นหน้าแรกของเว็บไซต์ ที่เข้าถึงได้ทันทีเมื่อเข้าสู่ระบบ
อินเทอร์เน็ตโดยการพิมพ์โดเมนเนมหรือยูอาร์แอลซึ่งเป็นที่ติดตั้งของเว็บไซต์ 
 

 2.4.1 ความหมายของการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต 
 กิดานันท์  มลิทอง (2548 : 240) ได้ให้ความหมาย อินเทอร์เน็ต เป็นโครงสร้างพ้ืนฐานของ
เครือข่ายขนาดใหญ่ เรียกว่าเป็น “เครือข่ายของเครือข่าย” (network of network หรือบางคนอาจ
เรียกว่า The mother of all networks) ที่รวมและเชื่อมต่อเครือข่ายทั่วโลกจ านวนมากมาย
มหาศาลเข้าด้วยกัน เพ่ือสร้างเป็นเครือข่ายให้คอมพิวเตอร์ทั่วโลกสามารถติดต่อกันได้ตราบเท่าที่
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คอมพิวเตอร์เหล่านั้นยังเชื่อมต่อกันอยู่บนอินเทอร์เน็ต เพ่ือการใช้งานลักษณะต่าง  ๆ ทั้งด้านธุรกิจ 
การศึกษา บันเทิง สื่อสาร ฯลฯ 
 ใจทิพย์ ณ สงขลา (2544 : 19) ได้ให้ความหมายการเรียนการสอนผ่านเว็บว่าหมายถึง การ
ผนวกคุณสมบัติ ไฮเปอร์มีเดียเข้ากับคุณสมบัติของเครือข่ายเวิลด์ไวด์เว็บ เพ่ือสร้างสิ่งแวดล้อมแห่ง
การเรียนในมิติที่ไม่มีขอบเขต จ ากัดด้วยระยะทางและเวลาที่แตกต่างกันของผู้เรียน (Learning 
Without Boundary) 
 วิชุดา รัตนเพียร (2542 : 30) กล่าวว่า การเรียนการสอนผ่านเว็บเป็นการน าเสนอโปรแกรม 
บทเรียนบนเว็บเพจ โดยน าเสนอผ่านบริการเวิลด์ไวด์เว็บในเครือข่ายอินเทอร์เน็ต ซึ่งผู้ออกแบบและ 
สร้างโปรแกรมการสอนผ่านเว็บจะต้องค านึงถึงความสามารถและบริ การที่หลากหลายของ
อินเทอร์เน็ต และน าคุณสมบัติต่าง ๆ เหล่านั้นมาใช้เพื่อประโยชน์ในการเรียนการสอนให้มากที่สุด 
       สรุปได้ว่า การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตคือ การศึกษาบทเรียนโดยอาศัยเครือข่าย
อินเทอร์เน็ต มีการน าเสนอผ่านบริการ เวิลด์ไวด์เว็บ ผู้เรียนสามารถศึกษาได้ด้วยตัวเอง มีปฏิสัมพันธ์
กับบทเรียน ปฏิสัมพันธ์กับผู้สอน ปฏิสัมพันธ์กับเพ่ือนเพ่ือแลกเปลี่ยนความคิด (Sharing idea) โดย
ไม่มีข้อจ ากัดด้านสถานที่และเวลา 
 

 2.4.2 ข้อดีของการเรียนการสอนผ่านเว็บเมื่อเปรียบเทียบกับการเรียนการสอนแบบดั้งเดิม 
 ณัฐกร สงคราม (2543) [Online] ได้เปรียบเทียบถึงข้อดีของการเรียนการสอนผ่านเว็บเทียบ
กับการเรียนการสอนแบบดั้งเดิม มีรายละเอียดดังนี้ 
 1. ความยืดหยุ่นและความสะดวกสบาย (Flexibility and Convenience) นักเรียน
สามารถที่จะเข้าไปเรียนในหลักสูตรโดยไม่มีข้อจ ากัดของเวลาและสถานที่ ลักษณะทางกายภาพของ
ห้องเรียนมักจะมีการก าหนดตารางเวลาตายตัว แต่ถ้าหากใช้การเรียนการสอนผ่านเว็บแล้วจะลด
ปัญหาในเรื่องของการก าหนดเวลา สถานที่ และราคาค่าใช้จ่ายบางประการลงไปได้ 
 2. ความเหมาะสมในการเรียนรู้ (Just-in-time Learning) การเรียนการสอนผ่านเว็บมี
ความสัมพันธ์กับความต้องการที่จะเรียนรู้และเวลา นักเรียนที่เข้ามาเรียนจะได้รับความรู้ที่มี
ความส าคัญและมีประโยชน์ หากผู้ออกแบบการเรียนการสอนได้เพ่ิมแรงจูงใจและการระลึกถึงความรู้
ได้ สิ่งนี้จะเป็นสิ่งที่ส าคัญ เพราะผู้เรียนสามารถเรียนรู้ได้ตลอดชีวิต หากพวกเขาประสงค์ที่จะเรียนรู้ 
 3. การควบคุมผู้เรียน (Learner Control) ในสภาพการเรียนรู้แบบนี้ ลักษณะการควบคุม
การเรียนการสอนผ่านจากผู้สอนไปสู่ผู้เรียน โดยผู้เรียนจะตัดสินใจและก าหนดเส้นทางการเรียนตาม
ความต้องการของตนเอง 
 4. รูปแบบมัลติมีเดีย (Multimedia Format) เวิลด์ไวด์เว็บ จะมีการน าเสนอเนื้อหาของ
หลักสูตร โดยใช้สื่อมัลติมีเดียที่แตกต่างกัน ไม่ว่าจะเป็นข้อความ เสียง วีดิทัศน์ และการสื่อสารในเเว
ลาเดียวกัน ผู้สอนและผู้เรียนสามารถเลือกรูปแบบการน าเสนอได้ตามความยืดหยุ่นของเวิลด์ไวด์เว็บ
เพ่ือให้การเรียนเกิดประสิทธิภาพมากที่สุด 
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 5. แหล่งทรัพยากรข้อมูล (Information Resource) ตัวแปรที่เกี่ยวข้องกับแหล่งทรัพยากร
ข้อมูลมี 2 ตัวแปรคือ จ านวนและความหลากหลายของเนื้อหาที่มีอยู่ในเว็บ ข้อมูลได้มาจากหลายๆ 
แหล่งเช่น การศึกษา ธุรกิจ หรือ รัฐบาล ฯลฯ จากทั่วทุกมุมโลกถือได้ว่า เป็นพ้ืนที่ขนาดใหญ่และเป็น
ที่เก็บข้อมูลได้หลากหลายชนิด ผู้ออกแบบการเรียนการสอนจะต้องออกแบบให้ผู้เรียนได้เข้าถึงแหล่ง
ทรัพยากร ซึ่งไม่ได้มีอยู่ในชั้นเรียนแบบดั้งเดิม ตัวแปรที่สองคือ ข้อความหลายมิติ (Hypertext) ซึ่ง
ช่วยในการเข้าไปค้นหาข้อมูลจากแหล่งอ่ืนๆ ได้อย่างง่ายดายกว่าการค้นหาข้อมูลในชั้นเรียนแบบ
ดั้งเดิม 
 6. ความทันสมัย (Currency) เนื้อหาที่ใช้เรียนในชั้นเรียนแบบการเรียนการสอนผ่านเว็บ 
สามารถปรับปรุงให้ทันสมัยได้อย่างง่ายดาย แหล่งทรัพยากรอ่ืนๆ ที่มีอยู่บนเว็บโดยมากมักจะมีความ
ทันสมัย ดังนั้นผู้สอนในชั้นเรียนแบบการเรียนการสอนผ่านเว็บนี้สามารถจะเสนอข้อมูลที่มีความ
ทันสมัยให้แก่ผู้เรียน ประโยชน์ที่ได้รับจะสามารถน ามาประยุกต์เข้ากับหลักสูตรให้ทันสมัยอยู่
ตลอดเวลา 
 7. ความสามารถในการประชาสัมพันธ์ (Publishing Capabilities) เว็บให้โอกาสแก่นักเรียน 
ที่จะเสนองานที่ได้รับมอบหมายบนเว็บได้อีกทั้งนักเรียนยังมีโอกาสที่จะมองเห็นผลงานของผู้อ่ืน และ
เพ่ิมแรงจูงใจภายนอกโดยการใช้การท างานของนักเรียนได้ 
 8. เพิ่มทักษะทางเทคโนโลยี (Increase Technology Skills) นักเรียนที่เรียนด้วยการเรียน
การสอนผ่านเว็บจะได้เพ่ิมพูนทักษะทางเทคโนโลยี เนื้อหาที่นักเรียนเรียนจะมีการเปลี่ยนแปลงอย่าง
เหมาะสมและเพ่ิมแหล่งทรัพยากรต่างๆ ให้นักเรียนได้เพ่ิมพูนความรู้ นักเรียนจะได้รับประสบการณ์ 
และฝึกฝนทักษะได้จากเทคโนโลยีอันหลากหลาย 
 

 2.4.3 ข้อจ ากัดของการเรียนการสอนผ่านเว็บเม่ือเปรียบเทียบกับการเรียนการสอนแบบ
ดั้งเดิม 
 1. รูปแบบที่อ่อน (Format Weaknesses) รูปแบบการเข้าถึงมัลติมีเดียและประสิทธิภาพ
ของรูปแบบการเรียนส่วนบุคคล ทั้งสองสิ่งนี้เป็นข้อโต้เถียงท่ีจะน าการเรียนการสอนผ่านเว็บมาใช้งาน 
ข้อความที่อ่านได้ง่ายและใช้ในรูปแบบของสิ่งพิมพ์ วีดิทัศน์แบบออนไลน์ที่ช้ากว่าแถบบันทึกเสียง 
หรือโทรทัศน์และการสื่อสารโดยทันที ไม่สามารถจับเสียงมนุษย์ได้เหมือนกับการใช้โทรศัพท์ ขณะที่
นักเรียนก าลังพิมพ์เนื้อหาออกมา หรือรอขณะที่วีดิทัศน์ก าลังดาวน์โหลดจะสูญเสียความสนใจจาก
การเรียน 
 2. ปัญหาของเส้นทางการเข้าสู่เนื้อหา (Navigational Problems) รูปแบบข้อความหลาย
มิติ จะให้นักเรียนได้ย้ายจากสภาพแวดล้อมของห้องเรียน ไปยังสภาพแวดล้อมภายในของเว็บด้วยการ
เชื่อมโยงไปยังแหล่งต่าง ๆ การควบคุมผู้เรียนสามารถจ ากัดได้ ถ้าผู้เรียนหลงทางในสภาพแวดล้อม
ของเว็บ การหลงทางและสูญเสียความสนใจเป็นปัญหาใหญ่ส าหรับผู้เรียน การใช้ส่วนชี้น าจะเป็นการ
ช่วยเหลือให้ผู้เรียนลดปัญหาเหล่านี้ลงไปได้ 
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 3. การขาดการติดต่อ (Lack of Human Contact) ผู้เรียนบางคนชอบสภาพของการเรียน
แบบดั้งเดิม ที่มีปฏิสัมพันธ์กับผู้สอนและเพ่ือนนักเรียนด้วยกัน ผู้สอนจะได้รับทราบปฏิกิริยาของ
ผู้เรียนว่าเป็นอย่างไร แต่ผู้สอนในรูปแบบการเรียนการสอนผ่านเว็บนี้จะไม่สามารถรู้ได้เลยว่า ผู้เรียน
ก าลังสับสนหรือเข้าใจในเนื้อหา หรือไม่ถ้าไม่ได้ติดต่อสื่อสารกัน สภาพการเรียนการสอนผ่านเว็ บ
ผู้เรียนมีโอกาสจะได้มีปฏิสัมพันธ์เช่นเดียวกับการเรียนแบบดั้งเดิม แต่จะมีวิธีการต่างไปโดยจะอาศัย
จดหมายอิเล็กทรอนิกส์ การอภิปราย หรือวิธีการอ่ืน ๆ ได้ แต่ผู้เรียนบางคนก็อาจขาดการติดต่อและ
ขนาดปฏิสัมพันธ์กับชั้นเรียน ซึ่งประเด็นนี้ก็ยังเป็นปัญหาที่เกิดขึ้นอยู่บ่อยครั้ง 
 4. แรงจูงใจ (Motivation) นักเรียนในชั้นเรียนการเรียนการสอนผ่านเว็บต้องมีแรงจูงใจ
ส่วนตัวและจัดระบบการเรียน การขาดการวางแผนการเรียนจะท าให้นักเรียนไม่ประสบความส าเร็จ
กับการเรียน และอาจสอบไม่ผ่านในหลักสูตรนั้น ๆ ได ้
 5. เนื้อหาที่กระจายไม่มีข้อยุติ (Open-ended Content) เนื้อหาของการเรียนการสอน
ผ่านเว็บที่เสนอให้กับผู้เรียนนั้น บางครั้งผู้เรียนจะไม่รู้ว่าขอบเขตของเนื้อหาสิ้นสุดที่ใด หากหัวข้อหรือ
หลักสูตรของการเรียนเปลี่ยนแปลงบ่อยครั้ง ท าให้ผู้เรียนเกิดอุปสรรคต่อการเรียนได้ 
 

 2.4.4 บทเรียนผ่านเว็บ 
 1. ความหมายของบทเรียนผ่านเว็บ 
 บทเรียนผ่านเว็บ หมายถึง บทเรียนคอมพิวเตอร์ช่วยสอนที่น าเสนอผ่านเครือข่ายคอมพิวเตอร์ 
โดยใช้เว็บเบราเซอร์เป็นตัวจัดการ ดังนั้น จึงมีความแตกต่างกับคอมพิวเตอร์ช่วยสอนธรรมดาอยู่บ้าง
ในส่วนของการใช้งาน ได้แก่ ส่วนของระบบการติดต่อกับผู้ใช้ (User Interfacing System) ระบบการ
น าเสนอบทเรียน (Delivery System) ระบบการสืบท่องข้อมูล (Navigation System) และระบบการ
จัดการบทเรียน (Computer Managed System) (มนต์ชัย เทียนทอง. 2545 : 355) 
 บทเรียนผ่านเว็บ หมายถึง การจัดการเรียนการสอนโดยใช้ศักยภาพของเครือข่ายอินเทอร์เน็ต 
ท าให้การเรียนการสอนสามารถเชื่อมโยงไปยังแหล่งข้อมูลต่าง ๆ ที่อยู่ในเครือข่ายได้ทุกเวลาและทุก
สถานที่ตามความต้องการของผู้เรียนและผู้สอน นอกจากนี้ผู้เรียนและผู้สอนยังสามารถปฏิสัมพันธ์กัน
ได้โดยผ่านระบบเครือข่ายคอมพิวเตอร์ (ฤทธิชัย อ่อนมิ่ง. 2546 : 66) 
 การสอนผ่านเว็บกับคอมพิวเตอร์ช่วยสอน เป็นสื่อการสอนที่มีลักษณะคล้ายคลึงกัน จนผู้สอน
บางคนคิดว่าคอืสิ่งเดียวกัน แต่ในความเป็นจริงการสอนผ่านเว็บกับคอมพิวเตอร์ช่วยสอนมีข้อแตกต่าง
กัน คือการสอนผ่านเว็บท างานบนระบบเครือข่ายอินเทอร์เน็ต ผู้เรียนและผู้สอน  สามารถติดต่อ 
สื่อสารถึงกันได้ และผู้สอนสามารถติดตามพฤติกรรมการเรียนตลอดจนผลการเรียนของผู้เรียนได้ 
ส่วนคอมพิวเตอร์ช่วยสอนท างานภายใต้ระบบเครื่องเดี่ยว ( Standalone) หรืออาจท าภายใต้
เครือข่ายภายในองค์กร (Local Area Network : LAN) และคอมพิวเตอร์ช่วยสอนไม่ได้ออกแบบเพ่ือ
การสื่อสารถึงกันได ้
 2. องค์ประกอบของการสอนผ่านเว็บ แบ่งเป็น 3 ส่วน คือ 
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 2.1 ส่วนน าเข้า (Input) ประกอบด้วยผู้เรียน ผู้สอน วัตถุประสงค์ของการเรียน ฐานความรู้
การสื่อสารหรือกิจกรรม การวัดและประเมินผล 
 2.2 ส่วนกระบวนการ (Process) เป็นการสร้างสถานการณ์หรือการจัดสภาวะการเรียนการ
สอน โดยใช้ส่วนน าเข้าในการบริหารจัดการ เพ่ือให้เกิดประโยชน์สูงสุดและบรรลุวัตถุประสงค์ที่ตั้งไว้ 
 2.3 ส่วนผลลัพธ์ (Output) คือ ผลสัมฤทธิ์ทางการเรียนที่ได้จากการวัดและประเมินผล 
 3. การออกแบบสร้างบทเรียนผ่านเว็บ 
 บทเรียนผ่านเว็บ ผู้ออกแบบต้องปรับให้เข้ากับความสามารถของผู้เรียนที่จะตอบสนองหรือมี
ปฏิสัมพันธ์ได้อย่างดี หากผู้เรียนพบความยุ่งยากในการใช้งานไม่ว่าจะเป็นแนวคิดการเรียกใช้ การ
ให้บริการ การน าเสนอ การติดต่อสื่อสาร การเชื่อมโยง การโต้ตอบ จะท าให้ผู้เรียนเกิดความเบื่อ
หน่ายควรสร้างความแปลกใหม่และแตกต่างเพ่ือกระตุ้นให้ผู้เรียนเกิดความอยากรู้ อยากเรียน ซึ่ง
รูปภาพจะช่วยท าให้เกิดความเข้าใจง่ายขึ้น การออกแบบบทเรียนต้องพิจารณาเลือกข้อมูลที่จะ
น าเสนอทั้งหมด และประเมินได้ว่าผู้เรียนได้รับประโยชน์มากน้อยเพียงใด ในการออกแบบไม่จ าเป็น
ว่าผู้เรียนต้องเรียนตามล าดับขั้นตอน จากขั้นที่ 1 ไปขั้นสุดท้าย แต่อาจให้เลือกเรียนจากส่วนใดส่วน
หนึ่งตามความต้องการของผู้เรียนได้ และควรหลีกเลี่ยงเนื้อหาจ านวนมากหรือการโต้ตอบกับเครื่อง 
ควรสร้างความหลากหลาย โดยใช้แป้นเมนู ไอคอน ปุ่ม ภาพเคลื่อนไหว บนจอร่วมด้วยการออกแบบ
โปรแกรมที่ดีจะต้องค านึงถึง 2 ส่วนคือ ส่วนที่ส าคัญและส่วนเพ่ิมเติมส่วน ที่ส าคัญจะอยู่ในเว็บ และ
เป็นบทเรียน ประกอบด้วย การโต้ตอบซึ่งกันและกัน การใช้สื่อประสมระบบเปิด การค้นหาที่เชื่อมโยง
ถึงกันได้ เครื่องมือที่ใช้ได้ทุกแห่งทุกที่ การเชื่อมต่อเครือข่ายทั่วโลกส่วนเพ่ิมเติม คือ ความสะดวก 
สบายสามารถเรียนรู้ได้ด้วยตนเองใช้ง่าย (พรรณี เกษกมล. 2546 : 50-51)  
 4. วิธีการจัดการสอนผ่านเว็บ 
 วิธีการจัดการสอนผ่านเว็บ สามารถจัดในรูปแบบการสอนแบบเข้าชั้นเรียนและไม่ต้องเข้าชั้น
เรียน ตามความเหมาะสมของเนื้อหาของแต่ละวิชา การสอนผ่านเว็บผู้สอนจะต้องมีการเตรียมการ
ล่วงหน้า โดยเฉพาะอย่างยิ่งการเตรียมความพร้อมของตัวผู้สอนในการฝึกฝนทักษะ ทางคอมพิวเตอร์
และสร้างความคุ้นเคยกับเครื่องมือต่าง ๆ บนเครือข่าย เพ่ือให้การจัดการเรียนการสอนเป็นไปอย่างมี
ระสิทธิภาพ เช่น การสร้างโฮมเพจส าหรับรายวิชาของผู้สอนเองที่สามารถเชื่อมโยงแหล่งความรู้ต่าง ๆ 
ที่เหมาะสมและเป็นประโยชน์ส าหรับผู้เรียนการสอนบนเว็บให้เกิดประสิทธิภาพสูงสุดต้องมีการ
ออกแบบบทเรียนตามหลักการออกแบบและพัฒนาระบบการสอน(Instructional design and 
development) เพ่ือให้การสอนผ่านเว็บมีความใกล้เคียงกับการสอนในห้องเรียนแบบปกติมากที่สุด 
การจัดการเรียนการสอนผ่านเว็บนั้นมีขั้นตอนการจัดการเรียนการสอน ดังนี้ 
 4.1 ก าหนดวัตถุประสงค์ของการเรียนการสอน 
 4.2 การวิเคราะห์ผู้เรียน 
 4.3 การออกแบบเนื้อหารายวิชาใช้เนื้อหาตามหลักสูตรและสอดคล้องกับความต้องการของ
ผู้เรียน จัดล าดับเนื้อหาจ าแนกตามหัวข้อ ตามหลักการเรียนรู้และลักษณะเฉพาะในแต่ละหัวข้อ 
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ก าหนดระยะเวลาและตารางการศึกษาในแต่ละหัวข้อ ก าหนดวิธีการศึกษา ก าหนดสื่อที่ ใช้ประกอบ
การศึกษาในแต่ละหัวข้อ ก าหนดวิธีการประเมินผล ก าหนดความรู้และทักษะพ้ืนฐานที่จ าเป็นต่อการ
เรียนและสร้างประมวลรายวิชาการก าหนดกิจกรรมการเรียนการสอนผ่านเว็บ โดยใช้คุณสมบัติของ
อินเทอร์เน็ตที่เหมาะสมกับกิจกรรมการเรียนการสอนนั้น ๆ 
 4.4 การเตรียมความพร้อมและสภาพแวดล้อมทางการเรียนการสอนผ่านเว็บได้แก่ ส ารวจ
แหล่งทรัพยากรการเรียนรู้ที่ผู้เรียนสามารถเชื่อมโยงไปศึกษาค้นคว้าได้ ก าหนดสถานที่และอุปกรณ์ที่
ให้บริการและการติดต่อทางอินเทอร์เน็ต 
 4.5 สร้างเว็บเพจเนื้อหาความรู้ตามหัวข้อของการเรียนการสอนรายสัปดาห์ 
 4.6 การเตรียมความพร้อมให้กับผู้เรียนโดยการแจ้งวัตถุประสงค์ทางการเรียน อธิบายเนื้อหา 
และวิธีการเรียนการสอน 
 4.7 จัดการเรียนการสอนตามแบบที่ก าหนดไว้ 
 4.8 การประเมินผล โดยท าการประเมินผลทั้งระหว่างเรียนและเมื่อสิ้นสุดการเรียน รวมทั้ง
การเรียน ประเมินผลผู้สอนและการประเมินผลการจัดการเรียนการสอนทั้งรายวิชา เพ่ือน าข้อมูลไป
ปรับปรุงแก้ไขการเรียนการสอนให้มีประสิทธิภาพมากยิ่งข้ึนต่อไป 
 5. ข้อค านึงในการจัดการเรียนการสอนผ่านเว็บ การจัดการเรียนการสอนผ่านเว็บ ควร
ค านึงถึงประเด็นต่าง ๆ ต่อไปนี้ 
 5.1 ความพร้อมของอุปกรณ์และระบบเครือข่าย เนื่องด้วยการเรียนการสอนผ่านเว็บเป็นการ
ปรับเนื้อหาเดิมสู่รูปแบบใหม่ จ าเป็นต้องมีเครื่องมือ อุปกรณ์ และระบบเครือข่ายที่พร้อมและสมบูรณ์ 
เพ่ือให้ได้บทเรียนดิจิตอลที่มีคุณภาพ และทันต่อความต้องการเรียน ผู้เรียนสามารถเลือกเวลาเรียนได้
ทุกช่วงเวลาตามที่ต้องการซึ่งในประเทศไทยพบว่ามีปัญหาในด้านนี้มากโดยเฉพาะในเขตนอกเมือง
ใหญ่ 
 5.2 ทักษะการใช้คอมพิวเตอร์และอินเทอร์เน็ต ผู้เรียนและผู้สอน ต้องมีความรู้และทักษะทั้ง
ด้านคอมพิวเตอร์และเครือข่ายอินเทอร์เน็ตพอสมควรโดยเฉพาะผู้สอนจ าเป็นต้องมีทักษะอ่ืน  ๆ 
ประกอบ เพ่ือสร้างเว็บไซต์การสอนที่น่าสนใจให้กับผู้เรียน 
 5.3 ความพร้อมของผู้เรียน ผู้เรียนจะต้องมีความพร้อมทั้งทางจิตใจและความรู้คือ จะต้อง
ยอมรับในเทคโนโลยีรูปแบบนี้ยอมรับการเรียนด้วยตนเอง มีความกระตือรือร้น ตื่นตัว ใฝ่รู้ มีความ
รับผิดชอบกล้าแสดงความคิดเห็นและศึกษาความรู้ใหม่ ๆ 
 5.4 ความพร้อมของผู้สอน จะต้องเปลี่ยนบทบาทจากผู้แนะน ามาเป็นผู้อ านวยความสะดวก 
ยึดผู้เรียนเป็นศูนย์กลาง กระตุ้นให้ผู้เรียนเกิดความอยากรู้อยากเห็น อยากเรียนรู้เพ่ือกระตุ้นการท า
กิจกรรมเตรียมเนื้อหาและแหล่งค้นคว้าที่มีคุณภาพ รวมทั้งความพร้อมด้านการใช้คอมพิวเตอร์และ
การผลิตบทเรียนออนไลน์ และการเผยแพร่บทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 5.5 เนื้อหาบทเรียน จะต้องเหมาะสมกับผู้เรียนให้มากกลุ่มที่สุดมีหลากหลายให้ผู้เรียนแต่ละ
กลุ่มเลือกเรียนได้ด้วยตนเอง มีกิจกรรมวัตถุประสงค์ที่ชัดเจนเลือกใช้สื่อการสอนที่เหมาะสมและ
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เหมาะสมกับความพร้อมของเทคโนโลยี การล าดับเนื้อหาไม่ซับซ้อน ไม่ก่อให้เกิดความสับสน ระบุ
แหล่งค้นคว้าอื่น ๆ ที่เหมาะสม 
 6. รูปแบบการเรียนการสอนในอินเทอร์เน็ต 
 รูปแบบการเรียนการสอนในอินเทอร์เน็ต เป็นการสอนผ่านเว็บ (Web-Based Instruction) คือ
การเรียนการสอน online โดยใช้เว็บเป็นฐานโดยอาศัยเทคโนโลยีอินเทอร์เน็ต อินทราเน็ต
หรือ ASP ดังนั้นการเรียนการสอนจะอยู่ในเวลาและสถานที่ต่างกัน อย่างไรก็ดี การโต้ตอบจะไม่จ ากัด 
เพราะมีการจัดหาเครื่องมือ ในการตอบโต้กับผู้สอนและผู้เรียนสะดวก 
 6.1 การสร้างบทเรียน 
 1. การมีปฎิสัมพันธ์ มีลักษณะในการโต้ตอบระหว่างบทเรียนกับผู้เรียน ผู้เรียนกับผู้สอน 
ผู้เรียนกับผู้เรียน 
 2. ใช้สื่อผสม เพื่อการน าเสนอเข้าใจง่าย 
 3. อิสระกับระยะทางกับเวลา บทเรียนที่สร้างควรมีอิสระ ที่จะท าให้ผู้เรียนเข้าถึงจากที่
ห่างไกลได้และไม่ข้ึนกับเวลา 
 4. เป็นระบบออนไลน์เพ่ือสามารถเข้าถึงบทเรียนได้ตลอดเวลาน่าสนใจทันกับเหตุการณ์
ตลอดเวลา 
 5. การเข้าถึงได้ทั่วโลก สามารถเข้าถึงข้อมูลข่าวสารได้ทุกหนทุกแห่ง 
 6. การควบคุมกิจกรรม ผู้เรียนสามารถเข้าถึงและสามารถควบคุมกิจกรรมต่าง ๆ ภายใต้ความ
สนใจของผู้ศึกษาเอง 
 7. ความสะดวก เน้นการท าให้ผู้เรียนเรียนรู้จากระบบได้ง่าย 
 8. ใช้ได้ง่าย โดยเน้นการติดต่อสื่อสาร การเรียนรู้ด้วยตนเอง 
 9. มีประสิทธิภาพ โดยเน้นการเรียนการสอนที่ได้ความรู้ตรงกับผู้เรียนและสามารถท าให้เรียนรู้
ได้เร็ว 
 10. ต้นทุนต่ า ค่าใช้จ่ายต่าง ๆ ต่ ากว่า เมื่อเปรียบเทียบกับการจัดการเรียนการสอนหรือการ
ผลิตบทเรียนอื่น ๆ 
 6.2 การพัฒนาระบบการเรียนการสอนผ่านเว็บ ต้องมีการพัฒนาอย่างเป็นระบบเพ่ือให้
ผู้พัฒนาได้มีกระบวนการในการด าเนินการอย่างเป็นล าดับขั้นตอน ขณะเดียวกันผู้เรียนก็จะได้รับสื่อ
การเรียนการสอนทีม่ีคุณภาพ ซึ่งผู้ท าการวิจัยได้กล่าวแสดงข้อเปรียบเทียบของการออกแบบการเรียน
การสอนเชิงระบบเอาไว้ดังนี้คือ 
 ตวงรัตน์ ศรีวงษ์คล (2549) [Online] ได้กล่าวถึงข้อเปรียบเทียบของการออกแบบการเรียน
การสอนเชิงระบบเอาไว้ดังนี้ 
 1. กระตุ้นในเกิดการเน้นผู้เรียน โดยทั่วไปผู้เรียนคือหัวใจของการเรียนการสอนนักออกแบบใช้
ความพยายามอย่างมากในช่วงแรกของการออกแบบ เพ่ือที่จะศึกษาเกี่ยวกับผู้เรียนข้อมูลเกี่ยวกับ
ผู้เรียนเป็นปัจจัยส าคัญในการออกแบบมากกว่าปัจจัยอ่ืน ๆ รวมทั้งปัจจัยเนื้อหาบ่อยครั้งที่นัก
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ออกแบบไม่ใช้ผู้เชี่ยวชาญด้านเนื้อหาจึงไม่มีความช านาญในด้านเนื้อหาคล้ายกับผู้เรียนเอง ท าให้
พยายามหาข้อมูลเพื่อที่จะท าให้เนื้อหาชัดเจนต่อผู้เรียน 
 2. ส่งเสริมองค์ประกอบของประสิทธิผล ประสิทธิภาพและความน่าสนใจซึ่งถือเป็นตัวชี้ส าคัญ
ของความส าเร็จ กระบวนการออกแบบมุ่งเน้นให้มีบทเรียนที่มีประสิทธิผลการวิเคราะห์การเรียนการ
สอนท าให้เกิดประสิทธิภาพ เมื่อเนื้อหาที่ไม่จ าเป็นถูกคัดสรรออกไป ข้อพิจารณาเกี่ยวกับผู้เรียนและ
ยุทธวิธีการเรียนการสอนที่เหมาะสมท าให้การเรียนการสอนน่าสนใจ 
 3. ส่งเสริมการประสานงานกันของนักออกแบบ นักพัฒนาและบุคลากรที่เกี่ยวข้องกับการใช้
การเรียนการสอนนั้น กระบวนการออกแบบเชิงระบบและเอกสารข้อมูลที่เขียนบันทึกไว้ท าให้เกิดการ
สื่อสาร การประสานงาน ระหว่างบุคคลต่างๆ ที่เกี่ยวข้องกับการออกแบบการผลิตและการส่งถ่ายการ
สอนบทเรียน หรือการเรียนการสอน นอกจากนี้รายการวัตถุประสงค์ ค าอธิบายเกี่ยวกับผู้เรียนและ
การวิเคราะห์งานรวมทั้งชิ้นที่ออกแบบไว้ช่วยให้สามารถทบทวนและปรับปรุงงานในระหว่างทีมงานได้ 
 4. ช่วยในการเผยแพร่การน าไปใช้และการยอมรับเพราะได้ออกแบบอย่างมีระบบสามารถ
ท าซ้ า เผยแพร่และน าไปใช้เนื่องจากมีการพิจารณาด้านผู้เรียนและสิ่งแวดล้อมท าให้สามารถน าไปใช้
ในทางปฏิบัติและเป็นที่ยอมรับในการแก้ปัญหาการเรียนการสอน 
 5. ส่งเสริมการพัฒนาให้มีรูปแบบการเรียนการสอนที่หลากหลายไม่จ ากัดขอบเขตเพียงอยู่แค่
สื่อรูปแบบใดรูปแบบหนึ่งเท่านั้นโดยมีการวิเคราะห์เบื้องต้น (Front-end Analysis) และข้อค านึง
เกี่ยวกับยุทธวิธีการเรียนการสอนเป็นมูลเหตุในการส่งถ่ายการเรียนรู้ในหลากหลายรูปแบบ 
 6. ช่วยให้เกิดความสอดคล้องระหว่างวัตถุประสงค์ กิจกรรมการประเมินผลการออกแบบเชิง
ระบบช่วยให้มั่นใจได้ว่าสิ่งที่สอนคือ สิ่งที่จ าเป็นส าหรับผู้เรียนในการบรรลุเป้าหมายของการเรียนรู้
และการประเมินผลมีความถูกต้องและเหมาะสม 
 

 2.4.5 การออกแบบบทเรียนผ่านเว็บ 
 Ritchie & Hoffman (1996 : 135-138) ได้เสนอแนะการออกแบบบทเรียนทางเว็บที่
ก่อให้เกิดการเรียนรู้ที่ดีที่สุด ว่าควรมีหลักกระบวนการเรียนการสอน 7 ขั้นตอน ดังนี้ 
 1. การสร้างแรงจูงใจให้กับผู้เรียน (Motivating the learner) การออกแบบบทเรียนทาง
เว็บควรสร้างความสนใจแก่ผู้เรียนด้วยการใช้กราฟิก ภาพเคลื่อนไหว และเสียงประกอบ เพ่ือกระตุ้น
ผู้เรียนให้อยากเรียนรู้ ภาพกราฟิกที่ใช้ควรมีขนาดและจ านวนที่เหมาะสมและสอดคล้องกับเนื้อหา
บทเรียน 
 2. การระบุวัตถุประสงค์ของการเรียน (Identifying what is to be learned) ผู้เรียนควร
ทราบวัตถุประสงค์เชิงพฤติกรรมหรือวัตถุประสงค์ทั่วไป และประเด็นส าคัญของบทเรียนหรือเค้าโครง
เนื้อหา โดยใช้ค าที่สั้น กระชับ และเข้าใจง่าย ประกอบกับภาพกราฟิกแบบง่าย ๆ สร้างความสนใจ 
เพ่ือให้ผู้เรียนทราบก่อนการเรียนล่วงหน้าและเตรียมตัวส าหรับบทเรียนที่จะเรียน และไม่ให้หลงลืม
วัตถุประสงค์ของบทเรียน 
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 3. การทบทวนความรู้เดิม (Remiding learners of past knowledge) เป็นการเตรียม
พ้ืนฐานผู้เรียนส าหรับความรู้ใหม่ การทบทวนอาจไม่จ าเป็นต้องเป็นแบบทดสอบเสมอไป อาจใช้เสียง
ข้อความ ภาพ หรือหลายสื่อผสมผสานกัน เพ่ือกระตุ้นให้ผู้เรียนนึกถึงความรู้ที่ได้รับมาก่อน ควรมี
ความหลากหลายของโครงสร้างบทเรียนส าหรับผู้เรียนที่มีความแตกต่างกันด้านภูมิหลังพ้ืนความรู้ 
ความถนัดทางการเรียน หรือความสามารถทางการเรียนรู้ เพ่ือให้ผู้เรียนได้รับความรู้ใหม่ได้เร็วและ
ตรงความต้องการมากขึ้น 
 4. การกระตุ้นการเรียนรู้ (Requiring active involvement) นักการศึกษาต่างเห็นพ้อง
ต้องกันว่า การเรียนรู้จะเกิดขึ้นเมื่อผู้เรียนมีความตั้งใจที่จะรับความรู้ใหม่ ผู้เรียนที่เป็นผู้กระตืนรือค้น
จะรับความรู้ได้ดีกว่าผู้เรียนที่เฉื่อยชา การน าเสนอเนื้อหาที่ดีจะช่วยให้ผู้เรียนสามารถจดจ าได้ดียิ่งขึ้น 
ทั้งนี้จะสัมพันธ์กับประสบการณ์เดิมของผู้เรียนด้วย ดังนั้นควรหาเทคนิคต่าง ๆ ที่จะกระตุ้นให้ผู้เรียน
น าความรู้เดิมมาใช้กับความรู้ใหม่ท่ีได้รับให้ผู้เรียนมีความรู้ที่กระจ่างชัดมากขึ้น ควรพยายามให้ผู้เรียน
รู้จักเปรียบเทียบ จัดกลุ่ม หาเหตุผล รู้จักค้นคว้าและวิเคราะห์หาค าตอบด้วยตนเอง โดยออกแบบ
บทเรยนให้เรียนจากเรื่องทั่วไปหรือเรื่องกว้าง ๆ ก่อนเรื่องเฉพาะเจาะจงหรือแคบลง และใช้ข้อความ
กระตุ้นให้ผู้เรียนคิดไปกับบทเรียนด้วย 
 5. การให้ค าแนะน าและข้อมูลย้อนกลับ (Providing guidance and feedback) การให้
ค าแนะน าและให้ข้อมูลย้อนกลับในระหว่างผู้เรียนศึกษาอยู่ในบทเรียนทางเว็บ เป็นการกระตุ้นความ
สนใจของผู้เรียนได้ดี ผู้เรียนจะทราบความก้าวหน้าในการเรียนของตนเอง เป็นการเปิดโอกาสให้
ผู้เรียนร่วมคิด ร่วมท ากิจกรรมในส่วนที่เกี่ยวข้องกับเนื้อหา การซักถามและการตอบจะช่วยให้ผู้เรียนย
จดจ าบทเรียนได้มากกว่าการอ่านหรือคัดลอกข้อความเพียงอย่างเดียว ทั้งนี้ ควรให้ผู้เรียนตอบสนอง
ด้วยวิธีใดวิธีหนึ่งเป็นครั้งคราว รวมทั้งการถาม - ตอบหลาย ๆ แบบ เช่น จับคู่ แบบปรนัย เติมค าใน
ช่องว่าง เป็นต้น 
 6. การทดสอบความรู้ (Testing) เพ่ือทราบว่าผู้เรียนได้รับความรู้จากการเรียนมากน้อยเพียง 
ใด ผู้ออกแบบทดสอบซึ่งอาจเป็นแบบออนไลน์หรือแบบออฟไลน์ก็ได้ และเป็นการเปิดโอกาสให้
ผู้เรียนได้ประเมินผลการเรียนของตนเองได้ โดยอาจจัดให้มีความทดสอบระหว่างเรียน หรือหลังเรียน 
ทั้งนี้แบบทดสอบจะต้องตรงหรือสอดคล้องกับวัตถุประสงค์ของบทเรียน แบบทดสอบค าตอบและ
ข้อมูลย้อนกลับจากการท าแบบทดสอบ ควรจัดให้อยู่ในกรอบเดียวกัน แสดงได้อย่างต่อเนื่องและ
รวดเร็ว ไม่ควรออกแบบให้ผู้เรียนพิมพ์ค าตอบยาวเกินไป และควรชี้แจงวิธีตอบค าถามให้ชัดเจน โดย
ค านึงถึงความถูกต้องและความน่าเชื่อถือของแบบทดสอบ 
 7. การน าเสนอข้อมูลเพิ่มเติมหรอืการซ่อมเสริม (Providing enrichment and 
remediation) เป็นการสรุปแนวคิดส าคัญ ผู้เรียนควรทราบว่าความรู้ใหม่สัมพันธ์กับความรู้เดิม
อย่างไร ควรเสนอแนะสถานการณ์ที่จะน าความรู้ใหม่ไปใช้ และแนะน าแหล่งข้อมูลให้ผู้เรียนได้ค้นคว้า
เพ่ิมเติม 
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2.5 โปรแกรมที่ใช้ในการพัฒนาบทเรียนอีเลิร์นนิง 
 
 การสร้างบทเรียนอีเลิร์นนิงอาศัยเครื่องมือเข้ามาช่วยในการสร้างหลายรูปแบบโดยเฉพาะการ
สร้างบทเรียนในส่วนเนื้อหานั้นต้องใช้องค์ประกอบหลายอย่างประกอบกันจึงจะเป็นบทเรียนมีความ
สมบูรณ์และเหมาะสมในการใช้งานตามเทคโนโลยีปัจจุบันผู้วิจัยจึงเลือกใช้เครื่องมือในการสร้าง
บทเรียนหลายโปรแกรม ดังนี้ 
 

 2.5.1 Adobe Dreamweaver CS5  
 Dreamweaver คือโปรแกรมสร้างเว็บเพจแบบเสมือนจริงของค่าย Adobe ซึ่งช่วยให้ผู้ที่
ต้องการสร้างเว็บเพจไม่ต้องเขียนภาษา HTML หรือโค๊ดโปรแกรมเองหรือที่ศัพท์เทคนิคเรียกว่า 
"WYSIWYG " โปรแกรม Dreamweaver มีฟังก์ชันที่ท าให้ผู้ใช้สามารถจัดวางข้อความ รูปภาพ ตาราง 
ฟอร์ม วิดีโอ รวมถึงองค์ประกอบอ่ืน ๆ ภายในเว็บเพจได้อย่างสวยงามตามที่ผู้ใช้ต้องการ โดยไม่ต้อง
ใช้ภาษาสคริปต์ที่ยุ่งยากซับซ้อนเหมือนก่อน Dreamweaver มีทั้งในระบบปฏิบัติการแมคอินทอช
และไมโครซอฟท์วินโดวส์ Dreamweaver ยังสามารถท างานบนระบบปฏิบัติการแบบยูนิกซ์ ผ่าน
โปรแกรมจ าลองอย่าง WINE ได้ ซึ่งเวอร์ชั่นล่าสุดของโปรแกรมตัวนี้คือ Adobe Dreamweaver 
CS5.5 และสามารถท างานกับภาษาคอมพิวเตอร์ในการเขียนเว็บไซต์แบบไดนามิค ซึ่งมีการใช้ HTML 
เป็นตัวแสดงผลของเอกสาร เช่น ASP, ASP.NET, PHP, JSP และ ColdFusion รวมถึงการจัดการ
ฐานข้อมูลต่าง ๆ และยังสามารถท างานร่วมกับ XML และ CSS ได้อย่างง่ายดาย 
 1. ขั้นตอนการสร้างเว็บไซต์ใน Dreamweaver CS5  
 1.1 สร้างเว็บไซต์ใหม่ เนื่องจากการเริ่มต้นสร้างเว็บไซต์ใน Dreamweaver จะต้องก าหนด
ข้อมูลเบื้องต้น เช่น ชื่อเว็บไซต์ ที่อยู่ของไฟล์เว็บเพจที่อยู่ในเว็บไซต์ เป็นต้น ท าให้ไฟล์เว็บเพจทุกไฟล์
ของเว็บไซต์ที่สร้างขึ้นมา ได้จัดเก็บไว้ในที่เดียวกัน เพ่ือความสะดวกในการอัพโหลดเว็บไซต์ขึ้นบน
อินเตอร์เน็ต 
 1.2 สร้างเว็บไซต์ใหม่ หลังจากสร้างเว็บไซต์ขึ้นมาแล้ว ในขั้นนี้เป็นการสร้างเว็บเพจขึ้นมา
ประกอบในเว็บไซต์ เปรียบได้กับแฟ้มใหม่ที่รอเอกสารมาใส่ในแฟ้มนั่นเอง ในเว็บไซต์หนึ่งมีจ านวน
หน้าเว็บเพจเท่าไรก็ได้ 
 1.3 แทรกองค์ประกอบลงในเว็บเพจ เว็บเพจที่สร้างขึ้นอาจสร้างจากหน้าเปล่าที่ไม่มีการจัด
องค์ประกอบไว้ก่อน หรืออาจสร้างจากไฟล์ตัวอย่างที่มีอยู่แล้ว ซึ่งสามารถน าข้อความ ภาพ ไฟล์เสียง  
หรือแม่แต่ไฟล์วีดีโอ เข้ามาไว้ในหน้าเว็บเพจได้ 
 1.4 ปรับแต่งคุณสมบัติขององค์ประกอบที่แทรกในเว็บเพจ การวางองค์ประกอบต่าง ๆ ลงบน
เว็บเพจเพียงอย่างเดียว อาจดูไม่เป็นระเบียบสวยงาม จึงจ าเป็นต้องจัดรูปแบบองค์ประกอบเหล่านั้น
ให้เหมาะสม เช่น การปรับขนาดรูปให้เหมาะกับข้อความในเว็บเพจ การปรับแต่งสีของตัวอักษร เป็น
ต้น 
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 1.5 ทดสอบเว็บเพจ ภายหลังจากจัดหน้าเว็บเพจแล้ว จะดูการแสดงผลของเว็บเพจที่สร้างได้
จากโปรแกรมเว็บบราวเซอร์ เช่น Internet Explorer หรือ firefox โดยทดสอบการแสดงผลของ
องค์ประกอบต่าง ๆ เช่น ข้อความ ภาพกราฟฟิก ตาราง รวมถึงไฮเปอร์ลิงค์ ไฟล์เสียงหรือไฟล์วีดีโอ 
ว่าเป็นไปตามที่ออกแบบไว้หรือไม่ โดยสามารถแก้ไขได้จาก Dreamweaver และทดสอบเว็บเพจ
เหล่านี้ซ้ า จนกว่าจะเป็นที่พอใจ 
 1.6 สร้างไฮเปอร์ลิงค์ เมื่อจัดหน้าเว็บเพจในแต่ละหน้าเสร็จแล้ว ก็ต้องเชื่อมโยงเว็บเพจแต่ละ
หน้าเข้าหากันได้ด้วยไฮเปอร์ลิงค์ นอกจากนี้อาจสร้างลิงค์ไปที่เว็บไซต์อ่ืนภายนอกด้วยก็ได้ 
 1.7 ทดสอบไฮเปอร์ลิงค์ แต่ละเว็บเพจที่เชื่อมโยงถึงกัน ควรตรวจสอบการแสดงผลบนเว็บ
บราวเซอร์ว่าสามารถใช้ไฮเปอร์ลิงค์ในการเชื่อมโยงเว็บเพจแต่ละหน้าได้ตรงกับที่ตั้งค่าไว้หรือไม่ 
 1.8 เผยแพร่เว็บไซต์ เป็นขั้นตอนสุดท้ายของกระบวนการทั้งหมด หลังจากที่ได้ทดสอบเว็บ
เพจแต่ละหน้าและปรับปรุงแก้ไขแล้ว เว็บไซต์ที่สร้างขึ้นมานั้น จะอัพโหลดทั้งไฟล์เว็บเพจ ไฟล์ภาพ 
ไฟล์เสียง และไฟล์อื่น ๆ ขึ้นไปไว้บนเซิร์ฟเวอร์ทีจะแสดงเว็บนั้นบนอินเทอร์เน็ต 
 2. ส่วนประกอบต่างๆ ของโปรแกรม Dreamweaver 
 2.1 แถบค าสั่ง (Menu Bar) เป็นแถบที่ใช้เก็บค าสั่งทั้งหมดของโปรแกรม 
 2.2 แถบค าเครื่องมือ (Toolbar) รวบรวมปุ่มค าสั่งที่ใช้งานบ่อย 
 2.3 แถบวัตถุ (Object Palette) เป็นกลุ่มเครื่องมือต่างๆ ที่ใช้ในการควบคุมวัตถุ บนชิ้นงาน 
เอกสารเว็บ เช่น เส้นกราฟิก (Horizontal Rule), ตาราง, รูปภาพ, เลเยอร์ (Layer) 
 2.4 แถบแสดงสถานะ (Status Bar) คอยแสดงสถานะการท างานต่างๆ ของเรา 
 2.5 แถบควบคุมการท างาน (Properties Palette) เป็นรายการที่ปรับเปลี่ยนได้ ตามลักษณะ
การเลือกข้อมูล เช่น หากมีการเลือกที่จะพิมพ์ หรือแก้ไขเนื้อหา รายการก็จะเป็น ส่วนท างานที่
เกี่ยวกับอักษร ถ้าเลือกท่ีรูปภาพ รายการจะเป็นค าสั่งต่าง ๆ ที่เกี่ยวกับการควบคุมเรื่องรูปภาพ 
 2.6 ส่วนของ Panel Group เป็นกลุ่มของแถบเครื่องมือที่สามารถเรียกใช้งานได้อย่างรวดเร็ว 
เพ่ือให้ง่ายในการสร้าง Application บนอินเทอร์เน็ต เช่น การแทรก Code ของ JavaScript และ 
VBScript ลงในเว็บเพจได้อย่างง่าย ๆ โดยสามารถเรียกใช้งานได้จาก Panel Group 
 3. การพิมพ์ข้อความ 
 การพิมพ์ข้อความในเว็บเพจจะคล้ายกับการพิมพ์เอกสารใน Word โดยเราสามารถจัดรูปแบบ
ข้อความให้สวยงามได้ด้วย โดยอาจใช้ตัวอักษรกราฟิกท่ีสีตัวอักษรตัดกับสีพ้ืนฉากหลัง เพ่ือให้สามารถ
อ่านได้ง่าย และเราสามารถจัดรูปแบบและขนาดตัวอักษรได้โดยให้ เลือกข้อความที่ต้องการปรับแต่ง
และแก้ไขค่าต่าง ๆ ได้ท่ีหน้าต่าง Properties โดยมีรายละเอียดดังนี้ 
 3.1 Format เป็นรูปแบบตัวอักษรส าเร็จที่เราน ามาก าหนดให้กับข้อความได้ 
 3.2 Font รูปแบบตัวอักษร โดยใน Dreamweaver จะแสดงรูปแบบตัวอักษรที่มีในเครื่อง 
 3.3 Size ขนาดของตัวอักษร ขนาดมาตรฐานที่ก าหนดไว้คือ 3 
 3.4 Color ก าหนดสีให้ตัวอักษร 
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 4. การสร้างตาราง 
 การใช้ตารางเหมาะส าหรับการน าเสนอข้อมูลจ านวนมาก เพ่ือความสะดวกในการจัดการข้อมูล
และความเป็นสัดส่วน ควรจัดระบบการน าเสนอข้อมูลของหน้าเว็บเพจโดยการใช้ตารางเป็นตัวจัดการ
ในการจัดวางข้อมูลในแต่ละหน้าเว็บเพจ ซึ่งตารางประกอบด้วย 
 Rows - จ านวนแถวที่ต้องการ 
 Column - จ านวนคอลัมน์ที่ต้องการ 
 Width - ความกว้างของตาราง 
 Border - ความหนาของขอบตาราง 
 Cell Padding - ระยะระหว่างข้อความกับขอบตาราง 
 Cell Spacing – ระยะระหว่างแต่ละเซลล์ในตาราง 
 5. การเชื่อมโยง (Link) 
 การเชื่อมโยงบนเว็บเพจมีด้วยกันหลายรูปแบบ อาจแบ่งตามการใช้งาน หรือตามลักษณะของ
การเชื่อมโยงภายในเว็บเพจ และการเชื่อมโยงภายนอกเว็บเพจ แต่ถ้าแบ่งตามวัตถุประสงค์ของ
รูปแบบการใช้งานจะแบ่งการเชื่อมโยงเว็บเพจออกเป็นดังนี้ 
 5.1 การเชื่อมโยงภายในเว็บเพจเดียวกัน 
 5.2 การเชื่อมโยงภายในไซต์เดียวกัน 
 5.3 การเชื่อมโยงไปยังเว็บไซต์อ่ืน 
 5.4 การเชื่อมโยงดัวย e-Mail 
 5.5 การเชื่อมโยงไปยังไฟล์ Download 
 5.6 การเชื่อมโยงด้วย Map Link 
 

 2.5.2 Moodle 
 Moodle ย่อมาจาก Modular Object-Oriented Dynamic Learning Environment เป็น
ระบบจัดการบทเรียนออนไลน์ (Course Management System : CMS) หรือที่รู้จักกันในชื่อ 
Learning Management System (LMS) หรือ Virtual Learning Environment (VLE) มูเดิลเป็น
ซอฟต์แวร์ฟรี พัฒาขึ้นในลักษณะโอเพ่นซอร์ส (Opensource) มีลิขสิทธิ์แบบGPL (General Public 
License) หรือลิขสิทธิ์แบบฟรีนั่นเอง ผู้ใช้สามารถดาวน์โหลดไปติดตั้งใช้งานได้ฟรีโดยไม่ต้องจ่ายค่า  
ลิขสิทธิ์แต่อย่างใดสามารถดูรายละเอียดเพิ่มเติมได้ที่เว็บท่าของมูเดิลที่ http://moodle.org  
 มูเดิล เป็นระบบ LMS ตัวหนึ่งที่มีความสามารถสูง สามารถน าไปประยุกต์ใช้งานได้หลากหลาย 
โดยเฉพาะน าไปสร้างเป็นระบบ e-Learning ใช้ในหน่วยงาน หรือศูนย์เก็บคลังความรู้ของหน่วยงาน 
(Knowledge Management) ผู้พัฒนาซอฟต์แวร์นี้คือ Martin Dougiams ประเทศออสเตรเลีย 
(อาณัติ รัตนถิรกุล, 2553 : 1) 
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 1. ลักษณะของโปรแกรม  
 ขนิษฐา รุจิโรจน์ (2546 : 9-13) กล่าวว่า  ลักษณะทั่วไปมูเดิล (Moodle) เป็นโปรแกรมการ
ท างานแบบเครื่องแม่ข่าย / ลูกข่าย (server/client) โดยไม่จ ากัดจ านวนผู้ใช้ สามารถแสดงผลเมนูได้
หลายภาษา ผู้สอนสามารถสร้างแหล่งความรู้หรือเนื้อหาวิชาได้ โดยผ่านฟังก์ชันต่างๆ ที่ระบบก าหนด
ไว้ให้และสามารถเชื่อมโยงไปยังเว็บไซต์ของแหล่งข้อมูลภายนอกได้ ผู้สอนจะมีรหัสผ่านเข้าระบบ 
(Login) เพ่ือจัดการกับเนื้อหา เช่น ตารางการสอน การจัดการเว็บไซต์ การจัดการผู้ใช้ การจัดการ
โมดูล การจัดการกลุ่มผู้เรียน เป็นต้น นอกจากนั้นยังมีระบบจัดการรายวิชา มีห้องสนทนา (Chart 
room) สนับสนุนการเรียนรู้แบบปฏิสัมพันธ์ระหว่างผู้เรียนกับผู้สอน ในขณะที่ผู้เรียนจะมีรหัสผ่านเข้า
ระบบ เพ่ือดูส่วนที่สนใจของรายวิชา เช่น ประกาศ ตารางงาน งานที่ได้รับมอบหมายจากผู้สอนและ
เปิดดูเนื้อหาเพ่ือเรียนรู้ สามารถสื่อสารกันได้ตลอดเวลามีหัวข้อแลกเปลี่ยนความคิดเห็นมีระบบเก็บ
ค าศัพท์ มีพ้ืนที่เก็บสื่อประกอบการเรียนการสอน ในรูปแบบของมัลติมีเดีย ในส่วนของการ
ประเมินผล ผู้เรียนสามารถเข้ามาทดสอบ วัดความรู้ และดูผลอย่างละเอียดได้ หากผู้เรียนไม่เข้าใจ
วิธีการใช้งาน จะมีระบบช่วยเหลือการใช้งานของผู้สอนและผู้เรียนเป็นภาษาไทย ในระบบและจัดท า
เป็นคู่มือประกอบ 
 2. ลักษณะเฉพาะส่วนของโปรแกรม 
 2.1 การจัดการรายวิชา (Course Management) สามารถรองรับการอัพโหลดและดาวน์
โหลด โดยไม่จ ากัดรูปแบบของไฟล์ 
 2.2 ระบบการสื่อสาร (Communication System) จะมีห้องสนทนา (Chat room) เพ่ือให้
ผู้เรียนสามารถติดต่อกันได้ในเวลาเดียวกัน การส่งจดหมายอิเล็กทรอนิกส์ ให้ผู้เรียนผู้สอนสามารถ
ติดต่อกันได้ต่างเวลากันและกระดานแสดงความคิดเห็น (Discussion forum) การรับส่งงานระหว่าง
ผู้สอนและผู้เรียนท าให้สามารถติดต่อสื่อสารหรือท างานกลุ่มภายในวิชาเรียนได้ 
 2.3 ระบบการวัดผลประเมินผล (Assessments) สามารถเปรียบเทียบ ทดสอบและวัดผลการ
พัฒนาการของผู้เรียนได้ โดยสร้างและก าหนดระเบียบของแบบทดสอบ สร้างและออกแบบทดสอบได้
ง่าย ผู้สอนสามารถสร้างค าถามได้หลากหลาย ทั้งปรนัย และอัตนัยภายในข้อสอบชุดเดียวกัน เช่น 
แบบเลือกค าตอบที่ถูกเพียงข้อเดียว (Multiple choice) แบบเลือกค าตอบที่ถูกต้องมากกว่าหนึ่งข้อ 
(Multiple response) แบบเลือกถูกผิดและแบบเขียนบรรยาย (Essay) เป็นต้น มีพ้ืนที่ส าหรับเป็น
แหล่งเก็บข้อสอบทั้งหมด โปรแกรมสามารถระบุช่วงวัน เวลา ที่อนุญาตให้ผู้เรียนเข้าไปท าข้อสอบได้ 
รวมทั้งสามารถก าหนดผลตอบรับ (Feedback) การท าข้อสอบ นอกจากนี้สามารถสร้างและเก็บ
รายงานสถิติของค าตอบ ในการท าข้อสอบของผู้เรียนได้ 
 2.4 ระบบควบคุม (Control) โปรแกรมสามารถควบคุมและจัดการกับรายวิชาที่เปิดสอนโดย
ผู้สอนและผู้ดูแลระบบ (Administrator) ในส่วนของผู้สอนจะมีฟังก์ชันที่ใช้ส าหรับควบคุมและจัดการ
ภายในรายวิชานั้นๆ และในส่วนของผู้ดูแลระบบ จะมีฟังก์ชันควบคุมทั้งระบบของโปรแกรมสื่อการ
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เรียนการสอนทางไกลและสามารถตรวจสอบการใช้งานระบบของผู้ใช้แต่ละคนได้ เช่นตรวจสอบผล
การท าข้อสอบการเข้าไปสืบค้นของผู้ใช้ รวมถึงผู้สอน ผู้เรียน และผู้เข้ามาเยี่ยมชมระบบ 
 2.5 การจัดการเว็บไซต์ (Site management) ซอฟต์แวร์สามารถให้ผู้ดูแลระบบก าหนดการ
ติดตั้งเว็บไซต์ได้ ปรับปรุงและเพ่ิมโมดูลเข้าสู่ระบบ พร้อมทั้งสามารถก าหนดให้ระบบแสดงผลได้
หลายภาษา 
 3. คุณลักษณะของโปรแกรมในส่วนของผู้ใช้ 
 3.1 ผู้เรียน สามารถเข้าไปอ่านประกาศของรายวิชาที่ลงทะเบียนเรียน ขอดูข้อมูลผู้สอนที่สอน
ในรายวิชานั้นๆ ดาวน์โหลดงานที่ผู้สอนมอบหมายแต่ละครั้งได้ ทั้งท่ีเป็นงานปัจจุบันและงานย้อนหลัง 
ส่งจดหมายอิเล็กทรอนิกส์ไปยังทุกคน ทุกกลุ่ม ทั้งผู้สอนและผู้ช่วยสอนภายในรายวิชานั้น  ๆ ได้ 
พร้อม ๆ กันได้ด้วย แสดงความคิดเห็นหรือตั้งกระทู้ระหว่างผู้เรียนด้วยกันหรือระหว่างผู้เรียนกับ
ผู้สอน ภายในรายวิชานั้นๆ ผ่านกระดานและการบ้านได้ ตรวจสอบผลการท าแบบทดสอบเฉพาะราย 
วิชาได้และท าข้อสอบของแต่ละวิชาที่ลงทะเบียนได้ 
 3.2 ผู้สอน มีฟังก์ชันที่เพ่ิมเติมจากระดับของผู้เรียน ซึ่งใช้ส าหรับการจัดการการสร้างและการ
ควบคุมภายในรายวิชานั้น ได้แก่ สามารถสร้างแบบทดสอบด้วยตนเอง มีแหล่ งข้อสอบเพ่ือให้ผู้สอบ
สามารถสืบค้นข้อสอบมาใช้งานได้ ผู้สอน สามารถตรวจสอบคะแนนผู้เรียนที่ลงเรียนในรายวิชาที่ตน
สอนอยู่ได้ ตรวจสอบสถิติการใช้งานของผู้เรียนแต่ละรายวิชาได้ มีอ านาจในการก าหนดสิทธิในการ
ท างานภายในวิชาของผู้เรียน สามารถเขียน ค าประกาศ นัดหมายหรือมอบหมายพร้อมค าอธิบาย
เนื้อหาในแต่ละรายวิชา และสามารถแก้ไขข้อมูลได้ตลอดเวลานอกจากนี้ยังสามารถบรรจุเนื้อหาในแต่
ละรายวิชาและสามารถแก้ไขข้อมูลได้ตลอดเวลานอกจากนี้ยังสามารถบรรจุเนื้อหาของรายวิชาลง
ระบบได้โดยป้อนผ่านแบบฟอร์มของระบบหรืออาจท าการดาวน์โหลดไฟล์มาเพ่ิมเติม และสามารถ
รองรับสื่อประสมได้ 
 3.3 ผู้ดูแลระบบ มีฟังก์ชันการจัดการการใช้งานของผู้ใช้และในส่วนของการบริหารจัดการและ
การควบคุมระบบ ดังนี้  ก าหนดสถานะของผู้ใช้ เพ่ิม ลบ และแก้ไขข้อมูลของผู้ใช้ก าหนดขีด
ความสามารถการใช้งานของผู้ใช้ เปลี่ยนแปลงชื่อ และสัญลักษณ์บนเว็บไซต์ เรียกดูสถิติการเข้าใช้
งานของผู้ใช้ทั้งระบบได้และสามารถจัดการกับทุกรายวิชาที่อยู่บนระบบได้ 
 4. องค์ประกอบของโปรแกรม 
 ไพทูรย์ ศรีฟ้า (2544 : 3-8) กล่าวว่า โดยทั่วไปจะประกอบด้วย 5 ส่วนดังนี้ คือ 
 4.1 ระบบจัดการหลักสูตร (Course management) กลุ่มผู้ใช้งานแบ่งเป็น 3 ระดับคือ 
ผู้เรียนผู้สอนและผู้บริหารระบบ โดยสามารถเข้าสู่ระบบที่ไหนเวลาใดก็ได้โดยผ่านเครือข่าย
อินเทอร์เน็ต ระบบสามารถรองรับจ านวนผู้ใช้และจ านวนบทเรียนได้ไม่จ ากัดโดยขึ้นอยู่กับเครื่องและ
อุปกรณ์ (Hardware) และโปรแกรม (Software) ที่ใช้และระบบสามารถรองรับการใช้งานภาษาไทย 
อย่างเต็มรูปแบบ 
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 4.2 ระบบสร้างบทเรียน (Content management) ระบบประกอบด้วย เครื่องมือในการช่วย
สร้างเนื้อหา (Content) ระบบสามารถใช้งานได้ดีทั้งกับบทเรียนในรูปข้อความหรือตัวหนังสือ (text -
based) และบทเรียนในรูปแบบสื่อสายธาร (Streaming media)  
 4.3 ระบบการทดสอบและประเมินผล (test and evaluation system) มีระบบคลังข้อสอบ 
โดยเป็นระบบการสุ่มข้อสอบ สามารถจับเวลาการท าข้อสอบและการตรวจข้อสอบอัตโนมัติ พร้อม
เฉลย รายงานสถิติ คะแนนและสถิติการเข้าเรียนของนักเรียน 
 4.4 ระบบส่งเสริมการเรียน (Course tools) ประกอบด้วยเครื่องมือต่างๆ ที่ใช้สื่อสารระหว่าง
ผู้เรียน-ผู้สอน และผู้เรียน-ผู้เรียน ได้แก่ กระดานข่าว (Web board) และห้องสนทนา (Chat room) 
โดยสามารถเก็บประวัติหรือเรื่องคาว ของข้อมูลเหล่านี้ได้ 
 4.5 ระบบการจัดการข้อมูล (Data management system) ประกอบด้วยระบบจัดการไฟล์
และโฟลเดอร์ ผู้สอนมีเนื้อที่ เก็บข้อมูลบทเรียนเป็นของตนเองโดยได้เนื้อที่ตามที่ ผู้ดูแลระบบ 
(Administrator) ก าหนดให้ 
 5. ข้อดีของโปรแกรม   
 กิตติพันธ์ อุดมเศรษฐ์ (2547 : 5 ) กล่าวว่า ข้อดีของโปรแกรม Moodle 2 ด้านคือ 
 5.1 ด้านผู้เรียน 
 1. สามารถเข้ามาศึกษาบทเรียน ค้นหาความรู้และข้อมูลต่าง ๆ ด้วยตนเองได้ตลอดเวลาทุก
สถานที่ 
 2. สามารถเรียนได้ทุกที่ ทุกเวลา ที่มีระบบเครือข่ายอินเทอร์เน็ต 
 3. สามารถเลือกเรียนตามความยาก ง่าย ก่อน หลัง ได้ตามความถนัดของแต่ละบุคคล 
 4. หากมีข้อสงสัยในบทเรียน สามารถตั้งค าถามเพ่ือสอบถามครูผู้สอนได้ 
 5. สามารถถาม แสดงข้อคิดเห็น หรือนัดสนทนาระหว่างเพื่อนผ่านเครือข่ายอินเทอร์เน็ตได้ 
 6. สามารถท ากิจกรรมตามท่ีได้รับมอบหมาย เช่น ท าแบบฝึกหัด และส่งการบ้านได้ 
 5.2 ด้านผู้สอน 
 1. สามารถที่จะใช้เพ่ิมเนื้อที่บทเรียนในรูปแบบต่าง ๆ ลงไปในรายวิชาเช่น รูปภาพ พาวเวอร์
พ้อยท์ไฟล์เวิร์ด ไฟล์เสียง วีดิทัศน์ประกอบการเรียนการสอน เป็นต้น 
 2. สามารถสร้างแบบทดสอบแบบต่าง ๆ ได้เช่น แบบปรนัย อัตนัย เติมค าจับคู่ ค าถามแบบสุ่ม 
เป็นต้น 
 3. สามารถเช็กเวลาเข้าเรียนของนักเรียนที่ให้เข้ามาศึกษาเนื้อหาในเวลาที่ระบุได้ 
 4. สามารถประกาศข่าวสารต่าง ๆ และมอบหมายงานให้กับผู้เรียนแต่ละคนได้ 
 5. ช่วยลดเวลาที่ผู้สอนจะต้องจัดเตรียมเนื้อหา เพ่ือการน าเสนอ 
 6. สามารถสร้างหลักสูตร จัดเนื้อหาของหลักสูตร ประกาศต่าง ๆ ที่มอบหมาย แบบฝึกหัด
และแบบทดสอบ รวมทั้งสามารถเรียกออกมาแก้ไขภายหลังได้อย่างสะดวก 
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 7. สามารถใช้ประโยชน์จากระบบบันทึก ติดตาม และตรวจสอบ ประเมินผล การเรียนรู้ของ
ผู้เรียนได้ตลอดเวลา 
 8. สามารถตรวจความก้าวหน้าของผู้เรียนในแต่ละบทเรียนรวมทั้งเก็บรวบรวมและวิเคราะห์
คะแนนสอบของผู้เรียนแต่ละคน 
 9. มีระบบแบบทดสอบ และส่งการบ้าน สามารถตรวจการบ้านและให้คะแนนโดยอัตโนมัติ 
 10. สามารถเก็บงานทั้งหมดที่ท าไปเป็นไฟล์ .Zip แฟ้มเดียว สามารถน าไปติดตั้งเครื่องที่ไหนก็
ได้ โดยไม่ต้องเริ่มต้นใหม่ 
 11. สามารถออกใบประกาศได้เมื่อเรียนจบหลักสูตร 
 7. การจัดการเรียนรู้ด้วยโปรแกรม Moodle LMS 
 ขนิษฐา รุจโรจน์ (2546 : 18-22) กล่าวว่า การจัดการเรียนรู้ในรูปแบบ e-Learning เป็นการ
จัดการเรียนการสอน ผ่านระบบเครือข่ายแบบออนไลน์ ซึ่งมีข้ันตอนการด าเนินการดังต่อไปนึ้ 
 7.1 การออกแบบและจัดท าบทเรียน e-Learning ถือเป็นขั้นตอนที่ส าคัญที่สุด เรียกได้ว่าเป็น 
“หัวใจ” ของการเรียนการสอน เพราะบทเรียนที่มีคุณภาพสูงจะสามารถพัฒนาผู้เรียนให้เกิดการ
เรียนรู้ได้ดีเท่า ๆ กับหรือมากว่าการเรียนการสอนในชั้นเรียน ขั้นตอนนี้มีวิธีการด าเนินการดังนี้ 
 1. การออกแบบบทเรียน (Courseware) เริ่มจากการศึกษาวิเคราะห์หลักสูตรที่ใช้อยู่ในปัจจุบัน
ศึกษาสภาพความพร้อมของผู้เรียน เวลาที่ใช้ในการเรียน โอกาสในการเรียนของผู้เรียน จากนั้น
วิเคราะห์ผลการเรียนรู้ที่คาดหวัง คัดเลือกเนื้อหา ก าหนดเนื้อหาออกเป็นหน่วยการเรียนก าหนด
จุดประสงค์การเรียนรู้แต่ละหน่วย ออกแบบกิจกรรมการเรียนรู้แต่ละหน่วย สื่อการเรียนรู้และแหล่ง
เรียนรู้ที่ส าคัญและจ าเป็น ก าหนดวิธีการวัดและประเมินกิจกรรมของแต่ละหน่วยการเรียน 
 2. การจัดท าบทเรียน โดยการก าหนดกิจกรรมการเรียนรู้ในแต่ละหน่วยให้สอดคล้องกับ
จุดประสงค์การเรียนรู้ และเนื้อหาที่ก าหนดไว้ จัดท าสื่อการสอนในรูปแบบต่าง ๆ ที่เหมาะสมต่อการ
เรียนรู้และน่าสนใจ จัดสร้างเครื่องมือในการวัดและประเมินผลกิจกรรมหรือผลงานที่ก าหนดใน
บทเรียน ก าหนดเกณฑ์การวัดและการประเมินผลให้ชัดเจน เหมาะสม สอดคล้องกับเนื้อหา และ
กิจกรรม การใช้ข้อความ รูปภาพ หรือสัญลักษณ์ใด ๆ ในบทเรียน ต้องค านึงถึงความถูกต้อง สมบูรณ์
ละเอียดชัดเจนในตัวเอง เนื่องจาก e-Learning ถือเป็นการจัดการเรียนการสอนทางไกลที่ผู้เรียนและ
ผู้สอนอาจไม่มีโอกาสพบปะกัน ดังนั้นการจัดท าบทเรียนจึงต้องค านึงถึงคุณภาพให้มาก 
 3. การบรรจุบทเรียนลงในระบบ หลังจากที่จัดท าบทเรียนเสร็จเรียบร้อยแล้วน าบทเรียนมา
บรรจุลงในระบบ ซึ่งทางระบบส่งเสริมการเรียนรู้ได้จัดเตรียมไว้ให้พร้อมแล้ว หากมีรูปแบบข้อมูลทาง
อิเล็กทรอนิกส์แบบอ่ืนประกอบในบทเรียนด้วยก็จะต้องมีการใส่แฟ้มข้อมูลจากคอมพิวเตอร์ส่วน
บุคคล ไปยังเครื่องส่วนกลาง (Upload file) ดังกล่าวเข้าไปด้วย ซึ่งจะท าให้บทเรียนมีความน่าสนใจ
มากขึ้นและหลังจากท่ีได้บรรจุบทเรียนเข้าในระบบแล้ว ควรมีการทดสอบการใช้งานของบทเรียนโดย
การทดลองเข้าดูเนื้อหาหลาย ๆ ครั้ง เพ่ือให้เกิดความมั่นใจมากขึ้นว่าบทเรียนมีความสมบูรณ์พร้อม
แล้ว 
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 7.2 การจัดการเรียนเป็นขั้นตอนของการน าบทเรียนไปใช้ในการจัดการเรียนการสอน ดังนี้ 
 1. การน าเสนอบทเรียน เป็นการน าเสนอข้อมูลเบื้องต้นเกี่ยวกับบทเรียน หรือเรียกว่าเป็นส่วน
แนะน าบทเรียน โดยน าเสนอข้อมูลเกี่ยวกับ ค าอธิบายรายวิชา ผลการเรียนรู้ที่คาดหวัง รายวิชา 
จุดประสงค์ของแต่ละหน่วยการเรียนรู้ วิธีการเรียน เงื่อนไขการเรียน การนัดหมาย การส่งงาน ช่วง  
เวลาที่มีการทดสอบ เกณฑ์การวัดและประเมินผลกการเรียนรู้ ฯลฯ เพ่ือให้ผู้เรียนได้รู้จักและเข้าใจถึง
วิธีการใช้บทเรียน ท าให้การเข้าใช้บทเรียนมีประสิทธิภาพในการพัฒนาการเรียนรู้ของผู้เรียนมากขึ้น 
จากนั้นก็แนะน าให้ผู้เรียนสมัครเข้าเรียน 
 2. การรับสมัครและอนุมัติสิทธิ์ผู้เรียน หลังจากที่ผู้เรียนสมัครเข้าเรียน และเลือกรายวิชาที่
ต้องการเรียนแล้ว ผู้สอนจะท าการอนุมัติสิทธิ์ในการเรียนของผู้เรียนที่อยู่ในเงื่อนไข ตามที่ผู้สอน
ก าหนด นอกจากนี้ผู้สอนยังสามารถตัดสิทธิ์การเข้าเรียนของผู้เรียนออกจากรายวิชาได้ในกรณีที่
ผู้เรียนไม่ปฏิบัติตามเงื่อนไขที่ก าหนด 
 3. การติดต่อสื่อสาร ติดตามการเรียน ในระหว่างเรียน ผู้สอนอาจนัดหมายเวลาพบปะ เพ่ือให้
ผู้เรียนได้ปรึกษาปัญหา พบปะ พูดคุย แสดงความคิดเห็นต่อการเรียน หรือผู้สอนอาจใช้โอกาสนี้ชี้แจง
บทเรียน แนะน า ติดตาม ท าการสอน พิจารณางาน แก้ไขงาน รวมถึงตรวจผลงานของผู้เรียนได้ ใน
การเรียนการสอน e-Learning ผู้สอนควรก าหนดเงื่อนไขให้ผู้เรียนได้พบปะกับผู้สอนในช่องทางติดต่อ
อย่างใดอย่างหนึ่งอย่างน้อยสองสัปดาห์ต่อครั้ง เพื่อเป็นการติดตามงานและกระตุ้นไม่ให้ผู้เรียนละเลย
การท ากิจกรรมที่ก าหนด แต่ทั้งนี้ขึ้นอยู่กับลักษณะการเรียนแต่ละรายวิชา 
 4. การวัดและประเมินผลการเรียนรู้ เป็นส่วนส าคัญอีกส่วนหนึ่งของกระบวนการจัดการเรียนรู้ 
ซึ่งหลังจากที่ผู้เรียนศึกษาแล้ว จะต้องมีการประเมินการเรียนรู้ของผู้เรียนเพ่ือน าผลมาพิจารณาว่า 
ผู้เรียนเกิดกาเรียนรู้หรือไม่ มากน้อยอย่างไร การวัดผลการเรียนรู้สามารถกระท าได้ดังนี้ 
 4.1 การจัดท าแบบทดสอบ โดยการท าแบบทดสอบออนไลน์ ที่ครูผู้สอนจัดท าไว้ในระบบ ซึ่งมี
วิธีการให้ครูผู้สอนสามารถจัดท าได้ในหลาย ๆ ครั้ง หรือให้ท าเพียงครั้งเดียวก็ได้ และเมื่อท า
แบบทดสอบเสร็จสิ้น ทางระบบจะท าการประเมินผลการสอบให้ผู้เรียนทราบทันที หรืออาจปรับ
ระบบให้ผู้เรียนทราบในภายหลังก็ได้ 
 4.2 การประเมินผลการเรียนรู้ เป็นการประเมินการเรียนรู้ของผู้เรียนในด้านต่าง ๆ เช่น ด้าน
ความรู้ ความคิด ด้านทักษะ ด้านเจตคติ เป็นต้น โดยพิจารณาจากข้อมูลที่รวบรวมไว้ ทั้งจากผลงานที่
ผู้เรียนจัดท าและส่งให้ประเมินตามที่ผู้สอนก าหนด การท าแบบฝึกหัด แบบทดสอบ รวมถึงการ
พิจารณาการเข้าเรียน การส่งงาน ความรับผิดชอบ การมีปฏิสัมพันธ์กับผู้สอนหรือกับผู้เรียนคนอ่ืน ๆ 
หรือคุณลักษณะอ่ืน ๆ ตามที่ได้ก าหนดไว้ในบทเรียน ผู้สอนจะต้องรวบรวมข้อมูลต่าง ๆ เหล่านี้ เพ่ือ
ท าการประเมินการเรียนรู้เป็นรายบุคคล 
 4.3 การอนุมัติผลการเรียน หลังจากการประเมินผลการเรียนรู้ของผู้เรียนเรียบร้อยแล้วก็ท า
การแจ้งผลการประเมินการเรียนรู้ให้ผู้เรียนทราบตามระดับหรือเกณฑ์คุณภาพที่ก าหนดผู้เรียนที่ไม่
ผ่านการประเมิน อาจมีการซ่อมเสริมในบางเนื้อหา ผลการเรียนสามารถแจ้งไปยังผู้เรียนทราบได้
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โดยตรง เป็นลายลักษณ์อักษรทางไปรษณีย์ เพ่ือเป็นหลักฐานให้ผู้เรียนเก็บรวบรวมไว้ใช้ในการ
ประเมินอย่างอ่ืน ๆ ต่อไป การอนุมัติผลการเรียนจะกระท าในกรณีที่มีการจัดการเรียนการสอนตลอด
ทั้งรายวิชา ส าหรับรายวิชาที่มีการเรียนการสอนออนไลน์เป็นบางบทเรียน หรือบางเนื้ อหา อาจ
รวบรวมผลการเรียนรู้ที่ได้รวมกับผลการเรียนการสอนปกติก็ได้ ทั้งนี้ขึ้นอยู่กับนโยบายและเงื่อนไข
การจัดการเรียนรู้ e-Learning ของสถานศึกษาแต่ละแห่ง 
 

 2.5.3 AppServ 
 AppServ คือโปรแกรมที่รวบรวมเอา Open Source Software หลาย ๆ อย่างมารวมกันโดย
มีPackage หลัก คือ Apache PHP MySQL phpMyAdmin และ Moodle 
 โปรแกรมต่าง ๆ ที่น ามารวบรวมไว้ทั้งหมดนี้ ได้ท าการดาวน์โหลดจาก Official Release ทั้งสิ้น
โดยตัว AppServ จึงให้ความส าคัญว่าทุกสิ่งทุกอย่างจะต้องให้เหมือนกับต้นฉบับ เราจึงไม่ได้ตัดทอน
หรือเพ่ิมเติมอะไรที่แปลกไปกว่า Official Release แต่อย่างได้เพียงแต่มีบางส่วนเท่านั้นที่เราได้เพ่ิม
ประสิทธิภาพการติดตั้งให้สอดคล้องกับการท างานแต่ละคน โดยที่การเพ่ิมประสิทธิภาพนี้ไม่ได้ไปยุ่ง
ในส่วนของ Original Package เลยแม้แต่น้อยเพียงแต่เป็นการก าหนดค่า Config เท่านั้น เช่น Apache 
ก็จะเป็นในส่วนของ httpd.conf, PHP ก็จะเป็นในส่วนของ php.ini, MySQL ก็จะเป็นในส่วนของ 
my.iniดังนั้น เราจึงรับประกันได้ว่าโปรแกรม AppServ สามารถท างานและมีความเสถียรของระบบ
ได้เหมือนกับ Official Release ทั้งหมด  
 

2.6 ประสิทธิภาพของสื่อการเรียนการสอน 
 
 ในการหาประสิทธิภาพของสื่อการเรียนการสอนต้องค านึงถึงเกณฑ์การประเมิน ของ
กระบวนการและผลลัพธ์โดยมีผู้ก าหนดเป็นค่าตัวเลขไว้หลายท่านโดยการหาค่าทางการค านวณ 
 

 2.6.1 สูตรการหาประสิทธิภาพของสื่อการเรียนการสอน 
 ชัยยงค์ พรหมวงศ์ และคณะ (2521: 136) กล่าวถึงการหาประสิทธิภาพ โดยใช้สูตร E1 : E2  
 เมื่อ E1 เป็นประสิทธิภาพของกระบวนการ  
             E2 เป็นประสิทธิภาพของผลลัพธ์ 
 การคิดค่า E1 และ E2 ของชุดการสอนที่สร้างข้ึน ค านวณค่าทางสถิติโดยใช้สูตรต่อไปนี้ 
 

 สูตรที่ 1 
 

    [

∑ 
 
 
]      

 

 เมื่อ E1 แทน ประสิทธิภาพกระบวนการเป็นร้อยละ เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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            ∑  แทน คะแนนรวมของแบบฝึกหัดหรืองานที่ท าได้ 
            A   แทน คะแนนเต็มของแบบฝึกหัดทุกแบบฝึกหัดรวมกัน 
            N   แทน จ านวนผู้เรียน 
 

 สูตรที่ 2 

    [

∑ 
 
 
]      

 

 เมื่อ E2 แทน ประสิทธิภาพของผลลัพธ์เป็นร้อยละ 
            ∑  แทน คะแนนรวมของผลลัพธ์หลังเรียน 
             B  แทน คะแนนเต็มของการสอบหลังเรียน     
    N  แทน จ านวนผู้เรียน 
 

 2.6.2 ขั้นตอนการทดลองประสิทธิภาพของสื่อการเรียนการสอน 
 การทดลองประสิทธิภาพโดยใช้สูตรดังกล่าวข้างต้น ต้องด าเนินการเป็นขั้นตอนดังนี้ (ชัยยงค์ 
พรหมวงศ์ และคณะ. 2521 : 49 – 52) 
 1. ขั้น 1:1 (แบบเดียว) คือ ทดลองกับผู้เรียนที่ละคน โดยทดลองกับผู้เรียนก่อนน าผลที่ได้มา
ปรับปรุง น าชุดการสอนที่ปรับปรุงไปทดลองกับผู้เรียนปานกลาง น าผลที่ได้มาปรับปรุง แล้วจึงน าไป
ทดลองกับผู้เรียนที่เก่ง การพิจารณาปรับปรุงท าได้โดยการพิจารณาจากการสังเกตพฤติกรรมขณะ
เรียนของผู้เรียน แบบฝึกหัด ผลการสอบและการสัมภาษณ์นักเรียนถึงปัญหาที่เกิดขึ้นในการเรียน ใน
การเลือกผู้เรียนมาทดลองหากสภาพการณ์ไม่เหมาะสมก็ให้เลือดผู้เรียนอ่อนหรือปานกลางมาทดลอง 
ค่า E1 / E2 ในขั้นนี้โดยปกติแล้วจะต่ ากว่าเกณฑ ์ 
 2. ขั้น 1:10 (แบบกลุ่ม) คือการทดลองกับผู้เรียน 6-12 คน โดยเลือกผู้ที่เรียนอ่อน ปานกลาง 
และเก่ง คละกันน าผลที่ได้มาปรับปรุง โดยใช้การพิจารณาส่วนของชุดการสอนที่จะต้องปรับปรุงแบบ
เดียวกันในข้ัน 1:1 ในขั้นนี้ค่า E1 / E2 จะสูงขึ้นกว่าในขั้นแบบเดี่ยว  
 3. ขั้น 1:100 ( ภาคสนาม ) คือ ในขั้นนี้จะท าการทดลองกับผู้เรียนทั้งชั้น 30-40 คน ชั้นเรียน
ที่เลือกมาทดลองจะต้องเป็นชั้นเรียนที่มีผู้เรียนที่มีความสามารถคละกันไปทั้งเด็กอ่อน ปานกลาง และ
เก่ง ไม่ควรเลือกห้องเรียนที่มีผู้เรียนเก่งล้วนหรือผู้เรียนที่อ่อนล้วนน าผลที่ได้มาพิจารณาปรับปรุง เพ่ือ
น ามาใช้จริงในสภาพขั้นเรียนทั่วไป ในชั้นนี้ค่า E1 / E2 จะใกล้เคียงหรือเท่ากับเกณฑ์ หรือถ้าไม่ถึง
เกณฑ์ที่ตั้งไว้จะต้องปรับปรุงชุดการสอนและชุดท าการทดสอบหาประสิทธิภาพซ้ าอีก  ในกรณีที่
ประสิทธิภาพของชุดการสอนสร้างขึ้นไม่ถึงเกณฑ์ที่ตั้งไว้ เนื่องจากมีตัวแปรที่ควบคุมไม่ได้ เช่น สภาพ
ห้องเรียน ความพร้อมของผู้เรียน บทบาท และความช านาญในการใช้ชุดการสอนของครูเป็นต้น อาจ
อนุโลมให้มีระดับผิดพลาดได้ต่ ากว่าที่ก าหนดไว้ประมาณ 2.5% - 5%  
ประสิทธิภาพของชุดการสอนที่สร้างข้ึนอาจก าหนดไว้ 3 ระดับคือ 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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 1. สูงกว่าเกณฑ์ เมื่อประสิทธิภาพของชุดการสอนสูงกว่าเกณฑ์ที่ตั้งไว้ มีค่าเกิน 2.5 ขึ้นไป 
 2. เท่าเกณฑ์ เมื่อประสิทธิภาพของชุดการสอนเท่ากับเกณฑ์ ที่ตั้งไว้ แต่ไม่เกิน 2.5 
 3. ต่ ากว่าเกณฑ์ เมื่อประสิทธิภาพของชุดการสอนต่ ากว่าเกณฑ์ ที่ตั้งไว้ แต่ไม่ต่ ากว่า 2.5 ถือ
ว่ายังมีประสิทธิภาพที่ยอมรับได้ 
 การพัฒนาบทเรียนอีเลิร์นนิ่งของผู้วิจัยในครั้งนี้ใช้เกณฑ์ E1/E2 ไม่น้อยกว่า 80/80 เนื่องจาก
เป็นบทเรียนซึ่งเสนอเนื้อหาวิชา ในการสร้างบทเรียนนี้มุ่งให้ประโยชน์ในการสอนเนื้อหา ให้สามารถ
ศึกษาเนื้อหาได้ด้วยตนเอง 
 

 2.6.3 การหาประสิทธิภาพของบทเรียน 
 ขั้นตอนนี้เป็นการตรวจสอบคุณภาพของบทเรียนที่สร้างเสร็จแล้ว โดยใช้ผู้เชี่ยวชาญทางด้าน
เทคโนโลยีมัลติมีเดียเป็นผู้ตรวจสอบ การตรวจสอบคุณภาพมัลติมีเดียของบทเรียน จะต้องมีเกณฑ์ที่
เชื่อถือได้ทั้งนี้เพ่ือให้มีเกณฑ์ในการพิจารณาเป็นเกณฑ์เดียวกัน เกณฑ์ในการตรวจสอบคุณภาพ
มัลติมีเดียของบทเรียน โดยการตรวจสอบจากผู้เชี่ยวชาญทั้ง 2 ด้าน คือ การตรวจสอบโดย
ผู้เชี่ยวชาญด้านเนื้อหา และการตรวจสอบโดยผู้เชี่ยวชาญด้านเทคโนโลยีมัลติมีเดีย ตามแนวคิดของ
ไพโรจน์ ตีรณธนากุล และคณะ (2546 : 197-204) 
 1. การตรวจสอบโดยผู้เชี่ยวชาญด้านเนื้อหา ได้แบ่งเกณฑ์ออกเป็น 3 ส่วน คือ 
 1.1 เกณฑ์ตรวจสอบเนื้อหา 
 1.1.1  ความถูกต้องของการน าเสนอเนื้อหาบทหน้าจอ 
  - ตรวจสอบเนื้อหาสาระบนหน้าจอถูกต้องตามกรอบการสอนที่ออกแบบไว้ 
  - มีวิธีการล าดับการน าเสนอเนื้อหาสาระบนหน้าจอเหมาะสมกับการเรียนรู้ 
 1.1.2  ความถูกต้องของเนื้อหาที่น าเสนอโดยสื่อที่เหมาะสม 
  - ความถูกต้องตามเนื้อหาของสื่อกราฟิก 
  - ความถูกต้องตามเนื้อหาของสื่อภาพนิ่ง 
  - ความถูกต้องตามเนื้อหาของสื่อเสียง 
  - ความถูกต้องตามเนื้อหาของสื่อภาพเคลื่อนไหว 
  - ความถูกต้องตามเนื้อหาของสื่อวีดิทัศน์ 
 1.1.3  ความถูกต้องของวิธีการปรากฏสื่อ 
  - วิธีการปรากฏสื่อกราฟิกบนหน้าจอถูกต้องเหมาะสม 
  - วิธีการปรากฏสื่อภาพนิ่งบนหน้าจอถูกต้องเหมาะสม 
  - วิธีการน าเสนอสื่อเสียงบนหน้าจอถูกต้องเหมาะสม 
  - วิธีการปรากฏสื่อภาพเคลื่อนไหวบนหน้าจอถูกต้องเหมาะสม 
  - วิธีการปรากฏสื่อวีดิทัศน์บนหน้าจอถูกต้องเหมาะสม 
 1.2 เกณฑ์ตรวจสอบการปฏิสัมพันธ์ 
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 1.2.1  การปฏิสัมพันธ์ในบทเรียน 
  - การปฏิสัมพันธ์บนหน้าจอถูกต้องตามกรอบการสอน 
  - วิธีการน าเสนอปฏิสัมพันธ์เหมาะสมกับเนื้อหาสาระ 
  - มีการให้ผลย้อนกลับอย่างเหมาะสมทันทีทันใด 
 1.2.2  การปฏิสัมพันธ์ในแบบฝึกปัด 
  - การปฏิสัมพันธ์บนหน้าจอถูกต้องตามกราอบการสอน 
  - มีการให้ผลย้อนกลับอย่างเหมาะสมทันทีทันใด 
  - วิธีการน าเสนอการย้อนกลับสร้างการเรียนรู้เพิ่มข้ึน หรือสร้างความเข้าใจให้มากขึ้น 
  - วิธีการให้ผลย้อนกลับสื่อความหมายได้ชัดเจน 
 1.2.3  การปฏิสัมพันธ์ในแบบทดสอบ 
  - การปฏิสัมพันธ์บนหน้าจอถูกต้องตามกรอบการสอน 
  - มีวิธีการแจ้งผลการทดสอบที่เหมาะสมและสื่อความหมายชัดเจน 
 1.3 เกณฑ์ตรวจสอบโครงสร้างของบทเรียน 
  - โครงสร้างของบทเรียนเป็นไปตามที่ออกแบบไว้ 
  - วิธีการเข้าถึงเนื้อหาง่ายและสะดวก 
  - การเชื่อมโยงเนื้อหาเหมาะสม เข้าใจง่าย 
  - ความสมบูรณ์ของการเชื่อมโยง และการเปลี่ยนแปลงหน้าจอเหมาะสมกับการเรียน 
  - การออกจากโปรแกรมสะดวก 
 2. การตรวจสอบโดยผู้เชี่ยวชาญด้านเทคโนโลยีมัลติเดีย ได้แบ่งเกณฑ์ออกเป็น 3 ส่วนคือ 
 2.1 เกณฑ์พิจารณาการน าเสนอมัลติมีเดีย 
 2.1.1  องค์ประกอบของหน้าจอ  
  - องค์ประกอบในการจัดแบ่งหน้าจอ ได้แก่ ส่วนหัว ส่วนเสนอเนื้อหา และส่วนควบคุม
หน้าจอ 
  - องค์ประกอบในการจัดวางต าแหน่งต่าง ๆ บนหน้าจอ เช่น ตัวอักษร ภาพ เป็นต้น 
 2.1.2  พ้ืนหลัง 
  - สีของพ้ืนหลังเหมาะสมไม่รบกวนการมอง หรือการอ่านเนื้อหาสาระ 
  - สีของพ้ืนหลังเหมาะสมไม่ท าลายสายตา 
  - พ้ืนหลังเหมาะสมกับกราฟิก ภาพประกอบ ภาพเคลื่อนไหว และวีดิทัศน์ 
  - สีของพ้ืนหลงเหมาะสมกับเนื้อหาที่น าเสนอ 
 2.1.3  ตัวอักษร 
  - ขนาดของหัวข้อแต่ละระดับเหมาะสม 
  - รูปแบบและขนาดของตัวอักษรที่น าเสนอเนื้อหาสาระ 
  - สีสันเหมาะสม 
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  - การอ่านง่าย เหมาะสมกับกลุ่มเป้าหมาย 
  - การพิมพ์อักขระถูกต้อง 
 2.1.4  ปุ่มต่าง ๆ 
  - ขนาดของปุ่มมีความเหมาะสม 
  - ต าแหน่งที่วางปุ่มมีความเหมาะสม 
  - ความคงที่ของปุ่ม (ไม่เปลี่ยนต าแหน่งจนสับสน) 
  - การสื่อความหมายชัดเจน เข้าใจ ใช้ง่าย 
 2.1.5  การเปลี่ยนหน้าจอ 
  - การปรับเปลี่ยนหน้าจอต่อเนื่องเหมาะสม 
  - การปรับเปลี่ยนหน้าจอคงที่ไม่กระโดด หรือไม่เปลี่ยนรูปแบบมากเกินไป 
  - การเปลี่ยนหน้าจอไม่ท าให้สับสน 
  - เวลาที่ใช้ในการเปลี่ยนหน้าจอเหมาะสม 
 2.1.6  เสียง 
  - เสียงบรรยายชัดเจนหลักการอ่านถูกต้อง และสื่อความหมายหรือได้อารมณ์ตาม
เนื้อหาสาระ 
  - จ านวนเสียงบรรยายเหมาะสม / เพียงพอ 
  - เสียงดนตรีเหมาะสม 
  - เสียงประกอบเหมาะสม 
 2.1.7  ภาพประกอบ 
  - ขนาดของภาพมีความเหมาะสม (ขนาดใหญ่ – เล็ก) 
  - การสื่อความหมายของภาพเหมาะสม 
  - ความชัดเจนของภาพ 
 2.1.8  ภาพเคลื่อนไหว 
  - ความยาว เวลาที่ใช้เหมาะสม 
  - ขนาดของภาพเหมาะสม (ขนาดใหญ่ – เล็ก) 
  - การให้สีเหมาะสมง่ายต่อการมองและมีความชัดเจน 
  - การสื่อความหมายเหมาะสม 
  - ความสวยงาม 
 2.1.9  วีดิทัศน์ 
  - ความยาว เวลาที่ใช้เหมาะสม 
  - ขนาดของภาพเหมาะสม (ขนาดใหญ่ – เล็ก) 
  - ความชัดเจน 
  - การสื่อความหมายเหมาะสม 
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 2.2 เกณฑ์ตรวจสอบการปฏิสัมพันธ์ 
 2.2.1  การปฏิสัมพันธ์ในบทเรียน 
  - มีการแจ้งให้ผู้เรียนทราบถึงปฏิสัมพันธ์ที่ชัดเจน และมีรูปแบบที่แน่นอน 
  - วิธีการน าเสนอปฏิสัมพันธ์เหมาะสม 
  - สื่อที่ใช้แสดงการปฏิสัมพันธ์เหมาะสม 
  - เวลาที่ใช้แสดงการปฏิสัมพันธ์เหมาะสม 
  - มีการให้ผลย้อนกลับอย่างเหมาะสมทันทีทันใด 
 2.2.2  การปฏิสัมพันธ์ในแบบฝึกหัด 
  - มีการให้ผลย้อนกลับอย่างเหมาะสมทันทีทันใด 
  - วิธีการให้ผลย้อนกลับสื่อความหมายได้ชัดเจน 
  - สื่อที่ใช้ในการให้ผลย้อนกลับเหมาะสม 
  - เวลาที่ใช้แสดงการปฏิสัมพันธ์เหมาะสม 
 2.2.3  การปฏิสัมพันธ์ในแบบทดสอบ 
  - มีวิธีการแจ้งผลการทดสอบที่เหมาะสม และสื่อความหมายชัดเจน 
  - สื่อที่ใช้ในการให้ผลย้อนกลับเหมาะสม 
  - เวลาที่ใช้แสดงการปฏิสัมพันธ์เหมาะสมโครงสร้างบทเรียน 
  - การเข้าถึงเนื้อหาง่าย 
  - ความสมบูรณ์องการเชื่อมโยง และการเปลี่ยนหน้าจอ 
  - การออกจากโปรแกรมสะดวก 
  - การให้โอกาสเลือกเรียนต่อจากครั้งก่อนได้ 
 2.3 โครงสร้างบทเรียน 
  - การเข้าถึงเนื้อหาง่าย 
  - ความสมบูรณ์ของการเชื่อมโยงและการเปลี่ยนหน้าจอ 
  - การออกจากโปรแกรมสะดวก 
  - การให้โอกาสเลือกเรียนต่อจากครั้งก่อนได้ 
 ส าหรับการประเมินคุณภาพบทเรียนนี้ มีข้นตอนที่จะต้องด าเนินการโดยการน าบทเรียนที่
พัฒนาเสร็จแล้ว พร้อมแบบสอบถามประเมินคุณภาพของบทเรียนที่เป็นปลายเปิดให้ผู้เชี่ยวชาญทั้ง 2 
ด้านท าการตรวจสอบ หากในการตรวจสอบคุณภาพมีการแก้ไขสิ่ งใด ผู้เชี่ยวชาญก็จะระบุลงไปใน
แบบสอบถามนั้น 
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2.7 การวัดผลสัมฤทธิ์ทางการเรียน 
 
 ในการวิจัยครั้งนี้  ผู้วิจัยได้ใช้แบบทดสอบชนิดเลือกตอบ 4 ตัวเลือกเป็นเครื่องมือวัด   
ประสิทธิภาพทางการเรียน ทางด้านพุทธพิสัย (Cognitive Domain) ในด้านความรู้ความจ า ความ
เข้าใจ และการน าไปใช้งาน ตามแนวคิดของภพ เลาหไพบูลย์ (2537 : 161 -165) ซึ่งได้แบ่ง
จุดประสงค์ทางด้านพุทธิพิสัยออกไว้เป็น 6 ระดับคือ 
 1. ความรู้ความจ า  (Knowledge) หมายถึง การที่ผู้เรียนสามารถระลึกข้อความรู้ต่างๆ ที่ครู
สอนหรือข้อความรู้ที่ตนได้ศึกษามาด้วยวิธีการต่างๆไว้ได้เช่นนักเรียนสามารถนึกถึงพยัญชนะได้ครบ 
ทั้ง 44 ตัว สามารถท่ีจะบอกได้ว่าพยัญชนะตัวใดเป็นอักษรกลาง อักษรสูง หรืออักษรต่ า 
 2. ความเข้าใจ (Comprehension) หมายถึง ความสามารถของผู้เรียนที่จะอธิบาย ขยาย
ความหรือเขียนเรื่องราวใด ๆ ที่ตนได้รับรู้มาโดยการใช้ถ้อยค า ส านวนภาษาของตนเอง และ
หมายความรวมไปถึงความสามารถในการที่แปลความหมาย ตีความหมายหรือขยายความหมายข้อมูล 
จากส านวนสุภาษิต แผนที่ กราฟ หรือตารางต่าง ๆ ตัวอย่างของพฤติกรรมความเข้าใจเช่น แปล
ตัวเลขในตารางเวลารถเข้าออก ในสถานีรถประจ าทาง การอ่านแผนที่ การอธิบายความหมายของ
ส านวน ภาษาสุภาษิต 
 3. การน าไปใช้ (Application) ได้แก่ ความสามารถของผู้เรียนในการที่จะน าความรู้ ความ
เข้าใจที่ตนมีไปใช้ในสถานการณ์ที่แตกต่างไปจากเดิมได้ เช่น ครูสอนวิธีการบวกเลขในชั้นเรียนแล้ว
นักเรียนสามารถคิดทอนเงินเมื่อทางบ้านใช้ให้ไปซื้อของที่ร้านค้าได้หรือหลังจากที่นักเรียนเรียนรู้
ประโยชน์ของปุ๋ยประเภทต่าง ๆ แล้ว สามารถเลือกปุ๋ยเพ่ือใช้ในการปลูกผักท่ีบ้านของตนได้ถูกต้อง 
 4. การวิเคราะห์ (Analysis) ได้แก่ ความสามารถของนักเรียนในการที่จะใช้สมองขบคิดหา
เหตุผล หาหลักการ หาสาเหตุ หรือความเป็นไปของเรื่องใดเรื่องหนึ่ง เช่น นักเรียนที่ปลูกผัก 
สังเกตเห็นว่าผักที่ตนปลูกไว้ไม่งอกงาม ถ้านักเรียนใช้ความสามารถโดยล าพังของตนเองค้นหาสาเหตุ
ที่ท าให้ผักของตนไม่งาม   เช่น เพราะไม่รดน้ า ดินไม่ดี แดดส่องไม่ถึง อุณหภูมิไม่เหมาะ หรือปุ๋ยไม่
เพียงพอ โดยการคิดหาสาเหตุดังกล่าวนี้ นักเรียนกระท าด้วยตนเอง ไม่ได้อาศัยค าบอกเล่าของครูแต่
ประการใด ลักษณะการใช้สมองดังกล่าวนี้ถือเป็นการวิเคราะห์ 
 5. การสังเคราะห์ (Synthesis) ได้แก่ ความสามารถของผู้เรียนในการที่จะใช้สมองคิดสร้าง
สิ่งใหม่ขึ้นมา โดยอาศัยความสามารถของตนเอง เช่น การที่นักเรียนเขียนเรียงความโดยไม่ได้คัดลอก
มาจากบทความของใครหรือการออกแบบของใช้ใหม่ ๆ โดยใช้ความคิดของตนเอง การสังเคราะห์ยังมี
ความหมายรวมไปถึง ความสามารถในการวางแผนการท างานล่วงหน้าเช่น การที่นักเรียนสามารถวาง
แผนการจัดกิจกรรมวันเด็กในหมู่ของพวกเขากันเอง โดยครูไม่ต้องเข้าไปก ากับหรือไปสั่งการได้ 
 6. การประเมินค่า (Evaluation) ได้แก่ การที่ผู้เรียนพิจารณาสิ่งใดสิ่งหนึ่งในลักษณะที่
เพ่งเล็ง ว่าสิ่งนั้นมีคุณค่า ดี-เลว-ถูก-ไม่ถูก-ควร-ไม่ควร โดยมีเหตุผลประกอบ เช่น สมมติว่ามีเงินอยู่ใน
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มือ 10 บาท จะต้องมาคิดพิจารณาตัดสินใจด้วยตนเองว่าเงินดังกล่าวนั้นจะใช้จ่ายอย่างไร เช่น 
ตัดสินใจซื้อของเล่น ซื้อขนมรับประทาน หรือซื้อหนังสือที่ตนสนใจมาอ่าน 
 จากแนวความคิดของภพ เลาหไพบูลย์ สรุปได้ว่า ประสิทธิภาพของผลลัพธ์ทางการเรียน ด้าน
พุทธิพิสัย แบ่งจุดประสงค์ออกเป็น 6 ระดับ ในการวิจัยครั้งนี้ผู้วิจัยได้สร้างแบบทดสอบวัด
ประสิทธิภาพของผลลัพธ์ ในวิชาการพัฒนาเว็บเพจขั้นสูง ทางด้านพุทธิพิสัย 3 ระดับคือ ด้านรู้
ความจ า ความเข้าใจ และการน าความรู้ไปประยุกต์ใช้ 
 

2.8 งานวิจัยที่เกี่ยวข้อง 
 

 2.8.1 งานวิจัยในประเทศ 
 วรัญญา มีฮะ (2553 : บทคัดย่อ) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนอิเล็กทรอนิกส์ (e-learning) 
เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ ชั้นมัธยมศึกษาปีที่ 3 มีจุดประสงค์เพ่ือสร้างบทเรียน
อิเล็กทรอนิกส์ (e-learning) เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ ของนักเรียนชั้น
มัธยมศึกษาปีที่ 3 ให้มีประสิทธิภาพตามเกณฑ์มาตรฐาน 90/90 มีการเปรียบเทียบผลสัมฤทธิ์ทางการ
เรียน เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ ของนักเรียนชั้นมัธยมศึกษาปีที่ 3 ระหว่างการ
เรียนด้วยบทเรียนอิเล็กทรอนิกส์ (e-learning) กับการเรียนปกติ และศึกษาความพอใจในการเรียนรู้
ด้วยบทเรียนอิเล็กทรอนิกส์ (e-learning) ผลการวิจัยพบว่า บทเรียนอิเล็กทรอนิกส์ (e-learning) 
เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ มีคุณภาพอยู่ในระดับดีมาก และมีประสิทธิภาพ 
94.67/90.00 และผลสัมฤทธิ์ทางการเรียน เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ แตกต่าง
กันอย่างมีนัยส าคัญทางสถิติระดับ 0.05 โดยผลสัมฤทธิ์ของนักเรยนที่เรียนด้วยบทเรียนอิเล็กทรอนิกส์ 
(e-learning) สูงกว่านักเรียนที่เรียนแบบปกติ ความพึงพอใจของนักเรียนที่เรียนโดยใช้บทเรียน
อิเล็กทรอนิกส์ (e-learning) อยู่ในระดับมาก ซึ่งมีค่าเฉลี่ยเท่ากับ 4.49 
 สุบิน ยมบ้านกวย (2550 : 134 – 137) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียน e-Learning แบบ
ปฏิสัมพันธ์ เรื่อง ความน่าจะเป็นส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 มีจุดประสงค์เพ่ือพัฒนา
บทเรียน e-Learning แบบมีปฏิสัมพันธ์ ตามเกณฑ์ 80/80 และเปรียบเทียบผลสัมฤทธิ์ทางการเรียน
ที่ก าหนด (ร้อยละ 65) และผลสัมฤทธิ์ทางการเรียนก่อนและหลังการเรียนโดยใช้บทเรียนe-Learning
แบบปฏิสัมพันธ์ เรื่องความน่าจะเป็น ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 และศึกษาความพึงพอใจ
ของผู้เรียนที่มีต่อบทเรียน e-Learning แบบปฏิสัมพันธ์ ผลการวิจัยพบว่า บทเรียน e-Learning แบบ
ปฏิสัมพันธ์ เรื่อง ความน่าจะเป็นส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 มีประสิทธิภาพสูงกว่าเกณฑ์ 
80/80 โดยมีประสิทธิภาพ 84.95/86.68 ผลสัมฤทธิ์ทางการเรียนของนักเรียนชั้นมัธยมศึกษาปีที่ 3 
ภายหลังการเรียนด้วยบทเรียน e-Learning แบบปฏิสัมพันธ์ ผ่านเกณฑ์ร้อยละ 65 และสูงขึ้นไป
อย่างมีนัยส าคัญทางสถิติที่ระดับ .01 และนักเรียนมีความพึงพอใจโดยรวมในระดับมาก ต่อการเรียน
ด้วยบทเรียน e-Learning แบบปฏิสัมพันธ์ เรื่องความน่าจะเป็น 
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 ประสิทธิ์ คลังบุญครอง (2550 : บทคัดย่อ)  ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนคอมพิวเตอร์
แบบมัลติมีเดียกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี เรื่องความรู้เบื้องต้นเกี่ยวกับ
เทคโนโลยีสารสนเทศ ส าหรับชั้นประถมศึกษาปีที่ 6 ผลการวิจัยพบว่า  ประสิทธิภาพของบทเรียน
คอมพิวเตอร์ช่วยสอนที่ผู้วิจัยพัฒนาขึ้นมีค่าเท่ากับ 80.32/81.28 ซึ่งแสดงว่ามีประสิทธิภาพตาม
เกณฑ์ที่ก าหนด ความพึงพอใจของนักเรียนที่มีต่อบทเรียนคอมพิวเตอร์ช่วยสอนที่ผู้วิจัยพัฒนาขึ้น
โดยรวม อยู่ในระดับดีมาก 
 จิระพร ศิริมา (2554 : 52-54) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือการทบทวน วิชาคอมพิวเตอร์ เรื่อง การสร้างงานฐานข้อมูลเบื้องต้นด้วยโปรแกรมไมโครซอฟต์
แอคเซส ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ผลการวิจัยพบว่า บทเรียนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือการทบทวน มีคุณภาพเนื้อหาในระดับดีมาก ( = 3.93) และคุณภาพด้านเทคนิคการผลิตสื่ออยู่ใน
ระดับดีมาก ( X = 3.91) ซึ่งเป็นไปตามสมมติฐานที่ตั้งไว้ มีประสิทธิภาพของบทเรียนผ่านเครือข่าย
อินเทอร์เน็ตเพ่ือการทบทวนเท่ากับ 82.00/85.00 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนด 80/80 และ
สอดคล้องกับสมมติฐานที่ตั้งไว้ และผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือการทบทวนหลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 ภัคจิรา รอดพ้น (2553 : 88-92) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนอีเลิร์นนิงที่มีฐานความ
ช่วยเหลือทางการเรียนเรื่องประวัติศาสตร์สุโขทัย ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 1 โดยมี
วัตถุประสงค์เพ่ือ พัฒนาบทเรียนอีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียนเรื่อง ประวัติศาสตร์
สุโขทัย ให้มีประสิทธิภาพตามเกณฑ์ 80/80 และเปรียบเทียบผลการเรียนรู้ ก่อนและหลังการใช้
บทเรียนอีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียน เรื่อง ประวัติศาสตร์สุโขทัยส าหรับนักเรียนชั้น
มัธยมศึกษาปีที่ 1 และศึกษาความคิดเห็นของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ที่มีต่อการจัดการเรียน
การสอนโดยใช้บทเรียนอีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียน ซึ่งผลการวิจัยพบว่า บทเรียนอี
เลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียน มีประสิทธิภาพเท่ากับ 80.87/80.99 เป็นไปตามเกณฑ์ที่
ก าหนด 80/80 และผลการเรียนรู้ของนักเรียนที่เรียนด้วยบทเรียนอีเลิร์นนิงมีฐานความช่วยเหลือ
ทางการเรียนเรื่อง ประวัติศาสตร์สุโขทัย หลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ 
.05 และนักเรียนมีความคิดเห็นต่อบทเรียนอีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียน ในภาพรวม
อยู่ในระดับมาก 
 นพดล อินทร์จันทร์ (2553 : 82-86) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนอิเล็กทรอนิกส์ รายวิชา
เครื่องแต่งกายกับงานภาพยนตร์ การวิจัยมีความมุ่งหมายเพ่ือจัดท าสื่อบทเรียนอิเล็กทรอนิกส์ 
(e-learning) รายวิชาเครื่องแต่งกายกับงานภาพยนตร์ ให้มีประสิทธิภาพตามเกณฑ์ 80/80 และเพ่ือ
การศึกษาผลสัมฤทธิ์ทางการเรียนของนิสิตวิทยาลัยนวัตกรรมสื่อสารสังคมเพ่ือเรียนสื่อบทเรียน
อิเล็กทรอนิกส์ (e-learning) รายวิชาเครื่องแต่งกายกับงานภาพยนตร์ และเพ่ือศึกษาความพีงพอใจ
ของนิสิต วิทยาลัยนวตกรรมสื่อสารสังคม มหาวิทยาลัยศรีนครินทรวิโรฒ ที่มีต่อการใช้สื่อบทเรียน
อิเล็กทรอนิกส์ (e-learning) รายวิชาเครื่องแต่งกายกับงานภาพยนตร์ ซึ่งผลการวิจัยสรุปว่า บทเรียน
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มีประสิทธิภาพเฉลี่ยเท่ากับ 87.25/90.25 ซึ่งสูงกว่าเกณฑ์มาตรฐานที่ก าหนด และเป็นไปตามสมมติ 
ฐานที่ตั้งไว้ และผลสัมฤทธิ์ทางการเรียนของนักเรียนนิสิตวิทยาลัยนวัตกรรมสื่อสารสังคมที่เรียน
บทเรียน การพัฒนาบทเรียนอิเล็กทรอนิกส์ รายวิชาเรื่องแต่งกายกับงานภาพยนตร์ หลังการเรียนมี
ระดับคะแนนเฉลี่ยสูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .01 และระดับความพึงพอใจของ
นิสิตวิทยาลัยนวัตกรรมสื่อสารสังคมที่มีการต่อการเรียนสื่อบทเรียนอิเล็กทรอนิกส์ รายวิชาเครื่องแต่ง
กายกับงานภาพยนตร์ อยู่ในเกณฑ์ระดับมาก 
 ศิริชัย นามบุรี (2550 : บทคัดย่อ) ได้ท าวิจัยเรื่อง การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนและ
ความพีงพอใจของผู้เรียนโดยใช้กิจกรรมหนังสืออิเล็กทรอนิกส์และบทเรียนส าเร็จรูปอิเล็กทรอนิกส์ใน
ภาพแวดล้อมแบบอีเลิร์นนิ่งผ่านโปรแกรม Moodle ผลการวิจัยพบว่า ประสิทธิภาพของบทเรียนอี
เลิร์นนิ่ง ทั้งรูปแบบหนังสืออิเล็กทรอนิกส์และบทเรียนส าเร็จรูปอิเล็กทรอนิกส์ เนื้อหาทั้ง 2 เรื่อง 
ต่ ากว่าเกณฑ์มาตรฐานที่ก าหนดไว้ คือร้อยละ 80 และผลสัมฤทธิ์ทางการเรียนเฉลี่ยของบทเรียน
หนังสืออิเล็กทรอนิกส์และบทเรียนส าเร็จรูปอิเล็กทรอนิกส์มีคะแนนสูงกว่าก่อนเรียนทุกเรื่อง ซึ่ง
แตกต่างกันอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 และผลสัมฤทธิ์ทางการเรียนหลังเรียนเฉลี่ยของกลุ่ม
ที่เรียนด้วยหนังสืออิเล็กทรอนิกส์สูงกว่ากลุ่มที่เรียนด้วยบทเรียนส าเร็จรูปอิเล็กทรอนิกส์ซึ่งแตกต่าง
กันอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 ระดับความพึงพอใจของผู้เรียนกลุ่มที่เรียนด้วยหนังสือ
อิเล็กทรอนิกส์สูงกว่ากลุ่มที่เรียนด้วยบทเรียนส าเร็จรูปอิเล็กทรอนิกส์เล็กน้อยและแตกต่างกันอย่างมี
นัยส าคัญทางสถิติที่ระดับ .05 โดยความพึงพอใจเฉลี่ยของผู้เรียนทั้งสองกลุ่มอยู่ในระดับมาก 
 กิตติยา ปลอดแก้ว (2551 : บทคัดย่อ) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนบนเว็บตามแนวทฤษฏี
การเรียนรู้เพ่ือสร้างสรรค์ด้วยปัญญา เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ ส าหรับนักเรียนชั้นมัธยม 
ศึกษาปีที่ 1 มีวัตถุประสงค์เพ่ือสร้างและหาประสิทธิภาพของบทเรียนบนเว็บตามแนวทฤษฏีการเรียนรู้
เพ่ือสร้างสรรค์ด้วยปัญญา เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ และเพ่ือศึกษาผลสัมฤทธิ์ทางการ
เรียนของนักเรียนชั้นมัธยมศึกษาปีที่ 1 หลังการเรียนจากบทเรียนบนเว็บตามแนวทฤษฏีการเรียนรู้
เพ่ือสร้างสรรค์ด้วยปัญญา เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ และศึกษาความคิดเห็นของนักเรียน
ชั้นมัธยมศึกษาปีที่ 1 หลังกการเรียนจากบทเรียนบนเว็บตามแนวทฤษฏีการเรียนรู้  เพ่ือสร้างสรรค์
ด้วยปัญญา เรื่องการสร้างหนังสืออิเล็กทรอนิกส์ ผลการวิจัยพบว่า  บทเรียนบนเว็บตามแนวทฤษฏี
การเรียนรู้ เ พ่ือสร้างสรรค์ด้วยปัญญา เรื่อง การสร้างหนังสืออิเล็กทรอนิกส์ มีประสิทธิภาพ 
85.45/84.85 ซึ่งสูงกว่าเกณฑ์ที่ก าหนดไว้ คือ 80/80 และผลสัมฤทธิ์ทางการเรียนของนักเรียนหลัง
การเรียนจากบทเรียนบนเว็บตามแนวทฤษฏีการเรียนรู้เพ่ือสร้างสรรค์ด้วยปัญญาเรื่อง การสร้าง
หนังสืออิเล็กทรอนิกส์ สูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ.05 และความคิดเห็นของ
นักเรียนที่มีต่อบทเรียนนบนเว็บอยู่ในระดับดี 
 ธนพงศ์ จันทร์สุข (2557 : บทคัดย่อ) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือบททวน เรื่องตัวแปรและค่าคงที่พัฒนา เพ่ือหาคุณภาพ และประสิทธิภาพของบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ตเพ่ือทบทวน เรื่องตัวแปรและค่าคงคงที่ วิชาการพัฒนาเว็บเพจขั้นสูง และเพ่ือ
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เปรียบเทียบผลสัมฤทธิ์ทางการเรียนก่อนเรียนและหลังเรียน ด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือทบทวน เรื่องตัวแปรและค่าคงที่ กลุ่มตัวอย่างที่ใช้ในการวิจัย คือ นักศึกษาระดับประกาศนียบัตร
วิชาชีพชั้นสูง ชั้นปีที่ 2 ซึ่งลงทะเบียนเรียนในภาคเรียนที่ 2 ปีการศึกษา 2556 วิทยาลัยอาชีวศึกษา
สระบุรี 1 ห้องเรียน จ านวน 30 คน โดยใช้วิธีสุ่มตัวอย่างแบบแบ่งกลุ่ม เครื่องมือที่ใช้ในการวิจัย คือ 
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือทบทวน เรื่องตัวแปรและค่าคงที่ แบบประเมินคุณภาพของ
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพื่อทบทวน และแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนมีค่าความ
ยากง่ายอยู่ระหว่าง 0.67–1.00 ค่าอ านาจจ าแนกอยู่ระหว่าง 0.25–0.79 และค่าความเชื่อมั่นเท่ากับ 
0.84 วิเคราะห์ข้อมูลโดยใช้สถิติค่าเฉลี่ย ส่วนเบี่ยงเบนมาตรฐาน และการทดสอบ t-test แบบ 
department sample  ผลวิจัยพบว่า บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือทบทวน เรื่องตัวแปร
และค่าคงที่ มีคุณภาพด้านเนื้อหาอยู่ในระดับดีมาก ( X = 4.59) และด้านเทคนิคการผลิตสื่ออยู่ใน
ระดับดีมาก ( X = 4.68) 2) บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือทบทวน เรื่องตัวแปรและค่างคงที่ 
มีประสิทธิภาพ 83.00/89.60 และผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือ
ทบทวน เรื่องตัวแปรและค่าคงคงท่ี หลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติท่ีระดับ .05 
 

 2.8.2 งานวิจัยต่างประเทศ 
 Tauro (1981 : 643-A) ได้ท าการวิจัยเกี่ยวกับผลสัมฤทธิ์ทางการเรียนวิชาเคมี และเจตคติวิชา
เคมี ของนักศึกษาทั้งหมดที่เรียนวิชาเคมี 127 มหาวิทยาลัยคอนเนคติกัท ในสหรัฐอเมริกา โดยแบ่ง 
กลุ่มตัวอย่างออกเป็น 2 กลุ่มเท่า ๆ กัน กลุ่มแรกเรียนโดยใช้คอมพิวเตอร์ช่วยสอน กลุ่มที่ 2 เป็นกลุ่ม
ที่มีการเรียนการสอนปกติ ผลการวิจัยพบว่า นักศึกษากลุ่มที่ใช้คอมพิวเตอร์ช่วยสอนมีผลสัมฤทธิ์
ทางการเรียน และมีเจตคติต่อวิชาเคมีในเชิงบวกสูงกว่านักเรียนที่มีการเรียนการสอนปกติ นอกจากนี้ 
นักศึกษายังแสดงความคิดเห็นว่า โปรแกรมคอมพิวเตอร์ช่วยสอนวิชาเคมีเป็นรูปแบบของการเรียน
การสอนที่ประสิทธิภาพ สามารถช่วยเพ่ิมความกระตือรือร้นในการเรียนและจูงใจนักศึกษาในการ
เรียนมากยิ่งขึ้น 
 McAlpine (2000) [Online] ศึกษาการน าการเรียนการสอนออน าไลน์มาใช้ร่วมกับวิธีการ
เรียนรู้ร่วมกัน (Collaborative Learning) เพ่ือเพ่ิมทักษะในด้านการวิเคราะห์ การติดต่อสื่อสารการ
เจรจาต่อรอง การประสานและการท างานร่วมกันเป็นทีมของนิสิตบันฑิตศึกษาในสาขาบริหารธุรกิจ 
ผลการวิจัยพบว่า ผู้เรียนส่วนใหญ่มีความรู้สึกที่ดีต่อการท างานร่วมกัน โดยเฉพาะการได้เรียนรู้ข้อมูล
จากผู้เรียนอ่ืน ท าให้เกิดความเข้าใจในการเรียนเพ่ิมขึ้น แต่บางส่วนเห็นว่าการอภิปรายบนเครือข่าย
ไม่มีความเป็นธรรมชาติ ควรใช้โทรศัพท์ในการสื่อสารมากกว่า ในขณะที่ส่วนใหญ่เห็นด้วยว่ามีการ
พัฒนาตนเองในทักษะการแก้ไขปัญหา และการใช้ประสบการณ์และความรู้ในงานที่ได้รับมอบหมาย 
ในด้านการมีปฏิสัมพันธ์ระหว่างกันพบว่ามีค่อนข้างน้อยจะสนทนากันเฉพาะในงานที่รับมอบหมาย
และยุติการสนทนาในเวลาสั้น มีการอ้างอิงถึงแหล่งข้อมูลที่จัดให้บ้างเล็กน้อยมีการตอบกระทู้หลัก
ของผู้สอน โดยเฉลี่ย 16-65 ข้อความ ซึ่งจัดอยู่ในระดับสูง ข้อความส่วนใหญ่เป็นการสรุปเนื้อหาสั้น 
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มีความยาวประมาณหนึ่งย่อหน้า ที่ส่วนใหญ่อ้างจากประสบการณ์ของตนเองรวมข้อความที่เกิดขึ้นใน
การเรียนทั้งหมด 450 ข้อความ 
 Lee and Huang (2004) [Online] ศึกษาเกี่ยวกับประสิทธิผลและประสิทธิภาพของเนื้อหา
ดิจิทัล (digital content) ในรูปแบบต่างๆ ที่ใช้ในการเรียนการสอนในระบบ e-Learning ได้แก่ เว็บ
เพจสไลด์ในรูปโปรแกรมเพาเวอร์พอยต์ (PowerPoint) และโปรแกรมสถานการณ์จ าลอง โดยเปรียบ 
เทียบกับรูปแบบที่ใช้ในการเรียนการสอนในระบบปกติ ซึ่งเน้นการบรรยายในห้องเรียนและการอ่าน
จากต ารา โดยพิจารณาจากปัจจัยต่าง ๆ เช่น การได้รับความรู้ วิธีการเรียนของผู้เรียน การเพ่ิมแรงจูงใจ
ของผู้เรียน และผลตอบแทนจากการลงทุน (Return on Investment - ROI) ผลการวิจัยพบว่า 
เนื้อหาดิจิทัลในรูปแบบทั้งสามดังกล่าวที่ใช้ในการเรียนการสอนในระบบ e-Learning มีประสิทธิผล 
ประสิทธิภาพ และให้ผลตอบแทนจากการลงทุนที่มากกว่ารูปแบบที่ใช้ในการเรียนการสอนในระบบ
ปกต ิ
 ผลจากการศึกษาเอกสารการวิจัยที่เกี่ยวข้องพบว่า การใช้บทเรียนอีเลิร์นนิง จะช่วยให้
ผลสัมฤทธิ์ทางการเรียนของผู้เรียนสูงขึ้น เมื่อเปรียบเทียบกับการเรียนการสอนแบบปกติ โดยข้อดีของ
การจัดการเรียนการสอนด้วยบทเรียนอีเลิร์นนิง เป็นวิธีการสอนที่มีสื่อประสมหลายแบบรวมไว้ที่จุด
เดียว ซึ่งเป็นการกระตุ้นให้เกิดความน่าสนใจในการเรียน รวมทั้งเปิดโอกาสให้ผู้เรียนศึกษาค้นคว้าหา
ความรู้ตามความต้องการและทบทวนความรู้ได้ อีกทั้งยังช่วยอ านวยความสะดวกในเรื่องเวลา สถานที่ 
และช่วยเพ่ิมปฏิสัมพันธ์ระหว่างครูผู้สอนกับผู้เรียน โดยผู้เรียนมีบทบาทในการเรียนและผู้สอนเป็นผู้
จัดกิจกรรมเพ่ิมพูนความรู้ให้กับผู้เรียน รวมทั้งกระตุ้นให้ผู้เรียนเกิดการเรียนรู้อย่างลึกซึ้งและสามารถ
โต้ตอบกับครูผู้สอนผ่านกิจกรรมการเรียนรู้โดยใช้สื่อบทเรียนอีเลิร์นนิ่งเป็นศูนย์กลางในการติดต่อ 
สื่อสาร อีกทั้งยังเป็นแนวทางให้ผู้สอนน ามาพัฒนารูปแบบการเรียนการสอนให้มีประสิทธิภาพมาก
ยิ่งขึ้น 
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บทที่ 3 

วิธีด าเนินการวิจัย 
 
 การวิจัยครั้งนี้เป็นการวิจัยการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ชั้นมัธยมศึกษาปีที่ 3 ผู้วิจัยได้ด าเนินการตามล าดับขั้นตอนดังต่อไปนี้ 
 3.1  ประชากรและกลุ่มตัวอย่าง  
 3.2 เครื่องมือที่ใช้ในการวิจัย 
 3.3 การเก็บรวบรวมข้อมูล  
 3.4  การวิเคราะห์ข้อมูล  
 

3.1 ประชากรและกลุ่มตัวอย่าง 
 
 3.1.1 ประชากร 
 ประชากรที่ใช้ในการศึกษาคือนักเรียนโรงเรียนโนนกุงวิทยาคม อ าเภอตระการพืชผล จังหวัด
อุบลราชธานี สังกัดส านักงานเขตพื้นที่การศึกษามัธยมศึกษา เขต 29 ภาคเรียนที่ 2 ปีการศึกษา 
2557 จ านวน 3 ห้อง มีนักเรียนห้องละ 30 คน รวมทั้งหมด 90 คน 
 

 3.1.2 กลุ่มตัวอย่าง 
 กลุ่มตัวอย่าง ที่ใช้ในการศึกษาคือนักเรียนชั้นมัธยมศึกษาปีที่ 3  โรงเรียนโนนกุงวิทยาคม  
อ าเภอตระการพืชผล จังหวัดอุบลราชธานี สังกัดส านักงานเขตพื้นที่การศึกษามัธยมศึกษา เขต 29 
ภาคเรียนที่ 2 ปีการศึกษา 2557 จ านวนนักเรียน 90 คน ซึ่งได้มาจากการจับสลากนักเรียนมา 1 ห้อง 
เรียน มีนักเรียนจ านวน 30 คน 

 

3.2 เครื่องมือที่ใช้ในการวิจัย 
 

 การสร้างเครื่องมือที่ใช้ในการวิจัยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ชั้น
มัธยมศึกษาปีที่ 3 โดยผู้วิจัยแบ่งการสร้างเครื่องมือออกเป็น 3 ประเภทประกอบด้วย 
 1. การสร้างบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
 2. การสร้างแบบประเมินคุณภาพของบทเรียนอีเลิร์นนิ่ง 
 3. การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
 เครื่องมือที่ใช้ในการวิจัยแต่ละประเภทดังกล่าวมีขั้นตอนการสร้างดังนี้ 
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 3.2.1 การสร้างบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
       ในการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ชั้นมัธยมศึกษาปีที่ 3
ผู้วิจัยได้น าขั้นตอนการพัฒนาบทเรียนคอมพิวเตอร์ตามหลักการออกแบบของ ADDIE Model อ้างใน 
ฉัตรพงศ์ ชูแสงนิล. 2555. [ออนไลน์] ซึ่งมี 5 ขั้นตอนดังนี ้
       1.  การวิเคราะห์ (Analysis) 
       2.  การออกแบบ (Design) 
       3.  การพัฒนา (Development) 
       4.  การทดลองใช้ (Implementation) 
       5.  การประเมินผล (Evaluation) 
       รายละเอียดของการพัฒนาบทเรียนอีเลิร์นนิ่งทั้ง 5 ขั้นตอน ผู้วิจัยได้น ามาดัดแปลงการพัฒนา
บทเรียนอีเลิร์นนิ่งดังนี้ 
 1. การวิเคราะห์ (Analysis) 
       เป็นขั้นตอนแรกของกระบวนการพัฒนา ในขั้นตอนนี้ ผู้วิจัยได้ท าการวิเคราะห์เนื้อหา กิจกรรม
การเรียนการสอนรวมถึงคุณลักษณะของนักเรียน และวัตถุประสงค์ของการเรียนการสอน เพื่อ
รวบรวมข้อมูล ส าหรับใช้เป็นแนวทางในการก าหนดขอบเขตของบทเรียน ซึ่งขั้นการวิเคราะห์
ประกอบด้วยขั้นตอนย่อยดังนี้ 
 1.1 ศึกษาทฤษฎีและหลักการพัฒนาบทเรียนอีเลิร์นนิ่งจากเอกสาร ต ารา และงานวิจัยต่างๆ  
 1.2 ศึกษาเนื้อหา เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร ์CS5 
 1.3 วิเคราะห์เนื้อหา เหตุผลความสัมพันธ์ และน ามาก าหนดจุดประสงค์การเรียนรู้  โดยแบ่ง
เนื้อหาในบทเรียนดังนี้  
 (1)  หลักการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver 
 (2)  การใส่และตกแต่งข้อความบนเว็บเพจ 
  (3)  การใส่ภาพประกอบเว็บเพจ 
 (4)  การสร้างไฮเปอร์ลิงค์ (Hyperlink) 
 (5)  การจัดหน้าเว็บเพจด้วยตาราง (Table) 
 (6)  การแบ่งหน้าเว็บเพจด้วยเฟรม (Frame) 
 (7)  การเล่นมัลติมีเดียบนเว็บเพจ (Web Multimedia) 
           จุดประสงค์การเรียนรู้ 
 (1)  มีความรู้เกี่ยวกับการใช้โปรแกรม Adobe Dreamweaver CS5 
 (2)  สามารถบอกส่วนประกอบต่าง ๆ ของโปรแกรม Adobe Dreamweaver CS5  
 (3)  มีความรู้เกี่ยวกับการปรับแต่งข้อความบนเว็บเพจ 
 (4)  มีความรู้เกี่ยวกับการการใส่ภาพบนเว็บเพจ 
 (5)  มีความรู้เกี่ยวกับการเชื่อมโยงเว็บเพจ 
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 (6)  มีความรู้เกี่ยวกับการสร้างตารางบนเว็บเพจ 
 (7)  มีความรู้เกี่ยวกับการแบ่งหน้าเว็บเพจด้วยเฟรม 
 (8)  มีความรู้เกี่ยวกับการเล่นมัลติมีเดียบนเว็บเพจ 
 1.4 ศึกษาและวิเคราะห์สื่อการเรียนการสอน ให้มีความเหมาะสมกับบทเรียนและผู้เรียน ซึ่ง
เลือกใช้โปรแกรม Moodle 2.8 ในการพัฒนาบทเรียนอีเลิร์นนิ่ง 
 2. การออกแบบ (Design)  
 เป็นการน าผลการวิเคราะห์มาออกแบบกระบวนการด าเนินงานในลักษณะแบบร่าง โดย
ขั้นตอนการออกแบบประกอบด้วยขั้นตอนย่อยดังนี ้
 2.1 ออกแบบเนื้อของบทเรียน น าเนื้อหามาแบ่งออกเป็นหน่วยย่อยและก าหนดจุดประสงค์ให้
อยู่ภายในหน่วยการเรียนรู้นั้นๆ ประกอบด้วยค าอธิบาย ตัวอย่างและแบบทดสอบ จากนั้นตรวจสอบ
เนื้อหาว่ามีความถูกต้อง ชัดเจน ครอบคลุมจุดประสงค์หรือไม่ แล้วปรับปรุงแก้ไขและจัดล าดับของ
เนื้อหา 
 2.2 ออกแบบโครงสร้างและลักษณะของบทเรียน เป็นการน าเนื้อหามาออกแบบหน้าจอ 
ประกอบด้วย ตัวอักษร สี รูปภาพ เสียงและภาพเคลื่อนไหว ให้มีความเหมาะสมกับผู้เรียน และ
ก าหนดรูปแบบการน าเสนอให้มีความทันสมัย 
 2.3 จากนั้นน ารูปแบบการน าเสนอทั้งหมดมาเชื่อมโยงความสัมพันธ์ระหว่างเนื้อหาแต่ละ
หน่วยการเรียนรู้ 
 3. การพัฒนา (Development) เป็นขั้นตอนการสร้างบทเรียนอีเลิร์นนิ่งและท าการประเมิน 
ผลการพัฒนาเพื่อปรับปรุงแก้ไขให้ได้ระบบการเรียนการสอนที่มีประสิทธิภาพ ซึ่งประกอบด้วย 
 3.1 เขียนสตอรี่บอรด (Storyboard) อธิบายแต่ละหน้าจอว่า ผู้เรียนเห็นหรือมีปฏิสัมพันธ์กับ
บทเรียนอย่างไร 
 3.2 จัดเตรียมวัสดุต่าง ๆ เช่น ภาพ ข้อความ เสียงและโปรแกรม Learning Management  
System ในการสร้างบทเรียนมาท าการบันทึกข้อมูลไว้ก่อน เพื่อน าไปใช้พัฒนาบทเรียนอีเลิร์นนิ่ง 
 3.3 จากนั้นสร้างบทเรียนอีเลิร์นนิ่ง โดยใช้โปรแกรม Moodle 2.8 (Learning Management 
System) ในการจัดรูปแบบการน าเสนอตามที่มีการออกแบบผังงานและบทด าเนินเรื่อง แล้วเชื่อมโยง
ความสัมพันธ์ระหว่างเนื้อหาแต่ละหน่วย และในการน าเสนอเนื้อหาบางส่วนมีการใช้โปรแกรม 
Adobe Photoshop CS5 ส าหรับตกแต่งภาพเพื่อใช้ในการท าสื่อให้ดูน่าสนใจมากยิ่งขึ้น จากนั้นใช้
โปรแกรม Adobe SoundBooth CS5 ในการตัดเสียง และใช้โปรแกรม Camtasia Studio 8 ในการ
ตัดต่อวีดีโอ แล้วอัพโหลดไฟล์ขึ้นเว็บไซต์ www.youtube.com จากนั้นน าลิงค์เชื่อมโยงมาประกอบ
ในสื่อการเรียนการสอน เพื่อให้สื่อน่าสนใจยิ่งขึ้น จากนั้นทดสอบสอบความถูกต้องและรูปแบบการ
น าเสนอทั้งหมด เพื่อหาข้อบกพร่องและปรับปรุงสื่อการเรียนสอน 
 3.4 น าบทเรียนบทเรียนอีเลิร์นนิ่งที่สร้างเสร็จเสนออาจารย์ที่ปรึกษาวิทยานิพนธ์และอาจารย์
ที่ปรึกษาวิทยานิพนธ์ร่วมและตรวจสอบบทเรียนอีเลิร์นนิ่งเพื่อหาข้อบกพร่อง ประกอบด้วย    
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 3.3.1 ตรวจสอบความถูกต้องด้านเนื้อหาของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟ
เวอร์ CS5 โดยน าเนื้อหาที่ได้ท าการออกแบบไว้ เสนออาจารย์ที่ปรึกษาและผู้ทรงคุณวุฒิ เพื่อน าข้อ 
บกพร่องจากการตรวจสอบมาปรับปรุงแก้ไขให้สมบูรณ์ จ านวน 3 ท่าน ดังต่อไปนี้ 
            1)  ดร.ทศพร แสงสว่าง  อาจารย์ประจ าสาขาเทคโนโลยี 
       และสื่อสารการศึกษา     
                                                  ภาควิชาเทคโนโลยีและสื่อสารการศึกษา 
       คณะครุศาสตร์อุตสาหกรรม  
       มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี 
            2)  ดร.สมเกียรติ ตันติวงศ์วาณิช อาจารย์ประจ าสาขาวิชาครุศาสตร์อุตสาหกรรม   
       คณะครุศาสตร์อุตสาหกรรม  
                                         สถาบันเทคโนโลยีพระจอมเกล้า  
       เจ้าคุณทหารลาดกระบัง 
 3)  ดร.เศรษฐชัย ชัยสนิท  รองคณบดีคณะเทคโนโลยีสารสนเทศ 
                                                  คณะเทคโนโลยีสารสนเทศ  
       มหาวิทยาลัยศรีปทุม วิทยาเขตชลบุรี 
 3.3.2 ตรวจสอบความถูกต้องด้านเทคนิคการผลิตสื่อของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ 
อะโดบี ดรีมวีฟเวอร์ CS5 โดยน าบทเรียนที่ได้ท าการออกแบบไว้ เสนออาจารย์ที่ปรึกษาและผู้ทรง 
คุณวุฒิ เพื่อน าข้อบกพร่องจากการตรวจสอบมาปรับปรุงแก้ไขให้สมบูรณ์ จ านวน 3 ท่าน ดังต่อไปนี้ 
 1)  ดร.ทศพร แสงสว่าง  อาจารย์ประจ าสาขาเทคโนโลยีและ 
       สื่อสารการศึกษา ภาควิชาเทคโนโลย ี
       และสื่อสารการศึกษา 
       คณะครุศาสตร์อุตสาหกรรม  
       มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี 
 2)  ดร.สมเกียรติ ตันติวงศ์วาณิช อาจารย์ประจ าสาขาวิชาครุศาสตร์อุตสาหกรรม   
       คณะครุศาสตร์อุตสาหกรรม 
       สถาบันเทคโนโลยีพระจอมเกล้า 
       เจ้าคุณทหารลาดกระบัง 
 3)  ดร.เศรษฐชัย ชัยสนิท  รองคณบดีคณะเทคโนโลยีสารสนเทศ 
       คณะเทคโนโลยีสารสนเทศ  
       มหาวิทยาลัยศรีปทุม วิทยาเขตชลบุรี 
 3.4 น าข้อบกพร่องจากการตรวจสอบมาปรับปรุงแก้ไข โดยผู้ทรงคุณวุฒิมีข้อเสนอแนะดังนี้ 
ให้แก้ไขหัวข้อแต่ละบทเรียนให้มีความกระชับยิ่งขึ้น และให้เพิ่มจุดประสงค์ย่อยในบทที่ 4 ให้ครอบคลุม
จุดประสงค์เชิงพฤติกรรม แล้วน าผลการประเมินจากผู้ทรงคุณวุฒิมาวิเคราะห์หาคุณภาพของบทเรียน

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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อีเลิร์นนิ่งด้านเนื้อหาและด้านเทคนิคการผลิตสื่อ แล้วไปทดลองใช้กับนักเรียนระดับชั้นมัธยมศึกษาปี
ที่ 3 โรงเรียนโนนกุงวิทยาคม โดยได้มาจากการคัดเลือกของอาจารย์ผู้สอน 
 4. การน าไปใช้ (Implementation) โดยด าเนินการทดสอบหาประสิทธิภาพของบทเรียน 
อีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 โดยมีขั้นตอนดังนี ้
 4.1 น าบทเรียนอีเลิร์นนิ่งที่ปรับปรุงแล้ว ไปทดลองใชค้รั้งที่ 1 โดยทดลองกับนักเรียนระดับชั้น
มัธยมศึกษาปีที่ 3 จ านวน 3 คน เป็นนักเรียนที่มีผลการเรียนในระดับเก่ง ปานกลาง และอ่อน อย่าง
ละ 1 คน ใช้การทดลองแบบเดียว โดยน าบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ไปใช้กับนักเรียนที่ไม่ใช่กลุ่มตัวอย่างในการทดลอง จ านวน 3 คน ซึ่งได้มาจากการสุ่มอย่างง่าย 
(Simple Random Sampling) ด้วยวิธีการจับสลาก โดยใช้ระดับผลการเรียนวิชาโปรแกรมภาษาขั้น
พื้นฐาน ภาคเรียนที่ 1 ปีการศึกษา 2557 โดยคัดเลือกจากนักเรียนที่มีเกรดเฉลี่ยในระดับสูง (3.00 – 
4.00) กลาง (2.00 – 2.99) ต่ า (1.00 – 1.99) แล้วจับสลากเลือกกลุ่มละ 1 คน จากนั้นท าการสังเกต
การ เพื่อตรวจสอบหาข้อบกพร่องของบทเรียนในด้านต่างๆ เช่น ความถูกต้องของเนื้อหา ความ
ชัดเจนของการน าเสนอเนื้อหา ภาษา คุณภาพของโปรแกรมคอมพิวเตอร์ ความชัดเจนของตัวอักษร
และรูปภาพตลอดจนสอดคล้องกับสภาพการเรียนการสอนจริง แล้วน าข้อเสนอแนะไปปรังปรุงแก้ไข
บทเรียนอีเลิร์นนิ่งต่อไป โดยมีข้อเสนอแนะดังนี้ นักเรียนมีความสนใจบทเรียนเป็นอย่างดี แต่ในส่วน
ของขนาดตัวอักษรให้มีขนาดเล็ก หัวข้อไม่ชัดเจน และเว็บเพจบางหน้ามีเนื้อหาเยอะเกินไป         
 4.2 แล้วน าบทเรียนอีเลิร์นนิ่งที่ปรับปรุงแล้ว ไปทดลองใช้ครั้งที่ 2 โดยทดลองกับนักเรียน
ระดับชั้นมัธยมศึกษาปีที่ 3 จ านวน 6 คน เป็นนักเรียนที่มีผลการเรียนในระดับเก่ง ปานกลาง และอ่อน
อย่างละ 2 ใช้การทดลองแบบกลุ่มย่อย โดยน าบทเรียนอีเลิร์นนิ่งที่ผ่านการปรับปรุงแก้ไขแล้ว ไป
ทดลองกับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ภาคเรียนที่ 1 ปีการศึกษา 2557 เป็นนักเรียนที่ไม่ใช่กลุ่ม
ตัวอย่างในการทดลอง จ านวน 6 คน ซึ่งได้มาจากการสุ่มอย่างง่าย (Simple Random Sampling) 
ด้วยวิธีการจับสลาก โดยใช้ระดับผลการเรียนวิชาโปรแกรมภาษาขั้นพื้นฐาน ภาคเรียนที่ 1 ปี
การศึกษา 2557 โดยคัดเลือกจากนักเรียนที่มีเกรดเฉลี่ยในระดับสูง (3.00 – 4.00) กลาง (2.00 – 2.99) 
ต่ า (1.00 – 1.99) แล้วจับสลากเลือกกลุ่มละ 2 คน เพื่อตรวจสอบข้อบกพร่องทั้งหมดแล้วน ามาปรับปรุง
แก้ไขอีกครั้งเป็นการทดลองอีกครั้งก่อนน าไปทดลองใช้จริงกับกลุ่มตัวอย่าง โดยมีข้อเสนอแนะดังนี้ 
เพิ่มเติมรูปภาพให้เยอะขั้น เพื่อให้ดูน่าสนใจ  
 5. การประเมินผล (Evaluation)  
 น าบทเรียนอีเลิร์นนิ่งที่ผ่านการปรับปรุงแก้ไขแล้วให้ผู้ทรงคุณวุฒิตรวจสอบก่อนน าไปทดลองใช้
กับกลุ่มตัวอย่างจ านวน 30 คน ที่ได้ก าหนดไว้แล้วน าผลการทดลองกับกลุ่มตัวอย่างมาท าการ
วิเคราะห์เพื่อหาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง โดยใช้สูตร E1/E2 ตามเกณฑ์ที่ก าหนด  
โดยเขียนขั้นตอนการสร้างบทเรียนอีเลิรน์น่ิง ได้ดังภาพที่  3.1  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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เริ่มต้น

ศึกษาทฤษฎีและหลักการพัฒนาบทเรียนบทเรียนอีเลร์นน่ิง

วิเคราะห์เน้ือหาและก าหนดจุดประสงค์การเรียนรู้

ออกแบบหน้าจอและเขียนบทด าเนินเร่ือง

สร้างบทเรียนอีเลิร์นน่ิง

เสนออาจารย์ที่ปรึกษาวิทยานิพนธ์ อาจารย์ท่ีปรึกษาวิทยานิพนธ์ร่วม

ปรับปรุงแก้ไข

เสนอผู้ทรงคุณวุฒิเพื่อท าการประเมินคุณภาพ 2 ด้าน

ประเมินคุณภาพ

ตรวจสอบ

ปรับปรุงแก้ไข

น าบทเรียนไปทดลองใช้คร้ังที่ 2 กับนักเรียน 6 คน และปรับปรุงแก้ไข

น าบทเรียนไปทดลองใช้กับกลุ่มตัวอย่าง จ านวน 30 คน

หาประสิทธิภาพบทเรียนอีเลิร์นน่ิง

จบ

ไม่ผ่าน

ไม่ผ่าน

ผ่าน

ผ่าน

น าบทเรียนไปทดลองใช้คร้ังที่ 1 กับนักเรียน 3 คน และปรับปรุงแก้ไข

1.การวิเคราะห์ (Analysis)

2.การออกแบบ (Design)  

3.การพัฒนา (Development) 

4.การน าไปใช้ (Implementation) 

5.การประเมินผล (Evaluation) 

ศึกษาเน้ือหาเร่ืองการใช้ อะโดบี ดรีมวีฟเวอร์ CS5

 

ภาพที่ 3.1  ขั้นตอนการสร้างบทเรียนอีเลิรน์นิ่ง 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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 3.2.2 การสร้างแบบประเมนิคุณภาพของบทเรียนอีเลิร์นนิ่ง  
 ผู้วิจัยได้ด าเนินการพัฒนาแบบประเมินบทเรียนอีเลิร์นนิ่งจากแบบประเมินบทเรียนคอมพิวเตอร์
ช่วยสอนของ ไพโรจน์ ตีรณธนากุล และคณะ (2546 : 197-214) โดยแบ่งเป็นการประเมินทางด้าน
เนื้อหาและการประเมินทางด้านเทคนิคการผลิตสื่อซึ่งมีขั้นตอนการสร้างดังต่อไปนี้ 
 1. ก าหนดจุดประสงค์และหัวข้อของแบบประเมิน 
 สร้างแบบประเมินบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับผู้ทรงคุณวุฒิ
ด้านเนื้อหาและผู้ทรงคุณวุฒิด้านเทคนิคการผลิตสื่อ โดยใช้แบบประเมินมาตราส่วนประมาณค่า 
(Rating Scale) โดยแบ่งเป็น 5 ระดับ ในการให้คะแนน โดยมีเกณฑ์การให้คะแนนดังนี้ 
 (1) ระดับความคิดเห็น 5 ระดับ 
 ระดับ 5  คุณภาพของบทเรยีนอยู่ในระดับ ดีมาก 
 ระดับ 4  คุณภาพของบทเรยีนอยู่ในระดับ ดี 
 ระดับ 3  คุณภาพของบทเรยีนอยู่ในระดับ ปานกลาง 
 ระดับ 2  คุณภาพของบทเรียนอยู่ในระดับ พอใช ้
 ระดับ 1  คุณภาพของบทเรยีนอยู่ในระดับ ควรปรับปรุง 
 (2) เกณฑ์การแปลความหมายค่าเฉลี่ยคุณภาพของบทเรียนอีเลิร์นนิ่ง ดังตารางที่ 3.1 
 
ตารางที่ 3.1 คะแนนและเกณฑ์การแปลความหมายของค่าเฉลี่ยคุณภาพของบทเรียนอีเลิร์นน่ิง 

เกณฑ์ค่าเฉลี่ย  ( ̅) ระดับคณุภาพของบทเรียนอเีลิรน์นิ่ง 

4.50 – 5.00 
3.50 – 4.49 
2.50 – 3.49 
1.50 – 2.49 
1.00 – 1.49 

ดีมาก 
ดี 

ปานกลาง 
พอใช ้

ควรปรับปรุง 

  

 ในการประเมินนั้นจะต้องได้เกณฑ์ค่าเฉลี่ย ( X ) ตั้งแต่ 3.50 ทุกรายการขึ้นไป จึงจะถือว่าผ่าน
เกณฑ์การประเมินจากผู้ทรงคุณวุฒ ิ

 2. น าแบบประเมินคุณภาพของบทเรียนอีเลิร์นนิ่งเสนอต่ออาจารย์ที่ปรึกษาวิทยานิพนธ์ และ   
อาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วมตรวจสอบแก้ไข 
 3. แก้ไขปรับปรุง 
 4. น าแบบประเมินคุณภาพของบทเรียนอีเลิร์นนิ่งที่ได้ปรับปรุงแล้วให้ผู้ทรงคุณวุฒิด้านเนื้อหา 
และผู้ทรงคุณวุฒิด้านเทคนิคการผลิตสื่อท าการประเมิน  
 ส าหรับรายละเอียดของการพัฒนาแบบประเมินคุณภาพของบทเรียนอีเลิร์นนิ่ง ดังภาพที่ 3.2 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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เริ่มต้น

ก าหนดวัตถุประสงค์และหัวข้อของแบบประเมิน

น าเสนออาจารย์ท่ีปรึกษาวิทยานิพนธ์และอาจารย์ที่
ปรึกษาวิทยานิพนธ์ร่วมตรวจสอบ

น าแบบประเมินคุณภาพให้ผู้ทรงคุณวุฒิด้านเน้ือหาและ
ผู้ทรงคุณวุฒิด้านเทคนิคการผลิตส่ือท าการประเมิน

ตรวจสอบ ปรับปรุงแก้ไข

จบ

ไม่ผ่าน

ผ่าน

 
 

ภาพที่ 3.2  ขั้นตอนการพัฒนาแบบประเมินคุณภาพของบทเรียนอีเลิร์นนิ่ง 
 

 3.2.3 การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
 ผู้วิจัยได้ท าการสร้างแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน มีขั้นตอนดังนี ้
 1. ศึกษาวิธีสร้างและเทคนิคการสร้างแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน 
 2. วิเคราะห์จุดประสงค์การเรียนรู้เชิงพฤติกรรมของเนื้อหาบทเรียนเรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 โดยสร้างตารางวิเคราะห์วัตถุประสงค์เชิงพฤติกรรมเพื่อสร้างแบบทดสอบให้มีความ
เที่ยงตรงเชิงเนื้อหาและพฤติกรรม ในการวิเคราะห์วัตถุประสงค์เชิงพฤติกรรมได้พิจารณาความส าคัญ
ของเนื้อหาในแต่ละเรื่อง เพื่อสร้างข้อสอบให้มีจ านวนครอบคลุมทุกวัตถุประสงค์ 
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ตารางที่ 3.2 แสดงการวิเคราะห์วัตถุประสงค์เชิงพฤติกรรมเพื่อสร้างแบบทดสอบ 

ล าดับ
ที่ 

เนื้อหา 

พฤติกรรมด้านพุทธิพิสัย 

คว
าม

รู-้ค
วา

มจ
 า 

คว
าม

เข
้าใ

จ 

กา
รน

 าไ
ปใ

ช ้

รว
ม 

1 มีความรู้เกี่ยวกับการใช้โปรแกรม 
Adobe Dreamweaver CS5 

2 1 1 4 

2 สามารถบอกส่วนประกอบต่างๆ ของโปรแกรม 
Adobe Dreamweaver CS5 

3 1 2 6 

3 มีความรู้เกี่ยวกับการปรับแต่งข้อความบนเว็บเพจ 2 2 2 6 
4 มีความรู้เกี่ยวกับการการใส่ภาพบนเว็บเพจ 2 2 2 6 
5 มีความรู้เกี่ยวกับการเชื่อมโยงเว็บเพจ 2 2 2 6 
6 มีความรู้เกี่ยวกับการสร้างตารางบนเว็บเพจ 1 2 3 6 
7 มีความรู้เกี่ยวกับการแบ่งหนา้เว็บเพจด้วยเฟรม 1 1 1 3 
8 มีความรู้เกี่ยวกับการเล่นมัลติมีเดียบนเว็บเพจ 1 1 1 3 

รวม 13 13 14 40 
 

 3. สร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS เป็น
แบบเลือกตอบ 4 ตัวเลือก โดยก าหนดให้ข้อที่ตอบถูกเป็น 1 คะแนน และข้อที่ตอบผิดหรือไม่ตอบ ให้ 
0 คะแนน จ านวน 120 ข้อ โดยใช้จริงจ านวน 40 ข้อ คัดเลือกจากการหาค่าดัชนีความสอดคล้อง 
(IOC) พิจารณาตามเกณฑ์ที่ก าหนดคือ ตั้งแต่ .50 ขึ้นไป มีข้อสอบที่ผ่านเกณฑ์ที่ก าหนด จ านวน 113 
ข้อ มีค่าอยู่ระหว่าง 0.67 - 1.00 จากนั้นน าไปวิเคราะห์หาค่าความยากง่าย พิจารณาเกณฑ์ความยาก
ง่ายที่ก าหนดคือ ตั้งแต่ .20 - .80 ซึ่งผ่านเกณฑ์จ านวนทั้งหมด 110 ข้อ มีค่าความยากง่าย(p) ตั้งแต่ 
.23 - .80 แล้วน าไปหาค่าอ านาจจ าแนก พิจารณาตามเกณฑ์ก าหนดตั้งแต่ระดับปานกลางขึ้นไปจนถึง
ระดับสูงและสูงมาก โดยมีค่า r ตั้งแต่ .20 ขึ้นไป ผ่านเกณฑ์จ านวน 101 ข้อ มีค่าอ านาจจ าแนกตั้งแต่ 
.20 - .47  แบ่งเป็นระดับปานกลาง จ านวน 64 ข้อ ระดับสูงจ านวน 30 ข้อ และสูงมากจ านวน 7 ข้อ 
จากนั้นท าการคัดเลือกข้อสอบจากระดับปานกลางจ านวน 27 ข้อ และระดับสูงจ านวน 17 ข้อ       
 4. หาค่าความเที่ยงตรงเชิงเนื้อหา ของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน โดยให้ผู้ทรง 
คุณวุฒิด้านเนื้อหาจ านวน 3 ท่าน ดังต่อไปนี้ 
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        1)  ดร.ทศพร แสงสว่าง  อาจารย์ประจ าสาขาเทคโนโลยีและสื่อสารการศึกษา 
      ภาควิชาเทคโนโลยีและสื่อสารการศึกษา 
      คณะครุศาสตร์อุตสาหกรรม  
      มหาวิทยาลัยเทคโนโลยีราชมงคลธัญบุรี 
        2)  ดร.สมเกียรติ ตันติวงศ์วาณิช อาจารย์ประจ าสาขาวิชาครุศาสตร์อุตสาหกรรม   
      คณะครุศาสตร์อุตสาหกรรม 
      สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

        3)  ดร.เศรษฐชัย ชัยสนิท รองคณบดีคณะเทคโนโลยีสารสนเทศ 

      คณะเทคโนโลยีสารสนเทศ  

      มหาวิทยาลัยศรีปทุม วิทยาเขตชลบุร ี
 

 พิจารณาความเที่ยงตรงของค าถาม โดยมีเกณฑ์การให้คะแนนดังนี้ 

 +1  คะแนน ส าหรับข้อสอบที่แน่ใจว่าวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ 

   0  คะแนน ส าหรับข้อสอบที่ไม่แน่ใจว่าวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ 

  -1  คะแนน ส าหรับข้อสอบที่แน่ใจว่าไม่สามารถวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ 
 บันทึกผลการพิจารณาของผู้ทรงคุณวุฒิแต่ละข้อ แล้วน าไปหาดัชนีความสอดคล้อง (IOC) โดย
ใช้สูตร ดังนี้ (พรรณี ลีกิจวัฒนะ. 2553 : 197) 
 

  สูตร          
∑ 

 
 

   เม่ือ      แทน  ดัชนีความสอดคล้องระหว่างผู้ทรงคุณวุฒ ิ

    ∑   แทน  ผลรวมของคะแนนความคิดเห็นของผู้ทรงคุณวุฒิด้านเนื้อหาทั้งหมด 

          แทน  จ านวนของผู้ทรงคุณวุฒิด้านเนื้อหา 

 
 น าคะแนนที่ผู้ทรงคุณวุฒิด้านเนื้อหาประเมินให้ในแต่ละข้อมาหาค่าเฉลี่ยแล้วน าไปเปรียบเทียบ
เกณฑ์ค่าดัชนีความสอดคล้องระหว่างผู้ทรงคุณวุฒิ โดยก าหนดค่าดัชนีความสอดคล้องตั้งแต่ 0.5 ขึ้น
ไป ถือว่าข้อสอบมีความเที่ยงตรง ซึ่งผลจากการประเมินหาค่า IOC ที่ได้จากการประเมินของผู้ทรง 
คุณวุฒิทั้ง 3 ท่าน พบว่า แบบทดสอบมีค่าดัชนีความสอดคล้องตั้งแต่ 0.5 ขึ้นไป มีจ านวน 113 ข้อ 
โดยค่าดัชนีความสอดคล้องมีค่าเท่ากับ 0.67 – 1.00 
 5. น าแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียนท่าผ่านเกณฑ์การประเมินหาค่า IOC ทั้ง 113 ข้อ
ที่ได้ปรับปรุงแก้ไขข้อบกพร่องแล้ว น าเสนออาจารย์ที่ปรึกษาวิทยานิพนธ์ และอาจารย์ที่ปรึกษา
วิทยานิพนธ์ร่วมเพื่อท าการตรวจสอบ 
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 6. น าแบบทดสอบที่แก้ไขแล้วไปทดลองใช้กับนักเรียนที่ผ่านการเรียนเรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 จ านวน 30 คน เพื่อหาคุณภาพของแบบทดสอบ 
 7. ตรวจให้คะแนนแบบทดสอบ โดยก าหนดให้ข้อที่ตอบถูกเป็น 1 คะแนน และข้อที่ตอบผิด
หรือไม่ตอบ ให้ 0 คะแนน 
 8. น าคะแนนที่ได้มาวิเคราะห์เป็นรายข้อ เพื่อหาความยากง่าย และค่าอ านาจจ าแนก โดยใช้
สูตรในการค านวณดังนี้ น าผลคะแนนที่ได้มาวิเคราะห์หาความยากง่าย (p) และค่าอ านาจจ าแนก (r) 
มีสูตร ดังนี้ 
 8.1 การหาค่าความยากง่ายโดยใช้เทคนิค 50% (พรรณ ีลีกิจวัฒนะ. 2553 : 208-209) โดยใช้
สูตรดังนี้ 
 

  สูตร   
     

  
 

   เม่ือ        แทน  ค่าความยากง่าย 

       แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง 

        แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มต่ า 

        แทน  จ านวนผู้ตอบในแต่ละกลุ่ม (ซึ่งมีจ านวนเท่ากัน) 
 
 ก าหนดเกณฑ์ความยากง่ายมีค่า p ตั้งแต่ .20 - .80 โดยเกณฑ์การแปลความหมายค่าความ
ยากง่าย (p) ดังนี้ 
 
ตารางที่ 3.3 เกณฑ์การแปลความหมายค่าความยากง่าย (p) มีดังนี้ 

ค่าความยากงา่ย 
ระดับความยากง่าย การน าไปใช ้

ร้อยละ สัดส่วน (p) 
81 – 100 .81 – 1.00 ง่ายมาก ไม่ควรใช้ 
61 – 80 .61 - .80 ง่าย ใช้ได ้
40 – 60 .40 - .60 ปานกลาง ใช้ได้ดี 
20 – 39 .20 - .39 ยาก ใช้ได ้
0 – 19 .00 - .19 ยากมาก ไม่ควรใช้ 

         

 8.2 การหาอ านาจจ าแนกโดยใช้เทคนิค 50% (พรรณี ลีกิจวัฒนะ. 2553 : 209-210) 
 

 สูตร      
     

 
  

  เม่ือ       แทน  ค่าอ านาจจ าแนก 
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      แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง  

       แทน  จ านวนผู้ตอบถูกของข้อนนั้นในกลุม่ต่ า 

        แทน  จ านวนผู้ตอบในแต่ละกลุ่ม (ซึ่งมีจ านวนเท่ากัน) 
 
 ก าหนดเกณฑ์อ านาจจ าแนกของข้อสอบที่จะเลือกมาไว้ใช้ตั้งแต่ระดับปานกลางขึ้นไปจนถึง
ระดับสูง และสูงมาก คือมีค่า r ตั้งแต่ .20 ขึ้นไป โดยเกณฑ์การแปลความหมายค่าอ านาจจ าแนก (r) 
ดังนี้ 
 
ตารางที่ 3.4 การแปลความหมายค่าอ านาจจ าแนก (r) ดังนี้ 

ค่าอ านาจจ าแนก (r) ระดับอ านาจจ าแนก การน าไปใช ้
.40 – 1.00 สูงมาก ใช้ได้ดี 
.30 - .39 สูง ใช้ได ้
.20 - .29 ปานกลาง ใช้ได ้
.10 - .19 ต่ า ไม่ควรใช้ 
.01 - .09 ต่ ามาก ใช้ไม่ได้ 

.00 ไม่มี ใช้ไม่ได้ 
-1.00 - -.01 กลับทิศทาง ใช้ไม่ได้ 

 

 9. คัดเลือกแบบทดสอบเฉพาะข้อที่มีความยากง่าย (p) อยู่ระหว่าง 0.20 – 0.80 มีจ านวน 
110 ข้อ และมีค่าอ านาจจ าแนก (r) ตั้งแต่ 0.20 ขึ้นไป จ านวน 101 ข้อ โดยเลือกข้อสอบเพื่อน าไปใช้
เป็นแบบทดสอบก่อนเรียนและหลังเรียนจ านวน 40 ข้อ และระหว่างเรียนอีกจ านวน 61 ข้อ รวม
ทั้งหมด 101 ข้อ เพื่อให้สอดคล้องกับจุดประสงค์การเรียนรู้ และเป็นไปตามเกณฑ์ที่ก าหนด 
 10.  น าคะแนนที่ได้จากการท าแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนไปหาค่าความเชื่อถือได้ 
โดยใช้ใช้สูตร KR-20 ของ Kuder-Richardson (พรรณี ลีกิจวัฒนะ. 2553 : 203) มีสูตรดังนี้ 
 

 สูตร KR 20        
 

   
{  

∑  

  
} 

 

 เม่ือ       แทน  ค่าความเชื่อถือได้ของแบบทดสอบ 

        แทน  จ านวนข้อสอบทั้งหมด 

          ∑   แทน  ผลรวม 

       แทน  สัดส่วนของผู้ตอบถูกในแต่ละข้อ 
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        แทน   สัดส่วนของผู้ตอบผิดในแต่ละข้อ 

                         แทน   ความแปรปรวนของคะแนนคะแนนทั้งฉบับ 
 
 12. พิจารณาความเชื่อถือไดท้ี่ 0.7 ขึ้นไป 
 ผลการวิเคราะห์ค่าความเชื่อถือได้ของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ อะ
โดบี ดรีมวีฟเวอร์ CS5 ได้น าแบบทดสอบที่ผ่านการวิเคราะห์ความยากง่าย (p) ระหว่าง 0.27 – 0.80 
และค่าอ านาจจ าแนก (r) ระหว่าง 0.20 – 0.47 และค่าความเชื่อถือได้เท่ากับ 0.81 ซึ่งสูงกว่าเกณฑ์ที่
ก าหนดไว้ โดยน าไปใช้จริงกับกลุ่มตัวอย่างจ านวน 40 ข้อ โดยแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน
นี้จะถูกบรรจุไว้ในบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
 13. น าแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียนไปใช้จริงกับกลุ่มตัวอย่าง  
 โดยมีขั้นตอนการสร้างแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน ดังภาพที่ 3.3 
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เริ่มต้น

ศึกษาวิธีสร้างและเทคนิคการสร้างแบบทดสอบ

วิเคราะห์เนื้อหาและจุดประสงค์การเรียนรู้

สร้างแบบทดสอบเลือกตอบ 4 ตัวเลือก จ านวน 120 ข้อ

เสนอแบบทดสอบให้ผู้ทรงคุณวุฒิพิจารณาเพื่อหาค่าความเท่ียงตรง
เชิงเนื้อหาของแบบทดสอบและข้อเสนอแนะ

คัดเลือกข้อสอบที่มีค่า IOC   0.5
ตัดท้ิง

หรือปรับปรุงแก้ไข

น าบทเรียนไปทดลองใช้กับนักเรียนท่ีเรียนเนื้อหามาแล้ว  30  คน

วิเคราะห์หาค่าความยากง่าย ค่าอ านาจจ าแนก  
และคัดเลือกข้อท่ีมีคุณภาพจ านวน 40 ข้อ

หาค่าความเช่ือถือได้ของข้อสอบ 40 ข้อ

น าแบบทดสอบไปใช้จริง

จบ

ไม่ผ่าน

ผ่าน

น าแบบทดสอบเสนอท่ีปรึกษาวิทยานิพนธ์และที่ปรึกษาวิทยานิพนธ์ร่วมตรวจสอบ

 

ภาพที่ 3.3  ขั้นตอนการสร้างแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน 
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3.3 การเก็บรวบรวมข้อมูล 

 
 การด าเนินการเก็บรวบรวมข้อมูลเพื่อใช้ในการวิจัยครั้งนี้ได้น าบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ 
อะโดบี ดรีมวีฟเวอร์ CS5 ชั้นมัธยมศึกษาปีที่ 3 โดยด าเนินการทดลองเชิงปฏิบัติการ ดังนี้ 
 1. น าหนังสือขอความร่วมมือในการท าการวิจัยจากคณะครุศาสตร์อุตสาหกรรม ส่งให้
ผู้อ านวยการโรงเรียนโนนกุงวิทยาคม เพื่อขออนุญาตและประสานงานในการทดลองเครื่องมือใน
โรงเรียน 
 2. การด าเนินการหาคุณภาพของบทเรียนอีเลิร์นนิ่ง โดยการประเมินตามแบบประเมินของ
ผู้ทรงคุณวุฒ ิ
 (1)  น าบทเรียนอีเลิร์นนิ่ง ให้ผู้ทรงคุณวุฒิทดลองใช้และตอบแบบประเมิน 
 (2)  น าผลที่ได้ไปวิเคราะห์ข้อมูลทางสถิติ 
 3. การด าเนินการวัดประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง 
 (1)  ผู้วิจัยอธิบายวิธีการเรียนด้วยบทเรียนอีเลริ์นนิ่ง 
 (2)  ให้นักเรียนกลุ่มตัวอย่างเรียนบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ที่ผู้วิจัยพัฒนาขึ้น โดยนักเรียน 1 คน ต่อคอมพิวเตอร์ 1 เครื่อง 
 (3)  ให้นักเรียนกลุ่มตัวอยา่งท าแบบทดสอบระหว่างเรียน (E1) 
 (4)  เมื่อเสร็จสิ้นการเรียน ให้นักเรียนท าแบบทดสอบหลังเรียน เพื่อวัดผลสัมฤทธิ์หลังจาก
เรียนด้วยบทเรียนอีเลิร์นนิ่ง (E2) 
 4. น าผลที่ได้ไปวิเคราะห์หาค่าประสิทธิภาพของบทเรียน (E1/ E2) 
 5. เปรียบเทียบผลสัมฤทธิ์ทางการเรียนระหว่างก่อนเรียนกับหลังเรียน โดยใช้รูปแบบการ
ทดลอง (One group pretest-posttest design) (พรรณี ลีกิจวัฒนะ. 2553 : 287) 
 

แผนภาพการทดลอง 
กลุ่ม วัดกลุ่ม สิ่งทดลอง วัดหลัง 
E T1 X T2 

 

ภาพที่ 3.4 การทดลองแบบกลุ่มเดียวมีการวัดก่อนและหลังเรียนให้สิ่งทดลอง 
 
 โดยที่    E   แทน กลุ่มทดลอง 
 X  แทน การให้สิ่งทดลอง 
 T1 แทน การวัดตัวแปรตามก่อนให้สิ่งทดลอง 
 T2 แทน การวัดตัวแปรตามหลังให้สิ่งทดลอง 
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3.4 การวิเคราะห์ข้อมูล 
 
 ในการวิจัยครั้งนี้ผู้วิจัยได้ด าเนินการวิเคราะห์ข้อมูลตามวัตถุประสงค์ของการวิจัยดังนี้ 
 1. การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง ด้านเนื้อหา และด้านเทคนิคการผลิตสื่อโดย
ใช้สูตรดังนี ้
 1.1 การหาค่าเฉลี่ยเลขคณิต (พรรณี ลีกิจวัฒนะ. 2553 : 244-245) 
 

  สูตร  ̅   
∑ 

 
 

 เม่ือ   ̅  แทน  ค่าเฉลี่ย 
  ∑  แทน  ผลรวมของคะแนนในชุดข้อมูล 
    แทน  จ านวนข้อมูลทั้งหมด 
 

 1.2 การหาส่วนเบี่ยงเบนมาตรฐาน (พรรณ ีลีกิจวัฒนะ. 2553 : 247) 
 

 สูตร   √
∑    ̅  

   
 

 เม่ือ     แทน ส่วนเบ่ียงเบนมาตรฐาน 
    ∑ แทน ผลรวม 

      แทน คะแนนแต่ละตัวในชุดข้อมูล 
     ̅ แทน   ค่าเฉลี่ยของคะแนนในชุดข้อมูล 
      แทน จ านวนข้อมูลทั้งหมด 
 

 2. การค านวณหาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ชั้น
มัธยมศึกษาปีที่ 3 ที่ตั้งไว้ 80 : 80 โดยใช้สูตร E1/E2  (ชัยยงค์ พรหมวงศ์และคณะ. 2521 : 136) 
 

 สูตร     
∑ 

 

 
      ;     

∑ 

 

 
      

 เม่ือ        แทน   คะแนนเฉลี่ยของนักเรียนที่ตอบถูกจากการท าแบบทดสอบระหว่างเรียน   
  คิดเป็นร้อยละ (ประสิทธิภาพของกระบวนการ) 
      แทน   คะแนนเฉลี่ยของนักเรียนที่ตอบถูกจากการท าแบบทดสอบหลังเรียนคิด 
    เป็นร้อยละ (ประสิทธิภาพของผลลัพธ์) 
     ∑   แทน   ผลรวมคะแนนที่ตอบถูกของแบบทดสอบระหว่างเรียน 
  ∑  แทน   ผลรวมคะแนนที่ตอบถูกของแบบทดสอบหลังเรียน 
        แทน   คะแนนเต็มของแบบทดสอบระหว่างเรียน 
      แทน   คะแนนเต็มของแบบทดสอบหลังเรียน 

        แทน   จ านวนนักเรียน 
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 3. การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 ทดสอบหานัยส าคัญความแตกต่างระหว่างคะแนนสอบเฉลี่ย ก่อนเรียนกับหลังเรียนของ
นักเรียนด้วยบทเรียนอีเลิร์นนิ่ง โดยใช้สูตรการหาค่า t-test (Dependent Samples) ดังนี้ (พรรณี ลี
กิจวัฒนะ. 2553 : 273) 
 

 สูตร      
∑ 

√ ∑    ∑   

   

 

 โดยมี          
 เม่ือ    แทน  ค่าสถิติที่ใช้เปรียบเทียบกบัค่าวิกฤติ เพื่อทราบความมนีัยส าคัญ 
    แทน  ผลต่างระหว่างคะแนนทดสอบก่อนเรียนกับหลังเรียน 
  ∑  แทน  ผลรวมของผลต่างระหว่างคะแนนทดสอบก่อนเรียนกับหลังเรียน 
   ∑   แทน  ผลรวมของผลต่างระหว่างคะแนนแต่ละคู่ยกก าลังสอง 
    แทน  จ านวนนักเรียน 
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บทที่ 4 

ผลการวิเคราะห์ข้อมูล 
 
 การวิจัยครั้งนี้ เป็นการศึกษาวิจัยเกี่ยวกับการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร ์CS5 ชั้นมัธยมศึกษาปีที่ 3 ผู้วิจัยได้ผลการวิเคราะห์ข้อมูล ดังนี ้
 4.1 ผลการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
 4.2 ผลการวิเคราะห์หาคณุภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
 4.3 ผลการวิเคราะห์หาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ 
CS5 
 4.4 ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
 

4.1 ผลการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
  

 ผลการพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับนักเรียนชั้น
มัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม ประจ าภาคเรียนที่ 2 ปีการศึกษา 2557 ที่ผู้วิจัยได้ท าการ
พัฒนาขึ้นนั้น ผู้วิจัยได้บรรจุบทเรียนอีเลิร์นนิ่งไว้ที่ http://www.dreamweaver-elearning.com
เมื่อนักเรียนได้ท าการลงทะเบียนเรียนเรียบร้อยแล้วก็จะพบกับหน้าเมนูหลัก ซึ่งประกอบไปด้วยเมนู
ย่อย ๆ ดังนี ้

- เมนูค าแนะน าการใช้บทเรียน 
- เมนูจุดประสงค์การเรียนรู ้
- เมนูแบบทดสอบก่อนเรียน 
- เมนูบทที่ 1 หลักการสร้างเว็บไซต์ด้วยโปรแกรม Dreamweaver 
- เมนบูทที่ 2 การใส่และตกแต่งข้อความบนเว็บเพจ 
- เมนูบทที่ 3 การใส่ภาพประกอบเว็บเพจ 
- เมนูบทที่ 4 การสร้างไฮเปอร์ลิงค์ 
- เมนูบทที่ 5 การจัดหน้าเว็บเพจด้วยตาราง 
- เมนูบทที่ 6 การแบ่งหน้าเว็บเพจด้วยเฟรม 
- เมนูบทที่ 7 การเล่นมัลติมีเดียบนเว็บเพจ 
- เมนูแบบทดสอบหลังเรียน 
- เมนูผู้จัดท า 

 การเรียงล าดับขั้นตอนการใช้บทเรียนอีเลิร์นนิ่งนั้น จะต้องเริ่มศึกษาค าแนะน าการใช้บทเรียน
แล้วท าการศึกษาจุดประสงค์การเรียนรู้ จากนั้นให้ท าแบบสอบก่อนเรียนจ านวน 40 ข้อ เมื่อท าเอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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แบบทดสอบก่อนเรียนแล้วให้นักเรียนเข้าไปศึกษาเนื้อหา โดยในส่วนของเนื้อหาบทเรียนนั้นมีทั้งหมด 
7 หน่วยเรียน ซึ่งแต่ละหน่วยการเรียนจะมีแบบทดสอบระหว่างเรียนเพ่ือวัดความรู้ที่ได้จากการเรียนที่
ผ่านมา เป็นข้อสอบแบบปรนัยแบบตัวเลือก มีจ านวนทั้งหมด 61 ข้อ โดยแบ่งข้อสอบระหว่างเรียน
ตามความเหมาะสมขอเน้ือหาแต่ละหน่วยการเรียน ดังนี้  

- หน่วยการเรียนที่ 1 มี 10 ข้อ 
- หน่วยการเรียนที่ 2 มี 10 ข้อ 
- หน่วยการเรียนที่ 3 มี 10 ข้อ 
- หน่วยการเรียนที่ 4 มี 8 ข้อ 
- หน่วยการเรียนที่ 5 มี 10 ข้อ 
- หน่วยการเรียนที่ 6 มี 7 ข้อ 
- หน่วยการเรียนที่ 7 มี 6 ข้อ 

 หลังจากที่นักเรียนศึกษาบทเรียนและท าแบบทดสอบระหว่างเรียนครบทั้งหมดแล้ว ให้นักเรียน
ท าแบบทดสอบหลังเรียน จ านวน 40 ข้อ ซึ่งทุกครั้งที่มีการท าแบบทดสอบนักเรียนสามารถรู้คะแนน
หลังสอบทันทีพร้อมทั้งเฉลยค าตอบที่ถูกต้อง นอกจากนั้นยังมีเมนูติดต่อผู้จัดท าในกรณีที่นักเรียนมีข้อ
สงสัยเกี่ยวกับบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 เพื่อส่งข้อความหาผู้สอนได้
ทันที 
 

4.2 ผลการวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟ
เวอร์ CS5 

 
 การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับ
นักเรียนชั้นมัธยมศึกษาปีที่ 3 ผู้วิจัยได้ขอความอนุเคราะห์จากผู้ทรงคุณวุฒิ 3 ท่าน เป็นผู้ประเมิน
บทเรียนอีเลิร์นนิ่ง เพื่อท าการประเมินคุณภาพด้านเนื้อหาและด้านเทคนิคการผลิต มีผลการประเมิน
ดังตารางที่ 4.1   
 
ตารางที่ 4.1  ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และระดับคุณภาพของบทเรียนอีเลิร์นนิ่ง 

ด้าน  ̅ S ระดับคณุภาพ 
เนื้อหาของบทเรียน 4.51 0.21 ดีมาก 
เทคนิคการผลติสื่อ 4.63 0.19 ดีมาก 

รวม 4.57 0.21 ดีมาก 
 

 จากตารางที่ 4.1 การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟ 
เวอร์ CS5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที ่3 พบว่า มีคุณภาพอยู่ในระดับดีมาก โดยมีค่าเฉลี่ยเท่า เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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กับ 4.57 ส่วนเบี่ยงเบนมาตรฐานเท่ากับ 0.22 เมื่อพิจารณาเป็นรายด้านพบว่า มีคุณภาพด้านเนื้อหา
ของบทเรียนอยู่ในระดับดีมาก ( ̅= 4.51, S = 0.21) และมีคุณภาพด้านเทคนิคการผลิตสื่อในระดับดี
มาก ( ̅= 4.63, S = 0.19) ซ่ึงไม่น้อยกว่าระดับดีเป็นไปตามสมมุติฐานที่ตั้งไว้  
 

 4.1.1 การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ด้านเนื้อหา ซึ่งได้ผ่านการประเมินโดยผู้ทรงคุณวุฒิ 3 ท่าน ดัง
สรุปรายละเอียดในตารางที่ 4.2 
 
ตารางที ่4.2  ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และระดับคณุภาพด้านเนื้อหา 

รายการประเมิน  ̅ S ระดับคณุภาพ 

1.  ด้านการน าเสนอเนื้อหา       

1.1  เนื้อหามีความสอดคล้องกับวัตถูประสงค์ 4.33 0.58 ดี 

1.2  ความเหมาะสมในการจดัแบ่งเนื้อหาในการ
น าเสนอแต่ละหน้า 

4.67 0.58 ดีมาก 

1.3  การเรียงล าดับเนื้อหาในแต่ละบทเรียน 4.67 0.58 ดีมาก 

1.4  ความครบถ้วนของเนื้อหาบทเรียน 4.67 0.58 ดีมาก 

1.5  ปริมาณเนื้อหาเหมาะสมในบทเรียน 4.33 1.15 ดี 

1.6  รูปแบบการน าเสนอเนื้อหาง่ายต่อการเข้าใจ 4.67 0.58 ดีมาก 

1.7  บทเรียนมีลักษณะจงูใจน่าสนใจในการเรียน 4.67 0.58 ดีมาก 

2.  ด้านความถูกต้องของเนื้อหา       

2.1  ความถูกต้องของเนื้อหา 4.33 0.58 ดี 

2.2  เนื้อหามีความสอดคล้อง เชื่อมโยงกัน 4.33 0.58 ดี 

2.3  ความถูกต้องของการใชภ้าษา 4.00 1.00 ดี 

2.4  ค าศัพท์มีความถูกต้องตามเนื้อหาวิชา 4.33 1.15 ดี 

3.  ด้านแบบทดสอบและผลย้อนกลับ       

3.1  ความเหมาะสมของค าถามต่อเนื้อหา 4.67 0.58 ดีมาก 

3.2  ความเหมาะสมของจ านวนข้อในแบบฝึกหัด 4.67 0.58 ดีมาก 

3.3  วิธีการให้ผลย้อนกลับ 4.67 0.58 ดีมาก 

3.4  ลักษณะผลย้อนกลับ 4.67 0.58 ดีมาก 

รวม 4.51 0.21 ดีมาก 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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 จากตารางที่ 4.2 พบว่า การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร์ CS5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ด้านเนื้อหา พบว่า มีคุณภาพอยู่ในระดับดี
มาก โดยมีค่าเฉลี่ยรวมเท่ากับ 4.51 และส่วนเบี่ยงเบนมาตรฐานเท่ากับ 0.21 เมื่อพิจารณารายการ
ประเมินที่มีค่าเฉลี่ยสูงสุดคือ 4.67 มีทั้งหมด 9 รายการ ได้แก่ ความเหมาะสมในการจัดแบ่งเนื้อหาใน
การน าเสนอแต่ละหน้า การเรียงล าดับเนื้อหาในแต่ละบทเรียน ความครบถ้วนของเนื้อหาบทเรียน 
รูปแบบการน าเสนอเนื้อหาง่ายต่อการเข้าใจ บทเรียนมีลักษณะจูงใจน่าสนใจในการเรียน ความ      
เหมาะสมของค าถามต่อเนื้อหา ความเหมาะสมของจ านวนข้อในแบบฝึกหัด วิธีการให้ผลย้อนกลับ 
ลักษณะผลย้อนกลับ รองลงมามีค่าเฉลี่ย 4.33 มี 5 รายการ ได้แก่ เนื้อหามีความสอดคล้องกับ
วัตถุประสงค์ ปริมาณเนื้อหาเหมาะสมในบทเรียน ความถูกต้องของเนื้อหา เนื้อหามีความสอดคล้อง 
เชื่อมโยงกัน ค าศัพท์มีความถูกต้องตามเนื้อหาวิชา และค่าเฉลี่ย 4.00 มี 1 รายการ ได้แก่ ความ
ถูกต้องของการใช้ภาษา  
 

 4.1.2 การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ด้านเทคนิคการผลิตสื่อ ซึ่งได้ผ่านการประเมินโดยผู้ทรงคุณวุฒิ 
3 ท่าน ดังสรุปรายละเอียดในตารางที่ 4.3 
 
ตารางที่ 4.3  ค่าเฉลี่ย ส่วนเบี่ยงเบนมาตรฐาน และระดับคุณภาพด้านเทคนิคการผลิตสื่อ 

รายการประเมิน  ̅ S ระดับคณุภาพ 

1.  ด้านตัวอักษร 

1.1  ขนาดของตัวอักษรสวยงาม 5.00 0.00 ดีมาก 

1.2  รูปแบบตัวอักษรอ่านง่าย และชัดเจน 4.67 0.58 ดีมาก 

1.3  ความเหมาะสมของสีตัวอักษรและสีของพื้นที่ใช ้ 4.67 0.58 ดีมาก 

1.4  ความเหมาะสมของการจัดวางตัวอักษร/ข้อความในแต่
ละกรอบ 

4.67 0.58 ดีมาก 

1.5  ความถูกต้องของข้อความตามหลักภาษา 4.00 1.00 ดี 

2.  ด้านภาพนิ่ง 

2.1  ขนาดของภาพเหมาะสม 4.67 0.58 ดีมาก 

2.2  สีและความชัดเจนของภาพ 4.67 0.58 ดีมาก 

2.3  ความเหมาะสมของภาพที่ใช้ในการสื่อ 4.67 0.58 ดีมาก 

2.4  ความสมดุลของการจัดวางภาพในแตล่ะกรอบ 4.67 0.58 ดีมาก 

3.  ด้านภาพเคลื่อนไหว 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ตารางที่ 4.3 (ต่อ) 

รายการประเมิน  ̅ S ระดับคณุภาพ 

3.1  ขนาดของภาพเคลื่อนไหวเหมาะสม 4.67 0.58 ดีมาก 

3.2  ความชัดเจนของภาพเคลื่อนไหว 4.67 0.58 ดีมาก 

3.3  ความเหมาะสมของภาพเคลื่อนไหวที่ใช้ในการสื่อ
ความหมาย 

4.67 0.58 ดีมาก 

4.  ด้านเสียง 

4.1  ระดับความดังของเสียงบรรยายมีความเหมาะสม 4.67 0.58 ดีมาก 

4.2  ความชัดเจนของเสียงทีอ่ธิบาย 4.67 0.58 ดีมาก 

5.  ด้านปฏิสัมพันธ ์

5.1  การควบคุมบทเรียนท าได้ง่ายและสะดวก 4.67 0.58 ดีมาก 

5.2  เปิดโอกาสให้ผู้เรียนโต้ตอบกับบทเรียน  4.33 1.15 ดี 

5.3  ความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วย
การเรียน 

4.67 0.58 ดีมาก 

5.4  ความเหมาะสมของการเชื่อมโยง ระหว่างบทเรียนแตล่ะ
หน่วยการเรียน 

4.67 0.58 ดีมาก 

5.5  รูปแบบการโต้ตอบกับบทเรียนเป็น มาตรฐานเดียวกัน 4.67 0.58 ดีมาก 

รวม 4.63 0.19 ดีมาก 

 
 จากตารางที่ 4.3 พบว่า การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร์ CS5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ด้านเทคนิคการผลิตสื่อ พบว่า มีคุณภาพอยู่
ในระดับดีมาก โดยมีค่าเฉลี่ยรวมเท่ากับ 4.63 และส่วนเบี่ยงเบนมาตรฐานเท่ากับ 0.19 เมื่อพิจารณา
รายการประเมินที่มีค่าเฉลี่ยสูงสุดคือ 5.00 มีทั้งหมด 1 รายการ ได้แก่ ขนาดของตัวอักษรสวยงาม 
รองลงมามีค่าเฉลี่ย 4.67 มีทั้งหมด 16 รายการ ได้แก่ รูปแบบตัวอักษรอ่านง่าย และชัดเจน ความ
เหมาะสมของสีตัวอักษรและสีของพื้นที่ใช้ ความเหมาะสมของการจัดวางตัวอักษร/ข้อความในแต่ละ
กรอบ ขนาดของภาพเหมาะสม สีและความชัดเจนของภาพ ความเหมาะสมของภาพที่ใช้ในการสื่อ 
ความสมดุลของการจัดวางภาพในแต่ละกรอบ ขนาดของภาพเคลื่อนไหวเหมาะสม ความชัดเจนของ
ภาพเคลื่อนไหว ความเหมาะสมของภาพเคลื่อนไหวที่ใช้ในการสื่อความหมาย ระดับความดังของเสียง
บรรยายมีความเหมาะสม ความชัดเจนของเสียงที่อธิบาย การควบคุมบทเรียนท าได้ง่ายและสะดวก 
ความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วยการเรียน ความเหมาะสมของการเชื่อมโยง 
ระหว่างบทเรียนแต่ละหน่วยการเรียน รูปแบบการโต้ตอบกับบทเรียนเป็น มาตรฐานเดียวกัน ค่าเฉลี่ย 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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4.33 มี 1 รายการ ได้แก่ เปิดโอกาสให้ผู้เรียนโต้ตอบกับบทเรียน และค่าเฉลี่ย 4.00 มี 1 รายการ 
ได้แก ่ความถูกต้องของข้อความตามหลักภาษา 
 

4.3 ผลการวิเคราะห์หาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 

 
 การวิเคราะห์หาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ผู้วิจัยได้ทดลองใช้กับกลุ่มตัวอย่างที่เป็นนักเรียนระดับชั้นมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
จ านวน 30 คน โดยน าผลคะแนนจากแบบทดสอบระหว่างเรียนและผลคะแนนสอบหลังเรียนมา
เปรียบเทียบกัน โดยใช้เกณฑ์การหาประสิทธิภาพ 80/80 ซึ่งได้ผลลัพธ์ดังตารางที่ 4.4 
 
ตารางที่ 4.4  ประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 

ผลการ
ทดลอง 

จ านวน
นักเรียน 

คะแนน ค่าเฉลี่ย
ร้อยละ 

ประสิทธิภาพของบทเรียน 
(E1/E2) ที่ค านวณได ้คะแนนเต็ม คะแนนเฉลี่ย 

ระหว่างเรียน 
30 

61 50.27 82.41 
82/88 

หลังเรียน 40 35.17 87.93 
 
 จากตารางที่  4.4 พบว่า บทเรียนอีเลิร์นนิ่งเรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 มี
ประสิทธิภาพของกระบวนการเท่ากับ 82.00 และประสิทธิภาพของผลลัพธ์เท่ากับ 88.00 ซึ่งเป็น
ประสิทธิภาพ E1/E2 เท่ากับ 82.00/88.00 ซึ่งไม่น้อยกว่า 80/80 เป็นไปตามสมมุติฐานที่ตั้งไว้ 
 

4.4 ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนเรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 

 
 การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน ก่อนเรียนกับหลังเรียน ด้วยบทเรียน 
อีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ผู้วิจัยได้ทดลองใช้กับกลุ่มตัวอย่าง ซึ่งได้ผลลัพธ์ดัง
ตารางที่ 4.5 
 
ตารางที่ 4.5  การเปรียบเทียบผลสัมฤทธ์ิทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ผลสัมฤทธิ์ทางการเรยีน n คะแนนเต็ม  ̅   t-test Sig 

ก่อนเรียน 
30 40 

19.73 8.1 
-10.93* 0.000 

หลังเรียน 35.17 4.31 
* Sig < .05 
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       จากตารางที่ 4.5 พบว่า ผลสัมฤทธิ์ทางการเรียนของนักเรียน หลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง 
เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 สูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 เป็นไป
ตามสมมุติฐานที่ตั้งไว้ 
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บทท่ี 5 

สรุปผลการวิจัย อภิปรายผล และข้อเสนอแนะ 
 

5.1 สรุปผลการวิจัย 
 
 5.1.1 วัตถุประสงค์ของการวิจัย 
 1. เพ่ือพัฒนาบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ที่มีคุณภาพและ      
ประสิทธิภาพ ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
 2. เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ของนักเรียน 
ชั้นมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม ก่อนเรียนกับหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง 
 

 5.1.2 สมมติฐานของการวิจัย 
 ผลสัมฤทธิ์ทางการเรียนของนักเรียนหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีม
วีฟเวอร์ CS5 ชั้นมัธยมศึกษาปีที่ 3 สูงกว่าก่อนเรียน 
 

 5.1.3 ประชากรและกลุ่มตัวอย่าง 
 ประชากรที่ใช้ในวิจัย คือ นักเรียนโรงเรียนโนนกุงวิทยาคม อ าเภอตระการพืชผล จังหวัด
อุบลราชธานี สังกัดส านักงานเขตพ้ืนที่การศึกษามัธยมศึกษา เขต 29 ภาคเรียนที่ 2 ปีการศึกษา 
2557 จ านวน 3 ห้อง มีนักเรียนห้องละ 30 คน รวมทั้งหมด 90 คน 
 กลุ่มตัวอย่างท่ีใช้ในการวิจัย คือ นักเรียนชั้นมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม อ าเภอ
ตระการพืชผล จังหวัดอุบลราชธานี สังกัดส านักงานเขตพ้ืนที่การศึกษามัธยมศึกษา เขต 29 ภาคเรียน
ที่ 2 ปีการศึกษา 2557 ซึ่งได้มาจากการจับสลากนักเรียนมา 1 ห้องเรียน มีนักเรียนจ านวน 30 คน 
 

 5.1.4 เครื่องมือที่ใช้ในการวิจัย 
 เครื่องมือที่ใช้ในการวิจัย ประกอบด้วย 
 1. บทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ซึ่งแบ่งเนื้อหาออกเป็น 7 หน่วย
การเรียน ซึ่งในแต่ละหน่วยมีการท าแบบทดสอบระหว่างเรียน 
 2. แบบประเมินคุณภาพบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับ
ผู้ทรงคุณวุฒิ 2 ฉบับ คือ 1) ด้านเนื้อหา 2) ด้านเทคนิคการผลิตสื่อ เป็นแบบมาตราส่วนประมาณค่า 
5 ระดับ (Rating Scales) ซ่ึงได้รับความอนุเคราะห์ตรวจสอบความเที่ยงตรงจากผู้ทรงคุณวุฒิจ านวน 
3 ท่าน 
 3. แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ 
CS5 ก่อนเรียนและหลังเรียน เป็นแบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จ านวน 40 ข้อ เกณฑ์การให้
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คะแนนข้อที่ถูกได้ 1 คะแนน ข้อที่ผิดหรือไม่ตอบได้ 0 คะแนน มีค่าดัชนีความสอดคล้องระหว่าง 
0.67 - 1.00 ค่าความยากง่ายระหว่าง 0.23 – 0.80 ค่าอ านาจจ าแนกระหว่าง 0.20 – 0.47 และค่า
ความเชื่อถือได้เท่ากับ 0.81 
 

 5.1.5 การเก็บรวบรวมข้อมูล 
 ผู้วิจัยด าเนินการทดลองและเก็บรวบรวมข้อมูลกลุ่มตัวอย่าง ซึ่งเป็นนักเรียนระดับชั้น
มัธยมศึกษาปีที่ 3 โรงเรียนโนนกุง ภาคการศึกษาที่ 2 ปีการศึกษา 2557 มีการเก็บรวบรวมข้อมูล  
ดังขั้นตอนต่อไปนี้ 
 1. น าหนังสือขอความร่วมมือในการท าการวิจัยจากคณะครุศาสตร์อุตสาหกรรม สถาบัน
เทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง ส่งให้ผู้อ านวยการโรงเรียนโนนกุงวิทยาคม อ าเภอ
ตระการพืชผล จังหวัดอุบลราชธานี เพื่อขออนุญาตในการเก็บรวบรวมข้อมูล 
 2. การด าเนินการหาคุณภาพของบทเรียนอีเลิร์นนิ่ง โดยน าบทเรียนอีเลิร์นนิ่งให้ผู้ทรงคุณวุฒิ
ทดลองใช้และประเมินตามแบบประเมินส าหรับผู้ทรงคุณวุฒิ จากนั้นน าผลที่ได้ไปวิเคราะห์ข้อมูล  
ทางสถิต ิ
 3. การด าเนินการทดลองตามแบบการทดลองแบบกลุ่มเดียว มีการวัดก่อนและหลังให้สิ่ง
ทดลอง โดยน าบทเรียนอีเลิร์นนิ่งไปใช้กับนักเรียนกลุ่มตัวอย่าง โดยให้กลุ่มตัวอย่างท าแบบทดสอบ
ก่อนเรียน (Pretest) จากนั้นให้นักเรียนด าเนินกิจกรรมการเรียนรู้ด้วยตนเองเมื่อเสร็จการเรียนในแต่
ละหน่วยให้นักเรียนท าแบบทดสอบระหว่างเรียน เมื่อเสร็จสิ้นการเรียนหมดทุกหน่วยการเรียนแล้ว 
ให้นักเรียนท าแบบทดสอบหลังเรียน (Post-test)  
 4. หาประสิทธิภาพของบทเรียน โดยการหาประสิทธิภาพของกระบวนการ ( E1) ได้จาก
แบบทดสอบระหว่างเรียน และค่าประสิทธิภาพของผลลัพธ์ (E2) ซึ่งได้จากแบบทดสอบหลังเรียน โดย
ค านวณตามสูตร E1/E2 

 5. เปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน จากแบบทดสอบก่อนเรียนและ
แบบทดสอบหลังเรียน และน าผลที่ได้ไปเปรียบเทียบหาค่าความแตกต่างของผลสัมฤทธิ์ทางการเรียน 
โดยวิเคราะห์ข้อมูลทางสถิติ t-test แบบ Dependent samples ที่ระดับนัยส าคัญทางสถิติที่ .05 
 

 5.1.6 การวิเคราะห์ข้อมูล 
 ในการวิจัยครั้งนี้ ผู้วิจัยได้น าข้อมูลที่ได้จากการทดลองมาวิเคราะห์ตามวัตถุประสงค์ของการ 
วิจัยดังนี้ 
 1. การวิเคราะห์หาคุณภาพของบทเรียนอีเลิร์นนิ่งด้านเนื้อหา และด้านเทคนิคการผลิตสื่อ 
ใช้สถิต ิ( ̅) ค่าเฉลี่ยและส่วนเบี่ยงเบนมาตรฐาน (S) จากการประเมินของผู้ทรงคุณวุฒิด้านเนื้อหา และ
ด้านการผลิตสื่อ 
 2. การค านวณหาประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
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วิเคราะห์จากคะแนนการท าแบบทดสอบระหว่างเรียน และแบบทดสอบหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง
โดยใช้สูตร E1/E2 
 3. การเปรียบเทียบผลสัมฤทธิ์ทางการเรียน เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ของนักเรียน
ชั้นมัธยมศึกษาปีที่ 3 ก่อนเรียนกับหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง ใช้สถิติการทดสอบที แบบสอง
กลุ่มไม่เป็นอิสระต่อกัน (Dependent Samples t-test) 
 

 5.1.7 สรุปผลการวิจัย 
 จากการวิจัยตามขั้นตอนดังกล่าว สามารถสรุปผลการวิจัย ได้ดังต่อไปนี้ 
 1. บทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 มีคุณภาพด้านเนื้ออยู่ในระดับดี
มาก ( ̅= 4.51) และมีคุณภาพด้านเทคนิคการผลิตสื่อในระดับดีมาก ( ̅= 4.63)  
 2. บทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 มีประสิทธิภาพ E1/E2 เท่ากับ 
82.00/88.00 ซึ่งมีประสิทธิภาพเป็นไปตามเกณฑ์ที่ก าหนดไว้ คือ 80/80 
 3. ผลสัมฤทธิ์ทางการเรียนของนักเรียนหลังเรียนด้วยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร์ CS5 สูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
 

5.2 อภิปรายผล 
 

 จากผลการวิจัยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับนักเรียนชั้น
มัธยมศึกษาปีที ่3 สามารถอภิปรายผลได้ดังนี้ 
 

 5.2.1 คุณภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับ
นักเรียนชั้นมัธยมศึกษาปีท่ี 3 
 บทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 มีคุณภาพด้านเนื้อหาอยู่ในระดับดี
มาก ( ̅=4.51) และคุณภาพด้านเทคนิคการผลิตสื่ออยู่ในระดับดีมาก ( ̅=4.63) ทั้งนี้เนื่องจากการ
สร้างบทเรียนอเีลิร์นนิ่งผู้วิจัยได้พัฒนาขึ้นโดยด าเนินการตามขั้นตอนการพัฒนาบทเรียนตามหลักการ
ออกแบบของ ADDIE Model อ้างใน ฉัตรพงศ์ ชูแสงนิล (2555) [ออนไลน์] ซึ่งมีขั้นตอนการพัฒนา
บทเรียนอีเลิร์นนิ่ง 5 ขั้นตอน ได้แก่ ขั้นการวิเคราะห์ ขั้นการออกแบบ ขั้นการพัฒนา ขั้นการน าไปใช้ 
และขั้นการประเมินผล ทั้งนี้ในส่วนของเนื้อหาได้มีการวิเคราะห์แล้วแบ่งเนื้อหาออกเป็นหน่วยการ
เรียนรู้ ก าหนดจุดประสงค์การเรียนรู้ สร้างแบบทดสอบก่อนเรียน ระหว่างเรียนและหลังเรียนตาม
กรอบแนวคิด โดยเนื้อหามีความสอดคล้องกับจุดประสงค์การเรียนรู้ อีกทั้งคุณภาพด้านเทคนิคการ
ผลิตสื่อ มีการออกแบบให้มีความเหมาะสมระหว่างบทเรียนกับผู้เรียน ในการพัฒนาบทเรียนอีเลิร์นนิ่ง
ได้ออกแบบให้หน้าจอมีขนาดตัวอักษร สี รูปภาพ มีความเหมาะสมกับเนื้อหา ความสวยงาม ชัดเจน 
ง่ายต่อการใช้งาน ทันสมัย และมีรูปแบบการน าเสนอที่กระตุ้นให้ผู้เรียนเกิดความอยากรู้อยากเรียน 
โดยแทรกเสียงและภาพเคลื่อนไหวลงในสื่อการเรียน เพ่ือให้การน าเสนอน่าสนใจมากยิ่งขึ้น รวมทั้งมี

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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แบบทดสอบท่ีให้ผลย้อนกลับในทันที เป็นการสร้างปฏิสัมพันธ์ระหว่างผู้เรียนกับบทเรียน ซึ่งจะส่งผล
ให้ผู้เรียนเกิดการเรียนรู้ที่ดียิ่งขึ้น นอกจากนี้ยังมีการตรวจสอบความบกพร่องของบทเรียนโดย
ผู้ทรงคุณวุฒิ เพ่ือน าข้อบกพร่องมาเป็นข้อมูลส าหรับการแก้ไขปรับปรุงบทเรียนให้มีความสมบรูณ์
ยิ่งขึ้น ซึ่งสอดคล้องกับงานวิจัยของ ธนพงศ์ จันทร์สุข (2557 : 62-63) ได้ท าวิจัยเรื่อง การพัฒนา
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพื่อทบทวน เรื่องตัวแปรและค่าคงที่ พบว่า ด้านเนื้อหา มีคุณภาพ
อยู่ในระดับดีมาก ( ̅=4.59) และด้านเทคนิคผลิตสื่อ มีคุณภาพอยู่ในระดับดีมาก ( ̅=4.68) และ
สอดคล้องกับงานวิจัยของ จิระพร ศิริมา (2554 : 52-54) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ตเพ่ือการทบทวน วิชาคอมพิวเตอร์ เรื่อง การสร้างงานฐานข้อมูลเบื้องต้นด้วย
โปรแกรมไมโครซอฟต์แอคเซส ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 พบว่า บทเรียนผ่านเครือข่าย
อินเทอร์เน็ตเพื่อการทบทวน มีคุณภาพเนื้อหาในระดับดีมาก ( ̅= 3.93) และคุณภาพด้านเทคนิคการ
ผลิตสื่ออยู่ในระดับดีมาก ( ̅ = 3.91) 
 

 5.2.2 ประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ส าหรับ
นักเรียนชั้นมัธยมศึกษาปีท่ี 3 
 ผลการค านวณค่าประสิทธิภาพของบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 ตามสูตร E1/E2 ของ ชัยยงค์ พรหมวงศ์ พบว่า มีประสิทธิภาพ
ของกระบวนการเท่ากับ 82.00และประสิทธิภาพของผลลัพธ์เท่ากับ 88.00 ซึ่งมีประสิทธิภาพเป็นไป
ตามเกณฑ์ท่ีก าหนดไว้ คือ 80/80 ถือว่ามีประสิทธิภาพ ทั้งนี้สืบเนื่องมาจากบทเรียนอีเลิร์นนิ่งที่สร้าง
ขึ้นมีความน่าสนใจ เนื้อหาเข้าใจง่าย ไม่ซับซ้อน มีแบบทดสอบระหว่างเรียน  หลังเรียนเนื้อหาแต่ละ
บทเพ่ือทบทวนความรู้ท าให้เกิดทักษะและจ าได้ และมีแบบทดสอบหลังเรียนเพ่ือวัดผลสัมฤทธิ์
ทางการเรียนเมื่อเรียนครบทุกหน่วย เพ่ือทดสอบระดับความรู้ ความเข้าใจของตนเอง การสร้าง
บทเรียนอีเลิร์นนิ่งมีกระบวนการและข้ันตอนที่เชื่อถือได้ มีการออกแบบอย่างเป็นระบบ สามารถน าไป
ประกอบการเรียนการสอนได้จริงและบทเรียนได้ผ่านการประเมินจากผู้ทรงคุณวุฒิ ด้านเนื้อหาและ
ด้านเทคนิคการผลิตสื่อ และผ่านการทอสลองใช้มาแล้ว 2 ครั้ง เพื่อหาข้อผิดพลาดของบทเรียน พร้อม
ทั้งน าข้อบกพร่องมาปรับปรุงแก้ไขก่อนน ามาทดลองใช้กับกลุ่มตัวอย่าง ดังนั้นจึงท าให้บทเรียนอีเลิร์
นนิ่งมีประสิทธิภาพเป็นไปตามเกณฑ์ที่ก าหนด เนื่องจากนักเรียนได้เรียนเนื้อหาแต่ละหน่วยการเรียน
จบแล้วท าแบบทดสอบระหว่างเรียน ซึ่งเป็นการเปดดโอกาสให้นักเรียนสามารถประเมินผลการเรียน
ของตนเองได้และทบทวนความรู้เดิม โดยมีการสร้างข้อสอบให้สอดคล้องกับจุดประสงค์เชิงพฤติกรรม
และเนื้อหาของบทเรียน ท าให้นักเรียนตอบค าถามได้ ส่วนแบบทดสอบหลังเรียน นักเรียนต้องเรียน
เนื้อหาในแต่ละหัวข้อให้จบ ซึ่งเนื้อหาในแต่ละหน่วยการเรียนจะสอดคล้องเชื่อมโยงความรู้เดิมกับ
ความรู้ใหม่ มีความต่อเนื่องของบทเรียน จึงท าให้คะแนนแบบทดสอบหลังเรียนสูงกว่าก่อนเรียน ซึ่ง
สอดคล้องกับงานวิจัยของ ภัคจิรา รอดพ้น (2553 : 88-92) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียน             

อีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียนเรื่องประวัติศาสตร์สุโขทัย ส าหรับนักเรียนชั้น
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มัธยมศึกษาปีที่ 1 ซึ่งผลการวิจัยพบว่า บทเรียนอีเลิร์นนิงที่มีฐานความช่วยเหลือทางการเรียน มี
ประสิทธิภาพเท่ากับ 80.87/80.99 เป็นไปตามเกณฑ์ที่ก าหนด 80/80 และสอดคล้องกับงานวิจัยของ 
สามมิติ สุขบรรจง (2554 : 53) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียน E-Learning รายวิชา “การแสดงและ
สื่อ” ซึ่งผลการวิจัยพบว่าการทดลองครั้งที่ 1 บทเรียนมีประสิทธิภาพเท่ากับ 82.00/84.40 การทดลอง
ครั้งที่ 2 บทเรียนมีประสิทธิภาพเท่ากับ 83.20/85.20 และการทดลองครั้งที่ 3 บทเรียนมีประสิทธิภาพ
เท่ากับ 85.20/86.80 เป็นไปตามสมมติฐานที่ตั้งไว้ โดยมีประสิทธิภาพของกระบวนการวัดผลคะแนน
เฉลี่ยเท่ากับ 83.47 และประสิทธิภาพของการวัดผลคะแนนแบบทดสอบหลังการเรียนเฉลี่ยเท่ากับ 
85.47        
 

 5.2.3 การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี 
ดรีมวีฟเวอร์ CS5 ของนักเรียนชั้นมัธยมศึกษาปีท่ี 3 
 ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟ
เวอร์ CS5 พบว่า คะแนนเฉลี่ยก่อนเรียนเท่ากับ 19.73 และคะแนนเฉลี่ยหลังเรียนเท่ากับ 35.17 เมื่อ
น ามาทดสอบทางสถิติโดยใช้ t-test แบบ dependent samples พบว่า ผลสัมฤทธิ์ทางการเรียนของ
นักเรียนหลังเรียนมีค่าสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 เป็นไปตามสมมติฐาน
ที่ตั้งไว้  ทั้งนี้บทเรียนอีเลิร์นนิ่งที่ผู้วิจัยได้สร้างขึ้น เป็นบทเรียนที่มีเนื้อหาของบทเรียนสอดคล้องกับ
วัตถุประสงค์การเรียนรู้ เนื้อหา การจัดล าดับเนื้อหา สามารถประเมินผลการเรียนของนักเรียนได้จาก
แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน โดยวัดพฤติกรรมทางด้านพุทธิพิสัยในระดับ ความรู้ – 
ความจ า ความเข้าใจ และการน าไปใช้ ตามความคิดของ ภพ เลาหไพบูลย์ (2537 : 161-165) โดย
การพัฒนาบทเรียนได้มีการทดสอบความรู้ของนักเรียนจากแบบทดสอบก่อนเรียน ระหว่างเรียน และ
หลังเรียน และเป็นการเปดดโอกาสให้นักเรียนประเมินตนเอง หลังจากท่ีมีการท าแบบเสร็จในแต่ละครั้ง
จะมีผลย้อนกลับทันทีพร้อมทั้งเฉลยค าตอบ เพ่ือให้เกิดการเรียนรู้อย่างมีประสิทธิภาพมากขึ้น ส่งผล
ให้บทเรียนอีเลิร์นนิ่ง มีผลสัมฤทธิ์ทางการเรียน หลังเรียนสูงกว่าก่อนเรียน ซึ่งสอดคล้องกับงานวิจัย
ของ จิระพร ศิริมา (2554 : 52-54) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือ
การทบทวน วิชาคอมพิวเตอร์ เรื่อง การสร้างงานฐานข้อมูลเบื้องต้นด้วยโปรแกรมไมโครซอฟต์แอคเซส
ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 3 มีการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ตเพื่อการทบทวนหลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
และสอดคล้องกับงานวิจัยของ วรัญญา มีฮะ (2553 : บทคัดย่อ) ได้ท าวิจัยเรื่อง การพัฒนาบทเรียน
อิเล็กทรอนิกส์ (e-learning) เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ ชั้นมัธยมศึกษาปีที่ 3 
พบว่า ผลสัมฤทธิ์ทางการเรียน เรื่องการสื่อสารข้อมูลและเครือข่ายคอมพิวเตอร์ แตกต่างกันอย่างมี
นัยส าคัญทางสถิติระดับ.05 โดยผลสัมฤทธิ์ของนักเรียนที่เรียนด้วยบทเรียนอิเล็กทรอนิกส์ (e-learning) 
สูงกว่านักเรียนที่เรียนแบบปกติ  
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5.3 ข้อเสนอแนะ 
 

 5.3.1 ข้อเสนอแนะเพื่อการน าผลวิจัยไปใช้ 
 1. ครูผู้สอนสามารถน าบทเรียนอีเลิร์นนิ่ง เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5 ไปใช้ในการ
จัดกิจกรรมการเรียนการสอนได้และเป็นแนวทางในการสร้างบทเรียนอีเลิร์นนิ่งรายวิชาอ่ืน ๆ 
 2. บทเรียนอีเลิร์นนิ่ง อ านวยความสะดวกให้ผู้เรียนสามารถเรียนได้ทุกที่และทุกเวลา จึงควร
สนับสนุนให้นักเรียนเรียนเกิดการเรียนรู้ด้วยตนเองมากข้ึน 
 3. ผู้เรียนควรมีความรู้เบื้องต้นเกี่ยวกับการใช้งานคอมพิวเตอร์ เพ่ือความคล่องตัวในการใช้
บทเรียนอีเลิร์นนิ่งที่สร้างขึ้น 
 

 5.3.2 ข้อเสนอแนะเพื่อการวิจัยครั้งต่อไป 
 1. ควรพัฒนาบทเรียนอีเลิร์นนิ่งผ่านอุปกรณ์แท็บเล็ตหรือโทรศัพท์มือถือ 
 2. ควรพัฒนาบทเรียนอีเลิร์นนิ่งโดยใช้ social network อาทิ Facebook และ YouTube มา
เสริมศักยภาพให้กับนักเรียนในการเรียนการสอนผ่าน e-Learning 
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แบบประเมินคุณภาพ ด้านเนื้อหา 
การพัฒนาบทเรียนอีเลิร์นน่ิงเร่ืองการใช้ อะโดบี ดรีมวีฟเวอร์ CS5  

สําหรับนักเรยีนช้ันมัธยมศึกษาปีท่ี 3 โรงเรียนโนนกุงวิทยาคม 
…………………………………………………………………………………………………………………………… 

คําช้ีแจง 
 แบบประเมินฉบับนี้จัดทําข้ึนเพ่ือประเมินคุณภาพด้านเน้ือหาของ  “การพัฒนา

บทเรียนอีเลิร์นน่ิงเรื่องการใช้ อะโดบี ดรีมวีฟเวอร์ CS5 สําหรับนักเรียนช้ันมัธยมศึกษาปีที่ 3 
โรงเรียนโนนกุงวิทยาคม”  และผลการประเมินจากผู้ทรงคุณวุฒิจะนําไปใช้ในการปรับปรุงบทเรียนอี
เลิร์นน่ิงต่อไป  ดังน้ันผู้วิจัยจึงใคร่ขอความกรุณาจากท่านผู้ทรงคุณวุฒิได้ทําการประเมินบทเรียนอีเลิร์
นน่ิง ตามความคิดเห็นของท่านผู้ทรงคุณวุฒิ  โดยแบบประเมินฉบับน้ีแบ่งเป็น 2 ตอน ดังน้ี 

 

ตอนท่ี 1 แบบประเมินคุณภาพบทเรียนอีเลิร์นน่ิงเรื่องการใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ตามความเห็นของผู้ทรงคุณวุฒิ เกี่ยวกับการนําเสนอเนื้อหา ความถูกต้องของเนื้อหา การให้
ข้อเสนอแนะ และผลย้อยกลับ ลักษณะของแบบประเมินเป็นแบบมาตราส่วนประมาณค่า (Rating 
Scale) 5 ระดับ จํานวน 15 ข้อ โดยมีเกณฑ์การให้คะแนนดังน้ี 

   5  หมายถึง  มีคุณภาพในระดับดีมาก 
   4  หมายถึง  มีคุณภาพในระดับดี 
   3  หมายถึง  มีคุณภาพในระดับปานกลาง 
   2  หมายถึง  มีคุณภาพในระดับพอใช้ 
  1  หมายถึง  มีคุณภาพในระดับควรปรับปรุง   

  

ตอนที่   2  แบบสอบถามปลายเปิดเกี่ยวกับความคิดเห็น และข้อเสนอแนะของ
ผู้ทรงคุณวุฒิที่มีต่อเน้ือหา ของบทเรียนอีเลิร์นน่ิง จํานวน 4 ข้อ 
 
 
 
 
 
 

ขอขอบพระคณุอย่างสูงในความอนุเคราะห์ของท่าน 
นางสาวอารีย์ญา  โพธ์ิกระสงัข ์

นักศึกษาปริญญาโท สาขาวิชาการศึกษาวิทยาศาสตร์ (คอมพิวเตอร์) 
คณะครุศาสตรอุ์ตสาหกรรม  สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 
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แบบประเมินคุณภาพการพฒันาบทเรียนอีเลิร์นนิ่งเร่ืองการใช้ อะโดบ ีดรมีวีฟเวอร ์CS5  

สําหรับนักเรียนชั้นมธัยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
ด้านเนื้อหา 

 

ตอนท่ี 1  คําชี้แจง  โปรดทําเคร่ืองหมาย  ลงในช่อง  ให้ตรงกับความคิดเห็นของท่าน 

ข้อ รายการประเมิน 
ระดับคุณภาพ 

5 4 3 2 1 

1. ด้านของการนําเสนอเนื้อหา 

1.1 เนื้อหามีความสอดคล้องกับวัตถุประสงค ์

1.2 ความเหมาะสมในการจัดแบ่งเนื้อหาในการนําเสนอแต่ละ
หน้า 

1.3 การเรียงลําดับเนื้อหาในแต่ละบทเรียน 

1.4 ความครบถ้วนของเน้ือหา 

1.5 ปริมาณเน้ือหาเหมาะสมในแต่ละบทเรียน 

1.6 รูปแบบการนําเสนอเนื้อหาง่ายต่อการเข้าใจ 

1.7 บทเรียนมีลักษณะจงูใจน่าสนใจในการเรียน 

2. ด้านความถูกต้องของเนื้อหา 

2.1 ความถูกต้องของเน้ือหา 

2.2 เนื้อหามีความสอดคล้อง เช่ือมโยงกัน           

2.3 ความถูกต้องของการใช้ภาษา           

2.4 คําศัพท์มีความถูกต้องตามเน้ือหาวิชา           

3. ด้านแบบทดสอบและผลย้อนกลับ 

3.1 ความเหมาะสมของคําถามต่อเน้ือหา           

3.2 ความเหมาะสมของจํานวนข้อในแบบฝึกหดั           

3.3 วิธีการให้ผลย้อนกลับ           

3.4 ลักษณะผลย้อนกลับ           

รวม           

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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แบบประเมินคุณภาพ ด้านเทคนิคการผลิตส่ือ 
การพัฒนาบทเรียนอีเลิร์นน่ิงเร่ืองการใช้ อะโดบี ดรีมวีฟเวอร์ CS5  

สําหรับนักเรยีนช้ันมัธยมศึกษาปีท่ี 3 โรงเรียนโนนกุงวิทยาคม 
…………………………………………………………………………………………………………………………………… 

คําช้ีแจง 
แบบประเมินฉบับน้ีจัดทําขึ้นเพ่ือประเมินคุณภาพด้านเทคนิคการผลิตสื่อ ในด้านความ

เหมาะสมและความถูกต้องด้านเทคนิคการผลิตสื่อ  ตามแนวคิดการศึกษา “การพัฒนาบทเรียนอีเลิร์

นน่ิงเรื่องการใช้ อะโดบี ดรีมวีฟเวอร์ CS5 สําหรับนักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุง

วิทยาคม”  และผลของการประเมินจากผู้ทรงคุณวุฒิจะนําไปใช้ในการปรับปรุงแบบสอบถามเพ่ือการ

วิจัยต่อไป   

ดังน้ันผู้วิจัยจึงใคร่ขอความกรุณาจากท่านผู้ทรงคุณวุฒิได้ทําการประเมินคุณภาพด้าน

เทคนิคการผลิตสื่อ ตามความคิดเห็นของท่านผู้ทรงคุณวุฒิ  โดยแบบประเมินคุณภาพด้านเทคนิคการ

ผลิตสื่อ ฉบับนี้แบ่งเป็น 2 ตอน ดังนี้ 
 

ตอนที่ 1 แบบประเมินคุณภาพบทเรียนอีเลิร์นน่ิงเรื่องการใช้ อะโดบี ดรีมวีฟเวอร์ CS5 
ตามความเห็นของผู้ทรงคุณวุฒิ ในด้านความเหมาะสมและความถูกต้องด้านเทคนิคการผลิตสื่อ
ลักษณะของแบบสอบถามเป็นแบบมาตราส่วนประเมินค่า (Rating Scale) 5 ระดับ จํานวน 19 ข้อ 
โดยแต่ละระดับความคิดเห็นเป็นดังนี้ 

ระดับ  5  หมายถึง  มีคุณภาพในระดับดีมาก 
ระดับ  4  หมายถึง  มีคุณภาพในระดับดี 
ระดับ  3  หมายถึง  มีคุณภาพในระดับปานกลาง 
ระดับ  2  หมายถึง  มีคุณภาพในระดับพอใช้ 
ระดับ  1  หมายถึง  มีคุณภาพในระดับควรปรับปรุง   
 

ตอนท่ี 2 แบบสอบถามเกี่ยวกับความเห็น และข้อแสนอแนะเพ่ิมเติม 
 

ขอขอบพระคณุอย่างสูงในความอนุเคราะห์ของท่าน 
นางสาวอารีย์ญา  โพธ์ิกระสงัข ์

นักศึกษาปริญญาโท สาขาวิชาการศึกษาวิทยาศาสตร์ (คอมพิวเตอร์) 
คณะครุศาสตรอุ์ตสาหกรรม  สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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แบบประเมินคุณภาพการพัฒนาบทเรียนอีเลิร์นนิ่งเร่ืองการใช้ อะโดบี ดรมีวีฟเวอร ์CS5  

สําหรับนักเรียนชั้นมธัยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 
ด้านเทคนิคการผลิตส่ือ 

 
ตอนท่ี 1 คําชี้แจง :  โปรดทําเครื่องหมาย  ลงในช่อง  ให้ตรงกับความคิดเห็นของท่าน 

ข้อ รายการประเมิน 
ระดับคุณภาพ 

5 4 3 2 1 

1. ด้านตัวอักษร (TEXT) 

1.1 ขนาดของตัวอักษรสวยงาม   
1.2 รูปแบบตัวอักษรอ่านง่าย และชัดเจน   
1.3 ความเหมาะสมของสีตัวอักษร และสีของพ้ืนท่ีใช้   
1.4 ความเหมาะสมของการจัดวางตัวอักษร/ข้อความในแต่ละ

กรอบ   
1.5 ความถูกต้องของข้อความตามหลักภาษา   

2. ด้านภาพนิง่ (IMAGE) 

2.1 ขนาดของภาพเหมาะสม   
2.2 สีและความชัดเจนของภาพ           
2.3 ความเหมาะสมของภาพที่ใช้ในการสื่อความหมาย           
2.4 ความสมดุลของการจัดวางภาพในแต่ละกรอบ           

3. ด้านภาพเคล่ือนไหว (ANIMATION) 

3.1 ขนาดของภาพเคลื่อนไหวเหมาะสม           
3.2 ความชัดเจนของภาพเคลื่อนไหว           
3.3 

ความเหมาะสมของภาพเคลือ่นไหวที่ใช้ในการสื่อความหมาย         
  

4.1 ระดับความดังของเสียงบรรยายมีความเหมาะสม      
4.2 ความชัดเจนของเสียงที่อธิบาย      
 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อ รายการประเมิน 
ระดับคุณภาพ 

5 4 3 2 1 

5. ด้านปฏิสัมพันธ์ (INTERACTIVE) 

5.1 การควบคุมบทเรียนทําได้ง่ายและสะดวก         
5.2 เปิดโอกาสให้ผู้เรียนโต้ตอบกับบทเรียน         
5.3 ความเหมาะสมของการเช่ือมโยงเนื้อหาภายในหน่วยการเรียน         
5.4 ความเหมาะสมของการเช่ือมโยง ระหว่างบทเรียนแต่ละหน่วย

การเรียน 
      

  
5.5 รูปแบบการโต้ตอบกับบทเรียนเป็น มาตรฐานเดียวกัน         
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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แบบประเมินความเท่ียงตรงเชิงเนื้อหาของแบบทดสอบ 
เรื่อง การใช้ อะโดบี ดรีมวีฟเวอร์ CS5  

สําหรับนักเรยีนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม 

………………………………………………………………………………………………………………………………………… 

คําช้ีแจง 
 แบบประเมินฉบับนี้จัดทําขึ้นเพ่ือประเมินคุณภาพของแบบทดสอบในด้านความเท่ียงตรงเชิง

เน้ือหา เพ่ือนําไปใช้เป็นแบบทดสอบก่อนเรียนและหลังเรียน “การใช้ อะโดบี ดรีมวีฟเวอร์ CS5” 

สําหรับนักเรียนช้ันมัธยมศึกษาปีที่ 3 โรงเรียนโนนกุงวิทยาคม และผลของการวิเคราะห์จาก

ผู้ทรงคุณวุฒิ จะนําไปใช้ในการปรับปรุงแบบทดสอบต่อไป   

 ดังน้ัน ผู้วิจัยจึงใคร่ขอความกรุณาจากท่านผู้ทรงคุณวุฒิได้ทําการประเมินแบบทดสอบ วัด

ผลสัมฤทธ์ิทางการเรียน ซ่ึงเป็นแบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จํานวน 120 ข้อ โดยการ

พิจารณากําหนดเกณฑ์การให้คะแนนแต่ละข้อดังน้ี 

  +1 คะแนน  แน่ใจว่าข้อคําถามน้ันสามารถวัดได้ตรงกับเน้ือหาและจุดประสงคก์ารเรียนรู้ 

  0 คะแนน  ไม่แน่ใจว่าข้อคําถามน้ันสามารถวัดได้ตรงกับเน้ือหาและจุดประสงค์การเรียนรู้ 

   -1  คะแนน  แน่ใจว่าข้อคําถามน้ันไม่สามารถวัดได้ตรงกับเน้ือหาและจุดประสงค์การเรียนรู้ 

 
 
 
 
 
 
 
 

ขอขอบพระคณุอย่างสูงในความอนุเคราะห์ของท่าน 
นางสาวอารีย์ญา โพธ์ิกระสังข์ 

นักศึกษาปริญญาโท สาขาวิชาการศึกษาวิทยาศาสตร์ (คอมพิวเตอร์) 
คณะครุศาสตรอุ์ตสาหกรรม  สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

จุดประสงค์การเรียนรู้ข้อท่ี 1 มีความรู้เกี่ยวกับการใช้
โปรแกรม Adobe Dreamweaver CS5 
 

      

1. โปรแกรมเว็บบราวเซอร์ (Web Browser) คือข้อใด 
ก. เครื่องมือในการใช้อินเทอร์เน็ต 
ข. เครื่องสื่อสารชนิดหนึ่ง 
ค. เอกสารหน้าที่หน่ึง 
ง. โปรแกรมทีใ่ช้ในสําหรับเปิดเว็บเพจ 
ข้อคําตอบไม่ดีครับ 
 

√      

2. เว็บเพจ (Web page) หมายถึง 
ก. หน้าเว็บทีป่ระกอบด้วยข้อความ รูปภาพ เสียง 
ข. กลุ่มของหนา้เว็บที่มีการเช่ือมโยงระหว่างกันด้วย
ไฮเปอร์ลิงค ์
ค. หน้าแรกของเว็บไซต์ 
ง. หน้าหลักของเว็บเพจ 
ข้อคําตอบไม่ดีครับ 
 

√      

3. ข้อใดคือโปรแกรมท่ีในการสร้างเว็บเพจ 
 ก. Internet Explorer  
 ข. Fire Fox  
 ค. Adobe Macromedia Dreamweaver 
 ง. Adobe Acrobat 
 

√      

4. โฮมเพจ (Home page) หมายถึง 
ก. หน้าแรกของเว็บไซต์ 
ข. หน้าเอกสารต่างๆ ในเว็บไซต์ 
ค. กลุ่มของเว็บเพจ 
ง. หน้าเว็บเพจที่แสดงชื่อผู้จัดทํา 
 

√      

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

5. เว็บไซต์ (Website) หมายถึง 
ก. กลุ่มของเว็บเพจที่มีการเชื่อมโยงระหว่างกันด้วย
ไฮเปอร์ลิงค์ 
ข. เว็บเพจหนึ่งหน้า 
ค. หน้าแรกของเว็บไซต์ 
ง. หน้าหลักของเว็บเพจ 
 

√      

6. โปรแกรมที่ใช้สําหรับดูผลลัพธ์ของเว็บเพจ เรียกว่า
อะไร  
ก. โปรแกรมประมวลผลคํา (word processing) 
ข. เว็บอีดิเตอร์ (Web editor) 
ค. เว็บมาสเตอร์ (Web master) 
ง. เว็บบราวเซอร์ (Web browser) 
 

√      

7. HTML ย่อมาจากอะไร 
ก. Hyper Link Text language 
ข. Hyper Text Markup language 
ค. Hyper V Markup language ข้อนี้ควรปรับ 
ง. Hyper Text Manage language 
 

√      

8. ข้อใดไม่ใช่กระบวนการสร้างเว็บไซต์ 
ก. การออกแบบและสร้าง 
ข. การเตรียมการ 
ค. การทดสอบ 
ง. การเช่ือมลิงค์ 
 

 √     

 

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

9. ข้อใดคือความละเอียดของหน้าจอเว็บเพจท่ีนิยมใช้
กันในปัจจุบัน 
ก. 800 x 600 
ข. 1024 x 768 
ค. 1280 x 800 
ง. 1280 x 1024 
 

√      

10. ข้อใดคือกระบวนการแรกของการสร้างเว็บไซต์ 
ก. การวางแผน 
ข. การเตรียมการ 
ค. การออกแบบและสร้าง 
ง. การทดสอบ 
 

√      

จุดประสงค์การเรียนรู้ข้อท่ี 2 สามารถบอก
ส่วนประกอบต่างๆ ของโปรแกรม Adobe 
Dreamweaver CS5 

      

11. ข้อใดต่อไปน้ีเป็นการเปิดใช้งานโปรแกรม Adobe 
Dreamweaver CS5 ที่ถูกต้อง 
ก. Adobe Dreamweaver CS5 > Start > Programs 
ข. Start > Programs > Adobe Master 
Collection CS5 > Dreamweaver CS5 
ค. File > Exit  
ง. File > Save AS 
ค ง ไม่เหมาสม 
 

  √    

12.  ข้อใดคือปุ่มคีย์ลัดในการแสดงผลบนเบราเซอร์ 
ก. F2 
ข. F5 
ค. F10 
ง. F12 

√      
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13. การจัดเก็บเว็บเพจควรจัดเก็บไฟล์ที่มีนามสกุลใด
ต่อไปนี้ 
ก. xml 
ข. html 
ค. exe 
ง. doc 

√      

14. ข้อใดต่อไปน้ีกล่าว ไม่ถูกต้อง 
ก. การทําเมนูลิงค์ (Link) คือการเช่ือมโยงหน้าเว็บเพจ 
ข. การออกแบบเว็บด้วยโปรแกรม Dreamweaver 
จําเป็นต้องใช้คําส่ัง HTML ในการเขียนโปรแกรม 
ค. การออกแบบเว็บเพจโดยใช้ตารางนั้นทําให้เว็บเพจ
เป็นระเบียบและเป็นสัดส่วน 
ง. การใส่ภาพกราฟิกบนหน้าเว็บเพจ เป็นการเพ่ิมสีสัน
ให้หน้าเว็บน่าสนใจมากย่ิงขึน้ 
 

 √     

15. ข้อใดกล่าวถูกต้องเก่ียวกับหลักการสรา้งเว็บไซต์ 
ก. ภาพและไฟล์ต่างๆ ควรอยู่ใน My Document 
ข. ภาพและไฟล์ต่างๆ ควรอยู่ในตําแหน่งเดียวกัน 
ค. ภาพอยู่ในโฟลเดอร์ (Folder) เดียวกันและไฟล์อยู่
ระดับเดียวกัน 
ง. ภาพและไฟล์ต่างๆ ควรอยู่ในฐานะเดียวกัน 
 

 √     

16. ถ้าเราต้องการบันทึก (Save) หน้าเว็บเพจควรไปที่
คําสั่งใด 
ก. เลือกเมนู Edit > Save 
ข. เลือกเมนู View > Save 
ค. เลือกเมนู Insert > Save As 
ง. เลือกเมน ูFile > Save As 
 

  √    
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17. ในโปรแกรม Dreamweaver สามารถเลือกมุมมอง
ที่ใช้จัดเลยเอาท์ของเว็บเพจได้ก่ีแบบ 
ก. 2 แบบ 
ข. 3 แบบ 
ค. 4 แบบ 
ง. 5 แบบ  
 

√      

18. การสร้างเว็บเพจที่เป็นภาษาไทย จะต้องกําหนดค่า
เริ่มต้นด้วยชุดแบบอักษร โดยใช้เมนูคําสั่งในข้อใด 
ก. File > Preferences 
ข. Edit > Preferences 
ค. Insert > Preference 
ง. View > Preference 
 

 √     

19. เม่ือคลิกมุมมอง split จะเกิดอะไรข้ึน 
ก. เป็นการแบ่งหน้าเว็บเป็นสองส่วน 
ข. เป็นการแยกตาราง 
ค. เป็นการแสดงมมุมองโค๊ดและมุมมองออกแบบ 
ง. เป็นการแสดงมุมมองออกแบบ 
 

 √     

20. มุมมอง Live view มีไว้เพ่ืออะไร 
ก. แสดงเมนู View 
ข. แสดงผลเหมือนดูจากบราวเซอร์ 
ค. แสดงมุมมองเหมือนจริง 
ง. แสดงการทํางานปัจจุบัน 

 √     

21. ข้อใดไม่ใช่วิธีการสร้างเว็บเพจใหม่ 
ก. เม่ือเปิดโปรแกรมครั้งแรก แล้วคลิกคําสั่ง HTML 
ข. คลิกที่พาเนลไซต์ คลิกขวา แล้วคลิก New file 
ค. คลิกเมนู File > New... 
ง. คลิกเมน ูSite > New Site 

 √     
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22. Property Inspector มีไว้เพ่ืออะไร 
ก. มีไว้กําหนดไซต์ของเว็บเพจ 
ข. มีไว้เพ่ือแสดงค่าต่างๆ ในเว็บเพจ 
ค. มีไว้เพื่อเปล่ียนแปลงแก้ไขคุณสมบัติเว็บและวัตถุ 
บนเว็บ 
ง. มีไว้กําหนดค่าเริ่มต้นของเว็บเพจ 
 

 √     

23. ข้อใดคือคาํสั่งในการใส่ขอ้ความเพ่ืออธิบายหัวเรื่อง
ของเว็บเพจ 
ก. <head>...</head> 
ข. <html>…</html> 
ค. <body>…</body> 
ง. <title>…</title> 
 

 √     

24. ข้อใดคือสว่นประกอบของหน้าจอโปรแกรม 
Adobe Dreamweaver CS5 
ก. Tab Document 
ข. Application Bar 
ค. Properties Inspector 
ง. ถูกทุกข้อ 
 

 √     

25. การออกจากโปรแกรม Adobe Dream CS5 ให้
คลิกที่เมนูใด 
ก. File > Open 
ข. File > Save 
ค. File > Close 
ง. File > Exit 
 

  √    
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

37. การแทรกสัญลักษณ์ © (Copyright) ให้คลิกที่เมนู
คําสั่งใด 
ก. Insert > Text > Characters > Line Break 
ข. Insert > Text > Characters > Non-Breaking 
space 
ค. Insert > Text > Characters > Copyright 
ง. Insert > Text > Characters > Registered 
Trademark 
 

  √    

38. การกําหนดสีสีเฉพาะข้อความบางส่วนบนหน้าต่าง 
Properties Inspector สไตล์ CSS ให้คลิกท่ีช่องใด 
ก. Font 
ข. Size 
ค. Targeted Rule 
ง. Text Color 
 

√      

39. การจัดรูปแบบข้อความด้วยพาเนล Properties 
แบ่งออกเป็นกี่รูปแบบ 
ก. 2 รูปแบบ 
ข. 3 รูปแบบ 
ค. 4 รูปแบบ 
ง. 5 รูปแบบ 
 

√      

40. การกําหนดเฉดสี/มิติ ของเส้นแบ่งเน้ือหา ให้คลิกที่
คําสั่งใด 
ก. Width 
ข. Align 
ค. Shading 
ง. Class 
 

√      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

41. การกําหนดสี ให้กับเส้นแบ่งเน้ือหา ให้คลิกขวาบน
เส้นแบ่งเน้ือหา แล้วเลือกคําสั่งใด 
ก. Edit Tag <hr> 
ข. Wrap Tag… 
ค. Remove Tag <hr> 
ง. ID 
 

 √     

42. การย้ายข้อความ ให้เลือกข้อความแล้วเลือกคําสั่งใด 
ก. Edit > Cut 
ข. Edit > Copy 
ค. Edit > Past 
ง. Edit > Clear 

  √    

43. การเลือกชุดฟอนต์ที่ต้องการใช้บนหนา้ต่าง
Properties Inspector สไตล์ CSS ให้เลือกท่ีช่องใด 
ก. Font 
ข. Size 
ค. Targeted Rule 
ง. Text Color 

 √     

44. การเพ่ิมชุดฟอนต์ที่ใช้กับข้อความให้เลือกคําสั่งใด 
ก. Font > Edit Font List.. 
ข. Size > Edit Font List.. 
ค. Targeted Rule > Edit Font List.. 
ง. Text Color > Edit Font List.. 

   √    

45. การจัดรูปแบบข้อความท่ีมีอยู่ในเว็บเพจให้จัดเสมอ
กันท้ังซ้ายและขวา ให้เลือกคําสั่งใด 
ก. Align > Left 
ข. Align > Center 
ค. Align > Right 
ง. Align > Justify 

  √      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

46. เม่ือต้องการจัดให้ข้อความในบรรทัดอยู่กึ่งกลาง
ตาราง ทําได้โดยคลิกเลือกคําส่ังใด 
ก. Horz > Left 
ข. Horz > Center 
ค. Horz > Right 
ง. Horz > Justify 
 

  √      

47. การกําหนดรูปแบบในการวางข้อความ Retain 
line breaks คือการวางในลักษณะใด 
ก. การวางข้อความตามโครงสร้างต้นฉบับ 
ข. การวางข้อความตามโครงสร้างต้นฉบับ และนําเอา
รูปแบบพ้ืนฐานของข้อความมาใช้ด้วย 
ค. การวางข้อความตามโครงสร้างต้นฉบับ และนําเอา
รูปแบบทุกอย่างมาใช้ด้วย 
ง. คงลักษณะการแบ่งบรรทัดตามต้นฉบับ 

 
 

 √     

จุดประสงค์การเรียนรู้ข้อท่ี 4 มีความรู้เก่ียวกับการการ
ใสภ่าพบนเว็บเพจ 

      

48. นามสกุลไฟล์ภาพใดท่ีไม่สามารถนํามาใช้แทรกใน
เว็บเพจได้ 
ก. Tiff 
ข. JPEG 
ค. GIF 
ง. PNG 

 

 √     

49. เมนูใดคือคําสั่งในการแทรกรูปภาพและตาราง 
ก. Menu File 
ข. Menu Edit 
ค. Menu Insert 
ง. Menu View 

  √    

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

50. กรณีที่นําภาพขนาดใหญ่มาวางบนเว็บเพจ หาก
ต้องการตัดภาพเพ่ือเน้นจุดสําคัญของภาพ สามารถใช้
เครื่องมือใดบนพาเนล PROPERTIES 
ก. Resample 
ข. Brightness and Contrast 
ค. Crop 
ง. Sharpen 

 

√      

51. หากภาพที่นํามาประกอบในเว็บเพจนั้นดูสว่างหรือ
มืดเกินไป สามารถปรับแต่งโดยใช้เครื่องมือใดบน
พาเนล PROPERTIES 
ก. Resample 
ข. Brightness and Contrast 
ค. Crop 
ง. Sharpen 

 

√      

52. ในหน้าเว็บเพจที่มีรูปภาพประกอบเป็นจํานวนมาก
จะเกิดปัญหาด้านใดมากท่ีสุด 
ก. ทําให้ลายตามาก 
ข. ทําให้ดูไม่สวยงาม 
ค. สร้างความสับสนให้กับผู้เข้าใช้ 
ง. ทําให้การแสดงผลในเว็บบราวเซอร์ (Web 
browser) ช้า 
 

 √     

53. เม่ือต้องการใส่รูปภาพลงในเว็บเพจต้องใช้คําสัง่ใด 
ก. Insert > Image 
ข. Insert > media 
ค. Insert > Table 
ง. Insert > File 

 

  √    

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

54. ข้อใดคือคุณสมบัติของการต้ังค่าเว็บเพจในหัวข้อ 
Background image 
ก. กําหนดคุณสมบัติของรูปภาพ 
ข. เลือกรูปภาพท่ีทําเป็นพืน้หลังเว็บเพจ 
ค. เลือกรูปแบบการแสดงผลรูปภาพ 
ง. การแทรกรูปภาพในเว็บเพจ 

 

 √     

55. ข้อใดไม่ใช่ประโยชน์ของการใส่คําหรือข้อความ
อธิบายให้รูปภาพ 
ก. กรณีเว็บเบราเซอร์ของผู้ชมไม่สามารถแสดงรูปได้ 
จะแสดงข้อความอธิบายแทน 
ข. เม่ือผู้ชมเลื่อนเมาส์ไปช้ีบนภาพจะแสดงข้อความ
อธิบายเพ่ิมเติม 
ค. กรณีเว็บเบราเซอร์หาไฟล์รูปภาพไม่พบจะแสดง
ข้อความอธิบายแทน 
ง. สามารถซ่อนข้อความบนเว็บได้ 
 

 √     

56. การกําหนดระยะห่างรอบรูป มี 2 แบบ 
ประกอบด้วยอะไรบ้าง  
ก. ระยะห่างรอบรูปตามแนวนอน และ ระยะห่างรอบ
รูปตามแนวต้ัง 
ข. ระยะห่างรอบรูปตามแนวนอน และ ระยะห่างรอบ
รูปตามแนวกว้าง 
ค. ระยะห่างรอบรูปตามแนวกว้าง และ ระยะห่างรอบ
รูปตามแนวยาว 
ง. ระยะห่างรอบรูปตามแนวต้ัง และ ระรยะห่างรอบรูป
ตามแนวยาว 
 

√      

 
 
 
 

      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

57. การปรับขนาดรูปภาพ สามารถทําได้กี่วิธี 
ก. 1 วิธี 
ข. 2 วิธ ี
ค. 3 วิธี 
ง. 4 วิธี 
 

√      

58. เม่ือต้องการปรับขนาดรูปภาพให้ได้สัดส่วนเดิม ให้
กดคีย์ใด พร้อมกับการคลิกลากแฮนเดิล 
ก. Enter 
ข. Alt 
ค. Shift 
ง. Ctrl 

  √    

59. การเพ่ิมความโดดเด่นให้กับรูปภาพด้วยการใส่เส้น
กรอบล้อมรูปภาพ ควรกําหนดความหนาของเส้นขอบ
ในช่องใด 
ก. V Space 
ข. H Space 
ค. Border 
ง. Align 

  √    

60. การปรับความคมชัดของภาพ ให้คลิกทีปุ่่มใด 
ก. Resample 
ข. Brightness and Contrast 
ค. Crop 
ง. Sharpen 

 √     

61. repeat เป็นรูปแบบการวนซํ้าแบบใด 
ก. รูปแบบการวนซํ้าภาพท้ังแนวนอนและแนวตั้ง 
ข. รูปแบบการวนซํ้าภาพเฉพาะแนวนอน 
ค. รูปแบบการวนซํ้าเฉพาะแนวต้ัง 
ง. รูปแบบการวนไม่ซํ้าภาพ 

 √     

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

62. การทํา Rollover Image เป็นเทคนิคสลับรูปภาพ
ขณะเลื่อนเมาส์ไปช้ี ควรมีรูปภาพอย่างน้อยกี่รูป 
ก. 2 รูป 
ข. 3 รูป 
ค. 4 รูป 
ง. 5 รูป 

 

 √     

63. การปรับขนาดความกว้างและความสูงของภาพ มี
หน่วยวัดเป็นอะไร 
ก. เซนติเมตร 
ข. นิ้ว 
ค. พิกเซล 
ง. เปอร์เซ็นต์ 

 

√      

64. เม่ือใส่ค่า 20 ในช่อง V space ของการปรับ
คุณสมบัติรูปภาพ จะเกิดอะไรขึ้น 
ก. ระยะห่างระหว่างรูปภาพกับข้อความในแนวต้ังมี
ค่าเท่ากับ 20 pixel 
ข. ระยะห่างระหว่างรูปภาพกับข้อความในแนวนอนมี
ค่าเท่า 20 pixel 
ค. รูปภาพห่างจากขอบบนของตารางเท่า 20 pixel 
ง. รูปภาพห่างจากขอบล่างของตารางเท่ากับ 20 pixel 
 

 √     

65. ในช่อง Alternate text ของการทํา Rollover 
Image เป็นการกําหนดอะไร 
ก. การบอกช่ือไฟล์รูปภาพ 
ข. การใส่ข้อความอธิบายรูปภาพ 
ค. การบอกแหล่งที่มาของรูปภาพ 
ง. การต้ังช่ือรูปภาพ 
 

√      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

จุดประสงค์การเรียนรู้ข้อท่ี 5 มีความรู้เกี่ยวกับการ
เช่ือมโยงเว็บเพจ 
 

      

66. การลิงค์ (Link) หมายถึงอะไร 
ก. การเช่ือมโยงหน้าเว็บเพจ 
ข. การแทรกรปูภาพหน้าเว็บเพจ 
ค. การแทรกตารางหน้าเว็บเพจ 
ง. การใส่วันท่ีหน้าเว็บเพจ 
 

√      

67. การเชื่อมโยงในเว็บไซต์ ส่วนของ Target ที่มี 
_blank หมายความว่าอย่างไร 
ก. เปิดเว็บเพจปลายทางในวินโดว์ใหม ่
ข. แสดงเว็บเพจในเฟรมที่ครอบอยู่ในเฟรมปัจจุบัน 
ค. แสดงเว็บเพจในเฟรมเดิมของลิงค ์
ง. แสดงเว็บเพจในวินโดวส์เดิม โดยยกเลิกเฟรมท่ีครอบ
อยู่ทั้งหมด 

√      

68. ในการต้ังค่าเว็บเพจในหมวด Appearance (CSS) 
ในหมวด Link หัวข้อ Active link เลือกสีแดง จะมีผล
เม่ือกระทําการใดกับข้อความที่เป็นลิงค ์
ก. เมื่อช้ีเมาส์ 
ข. เม่ือลากเมาส์ออก 
ค. เม่ือคลิกเมาส์แแล้ว 
ง. เม่ือคลิกเมาส์ด้านขวา 
 

 √     

69. Rollover Image เป็นเทคนิคสลับภาพระหว่าง 2 
รูป จะแสดงผลการเปลี่ยนภาพเม่ือกระทําสิ่งใด 
ก. เมื่อเล่ือนเมาส์ไปช้ี 
ข. เม่ือเลื่อนเมาส์ออก 
ค. เม่ือคลิกเมาส์แล้ว 
ง. เม่ือคลิกเมาส์ด้านขวา 

 √     

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

70. การเลือก Target _top เป็นการเช่ือมโยงลงิค์ใน
ลักษณะใด 
ก. แสดงเว็บเพจปลายทางโดยเปิดวินโดว์ใหม่ 
ข. แสดงเว็บเพจปลายทางในเฟรมที่ครอบเฟรมปัจจุบัน
อยู่ 
ค. แสดงเว็บเพจปลายทางในเฟรมเดิมของลิงค ์
ง. แสดงเว็บเพจปลายทางในวินโดว์เดิม โดยยกเลิก
เฟรมท่ีครอบอยู่ทั้งหมด 

 √     

71. การเช่ือมโยงเว็บเพจแต่ละเพจเข้าด้วยกันรวมท้ัง
เช่ือมโยงกับเว็บไซต์อ่ืนๆ เรียกว่าอะไร 
ก. การดาวน์โหลดไฟล์ 
ข. การอัพโหลดไฟล์ 
ค. การแทรกสือ่วีดีโอ 
ง. การสร้างลิงค์ 
 

 √     

72. การกําหนดรูปแบบลิงคแ์บบแสดงเส้นใต้เฉพาะเม่ือ
นําเมาส์ไปช้ีเท่าน้ัน ในช่อง Underline Style ต้อง
เลือกคําสั่งใด 
ก. Always underline 
ข. Never underline 
ค. Show underline only on rollover 
ง. Hide underline on rollover 
 

  √    

73.  การก๊อบปี ้URL จากเว็บไซต์อ่ืนมาเช่ือมโยงเข้ากับ
เว็บไซต์ของเราต้องใส่ URL ไว้ในช่องใด 
ก. ID 
ข. Target 
ค. Title 
ง. Link 
 

  √    

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

74. การเชื่อมโยงเว็บเพจไปยังเว็บอ่ืนๆ ในเว็บไซต์
เดียวกัน มีวิธีสร้างก่ีวิธี 
ก. 2 วิธ ี
ข. 3 วิธี 
ค. 4 วิธี 
ง. 5 วิธี 
 

√      

75. คําสั่งใดใช้ในการสร้าง Hyperlink 
ก. Insert > common > Hyperlink 
ข. Insert > Hyperlink 
ค. Modify > common > Hyperlink 
ง. Modify > Hyperlink 
 

  √    

76. การเปิดหน้าเว็บใหม่ที่เช่ือมโยงในเฟรมเดิม ควร
เลือก Target แบบใด 
ก. _self 
ข. _blank 
ค. _parent 
ง. top 
 

√      

77. การใช้เครื่องมือ Point to File ในการเช่ือมโยง มี
ลักษณะการทํางานอย่างไร 
ก. เปิดยังตําแหน่งของไฟล์ทีเ่ก็บไว้ 
ข. สร้างจุดเช่ือมโยงแบบข้อความ 
ค. ลากเมาส์ไปชี้และวางไปยังตําแหน่งไฟล์ 
ง. ใช้เมาส์ช้ีไปยังตําแหน่ง URL mต้องการ 
 

 √     

 
 
 
 
 
 
 

      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

78. การใช้เครื่องมือ Anchor เป็นการสร้างการ
เช่ือมโยงแบบใด 
ก. การเช่ือมโยงไปยังไฟลง์าน 
ข. การเช่ือมโยงไปภายในเว็บไซต์เดียว 
ค. การเช่ือมโยงไปยังอีเมล์ที่ต้องการ 
ง. การเช่ือมโยงภายในเว็บเพจเดียวกัน 
 

√      

79. การเชื่อมโยงด้วยเครื่องมือ Anchor ต้องใส่
เครื่องหมายใดไว้หน้าช่ือ ในช่อง Link ทุกครั้ง 
ก. # 
ข. % 
ค. $ 
ง. @ 
 

√      

80. การกําหนดสีของจุดเช่ือมโยงขณะที่ผู้เลื่อนเมาส์มา
ช้ี ต้องกําหนดจากตัวเลือกใด 
ก. Visited Links 
ข. Active Links 
ค. Link Color 
ง. Rollover Links 
 

  √    

81. การเชื่อมโยงเว็บเพจบนภาพ โดยเลือกส่วนใดส่วน
หน่ึงของภาพไปยังตําแหน่งต่างๆ ของเว็บไซต์ เป็นการ
สร้างลิงคแ์บบใด 
ก. การสร้างลิงค์เพ่ือส่งอีเมล์ 
ข. การสร้างลิงค์ไปยังเว็บไซต์อ่ืน 
ค. การสร้างลิงค์บนภาพแบบ Image Map 
ง. การสร้างลงิค์แบบดร็อปดาวน์ด้วย Jump Menu 
 

√      

 
 
 
 

      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

จุดประสงค์การเรียนรู้ข้อท่ี 6 มีความรู้เกี่ยวกับการสร้าง
ตารางบนเว็บเพจ 
 

      

82. ข้อใดให้ความหมายของ Cell padding ได้ถูกต้อง 
ก. ระยะระหว่างข้อความกับขอบตาราง 
ข. ระยะระหว่างแต่ละเซลล์ในตาราง  
ค. ความหนาของขอบตาราง 
ง. ความกว้างของตาราง 
 

 √     

83. คําสั่งใดต่อไปนี้คือคําสั่งที่ใช้กําหนดความหนาของ
เส้นขอบตาราง 
ก. Rows  
ข. Border 
ค. Cell padding 
ง. Cell spacing 
 

  √    

84. การเพ่ิมคอลัมน์ต้องเลือกใช้คําสั่งใด 
ก. Table > Insert Column 
ข. Table > Insert Row 
ค. Table > Merge Cells 
ง. Table > Select Table 
 

  √    

85. ข้อใดให้ความหมายของ Cell spacing ได้ถูกต้อง 
ก. ระยะระหว่างข้อความกับขอบตาราง 
ข. ระยะระหว่างแต่ละเซลล์ในตาราง  
ค. ความหนาของขอบตาราง 
ง. ความกว้างของตาราง 
 

√      

       
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

86. คําสั่งใดเป็นการรวมเซลหลายๆ เซลมารวมกันให้
เหลือเพียงเซลเดียว 
ก. Split Cell 
ข. Merge Cells 
ค. Increase Row Span 
ง. Decrease Row Span 
 

  √    

87. เมนูใดคือคําสั่งในการเพ่ิมแถว 
ก. Table > Insert Column 
ข. Table > Insert Row 
ค. Table > Merge Cells 
ง. Table > Select Table 

  √    

88. คําสั่งใดคอืการแบ่งเซลๆ หน่ึงออกเป็นหลายแถว
หรือหลายคอมลัมน์ 
ก. Split Cell 
ข. Merge Cells 
ค. Increase Row Span 
ง. Decrease Row Span 
ง. Cell Spacing 

  √    

89. เมนูใดคือคําสั่งในการลบคอลัมน์ 
ก. Table > Insert Column 
ข. Table > Insert Row 
ค. Table > Delete Column 
ง. Table > Delete Row 

  √    

90. เมนูใดคือคําสั่งในการลบแถว 
ก. Table > Insert Column 
ข. Table > Insert Row 
ค. Table > Delete Column 
ง. Table > Delete Row 

  √    

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

91. ข้อใดคือคาํสั่งในการกําหนดสีพ้ืนของตาราง 
ก. คําสั่ง Backgroundcolor 
ข. คําสั่ง Bordercolor 
ค. คําสั่ง Bgcolor 
ง. ถูกท้ังข้อ ก และข้อ ค 
 

 √     

92. คําสั่ง Order > Descending เป็นการเรียงลําดับ
ข้อมูลในตารางรูปแบบใด 
ก. เรียงลําดับตามตัวอักษร 
ข. เรียงลําดับตามตัวเลข 
ค. เรียงจากนอ้ยไปมาก 
ง. เรียงจากมากไปน้อย 
 

√      

93. ข้อมูลใดสามารถแทรกมาวางในตารางเว็บเพจได้ 
ก. ตัวอักษร 
ข. รูปภาพ 
ค. ไฟล์มัลติมีเดีย 
ง. ถูกทุกข้อ 

 

 √     

94. การกําหนดสีและภาพพ้ืนหลังของตารางแตกต่าง
กันอย่างไร 
ก. การกําหนดสีของตารางจะต้องกําหนด CSS Rule 
แต่ภาพไม่ต้องกําหนด 
ข. การกําหนดภาพพ้ืนหลังของตารางจะต้องกําหนด 
CSS Rule แต่สีไม่ต้องกําหนด 
ค. การกําหนดสีของตารางทําได้เพียงสีเดียวแต่ภาพไม่มี
ข้อกําหนด 
ง. การกําหนดภาพพ้ืนหลังของตารางทําได้เพียงภาพ
เดียวแต่สีไม่มีข้อกําหนด 
 

 √     

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

95. ถ้าต้องการให้แถวทีถู่กเพ่ิม อยู่บนแถวที่เลือกอยู่
ควรใช้คําสั่งใด 
ก. เลือก Above the Selection 
ข. เลือก Below the Selection 
ค. เลือก Before the Selection 
ง. เลือก After the Selection 
 

 √     

96. การเลือกข้อมูลท้ังตาราง ควรใช้วิธีการใด 
ก. นําเมาส์ไปช้ีที่เซลล์ใดเซลล์หนึ่ง แล้วกดแป้น Ctrl+T 
ข. นําเมาส์ไปช้ีที่เซลล์ใดเซลล์หน่ึง แล้วกดแป้น Ctrl+D 
ค. นําเมาส์ไปช้ีที่เซลล์ใดเซลล์หนึ่ง แล้วกดแป้น 
Ctrl+W 
ง. นําเมาส์ไปช้ีที่ขอบบนหรือล่างของตารางแล้วทําการ
คลิกเมาส์ 
 

 √     

97. การเลือกคําสั่ง Both ของตารางในกลุม่ Header 
เป็นกําหนดการเลือกตําแหน่งใดภายในตาราง 
ก. กําหนดให้มีหัวเร่ืองทางด้านซ้าย 
ข. กําหนดให้มีหัวเร่ืองทางด้านบน 
ค. กําหนดให้มีหัวเรื่องทั้งด้านซ้ายและด้านบน 
ง. ไม่ใช่หัวเรื่องของตาราง 
ก. None 
 

  √    

98. การกําหนดข้อความสรุปของตาราง Summary อยู่
ในกลุ่มคุณสมบัติใดของตาราง 
ก. Table size 
ข. Header 
ค. Insert 
ง. Accessibility 
 

√      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

99. คําสั่ง Order > Sort includes the first row  
เป็นการเรียงลาํดับข้อมูลในตารางรูปแบบใด 
ก. การเรียงลําดับโดยรวมแถวที่เป็นหัวตาราง 
ข. การเรียงลําดับโดยรวบรวมข้อมูลแถวแรก 
ค. การเรียงลําดับโดยรวมแถวท่ีเป็นท้ายตาราง 
ง. การเรียงลําดับโดยตัวอักษร 
 

  √    

100.  คําสั่ง Insert Column Left คือคําสั่งอะไร 
ก. แทรกคอลัมน์ด้านซ้ายของคอลัมน ์
ข. แทรกคอลัมน์ด้านขวาของคอลัมน์ 
ค. แทรกแถวด้านซ้าย 
ง. แทรกแถวด้านขวา 
 

√      

จุดประสงค์การเรียนรู้ข้อท่ี 7 มีความรู้เกี่ยวกับการแบ่ง
หน้าเว็บเพจด้วยเฟรม 
 

      

101. ส่วนประกอบของเฟรมมีอยู่ 2 ส่วน ประกอบด้วย
อะไรบ้าง 
ก. เฟรมส่วนบน และ เฟรมเซต 
ข. เฟรมเซต และ เฟรม 
ค. เฟรมส่วนซ้าย และ เฟรมส่วนกลาง 
ง. เฟรมส่วนบน และ เฟรมส่วนล่าง 
 

√      

102. เฟรม (Frame) คืออะไร 
ก. การเช่ือมโยงข้อมูลไปยังปลายทางท่ีต้องการ 
ข. การแบ่งพื้นที่ในหน้าเว็บเพจออกเป็นหลายๆ ส่วน 
แต่ละส่วนสามารถแสดงเนื้อหาที่ต่างกันได้ 
ค. เป็นแหลง่ขอ้มูลกลางๆ ที่ใช้กันบ่อยในเว็บไซต์ 
ง. การสํารวจความต้องการใช้เป็นแหล่งข้อมูล 
 

√      

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

103. การปรับแต่งคุณสมบัติของเฟรมหรือเฟรมเซต มี
วิธีการเลือก 2 แบบ ประกอบด้วยอะไรบ้าง 
ก. เลือกเฟรมและเฟรมเซตบนวินโดว์ Frames และ 
เลือกเฟรมบน Properties Inspector  
ข. เลือกเฟรมเซตจากเส้นแบ่งเฟรม และ เลอืกเฟรมเซต
จากขอบของเฟรม 
ค. เลือกช่ือเฟรมจาก Frame name และ เลือกช่ือ
พาเนล Frames 
ง. เลือกเฟรมและเฟรมเซตบนวินโดว์ Document 
และ เลือกเฟรมและเฟรมเซตจากพาเนล Frames 
 

√      

104. ข้อใดคือช่องสําหรับระบุค่าในการกําหนดความสูง
ของเฟรมและมีหน่วยเป็นอะไร 
ก. Border หน่วยเป็น pixel 
ข. Value หน่วยเป็น pixel 
ค. Units หน่วยเป็น pixel 
ง. Border width หน่วยเป็น pixel 
 

√      

105. ข้อใดคือเมนูการบันทึกเว็บเพจเฉพาะเฟรมใด
เฟรมหน่ึง 
ก. File > Save Frameset 
ข. File > Save All 
ค. File > Save as Template 
ง. File > Save all Related Files 
 

  √    

106. การกําหนดชื่อเฟรม ต้องระบุลงในช่องคําสั่งใด 
ก. Src 
ข. Scroll 
ค. Frame name 
ง. Margin width 

√      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

107. การเปิดพาเนล Frames ให้คลิกที่เมนูใด  
ก. Windows > Frames 
ข. Windows > Component 
ค. Windows > Insert 
ง. Windows > Extensions 
 

  √    

108. คําสั่ง Insert > Media > Flash Video เป็น
คําสั่งเพ่ือแทรกไฟล์นามสกุลอะไร 
ก. .SWF 
ข. .MOV 
ค. .flv 
ง. .mp3 
 

  √    

109. การสร้างเว็บเพจด้วยเฟรมจากต้นแบบท่ีโปรแกรม
มีให้ ควรเลือกคําสั่งใด 
ก. File > New 
ข. File > Open 
ค. File > New > Page Form Sample 
ง. File > Save 
 

  √    

110. การกําหนดความสูงภายในเฟรมเซต ให้ใสค่่าใน
ช่องใด 
ก. Border 
ข. Units 
ค. Scroll 
ง. Value 
 

√      

       
 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

111. การกําหนดชื่อเรียกของแต่ละเฟรม ให้ใส่ค่าใน
ช่องใด 
ก. Src 
ข. Margin width 
ค. Margin height 
ง. Frame name 
 

√      

จุดประสงค์การเรียนรู้ข้อท่ี 8 มีความรู้เกี่ยวกับการเล่น
มัลติมีเดียบนเว็บเพจ 
 

      

112. คําสั่ง Auto play เป็นคําสั่งในการกําหนด
คุณสมบัติใด 
ก. รักษาสัดส่วนของวีดีโอหว้เม่ือปรับความกว้างและ
ความสูง 
ข. คําสั่งปิดวีดีโออัตโนมัติ 
ค. เริ่มเล่นวีดีโออัตโนมัติเมื่อเว็บเพจถูกเปิด 
ง. กลับไปยังตําแหน่งเริ่มต้นของวีดีโอทันทีเม่ือเล่นจบ 
 

√      

113. คําสั่ง Auto rewind เป็นคําสั่งในการกําหนด
คุณสมบัติใด 
ก. รักษาสัดส่วนของวีดีโอหว้เม่ือปรับความกว้างและ
ความสูง 
ข. คําสั่งปิดวีดีโออัตโนมัติ 
ค. เริ่มเล่นวีดีโออัตโนมัติเม่ือเว็บเพจถูกเปิด 
ง. กลับไปยังตาํแหน่งเริ่มต้นของวีดีโอทันทีเมื่อเล่นจบ 
 

√      

       
 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

114. มัลติมีเดีย (Multimedia) คืออะไร 
ก. การนําเอาเทคโนโลยีมาประยุกต์ใช้กับระบบ
การศึกษา 
ข.เนื้อหาที่ประสมส่ือหลายๆอย่างเข้าด้วยกัน เช่น 
ข้อความ, ภาพนิ่ง , ภาพเคล่ือนไหว , เสียง เป็นตน้ 
ค. เป็นเทคโนโลยีเกี่ยวกับการแสดงผล ด้านเคลื่อนไหว 
ทั้งแบบ 2 มิติ และ 3 มิติ 
ง. การพัฒนาและประมวลผลในการปรับแต่งสื่อ 
 

 √     

115. มัลติมีเดียท่ีนิยมนํามาใช้บนเว็บเพจแบ่งตาม
ประเภทไฟล์มีกี่แบบ 
ก. 2 แบบ 
ข. 3 แบบ 
ค. 4 แบบ 
ง. 5 แบบ 
 

√      

116. การแทรกไฟล์มูฟว่ี flash ต้องใช้คําสัง่ใด 
ก. Insert > media > SWF 
ข. Common > media > SWF 
ค. Insert > media > Shockwave 
ง. ถูกท้ัง ก และ ข 
 

  √    

117. ข้อใดคือปุ่มคําสั่งในการปรับแต่งการเล่นเสียง 
ก. play 
ข. Edit 
ค. Parameters 
ง. File 
 

√      

 
 
 
 
 

      

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ข้อคําถาม 

 
พฤติกรรมท่ีวัด ความคิดเห็นข้อ

ผู้ทรงคุณวุฒ ิ
ความรู้-
ความจํา 

ความ
เข้าใจ 

การ
นําไปใช้ 

1 0 -1 

118. วิธีการใส่เสียงในเว็บเพจสามารถทําได้ 2 วิธี 
ประกอบด้วยอะไรบ้าง 
ก. การสร้างลิงค์ไฟล์เสียง และ การฝังไฟล์เสียงลงใน
เว็บ 
ข. การสร้างลิงค์ไฟล์เสียง และ การติดต้ังโปรแกรม
เสริม 
ค. การฝังไฟล์เสียงลงในเว็บ และการก๊อบป้ีไฟล์มาวาง 
ง. การติดต้ังโปรแกรม และ การก๊อบป้ีไฟล์มาวาง 
 

  √    

119.  การกําหนดคุณภาพการแสดงผลที่เน้นคุณภาพ
ของภาพมากกว่าความเร็ว ควรเลือกระดับคุณภาพใน
ช่องใด 
ก. Low 
ข. Auto Low 
ค. High 
ง. Auto High 
 

  √    

120. การแก้ไขไฟล์ต้นฉบับ Flash ให้คลิกปุ่มใด 
ก. Play 
ข. Stop 
ค. Autoplay 
ง. Edit 

  √    

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ภาคผนวก ค 

ค่าดัชนีความสอดคล้อง (IOC) ค่าความยากง่าย (p) ค่าอ านาจจ าแนก (r)  

ของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 

 

 

 

 

 

 

 

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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การวิเคราะห์หาค่าดัชนีความสอดคล้อง 
 

ตารางที่ ค.1 แสดงผลการวิเคราะห์ค่าดัชนีความสอดคล้อง (IOC) จ านวน 120 ข้อ 

ข้อที่ 
ความคิดเหน็ของผู้ทรงคุณวฒุิ 

 ∑  IOC แปลผล 
คนที่ 1 คนที่ 2 คนที่ 3 

1 +1 +1 -1 1 0.33 ไม่เที่ยงตรง 

2* +1 +1 +1 3 1.00 เที่ยงตรง 

3 +1 +1 +1 3 1.00 เที่ยงตรง 

4 +1 +1 +1 3 1.00 เที่ยงตรง 

5* +1 +1 +1 3 1.00 เที่ยงตรง 

6 +1 +1 +1 3 1.00 เที่ยงตรง 

7* +1 +1 +1 3 1.00 เที่ยงตรง 

8* 0 +1 +1 2 0.67 เที่ยงตรง 

9 0 +1 +1 2 0.67 เที่ยงตรง 

10 0 +1 +1 2 0.67 เที่ยงตรง 

11* +1 +1 0 2 0.67 เที่ยงตรง 

12 +1 +1 +1 3 1.00 เที่ยงตรง 

13* +1 +1 +1 3 1.00 เที่ยงตรง 

14 0 +1 -1 0 0.00 ไม่เที่ยงตรง 

15 0 +1 -1 0 0.00 ไม่เที่ยงตรง 

16* +1 +1 +1 3 1.00 เที่ยงตรง 

17 0 +1 -1 0 0.00 ไม่เที่ยงตรง 

18 +1 +1 +1 3 1.00 เที่ยงตรง 

19 0 +1 +1 2 0.67 เที่ยงตรง 

20* +1 +1 +1 3 1.00 เที่ยงตรง 

21* 0 +1 +1 2 0.67 เที่ยงตรง 

22 +1 +1 +1 3 1.00 เที่ยงตรง 
 
 เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.1 (ต่อ) 

ข้อที่ 
ความคิดเหน็ของผู้ทรงคุณวฒุิ 

 ∑  IOC แปลผล 
คนที่ 1 คนที่ 2 คนที่ 3 

23 +1 +1 +1 3 1.00 เที่ยงตรง 

24 0 +1 0 1 0.33 ไม่เที่ยงตรง 

25* +1 +1 +1 3 1.00 เที่ยงตรง 

26* +1 +1 +1 3 1.00 เที่ยงตรง 

27* +1 +1 +1 3 1.00 เที่ยงตรง 

28* +1 +1 +1 3 1.00 เที่ยงตรง 

29* +1 +1 +1 3 1.00 เที่ยงตรง 

30* +1 +1 0 2 0.67 เที่ยงตรง 

31 +1 +1 0 2 0.67 เที่ยงตรง 

32 +1 +1 +1 3 1.00 เที่ยงตรง 

33 +1 +1 +1 3 1.00 เที่ยงตรง 

34 +1 +1 +1 3 1.00 เที่ยงตรง 

35* +1 +1 0 2 0.67 เที่ยงตรง 

36 +1 +1 0 2 0.67 เที่ยงตรง 

37 +1 +1 +1 3 1.00 เที่ยงตรง 

38 +1 0 +1 2 0.67 เที่ยงตรง 

39 0 +1 +1 2 0.67 เที่ยงตรง 

40 0 +1 +1 2 0.67 เที่ยงตรง 

41 0 +1 +1 2 0.67 เที่ยงตรง 

42 +1 +1 0 2 0.67 เที่ยงตรง 

43 +1 +1 0 2 0.67 เที่ยงตรง 

44 0 +1 +1 2 0.67 เที่ยงตรง 

45 +1 0 +1 2 0.67 เที่ยงตรง 

46 0 +1 +1 2 0.67 เที่ยงตรง 

47 +1 +1 0 2 0.67 เที่ยงตรง 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.1 (ต่อ) 

ข้อที่ 
ความคิดเหน็ของผู้ทรงคุณวฒุิ 

 ∑  IOC แปลผล 
คนที่ 1 คนที่ 2 คนที่ 3 

48 +1 +1 +1 3 1.00 เที่ยงตรง 

49 +1 +1 +1 3 1.00 เที่ยงตรง 

50 +1 +1 0 2 0.67 เที่ยงตรง 

51 +1 +1 0 2 0.67 เที่ยงตรง 

52* +1 +1 +1 3 1.00 เที่ยงตรง 

53 +1 +1 +1 3 1.00 เที่ยงตรง 

54* +1 +1 +1 3 1.00 เที่ยงตรง 

55* 0 +1 +1 2 0.67 เที่ยงตรง 

56* +1 +1 0 2 0.67 เที่ยงตรง 

57 0 +1 +1 2 0.67 เที่ยงตรง 

58 +1 0 +1 2 0.67 เที่ยงตรง 

59 +1 +1 0 2 0.67 เที่ยงตรง 

60 +1 0 +1 2 0.67 เที่ยงตรง 

61 +1 0 +1 2 0.67 เที่ยงตรง 

62 +1 +1 +1 3 1.00 เที่ยงตรง 

63 +1 0 +1 2 0.67 เที่ยงตรง 

64 +1 0 +1 2 0.67 เที่ยงตรง 

65 +1 +1 0 2 0.67 เที่ยงตรง 

66* +1 +1 +1 3 1.00 เที่ยงตรง 

67* +1 +1 +1 3 1.00 เที่ยงตรง 

68 +1 +1 +1 3 1.00 เที่ยงตรง 

69* 0 +1 +1 2 0.67 เที่ยงตรง 

70 0 +1 +1 2 0.67 เที่ยงตรง 

71 +1 +1 +1 3 1.00 เที่ยงตรง 

72* +1 +1 +1 3 1.00 เที่ยงตรง 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.1 (ต่อ) 

ข้อที่ 
ความคิดเหน็ของผู้ทรงคุณวฒุิ 

 ∑  IOC แปลผล 
คนที่ 1 คนที่ 2 คนที่ 3 

73* +1 +1 +1 3 1.00 เที่ยงตรง 

74 1 1 -1 1 0.33 ไม่เที่ยงตรง 

75* +1 +1 +1 3 1.00 เที่ยงตรง 

76 0 +1 +1 2 0.67 เที่ยงตรง 

77 +1 0 +1 2 0.67 เที่ยงตรง 

78 0 +1 +1 2 0.67 เที่ยงตรง 

79 +1 +1 0 2 0.67 เที่ยงตรง 

80 +1 +1 +1 3 1.00 เที่ยงตรง 

81 +1 +1 +1 3 1.00 เที่ยงตรง 

82* +1 +1 +1 3 1.00 เที่ยงตรง 

83 +1 +1 +1 3 1.00 เที่ยงตรง 

84 +1 +1 +1 3 1.00 เที่ยงตรง 

85* +1 +1 +1 3 1.00 เที่ยงตรง 

86* +1 +1 +1 3 1.00 เที่ยงตรง 

87* +1 +1 +1 3 1.00 เที่ยงตรง 

88 +1 +1 +1 3 1.00 เที่ยงตรง 

89* +1 +1 +1 3 1.00 เที่ยงตรง 

90 +1 +1 +1 3 1.00 เที่ยงตรง 

91* +1 +1 +1 3 1.00 เที่ยงตรง 

92 +1 +1 +1 3 1.00 เที่ยงตรง 

93 +1 0 +1 2 0.67 เที่ยงตรง 

94 +1 +1 0 2 0.67 เที่ยงตรง 

95 +1 +1 +1 3 1.00 เที่ยงตรง 

96 0 +1 +1 2 0.67 เที่ยงตรง 

97 0 +1 +1 2 0.67 เที่ยงตรง 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.1 (ต่อ) 

ข้อที่ 
ความคิดเหน็ของผู้ทรงคุณวฒุิ 

 ∑  IOC แปลผล 
คนที่ 1 คนที่ 2 คนที่ 3 

98 0 +1 +1 2 0.67 เที่ยงตรง 

99 0 +1 +1 2 0.67 เที่ยงตรง 

100 +1 +1 0 2 0.67 เที่ยงตรง 

101* +1 +1 +1 3 1.00 เที่ยงตรง 

102* +1 +1 +1 3 1.00 เที่ยงตรง 

103 +1 +1 +1 3 1.00 เที่ยงตรง 

104 +1 +1 +1 3 1.00 เที่ยงตรง 

105* +1 +1 +1 3 1.00 เที่ยงตรง 

106 +1 +1 +1 3 1.00 เที่ยงตรง 

107 +1 +1 +1 3 1.00 เที่ยงตรง 

108 +1 +1 +1 3 1.00 เที่ยงตรง 

109 +1 0 +1 2 0.67 เที่ยงตรง 

110 0 +1 +1 2 0.67 เที่ยงตรง 

111 +1 +1 0 2 0.67 เที่ยงตรง 

112* +1 +1 +1 3 1.00 เที่ยงตรง 

113 +1 +1 +1 3 1.00 เที่ยงตรง 

114* +1 +1 +1 3 1.00 เที่ยงตรง 

115 0 +1 -1 0 0.00 ไม่เที่ยงตรง 

116 0 +1 +1 2 0.67 เที่ยงตรง 

117 +1 +1 +1 3 1.00 เที่ยงตรง 

118* +1 +1 +1 3 1.00 เที่ยงตรง 

119 +1 +1 0 2 0.67 เที่ยงตรง 

120 0 +1 +1 2 0.67 เที่ยงตรง 
 
หมายเหตุ : ข้อที่มีเครื่องหมาย * เป็นข้อที่เลือกไปใช้ในงานวิจัย 
 เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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       จากตารางที่ ค.1 แสดงผลการหาค่าดัชนีความสอดคล้อง (IOC) ของแบบทดสอบวัดผลสัมฤทธิ์
ทางการเรียนแต่ละข้อ ที่ได้รับการตรวจสอบจากผู้ทรงคุณวุฒิทางด้านเนื้อหา จากจ านวนแบบทดสอบ
ทั้งหมด 120 ข้อ โดยผู้ทรงคุณวุฒิจ านวน 3 ท่าน พิจารณาความเที่ยงตรงของค าถาม โดยมีเกณฑ์การ
ให้คะแนนดังนี้ ถ้าข้อใดวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ให้คะแนนเท่ากับ +1 ถ้าไม่
สามารถวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ให้คะแนนเท่ากับ -1 และถ้าไม่แน่ใจว่าไม่
สามารถวัดได้ตรงกับเนื้อหาและจุดประสงค์การเรียนรู้ให้คะแนนเท่ากับ 0 จากตาราง พบว่า ได้
แบบทดสอบที่ผ่านเกณฑ์ที่มีค่าตั้งแต่ 0.67 – 1.00 จ านวน 113 ข้อ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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การวิเคราะห์หาความยากง่าย (p)  
และค่าอ านาจจ าแนก (r) ของแบบทดสอบวัดผลสัมฤทธ์ิทางการเรียน 

 
ตารางที่ ค.2 แสดงการวิเคราะห์หาค่าความยากง่าย (p) และค่าอ านาจจ าแนก (r) ของแบบทดสอบ
วัดผลสัมฤทธ์ิทางการเรียน ที่ผ่านการวิเคราะห์หาค่าดัชนีความสอดคล้องมาแล้ว จ านวน 113 ข้อ 
ข้อที่ ตอบถูก

กลุ่มสูง 
   

ตอบถูก
กลุ่มต่ า 
   

รวมคน
ตอบถูก 

ค่าความ
ยากง่าย 

(p) 

ค่าอ านาจ
จ าแนก  
( r ) 

ระดับอ านาจ
จ าแนก 

การ
น าไปใช ้

2* 10 7 17 0.57 0.20 ปานกลาง ใช้ได ้

3 11 8 19 0.63 0.20 ปานกลาง ใช้ได ้

4 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

5* 10 6 16 0.53 0.27 ปานกลาง ใช้ได ้

6 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้

7* 10 6 16 0.53 0.27 ปานกลาง ใช้ได ้

8* 10 7 17 0.57 0.20 ปานกลาง ใช้ได ้

9 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

10 13 9 22 0.73 0.27 ปานกลาง ใช้ได ้

11* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

12 13 8 21 0.70 0.33 สูง ใช้ได ้

13* 11 6 17 0.57 0.33 สูง ใช้ได ้

16* 11 6 17 0.57 0.33 สูง ใช้ได ้

18 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้

19 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

20* 9 4 13 0.43 0.33 สูง ใช้ได ้

21* 10 6 16 0.53 0.27 ปานกลาง ใช้ได ้

22 14 9 23 0.77 0.33 สูง ใช้ได ้

23 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

25* 11 5 16 0.53 0.40 สูงมาก ใช้ไดดี้ 

26* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.2 (ต่อ) 
ข้อที่ ตอบถูก

กลุ่มสูง 
   

ตอบถูก
กลุ่มต่ า 
   

รวมคน
ตอบถูก 

ค่าความ
ยากง่าย 

(p) 

ค่าอ านาจ
จ าแนก  
( r ) 

ระดับอ านาจ
จ าแนก 

การ
น าไปใช ้

27* 10 6 16 0.53 0.27 ปานกลาง ใช้ได ้

28* 10 7 17 0.57 0.20 ปานกลาง ใช้ได ้

29* 10 6 16 0.53 0.27 ปานกลาง ใช้ได ้

30* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

31 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

32 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้

33 14 9 23 0.77 0.33 สูง ใช้ได ้

34 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

35* 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

36 10 7 18 0.60 0.27 ปานกลาง ใช้ได ้

37 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

38 11 9 20 0.67 0.13 ต่ า ใช้ไม่ได้ 

39 12 7 19 0.63 0.33 สูง ใช้ได ้

40 12 10 22 0.73 0.13 ต่ า ใช้ไม่ได้ 

41 10 8 18 0.60 0.13 ต่ า ใช้ไม่ได้ 

42 11 9 20 0.67 0.13 ต่ า ใช้ไม่ได้ 

43 9 8 17 0.57 0.07 ต่ ามาก ใช้ไม่ได้ 

44 12 10 22 0.73 0.13 ต่ า ใช้ไม่ได้ 

45 15 9 24 0.80 0.40 สูง ใช้ได ้

46 10 8 18 0.60 0.13 ต่ า ใช้ไม่ได้ 

47 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้

48* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

49* 12 7 19 0.57 0.20 ปานกลาง ใช้ได ้

50 12 7 19 0.63 0.33 สูง ใช้ได ้

51 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.2 (ต่อ) 
ข้อที่ ตอบถูก

กลุ่มสูง 
   

ตอบถูก
กลุ่มต่ า 
   

รวมคน
ตอบถูก 

ค่าความ
ยากง่าย 

(p) 

ค่าอ านาจ
จ าแนก  
( r ) 

ระดับอ านาจ
จ าแนก 

การ
น าไปใช ้

52* 10 7 17 0.57 0.20 ปานกลาง ใช้ได ้

53 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

54* 13 10 23 0.77 0.20 ปานกลาง ใช้ได ้

55* 13 9 22 0.67 0.27 ปานกลาง ใช้ได ้

56* 10 7 17 0.57 0.20 ปานกลาง ใช้ได ้

57 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

58 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

59 12 7 19 0.63 0.33 สูง ใช้ได ้

60 15 12 27 0.90 0.20 ปานกลาง ใช้ไม่ได้ 

61 13 8 21 0.70 0.33 สูง ใช้ได ้

62 11 8 19 0.63 0.20 ปานกลาง ใช้ได ้

63 11 9 20 0.67 0.13 ต่ า ใช้ไม่ได้ 

64 13 9 22 0.73 0.27 ปานกลาง ใช้ได ้

65 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

66* 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

67* 13 8 20 0.70 0.33 สูง ใช้ได ้

68 6 2 8 0.27 0.27 ปานกลาง ใช้ได ้

69* 13 8 21 0.70 0.33 สูง ใช้ได ้

70 10 4 14 0.47 0.40 สูงมาก ใช้ได ้

71 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

72* 10 7 17 0.70 0.33 สูง ใช้ได ้

73* 10 6 15 0.53 0.27 ปานกลาง ใช้ได ้

75* 12 7 19 0.63 0.33 สูง ใช้ได ้

76 14 13 27 0.90 0.07 ต่ ามาก ใช้ไม่ได้ 

77 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.2 (ต่อ) 
ข้อที่ ตอบถูก

กลุ่มสูง 
   

ตอบถูก
กลุ่มต่ า 
   

รวมคน
ตอบถูก 

ค่าความ
ยากง่าย 

(p) 

ค่าอ านาจ
จ าแนก  
( r ) 

ระดับอ านาจ
จ าแนก 

การ
น าไปใช ้

78 9 6 15 0.50 0.20 ปานกลาง ใช้ได ้

79 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

80 11 6 17 0.57 0.33 สูง ใช้ได ้

81 13 6 19 0.63 0.47 สูงมาก ใช้ได ้

82* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

83 13 8 21 0.70 0.33 สูง ใช้ได ้

84 8 4 12 0.40 0.27 ปานกลาง ใช้ได ้

85* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

86* 12 7 19 0.63 0.33 สูง ใช้ได ้

87* 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

88 8 4 12 0.40 0.27 ปานกลาง ใช้ได ้

89* 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

90 9 6 15 0.50 0.20 ปานกลาง ใช้ได ้

91* 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

92 13 8 21 0.70 0.33 สูง ใช้ได ้

93 8 6 14 0.47 0.13 ต่ า ใช้ไม่ได้ 

94 12 9 21 0.70 0.20 ปานกลาง ใช้ได ้

95 14 10 24 0.80 0.27 ปานกลาง ใช้ได ้

96 11 7 18 0.60 0.27 ปานกลาง ใช้ได ้

97 12 9 21 0.70 0.20 ปานกลาง ใช้ไม่ได้ 

98 11 6 17 0.57 0.33 สูง ใช้ได ้

99 13 12 25 0.83 0.07 ต่ ามาก ใช้ไม่ได้ 

100 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

101* 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

102* 13 8 21 0.70 0.33 สูง ใช้ได ้
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ตารางที่ ค.2 (ต่อ) 
ข้อที่ ตอบถูก

กลุ่มสูง 
   

ตอบถูก
กลุ่มต่ า 
   

รวมคน
ตอบถูก 

ค่าความ
ยากง่าย 

(p) 

ค่าอ านาจ
จ าแนก  
( r ) 

ระดับอ านาจ
จ าแนก 

การ
น าไปใช ้

103 9 6 15 0.50 0.20 ปานกลาง ใช้ได ้

104 11 5 16 0.53 0.40 สูงมาก ใช้ได ้

105* 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

106 10 4 14 0.47 0.40 สูงมาก ใช้ได ้

107 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

108 12 7 19 0.63 0.33 สูง ใช้ได ้

109 15 9 24 0.80 0.40 สูงมาก ใช้ได ้

110 11 6 17 0.57 0.33 สูง ใช้ได ้

111 9 6 15 0.50 0.20 ปานกลาง ใช้ได ้

112* 12 7 19 0.63 0.33 สูง ใช้ได ้

113 14 8 22 0.73 0.40 สูงมาก ใช้ได ้

114* 12 8 20 0.67 0.27 ปานกลาง ใช้ได ้

116 11 6 17 0.57 0.33 สูง ใช้ได ้

117 12 7 19 0.63 0.33 สูง ใช้ได ้

118* 13 8 21 0.70 0.33 สูง ใช้ได ้

119 12 5 17 0.57 0.47 สูงมาก ใช้ได ้

120 13 8 21 0.70 0.33 สูง ใช้ได ้

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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ภาคผนวก ง 

ตัวอย่างบทเรียนอีเลิร์นนิ่ง 

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่

ภาพท่ี ง.1

 ง.2 หน้าจอแ

 
1 หน้าหลักบท

 

 
แสดงการลงท

ทเรียนอีเลิร์นนิ

ทะเบียนเพ่ือเข้

นิ่ง 

ขา้สู่บทเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพท่ี ง.3  หน้าจอแสดง
 

งเม่ือลงทะเบีย
 

ยนเข้าสู่บทเรียยนเรยีบร้อยแแล้ว 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาาพที่ ง.4 หน้า
 

าจอแสดงคําแแนะนําการใช้บบทเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภ

ภาพที่ ง.6  

ภาพที่ ง.5 หน

 หน้าจอแสดง

 
น้าจอแสดงจดุ

 

 
คําแนะนําก่อ

ดประสงค์การ

นการทําแบบ

เรยีนรู้ 

บทดสอบก่อนเเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.7 

ภ

 หน้าจอแสดง

ภาพที่ ง.8 หน้

 
การยืนยันการ

 

 
น้าจอแสดงแบ

รเริ่มทําแบบท

บบทดสอบก่อน

ทดสอบก่อนเรี

นเรียน 

รยีน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพพที่ ง.9 หน้าจอแสดงสถาน
 

นะของการตอ
 

อบคําถามในแแบบทดสอบกอ่นเรียน 

153 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพ

ภาพที่ ง.11

พที่ ง.10 หน้า

1 หน้าจอแสด

จอแสดงการยื

ดงข้อมูลการต

 

ยนืยันในการส
 

 
ตอบแบบทดสอ

 

ส่งคําตอบของ

อบก่อนเรียนพ

งแบบทดสอบ

พร้อมเฉลยคาํ

ก่อนเรียน 

าตอบในแต่ละ
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ะข้อ 

 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาาพที่ ง.12 หน
 

น้าจอแสดงหวัวข้อในแต่ละบบทเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.13 หน้น้าจอแสดงเนือ้อหาบทเรียน 
 

 บทที ่1 หลัก
 

การสร้างเว็บไไซต์ด้วยโปรแแกรม Dreamw
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weaver 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.14  หน้าจอแสดงงแบบทดสอบ
 

บระหว่างเรียน
Dreamwea

นบทที ่1 หลัก
aver 

การสร้างเว็บไไซต์ด้วยโปรแ

157 

แกรม 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.15 หน้าจอแแสดงเน้ือหาบท
 

ทเรียน บทที ่ 2 การใส่และะตกแต่งข้อความบนเว็บเพจ

158 

จ 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภภาพที่ ง.16 หหน้าจอแสดงแแบบทดสอบร
 

ะหว่างเรียน บบทที ่2 การใสสแ่ละตกแต่งขข้อความบนเว็
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ว็บเพจ 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพพที่ ง.17 หน้าาจอแสดงเนือ้ห
 

หาบทเรียน บ
 

บทที่ 3  การใสส่ภาพประกอบเว็บเพจ 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.18 หน้าจอแสสดงแบบทดส
 

อบระหว่างเรีรียน บทที ่3   การใส่ภาพปรระกอบเว็บเพ
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จ 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภภาพที่ ง.19 หหน้าจอแสดงเ
 

เนือ้หาบทเรียนน บทที่ 4  กาารสร้างไฮเปออร์ลิงค์ 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพทีที่ ง.20 หน้าจจอแสดงแบบท
 

ทดสอบระหวา่างเรียนบทที่  4  การสร้างไไฮเปอร์ลิงค ์
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพทีที่ ง.21 หน้าจจอแสดงเน้ือห
 

หาบทเรียน บททที ่5  การจัดดหน้าเว็บเพจด้วยตาราง 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.222 หน้าจอแสดงแบบทดสอ
 

อบระหว่างเรียยน บทที ่5  กการจัดหน้าเว็บบเพจด้วยตาร
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ราง 
 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 
ภาพทีที่ ง.23 หน้าจจอแสดงเนือ้หหาบทเรียน บททที่ 6  การแบบ่งหน้าเว็บเพจจด้วยเฟรม 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

ภาพที่ ง.224 หน้าจอแสดงแบบทดสออบระหว่างเรยียน บทที ่6  กการแบ่งหน้าเว็ว็บเพจด้วยเฟ

167 

 
รม 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 
ภาพที่ ง.25 หน้าจจอแสดงเน้ือหหาบทเรียน บทที่ 7  การเลล่นมัลติมีเดียบบนเว็บเพจ 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 

ภาพที่ ง.226 หน้าจอแสสดงแบบทดสอ
 

อบระหว่างเรียยน บทที ่7  ก การเล่นมัลติมีมีเดียบนเว็บเพ

169 

พจ 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 

 

ภาพท่ี ง.27 

ภาพที่ ง.28

 หน้าจอแสดง

 หน้าจอแสดง

  

งคําแนะนํากอ่
 

งการยืนยันกา

อนการทําแบบ

ารเริ่มทําแบบ

บทดสอบหลัง

ทดสอบหนังเ

เรียน 

เรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 
ภาาพที่ ง.29 หนน้าจอแสดงแบบบทดสอบหลลังเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 
ภาพพที่ ง.30 หน้าาจอแสดงสถาานะของการตตอบคําถามในแบบทดสอบหหลังเรียน 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 

 

ภาพ

ภาพที่ ง.32

พที่ ง.31 หน้า

2 หน้าจอแสด

าจอแสดงการยื

ดงข้อมูลการต

 
ยืนยันในการส

 

ตอบแบบทดส

ส่งคําตอบของ

อบหลังเรียนพ

งแบบทดสอบ

พร้อมเฉลยคํา

หลังเรียน 

าตอบในแต่ละ
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ ง.333 หน้าจอแส
 

ดงข้อมูลผู้จัดทํา 

174 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้ 
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